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Chapter 1: Getting Started

O™ acdses Photo Studio

landard 2Ud

Welcome to ACDSee Photo Studio Standard 2019

Welcome to ACDSee, and congratulations on choosing the industry-leading digital photo management software.

ACDSee is the essential application for importing, organizing, viewing, enhancing, and sharing your digital photos
and other media files.

With ACDSee you can import your photos from your camera to your computer, categorize and rate your files, and
manage photo collections of any size—from a few hundred to a few hundred thousand. Choose to view thumbnail
previews of any size, or use a detailed list of file properties to sort your files. Can't find a particular photo? No
problem. ACDSee includes a variety of powerful searching tools and a Compare Images feature to eliminate
duplicates.

Achieve total control of your photography workflow and get back behind the lens faster with ACDSee, the complete
photography management solution for professional photographers.

View mode quickly generates high-quality displays of your images. You can run slideshows, play embedded audio,
and display multiple-page images in any of the more than 50 image and multimedia file formats.

Also, ACDSee includes a wide variety of image editing tools you can use to create, edit, and touch-up your digital
images. Use tools such as red eye reduction, crop, sharpen, blur, and photo repair to enhance or correct your
images. Image editing tools, such as exposure adjustment, convert, resize, rename, and rotate, can be performed
on multiple files at the same time.

The user interface is completely customizable, and provides quick access to tools and features. You can customize
the screen layout, the order of images, toolbar display, and many other options to suit your preferences. ACDSee
contains extensive context-sensitive Help to assist you as you move through the application.

ACDSee is a fast, powerful, and easy-to-use image management system that everyone from beginners to
professionals can use and enjoy.

About the ACDSee User Interface

The ACDSee user interface provides easy access to the various tools and features you can use to browse, view,
edit, and manage your photos and media files. ACDSee consists of five modes: Manage mode, Photos mode, View
mode, Edit mode, and Dashboard mode.

Manage Mode

0 Manage mode is the main browsing and managing component of the user interface, and is what you see when
you start ACDSee using the shortcut icon on your desktop. In Manage mode, you can find, move, preview, and sort
your files, and access organization and sharing tools.

Manage mode consists of 15 panes, most of which can be closed when not in use. The File List pane is always
visible, and displays the contents of the current folder, the results of your latest search, or the files in your
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database that match your filtering criteria. A status bar at the bottom of the Manage mode window displays
information about the currently selected file, folder, or category.

You can open and close panes, move them to different areas of your screen, and stack them on other panes or
dock them to the edge of the window. Most panes also have additional options you can set to further customize
their behavior and appearance.

Manage mode also features a toolbar and a set of drop-down menus. The toolbar provides buttons for your home
folder, and for navigating forwards and backwards through your folders. The drop-down menus provide quick
access to the most common tasks.

Photos Mode

9 Photos mode can be used to view your entire image collection by date. You can view them by year, month, or

day. If you have Microsoft OneDrive™ you can toggle viewing your OneDrive image collection along with the image
collection on your hard drive, or just your hard drive collection on its own. Photos mode only displays images that

have been cataloged. Images in Photos mode are displayed by the date they were taken, as indicated in the images
EXIF data.

Photos mode consists of two panes, the Date pane and Timeline pane. The Date pane displays all of your cataloged
photo collection by date. The Timeline pane displays the year and month of your photos and how many photos are
in each. You can also select individual images to launch them in other modes.

View Mode

9 In View mode you can play media files and display images in full resolution, one at a time. You can also open
panes to view image properties, display areas of an image at varying magnifications, or examine detailed color
information.

You can open View mode by selecting an image and clicking on the View mode tab, and you can use the Filmstrip in
View mode to flip quickly between all of the files in a folder. View mode contains a toolbar with shortcuts to
commonly-used commands, and a status bar at the bottom of the window, which displays information about the
current image or media file.

Edit Mode

6 Edit mode works on the image data already rendered to RGB. Edits are independently applied to the converted
RGB data in the order that you do them. This chain editing gives you full control over the pixels, allowing creative
freedom to apply precise adjustments. This makes operations such as selections and blend modes possible.

Dashboard Mode

6 Dashboard mode allows you to quickly access and browse file, camera, and database statistics based on your
ACDSee database and EXIF information. As Dashboard mode relies on information derived from your database, it is
important to catalog in order to get the most out of it.

Switching Modes in ACDSee

In ACDSee you can quickly switch between the five modes—Manage, Photos, View, Edit, and Dashboard mode.

The mode buttons are located at the top right of the ACDSee window:

Page 15 of 329



ACDSee Photo Studio Standard 2019

=== Manage = @ Pholos <® View N Edit Ll

To Switch from One Mode to Another:

Click one of the following mode buttons:
* Manage: Import, browse, organize, compare, find, and publish your photos.
* Photos: View your entire image collection by date.
* View: Display and examine photos at any magnification.
* Edit: Fix and enhance photos using the pixel-based Edit tools.

* Dashboard: Quickly access and browse file, camera, and database statistics.

Using Manage Mode

In Manage mode, you can browse, sort, catalog, manipulate, and share your files and images. You can combine
different tools and panes to perform sophisticated searching and filtering operations, and view thumbnail
previews of images and media files.

You can also switch very quickly to the other modes by clicking the mode buttons in the top right corner.

The panes in Manage mode are fully customizable, and can be moved, resized, hidden, docked, or closed. You can
also stack the panes together for easy reference and accessibility, and to maximize your screen space.

If the pane you want to view is not visible, click Panes from the top left main toolbar and select a pane.

About the Manage Mode Panes

Manage mode consists of the following panes:

Page 16 of 329



ACDSee Photo Studio Standard 2019

File List This pane displays the contents of the currently selected folder, the results of your latest
search, or the files and folders that match your selective browsing criteria. The File List
pane is always visible, and cannot be hidden or closed. You can customize the File List
pane by changing the way the files are displayed, or the size of the thumbnails.

Folders This pane displays the directory structure of your computer, much like the directory tree
in Windows Explorer. You can use the Folders pane to browse through the folders and
display their contents in the File List pane. You can also display the contents of multiple
folders in the File List by clicking the Easy-Select indicator opposite each folder, on the
left side of the pane.

Calendar This pane displays a calendar that you can use to organize and browse your files
according to their associated dates.

Shortcuts This pane stores shortcuts to your favorite images, files, folders or even applications.
Dragging an image, file, or folder into the Shortcuts pane creates a shortcut to the
original without affecting it in any way.

Search This pane provides access to a powerful search utility. You can specify the type of search
you want to perform, and enter your search criteria into the fields provided in the Search
pane.

You can also save a search and give it a name. Saved searches are listed on the Search
pane and the Catalog pane. On the Search pane, can select Saved searches from the
drop-down list to run again. On the Catalog pane, Saved Searches are listed below Auto
Categories, where you can run them again by clicking once on the Saved Search name.

Preview This pane displays a thumbnail preview of any image or media file currently selected in
the File List pane. You can adjust the size of the thumbnail by resizing the Preview pane,
and also specify whether you want the Preview pane to play media files or just display the

first frame.
Selective This panel combines input from the Folders, Catalog, and Calendar panes to limit the list
Browsing of files in the File List pane to those that match a specific set of criteria. You can include

or exclude files by adjusting the different criteria in the Selective Browsing pane. You
can access the Selective Browsing panel from the View menu.

Catalog This pane lists the categories, auto categories, ratings, color labels, keywords, and
saved searches to help you sort and manage your files. You can also use the Special
Items area in the Catalog pane to quickly view all of the images on your computer, or see
any uncategorized files in the current folder.

Task This pane displays menus of commonly-used buttons and commands from the menus
and toolbars. The menus change dynamically based on your current location and
selections in ACDSee.

Properties This pane displays file properties and metadata for any file or folder you select in the File
List pane. You can use the Properties pane to view and edit metadata for your files, and
the EXIF metadata included in digital photos.

Map This pane displays marked locations on a map for any file you select in the File List pane.
You can use the Map to view and mark the geographic location of your files.

Image Basket While browsing through your files and folders, you can place images in the Image Basket
to hold them temporarily. You can then edit, print, or share those images without moving
them all into a single folder.

Manage Mode Drop-Down Menus

The drop-down menus in Manage mode give you quick access to often-used tasks. The drop-down menus include
the following:

* Import: Where you can import photos from cameras and other devices.
* Batch: Where you can run all the batch editing processes.

* Create: Where you can create slide-show files, PowerPoint presentations, online albums, or archives.
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+* Slideshow: Where you can configure and run a slideshow.
+* Send: Where you can upload to photo sites, an FTP, or share photos by email.

+* Editors: Where you can list external editors for easy access.

Working with Manage Mode Panes

You can open and close panes in Manage mode to suit your preferences, and move, float, or stack any of the panes
to customize the layout of the Manage mode window.

To Open or Close Panes in Manage Mode:

Click Panes and select the pane you want to open or close.

Moving Panes

You can move a pane from a docked or floating position to a new location. You can move one pane at a time, or
several stacked panes.

To Move a Pane:
1. Drag the pane's title bar and hold your cursor over any of the arrows of the Docking Compass.
2. When the shaded marquee displays the position of the pane you want, release the mouse button.

3. Toreturn a pane toits previous location, double-click its title bar.

To Move a Docked or Floating Pane:
Do one of the following:
* Drag the pane's tab to a new location. Only one pane moves.
* Drag the pane's title bar to a new location. Any panes stacked beneath it also move.

k monitor.

/ J If you use dual monitors, you can move the panes to your second monitor to free up space on your main
I

Docking Panes

When you select a pane in the Manage mode, the Docking Compass activates to help you place the pane precisely.
The Docking Compass consists of an outer and inner ring of arrows. When you hold your cursor over any of the
arrows, a shaded marquee displays the potential position of the pane.

To Dock a Pane in Manage Mode Window:
1. Drag the pane's title bar or tab to activate the Docking Compass.

2. Todock a pane around the outer edge of the window, hold your cursor over any of the outer arrows of the
Docking Compass, and then release the mouse button.

3. Todock a pane around the outer edge of the File List pane, or any another pane, hold your cursor over the
inner arrows of the Docking compass, and then release the mouse button.

Stacking Panes

You can stack panes and reorder their tabs to suit your needs.
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To Stack Panes:
1. Do one of the following:

* Drag one pane's title bar onto the title bar of another pane until the shaded marquee appears, and
then release the mouse button.

* Drag one pane inside another, hold your cursor over the center of the Docking Compass, and then
release the mouse button.

2. Toreorder the panes, drag a tab to the left or right in the tab order.

3. Toseparate a tabbed pane, drag the pane’s tab to another location on the screen.

Resizing Panes
You can resize all the panes in Manage mode, whether they are docked or floating.

To Resize a Docked Pane:
1. Hold your cursor over the edge of the pane until the cursor changes to arrows and lines.

2. Drag the edge of the pane to the size you want.

To Resize a Floating Pane:

Hold your cursor over the edge or corner of the pane and then drag the pane to the size you want.

Resetting the Layout
You can restore all of the panes to their default positions for Manage and Edit mode at any time.

To Reset the Layout:
Click View | Reset Layout.

Using Photos Mode

Photos mode is a quick and convenient way to view your entire image collection by date. Photos mode displays
images that have been cataloged. Images in Photos mode are displayed by the date they were taken, as indicated
in the images' EXIF data. If the EXIF data does not contain a date taken, Photos mode will display the images based
on the modified date.

/ ) You can modify the date taken by using Batch Adjust Time Stamp.

L

Photos mode contains two areas:
Date pane: This pane displays all of your cataloged photo collection by date.

Timeline pane: This pane displays the year and month of your photos and how many photos are in each.

Viewing Images

Images are displayed in Photos mode by date. To toggle viewing them by year, month, or day, do one of the
following:

* Click the Year, Month, or Day buttons at the bottom right of the Date pane.

* Use the forward and back arrows at the top left to move from Year to Month to Day view.
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* Choose View | Year/Month/Day.
* Click an image to move from Year to Month to Day view.

* Click on a year/month entry in the Timeline pane to navigate to the images from that time.

To View Only Your Microsoft OneDrive® Photo Collection:

Click the Filter drop-down menu and select OneDrive.

To View All of Your Photo Collection (Including OneDrive):

Click the Filter drop-down menu and select All.

To View Photos from Your Pictures Folder Only:

Click the Filter drop-down menu and select Pictures.

To View Photos from Your Desktop Only:

Click the Filter drop-down menu and select Desktop.

To View Orphaned Files with Your Photo Collection:

Click the Show Orphan Files button at the top of the Date pane. Orphaned files will appear in sepia.
To View a Larger Version of an Image:
Do one of the following:

* Double-click an image to open it in View mode.

* Select an image and press Enter to toggle between View mode and Photos mode.

To Open an Image in Another Mode:

Do one of the following:
* Right-click the image in Day view and select an option from the context menu.

+* Ctrl + right-click the image in Year or Month view and select an option from the context menu.

To Locate an Image in Windows Explorer®:
* Right-click the image in Day view and select Show in File Explorer from the context menu.

* Ctrl + right-click the image in Month or Year view and select Show in File Explorer from the context
menu.

Cataloging

Photos mode will only display images that have been cataloged. You can catalog your images by:
* Browsing your folders in Manage mode.

* Using the Catalog button at the top of Photos mode.

Using View Mode

You can use View mode to display your images and media files using their actual dimensions or at a variety of
magnifications. You can also display a group of images in sequential order.

View mode contains four main areas:
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* View area: This is the main viewing area, which displays the current image or media file. You can
customize the view, and zoom in or out on your images and media files.

+ Bottom toolbar: Located below the main viewing area, the Bottom toolbar provides shortcut buttons to
commonly-used tools and commands, such as the zoom and scroll tools. You can customize the toolbar to
use large or small icons, or you can choose to not display the toolbar.

* Filmstrip: This is an area below the main viewing area, which displays thumbnails of the images in the
current folder or in the group of images you selected in Manage mode. It provides a scroll bar along the
bottom, so that you can scroll through your images, and buttons for moving to the next or previous image.

* Status bar: Located at the bottom of the window, the Status bar displays information and properties for
the current image or media file. It also displays icons for rating, color labels, and tagging that you can
click to edit.

View mode can also display the Properties pane to show EXIF, IPTC and ACDSee Metadata information about the
image or file. View mode also has the Navigator, Magnifying Glass, and Histogram panes, each of which show
detailed image information.

To Open an Image or Media File in View Mode:
In Manage mode, in the File List pane, do one of the following:
* Select a file and press Enter.
* Select afile and click the View mode button.
* Double-click afile.

* Right-click an image or media file, and then select View.

To Open a Group of Images in View Mode:
1. In Manage mode, in the File List pane, select a group of images.
2. Press Enter.
3. To navigate through the images , do the following:
* Toview the next image in the sequence, click Next.

* To view the previous image in the sequence, click Previous.

Viewing Images in Full Screen Mode

You can use the entire screen of your monitor to display images. In full screen mode, the window borders, menu
bar, status bar, and toolbars are hidden, and only the image is visible. If you want to always view your images in
full screen mode, you can set this option as the default for View mode.

To View Images in Full Screen Mode:
1. Open animage or a group of images in View mode.
2. Click View | Full Screen.
3. Right-click the image to access the View mode tools and options via a context menu.
To Exit Full Screen Mode:
Do one of the following:
* Press the F key.

* Right-click the image and select View | Full Screen.

' ) Use the keyboard shortcut F in View mode to toggle in and out of a full screen view.
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Using the View Mode Panes

To Open the View Mode Panes:
1. Open animage in View mode.
2. Do one of the following:
* Click Panes | Histogram to display the histogram for the image.

* Click Panes | Magnifying glass to display a pane which shows the area of the image under your
cursor at a higher magnification.

* Click Panes | Navigator to display a thumbnail overview of a magnified image.
* Click Panes | Page View to open the Page View panel for multi-page images.

* Click Panes | Properties to display the IPTC, EXIF and ACDSee Metadata for the image.

Using the Bottom Toolbar

Use the Bottom toolbar to access commonly-used tools.

Bottom Toolbar

Add to Image Basket Adds the image to the Image Basket.

=

o Rotate left Rotates the image to the left.

C Rotate right Rotates the image to the right.

1“ Scroll Pans or scrolls the image when the image is zoomed to a
larger size than the View mode area.

‘m Select Selects a rectangular area of the image.

CJ_ Zoom Zooms in or out on the image. Click to zoom in or right-

click to zoom out.

E Full Screen Displays the image on a full screen. Press F to view full
screen.

a*" ] External Editors Opens the file in an external editor of your choosing.

Shaw Original Show Original Toggles between the original image and the edited image.

= Navigator Displays the Quick Navigator pane so you can see a

thumbnail overview of a magnified image. (Only visible for
images that are zoomed in to a size larger than will fit on
the screen.)

Zoom slider Controls the size of the image in the View mode area. Drag
the slider to adjust the size.

Zoom drop-down list Displays a list of zoom sizes to select.

Actual Size Returns the image to its actual size.
Fit Image Reduces the image to fit within the View mode area.
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Using Windows Touch Gestures™ with View Mode

If you have a Windows Touch Gestures™-enabled device, you can use it with View mode for quick, easy viewing of
photos.

To Use Windows Touch Gestures™ with View Mode:

Open an image in View mode.

* Swipe on the image to scroll through images one at a time. You can also use this method on the Filmstrip
at the bottom of View mode.

* Hold and swipe slowly in one direction to go through all of the images in the folder.

* Hold down on an image, and then let go to achieve the same results as right-clicking with a mouse.
* Double-tap the image to return to Manage mode in ACDSee.

* Move two fingers apart to zoom in, and toward each other to zoom out.

* After zooming in further than 100%, you can pan the image with your finger.

* If viewing images in Actual Size (1:1), you can still swipe through your images. They will all be displayed
at 100% zoom level.

Switching to Manage Mode
You can return to Manage mode at any time.

To Return to Manage Mode from View Mode:

Do one of the following:
* Double-click the image.

* Click the Manage mode button.

Using Edit Mode

Edit mode is where you can apply changes to your images. You can edit the overall look of your images by
changing the lighting and color, or you can crop, flip, resize, or rotate your images. You can use selections to fix
specific parts of your images. And you can also add final touches to your images, such as red eye removal,
borders, and special effects.

In Edit mode, you can:

* Use the Selection tools or Edit Brush to select and apply edits to a specific part of the image.

* Remove flaws or red eye.

* Add text, watermarks, borders, a vignette, a tilt-shift, special effects, or drawings.

* Crop, flip, resize, or rotate your images.

* Adjustlighting using the exposure, levels, auto levels, tone curves, and lighting tools.

* Adjust color using the White Balance, Color Balance, Convert to Black & White, or Color LUTs tool.

* Add details to your image using Sharpen, Clarity, Remove Noise, Add Noise or Blur tools.
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Using Dashboard Mode

Dashboard mode is a quick and convenient way to browse your file, camera, and database statistics. Camera
statistics are read from your images' metadata, and file information is analyzed from your ACDSee database.
Therefore, it is important to catalog to get the most out of Dashboard mode.

Cataloging Files

To catalog, do one of the following:
* Goto Tools | Database | Catalog.

* Browse your folders in Manage mode.

Dashboard Mode

Dashboard mode contains the following tabs:

* Overview tab: The Overview tab summarizes the information found on the other tabs. It also displays a
graph detailing your monthly or yearly photo counts. You can use the drop-down menu at the top of the
tab to switch between viewing a range of months or a range of years. You can use the Prev and Next
buttons to navigate backward or forward in time.

* Database tab:The Database tab displays data pertaining to your database, such as its location, size,
backup information, a breakdown of your assets, and more.

* Cameras tab: The Cameras tab displays data pertaining to your camera usage, such as which cameras
you use the most, your favorite ISO setting, and more.

+* Files tab: The Files tab displays data pertaining to your image and video files, such as your most used bit
depths, image resolutions, and more.
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Chapter 2: Getting Help

Using the Quick Start Guide

The Quick Start Guide is designed to give you a brief orientation of the most important features in ACDSee. The
first two intro pages allow you to configure some settings to facilitate your future workflow. After the first two intro
pages, the Quick Start Guide contains a set of links on the left side that you can click to get a tour of the main
features in ACDSee. You can also use the Next button.

To Close the Quick Start:

Uncheck the Always show at start-up option in the bottom left corner of the dialog box, and click Close.

To Re-Open the Quick Start Guide:
On the Menu bar, click Help | Quick Start Guide.

To Use the Quick Start Guide:
Click the links on the left side of the Quick Start Guide or the Next button for a high-level tour.

To Set Preferences:
On the first page, click the Browse button to select the folder ACDSee will open to in the future.

On the second page, click the Select button to choose which folders you would like the ACDSee database to keep
track of.

Also on the second page, you can choose an interval from the drop-down menu on the right side to specify how
often ACDSee should remind you to backup your database.

Finding Resources and Support

The Help menu on the ACDSee menu bar contains links to open plug-in help files and options that link you to the
ACDSee Web site, where you can find updates, newsletters, and system requirements.

Other links take you to the support page, to the registration page, or the community home page where you can join
the community and participate in the ACDSee forums.

The Help menu is also where you can convert a trial version of ACDSee to a full version by entering a license code.

Click Help to see the following menu options:
* Plug-in Help

* Manage acdID Account

+* Check for Updates and Messages
* Quick Start Guide

* Product Support and Resources

* Customer Support

+ ACDSee Products

+ ACDSee Community

+ Facebook
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* Twitter

* About ACDSee Ultimate 2019
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Chapter 3: Manage Mode

Manage mode is the main browsing and managing component of the user interface, and is what you see when you
start ACDSee using the shortcuticon on your desktop.

In Manage mode, you can:

* Import your photos from a device, CD or DVD, or disk.

* Browse files and folders.

* Catalog files by tagging them, adding categories, color labels, ratings, keywords and other metadata.
* Search for files and create saved searches.

* Printimages.

+ Edit batches of files.

* Manage and maintain your ACDSee database.

* Automatically advance to the next image in the folder when you apply metadata.

Importing Files with ACDSee

You can use ACDSee to download images from devices like your digital camera, flash drives, CD/DVDs, or other
removable devices. In Manage mode, you can also use the File | Import | From Disk option to import files from a
network, and any kind of disk or drive that can be mapped, while preserving the original folders and subfolders.

Importing Files Using the Windows AutoPlay Dialog Box
When you connect your digital camera or other device to your computer, the Windows AutoPlay dialog box prompts
you to choose one of the following:

* Import pictures using ACDSee: Select this option to open the Import dialog box. You can then select
settings to rename, backup, and place the files. You can save your import settings and give them a name
so that you can re-use them later. You can also create advanced settings for import dates and RAW + JPEG
options if your camera takes both file formats. You can also create a file renaming template to use with
specific kinds of files or projects.

* Manage pictures using ACDSee: Select this option to browse the files in ACDSee. You can then choose
to import the files or simply copy and paste the files from the device.

* Import pictures and videos using Windows: Select this option if you prefer to use Windows to import
the files.

Depending on the other applications installed on your computer, there may be additional options.

Y If you experience difficulty with your computer recognizing your device as a drive, explore your device's
manual about mounting the device as a drive. Or, use your computer's card reader to access your
memory card.

Importing Files from Specific Types of Devices

For more specific instructions, select the type of device you connected:
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* Importing Photos From a Device

* Importing Photos From a CD or DVD

* Importing Photos From a Disk

About Removable Devices

With ACDSee, there are several ways to obtain images from your digital camera, scanner, or memory card. For
more information about how your device communicates with your computer, please consult your device's Help file
or manual. Some different types of removable devices are:

* USB Removable device: Removable devices include memory cards that you can attach to your computer
using a USB card reader, camera memory cards that insert directly into slots on the computer, or flash
drives. USB removable devices are detected by your computer and are shown in the structure as a
removable drive.

* Windows Image Acquisition (WIA): Cameras and scanners that use Windows Image Acquisition
(WIA) drivers to communicate with the computer. Some cameras, including Canon cameras, use WIA.
ACDSee automatically detects the WIA protocol.

._/" You require DirectX 9.0c and QuickTime to copy and view audio or video files.

Importing Photos From a Device

The Import From dialog box gives you multiple options for importing your files from cameras, card readers, flash
drives, and other mass storage devices. If you want to simply import files with a few clicks, you can. Or you can
select from several options to streamline your workflow and perform multiple tasks with each import.

In the Import From dialog box, you can view the thumbnails of the files on the device by their date or file type. You
can change the size of the thumbnails to make it easier to select those you want to import or leave on the device,
and then view only those you have selected.

You can also choose the destination folder or subfolders for the files, create a backup set of files as you import,
and rename the files during the import process, automatically rotating them if your camera has this option.
Advanced settings give you options to change the date you want to use, and where to place RAW and JPEG files if
your camera creates both file formats.

You can even organize your files as you import by adding Categories, IPTC and ACDSee Metadata.
Then you can save all these settings as a preset to use or adapt later.
If your camera connects to the computer as a removable drive, you can also simply copy photos directly
=£_ from the File List and Folders pane because ACDSee detects and displays the removable device in the

Folders pane. If you are not sure how your camera connects to your computer, please see About
Removable Devices in Importing Files with ACDSee.

Some cameras, for example, Canon, use Windows Image Acquisition (WIA) to communicate with a
-=£_ | computer. If your devices use these protocols, you can import by clicking From Device on the File |
Import menu. ACDSee automatically detects these protocols.

To Download Photos Using the Import From Dialog Box:

1. Connect your camera or device to the computer. Make sure your camera is turned on, and the cable is
properly connected to your computer.
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2. Do one of the following:
* If the Windows AutoPlay dialog box opens, select Import pictures using ACDSee.

* If you have more than one device connected to your computer, select the device you want to use
from the list, and then click OK.

* In Manage mode, click File | Import | From Device.
* Press ALT + G on the keyboard.

3. Inthe Import From dialog box, select from the import options as described below.
4. Click Import.

5. Tobrowse your imported photos, click Yes when the Import Complete dialog box displays.

,_/ You may require Direct X 9.0c and QuickTime to download audio and video files from your camera.

Import From Options
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View by

Choose import
preset

Location
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Select items to
import

Date

File Type

View all
View selected

Import settings
drop-down menu

Save import

settings

Delete import
settings

Choose Destination
drop-down menu

Place in Subfolders
drop-down menu

You can control which items are imported by choosing one of
the following:

* New: Only imports files that have not been imported in
the past.

* All: Imports all files.

* Custom: Imports the selected files. You can control
which files are imported by enabling or disabling their
checkboxes.

Displays all the files grouped by the dates they were created.
To deselect a date, click the checkbox beside the date. To
deselect all dates, click the All Dates checkbox.

Displays all the files grouped by their file type. To deselect a file
type, click the checkbox beside the file type. To deselect all file
types, click the All file types checkbox.

Displays all the thumbnails of the files on the device.
Displays only the files selected for import.
Displays the names of recently-used import settings to use
again, or you can select one of the following:
* Current: Uses the current settings to import.
* Last used: Uses the import settings from the last import.
* None: Clears all the current import settings.
Saves all the current import settings with a name so that you
can use them again. To save (or edit) import settings, select

the Save icon and type in new name (or re-save existing
settings).

The new name for the import settings appears in the drop-
down menu.

Deletes the saved import settings currently selected in the
Import settings drop-down menu.

Displays the names of recently-used destinations to use again,
or you can select one of the following:

* Last used: Uses the destination from the last import.
* None: Clears all the current destination settings.

Displays the following pre-defined subfolder options to select:

+ Single folder by name: Creates a new subfolder with
the name you type into the Name field, which activates
when you select this option. All the files are placed into a
folder with the new name.

+* Single folder by today's date: Creates one folder using
today's date as the name and places all the files into the
folder.

+* Nested folder by today's date: Creates a series of
nested folders, one below the other, based on today's date
and the format you select in the Format field. The folders
are created as the sample shows and all the files are
placed in the lowest folder.
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File
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Format

Sample

Backup to drop-
down menu

Rename files to
drop-down menu

Edit

Apply Metadata
drop-down menu

Customize

* Nested folders by file's date: Creates multiple sets of
nested folders based on the files' dates and on the format
you select in the Format field, which activates when you
select this option. The folders are created as the sample
shows and the files are imported into the lowest folders on
each date.

* Separate folders by file's date: Creates separate
folders based on the individual file dates in the format
selected from the Format drop-down options.

* Preserve subfolder names: Preserves existing folder
names when you use the From Disk option to import. For
example, if you have a flash drive or CD containing images
in a complex set of subfolders, the whole folder tree is
imported intact.

Displays date format options for the Nested folder options (see
above).

Displays a sample of the nested folders that will be created
using the current settings (see above).

Creates a backup set of files using an exact duplicate of the
subfolders you have selected under Place in.

You can also do one of the following:

* Click Browse and then navigate to an existing folder to
use as a backup destination.

* Click Browse and then Make New Folder to create a new
folder as a backup destination.

While existing ACDSee Metadata is included in the
=¥ | backup copy, any Catalog settings (IPTC or ACDSee
Metadata) added during import will not be included.

Renames each file as it imports according these predefined
renaming templates:

* Date/time - filename: Creates each filename using the
file date and time the file was created plus the original
filename.

* Date/time: Creates each filename using the file date and
the time it was created.

+ Camera - sequence number: Creates each filename
using the camera name and a sequential number starting
at one.

* Date/time - sequence number: Creates each filename
using the file date and the time it was created plus a
sequential number starting at one.

* Camera - filename: Creates each filename using the
camera name and the original filename.

When you create and save your own renaming templates, they
also appear in this list for you to select.

Opens the Rename Templates dialog box where you can create
and save your own renaming templates.

Select the names of saved metadata presets or select Manage
presets to open the Manage Metadata Presets dialog box of
options.

Properties pane Metadata tab: Enter ACDSee and IPTC
Metadata into to the fields to add to the files you are importing.
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Automatically
rotate images

Delete items from
source after import

Advanced ACDSee database
date

RAW+JPEG

Properties pane Categories tab: Assigns the imported files
to any category selected in this tab. You can select multiple
categories.

Rotates your images automatically if your camera creates the
information needed for this option to work.

Deletes the imported items from their original location(s) after
import.

Opens the Advanced Import Options dialog box where you can
change the date settings for files and specify where to place
RAW and JPEG files.

To set the ACDSee database, use one of the following as the file
date:
+ Exif date: Uses the EXIF date embedded in the image by
the camera.

+* File modified date: Uses the date the file was last
modified.

+ Specific date: Uses the date you select by clicking the in
the calendar drop-down arrow.

To specify where to place RAW+JPEG files select one of the
following:

* Place both in chosen destination folder: Places RAW
and JPEG files in the folder you have selected under
Choose destination on the Import From dialog box.

* Place JPEG in subfolder: Places the RAW files in the
folder you have selected under Choose destination on
the Import From dialog box. Then creates a new subfolder
with the name you type into the Subfolder name field,
which activates when you select this option. All the JPEG
files are placed into the new subfolder.

* Place RAW in subfolder: Places the JPEG files in the
folder you have selected under Choose destination on
the Import From dialog box. Then creates a new subfolder
with the name you type into the Subfolder name field,
which activates when you select this option. All the RAW
files are placed into the new subfolder.

fThe values set in the IPTC fields are reflected in their corresponding EXIF field.

Importing Photos From a Scanner

You can scan images using ACDSee and import them to specific, accessible locations.

To Specify a Destination for Your Scanned Images:

1. Click Tools | Options | Manage Mode.

2. On the Manage mode page, in the Scanning Destination section, click the Browse For Folder button.

3. Inthe Browse For Folder dialog, select a destination folder for your scanned images.

4. Press OK.

To Scan Images:
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1. In Manage mode, click File | Import | From Scanner.

2. Configure your scanning settings as desired. As the scanning dialog is controlled by Windows, these
settings will vary, depending on your OS and version of ACDSee.

3. Navigate to the location you set as the destination for your scanned images using the Folders pane.

Importing Photos From a CD or DVD

You can download photos from a CD or DVD using the Import From dialog box, or the Folders pane. Before you
import photos, you can browse to the CD and view them just like any other folder and then simply copy and paste
them into a new location.

If you use the Import From dialog box, you can set the subfolder options to import complex folder structures
intact, including all the folder names. You can also organize your files as you import them, as well as create a
duplicate backup folder, simultaneously.

To Import Photos from a CD or DVD:
1. Insertthe CD or DVD into the drive.
2. Do one of the following:
* If the Windows AutoPlay dialog box opens, select Import pictures using ACDSee.

* If you have more than one CD or DVD drive connected to your computer, select the device you
want to use, and then click OK.

* In Manage mode, click File | Import | From CD/DVD.

3. Inthe Import From dialog box, select the Import From options you want to use, and then click Import.

4. Tobrowse your imported photos, click Yes when the Import Complete dialog box displays.

Importing Photos From a Disk

ACDSee makes it easy to import photos from any other storage device, computer, network, flash drive etc. In fact,
any device that your computer can map to. When you connect a removable drive, or to a network, disk or another
computer, ACDSee sees it as a removable drive and you can browse to it, and around it, using the Folders pane.
You can just copy and paste the files into ACDSee.

If the files in the disk or drive have a complex folder structure or you want to organize, rename, and back up the
files as you import them, it is worth using the Import From dialog box, which has import settings do all of these
tasks simultaneously.

To Import Photos from a Disk:
1. Connect the disk to the computer.
2. Do one of the following:
* If the Windows AutoPlay dialog box opens, select Import pictures using ACDSee.

+ If you have more than one disk or drive connected to your computer, select the device you want to
use, and then click OK.

* In Manage mode, click File | Import | From Disk.

3. Inthe Browse for Folder dialog box, navigate to the removable drive or device in the folder tree, and then
click OK.

4. Inthe Import From dialog box, select the options you want to use, and then click Import.

5. Tobrowse your imported photos, click Yes when the Import Complete dialog box displays.
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Creating a Renaming Template

In the Import From dialog box, you can create, name, and save a template that gives each file a unique name as
they are imported and placed on your hard drive. You can then re-use the template each time you import photos.
Renaming templates can have a numerical sequence, custom text, and file-specific information in each new file
name. You can create and save different renaming templates for different sorts of files. For example, you could
have a different renaming template for a different camera, or a different type of file.

To Create a Renaming Template:
1. Inthe Import From dialog box, select Rename files to.
2. From the drop-down list, select one of the following system templates:

* Date/time - filename: Renames the files using the date and time each file was created and the
original file name.

* Date/time: Renames the files using the date and time each file was created.

* Camera - sequence number: Renames the files using the camera name and a sequential
number.

* Date/time - sequence number: Renames the files using the date and time each file was
created and a sequential number.

+* Camera - filename: Renames the files with the name of the camera and each file's original
name.

3. Tocreate your own renaming template, or add to a system template, click Edit.
4. Inthe Rename Templates dialog box, select from the options as described in the table below.

5. Click OK.

If you select the Skip video and audio files checkbox, the rename process will not rename video and
= | audiofiles.

Rename Templates Options
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System
template
drop-down
list

New rename
template

0

Delete

Rename
Template

Insert
Metadata

Sample

Skip video
and audio
files

Click the drop-down list to select a different pre-defined system template.

Click to open the New Rename Template dialog box where you can type in a name for your
own renaming template. Give the renaming template a name that clearly identifies how you
plan to use the template, or what kind of information the name will contain. For example,
Camera name_photographer.

When you click Save, the name of your new template is added to the drop-down list of
system templates.

Deletes the renaming template currently selected in the drop-down list unless it is a pre-
defined system template, which cannot be deleted.

Use this field to create the renaming template. You can type in the photographer's name and
an underscore between each element of the template to make it easier to read.

Use the following placeholders to ensure that each filename is unique:

* Insertan *. When your files are renamed, the * will be replaced by the original file
name.

* Inserta #. When your files are renamed, each # will be replaced by a sequential
number. If you have a large number of files, insert several # #s. For example, if you
enter ###, the first file renamed will be numbered 001, the next 002, and so on. If
you have over 1000 files, insert ## ##.

* Insert a metadata placeholder < > and the data inside these brackets is replaced
with whatever data you have chosen. For example, if you choose <Camera:Model>,
the model of the camera is inserted into each file name.

Click to open the Choose Properties dialog box, where you can select from a long list of
metadata to insert into your template.

As you type, or add placeholders in the Rename Template field, the same updates to show
you a sample of how renaming template will look.

Skips the renaming of video and audio files during the rename process.

Importing a Lightroom® Database

You can use the Adobe® Lightroom® Database Importer to import your collections, keywords, ratings, and color
labels from Lightroom® into ACDSee . Your keyword hierarchies will import independent of whether they are
embedded in the images selected for import.

._/" You cannot import smart collections.

! You cannot begin importing while Lightroom® is open.

If you have a hierarchy in your Collections in ACDSee that is identical to your hierarchy in Lightroom®,
-=*_ | these collections will merge.

To Import Your Lightroom® Database:

1. In Manage mode, choose Tools | Database | Import | Lightroom Database.

2. Inthe Adobe Lightroom Database Importer, press Next.
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3. Select the checkboxes of the database information you would like to import into ACDSee, including
Ratings, Labels, Collections, and Keywords.

4. Use the Browse button next to the Location field to navigate to the location of your Lightroom® database
file.

» By default, the field displays the default location where Lightroom® stores its database, so you will
=% only need to browse if you have moved your database.

5. Press Next.

6. Check the summary to ensure that the displayed information is correct. If you see a mistake, use the Back
button to return to the previous page to make any corrections.

7. Press Next. Green checkmarks will display next to the items that are successfully completed, and red
crossmarks will display next to items that failed.

8. Press Finish.

Lightroom is a registered trademark of Adobe Inc.

Working with Images on Mobile

You can access, browse, view, delete, and copy and paste images on your mobile phone with ACDSee. To edit
images on your mobile device, you will need to copy them to a local folder.

To Access the Images on Your Phone Using ACDSee:

*') Make sure that file sharing is enabled on your mobile device.
b

1. With your phone plugged in, open ACDSee.
2. In Manage mode, using the Folders pane, navigate to your phone under This PC/Computer.

3. Using the Folders pane or File List pane, navigate to your images. They are usually stored in a folder called
DCIM.

’) ACDSee displays file information supplied by your device in the Properties pane.
b

To View an Image from Your Mobile Phone:

In the File List pane, double-click the image.

’) You can use the Filmstrip to navigate through the images in the folder.
8

To Copy Images from Your Mobile Phone to Another Folder Using ACDSee:

In the File List pane, select the image(s) and do one of the following:
* Right-click and choose Copy. Browse to another folder, right-click and choose Paste.

* Right-click and choose Copy To Folder... In the Copy To Folder dialog, select the destination folder and
click OK.

* Go to Edit | Copy, or press CTRL + C. Then, in the destination folder, go to Edit | Paste, or press
CTRL + V.

To Delete Images from Your Mobile Phone Using ACDSee:

“') It may be necessary to change settings on your mobile device to allow files to be deleted using your PC.
h
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In the File List pane, select the image(s) and do one of the following:
Right-click and choose Delete.
Press DEL.

Go to Edit | Delete.

Sending Images to ACDSee from Your Mobile Device Using ACDSee
Mobile Sync

You can use the ACDSee Mobile Sync app to send photos and videos directly from your mobile device into ACDSee
Photo Studio on your PC. This free app is available on iOS and Android from the Apple App Store and the Google
Play Store, respectively.

ACDSee Mobile Sync will keep track of which photos have been sent to ACDSee and indicates new and

1 unsent items using a colored border.

In Manage mode, you will be able to access images you have sent to ACDSee by clicking the ACDSee Mobile Sync
node icon in the Folders pane.

Folders | Cz g Calendar

b [E Deskiop
< m Libraries

2 n Documents
(|

## ACDSee Mobile Sync

b i3 This PC

bW Net

COffline Media
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Getting Started

To procure the app, you can:

* Download itin the Apple App Store, for iOS. In the App Store, type ACDSee Mobile Sync in the Search
bar.

Q. ACDSee Mobile Synd ()

* Download it in the Google Play Store, for Android. In the Play Store, type ACDSee Mobile Sync in the
Search bar.

After installation, open the ACDSee Mobile Sync app on your device. Follow the prompts to give the app access to
your photos and to assign the target (ACDSee on your PC).

! You must be connected to the same wifi network as the PC that is running ACDSee in order to use ACDSee
Mobile Sync to send photos and videos.

Sending Images and Videos

You can send images and videos from the ACDSee Mobile Sync app to ACDSee. ACDSee Mobile Sync keeps track of
which items have already been sent. ACDSee will notify you with a pop-up in the lower right corner when it has
received your sent items. You can then click on the ACDSee Mobile Sync node icon in the Folders pane in Manage
mode to view the received files.

To send all new items, press the Send button.

To send specific items, select them and press the Send button.

/ ) You can use context-menus within the app for more specific selection options.

L

“ % You can customize the location of your ACDSee Mobile Sync folder on your hard drive. See Setting the
) ACDSee Mobile Sync Options.

.
I

Browsing Files in the File List Pane

The File List pane is the large pane in the center of the Manage mode window. The File List pane displays the
contents of the currently selected folder, the results of your latest search, or the files and folders that match your
selective browsing criteria. The File List pane is always visible, and cannot be hidden or closed.

Files display as thumbnails in the File List pane by default. However, you can change the File List pane view from
thumbnails to details, list, icons, tiles, or Filmstrip. You can sort your files according to name, size, properties,
and more. You can also use filters to control which files display in the File List pane.

Using the File List Pane

There are three sections in the File List pane: the Contents bar, the File List drop-down lists, and the File List
toolbar. The overlay icons, which appear on the thumbnails, allow you to rate, tag, and label your images and
indicate additional information, such as if the file has been processed or geotagged.

The Contents Bar

The Contents bar is located at the top of the File List pane and describes what you are currently browsing. When
you are using the Folders pane, the Contents bar will display the path or paths to the folders you are browsing, as
in the following example:
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[M® » Libraries » Pictures »

If you are browsing files by category or rating with the Catalog pane, the Contents bar displays the selected
classifications, as in the following example:

[Rating: 3] and [Label: Blue] And [1 Category:

The Contents bar also displays a date range when browsing with the Calendar pane, and a summary of your
search criteria when you use the Search pane.

File List Drop-Down Lists

Filter Displays a list of filter options such as rating and category. You can also select
Advanced Filters and create a custom filter.

Group Displays a list of file attributes that you can use to group files in the File List pane.

Sort Displays a list of file attributes that you can use to sort the files in the File List pane.

View Displays a list of view options for viewing files in the File List pane.

Select Displays a list of file selection options.

File List Toolbar

= Add to Image Basket Adds selected images to the Image Basket.

D Rotate left Rotates selected images to the left.

C Rotate right Rotates selected images to the right.

o Compare images Opens selected images in the Compare Images Viewer.

_ Zoom slider Controls the size of the thumbnails in the File List pane.
Drag the slider to adjust the thumbnails.

Overlay Icons

Page 39 of 329



ACDSee Photo Studio Standard 2019

Page 40 of 329

Sound / Playing
Sound

Rating

Color Label

Embed Pending

File format

Category

Collection

Shortcut

Offline

Excluded items

Tagged items

Untagged items

Geotagged items

Auto-rotate

Edited

Appears if the file contains
embedded or associated
audio. The second icon
appears if you click on the
sound icon and the
embedded sound begins
playing.

Appears if the file has been
rated in the ACDSee
database.

Appears if the file has been
assigned a color label.

Appears if the file has
ACDSee Metadata stored in
the ACDSee database that
has not yet been written to
the file.

Displays the file format.

Appears if the file has been
categorized.

Appears if the file has been
added to a collection.

Appears if the item is a
shortcut to another file.

Appears if the file is stored
on an offline device.

Appears if the file has been
excluded from the ACDSee
database.

Appears if the file has been
tagged.

Appears if the file has not
been tagged.

Appears if the file has been
geotagged.

Appears if the file has been
automatically rotated.

Appears if the file has been
edited.

Right-click to play
embedded audio.

Right-click and choose
either:

* Embed ACDSee
Metadata: Writes the
metadata to the file.

* Clear Embed
Pending Flag: Clears
this overlay icon, but
does not write the
metadata to the file.

Left-click to display the File
Information, Image
Attributes, and EXIF
Metadata (summary) on the
File tab of the Properties
pane.

Left-click to open the
Categories section on the
Organize tab of the
Properties pane.

Left-click to open the Map
pane.

Left-click to rotate the image
original permanently and
update the EXIF
information.
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Changing Overlay Icon Visibility
You can change whether overlay icons are visible, visible in color, and which icons are in color.

To Change Overlay Icon Visibility:

In Manage Mode, at the top of the File List pane, do one of the following:

* Click View | Toggle Overlay Mode to control whether the overlay icons are invisible, visible in grayscale,
or visible in color. Toggle the (]) key to move through the available modes.

* Click View | Highlight Overlay to select which icons appear in color. Toggle the ([) key to select from
the available options.

Note that this does not apply to all overlay icons. For more control over which icons are visible, see
= | Setting the Thumbnail Info Options.

Maximizing the File List Pane

To make the most of your available screen space, you can choose to maximize the File List pane and hide the rest of
the Manage mode panes. The only parts of the Manage mode window that remain visible are the File List pane and
whichever toolbars you are currently using.
To Maximize the File List Pane:

1. Click View | Maximize File List.

2. Toshow only the File List pane and its toolbar, click View | Full Screen.

3. Click the Close Full Screen button in the upper right corner to return to Manage mode.

Browsing Using the Folders Pane

The Folders pane displays a directory tree of all the folders on your computer in the same style as they appear in
Windows Explorer. You can select one or more folders in the Folders pane to display their contents in the File List
pane.

You can also use the Folders pane to create shortcuts to your favorite files, folders, or applications. Then, instead
of having to search for a specific file, you can quickly access it in the Shortcuts pane.

Whenever you browse to a folder using the Folders pane, the ACDSee database catalogs any images, or media files
in the folder.
To Open or Close the Folders Pane:

In Manage mode, click Panes | Folders.

When you connect a removable device, such as a mass storage device or digital camera, the Folders pane
displays the device as another drive, and assigns it a drive letter automatically.

You can access the device, and its contents, by clicking on it in the Folders pane.

Selecting Multiple Folders
Easy-Select bars are vertical columns of indicators on the left side of the Folders and Catalog panes. You can use
the Easy-Select bars to select multiple folders, categories, or ratings, and display their contents in the File List

pane.

To Use the Easy-Select Bar:

Page 41 of 329



ACDSee Photo Studio Standard 2019

In the Folders pane, select the indicator to the left of each folder with contents you want to display.

You can also use the Easy-Select bars with the Selective Browsing pane.

Creating and Managing Folders

You can use the Folders and File List panes to create, delete, rename, and move folders on your hard drive to help
organize your files.

To Manage Your Folders:
1. In the Folders pane, browse to where you want to add, delete, or rename a folder.
2. Do one of the following:

* To create a folder, click File | New, and then select Folder. Type a name for the new folder and
press Enter.

* To delete a folder, select a folder and press Delete.

* Torename a folder, right-click the folder you want to rename and select Rename. Type a new
name for the folder and press Enter.

._/ You cannot rename a drive or any folder on a read-only file system, such as a CD-ROM.

Browsing Files By Date or Event

With the Calendar pane you can browse your collection of image and media files using the dates associated with
each file. The Calendar pane includes Events, Year, Month, Day view and the Photo Calendar, which shows
thumbnails per day within a month. You can click any date in the Calendar pane to display a list of files associated
with that date.
To Open the Calendar Pane:

In Manage mode, click Panes | Calendar.

The Calendar pane opens in the center File List pane area.
Your images will not display in the Calendar pane until you have either browsed the folder containing the

=£ | images or used the Catalog Files wizard to catalog your images so they are in the ACDSee database.

If you are using the Photo Calendar, you only see thumbnails if there are photos on a particular day in that
==£__ month. Days that have no photo, are blank.

Calendar Pane View Options
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Events View Switches the Calendar pane to Events view. In the Events view you see only those
months during which images or media files are available. Next to the month you see
the number of dates on which images or media files are available. Expand the month
to see the dates and the number of pictures available for those dates. You can add a
description and a thumbnail image to help you remember the event.

[EE

Iﬂ Year View Switches the Calendar pane to Year view. In Year view you see a series of tables.
Each table represents a specific year. Next to the year you see how many images or
media files are associated with that year. The months during which images or media
files are available are highlighted.

Month View Switches the Calendar pane to Month view. In Month view you see a series of tables.
Each table represents a specific month. Next to the month you see how many images
or media files are associated with that month. The dates on which images or media
files are available are highlighted.

Day View Switches the Calendar pane to Day view. In Day view you see a series of tables. Each
table represents a specific day. Next to the date you see how many images or media
files are associated with that date. The time at which the images or media files are
available are highlighted.

Photo Switches the Calendar pane to the Photo Calendar. In the Photo Calendar, you see a
Calendar single month with thumbnails for any day that contains photos. A pop-up of the first
four images opens if you hover your cursor over a thumbnail. Click on a thumbnail
and all the pictures for that date display in the File List. The total number of photos
belonging to that month is in the top right corner of the calendar. Drag the title bar
to float this pane onto another monitor and drag a corner to resize it and make the
thumbnails bigger or smaller.

{3} Options Use the Calendar pane options to specify which date you want to use to organize
your files. For example, you can quickly change the setting so that the photos are
displayed by the following:

* Date the ACDSee database cataloged the file
* Date the image was taken

* Date the file was modified

* Date the file was loaded to your computer

Select Options to open the Calendar dialog, where you can set filter options, choose
the day to start the week, and set clock formats.

8 Table of Opens a list of event dates.
= Contents
/ Only available in Events View.

Adding Descriptions and Thumbnails in Events View

You can add a description and a thumbnail image to dates in Events view to help you remember the event.

i ) Try right-clicking the Calendar Title bar and select Floating to move the pane to a new location.

To Add a Description to a Date in Events View:
1. Expand the month to see the dates on which images or media files are available.
2. Click Enter event description here and replace the highlighted text with a new description.

3. Press Enter or click outside of the description area. The description is saved.

To Select a Specific Thumbnail in the Events View or Photo Calendar:
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1. Expand the month to see the dates on which images or media files are available.
2. Click on a date to display the images or media files in the File List pane.
3. Click and drag an image or media file and drag it to the thumbnail area for the date.

When you release the mouse button the thumbnail is saved. You can reset the default thumbnail by right-
clicking the thumbnail and selecting Restore Default Thumbnail.

To Navigate a Long List of Dates in Events View:

1. Toexpand and collapse specific groups click the +/= signs which are located on the left side of the group
header.

2. Toexpand and collapse all groups right-click a group header and select either Open All Groups or Close
All Groups.

3. Toscroll through multiple groups click the Next Group and Previous Group buttons, which are located
at the bottom of the File List scroll bar.

4. Atthe bottom of the Calendar pane scroll bar, click the Table of Contents button and select a date.

Browsing Your Favorite Files

You can create shortcuts to your favorite files for easy access.

Accessing the Shortcuts Pane

Click Panes | Shortcuts.

Creating a Shortcut

You can create shortcuts to folders and files, and even run executable files, from inside the Shortcuts pane.
Favorite shortcuts can be copied, renamed, moved, or deleted just like a folder. You can even use an executable
shortcut to start another application from inside ACDSee. You can also create a shortcut by dragging a file, folder,
or executable file directly from the File List pane to the Shortcuts pane.

To Add Files to the Shortcuts Pane:
1. In theFile List pane, select a file, folder, or executable file.
2. Do one of the following:
* Right-click the item you selected, and then select Add to Shortcuts.
* C(Click File | Add to Shortcuts.

3. Type aname for the new shortcut and click OK.

Creating a New Folder
You can create a folder, or an entire directory tree, in the Shortcuts pane to help organize your favorites.

To Create a New Folder:

1. In the Shortcuts pane, right-click the Shortcuts folder, or a folder you previously created, and then select
New | Folder.

2. Type the name of the folder and press Enter.
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¥ If you move a file or a folder that is a shortcuts, you break the link and the shortcut no longer works.

Deleting a Shortcut or Folder

You can delete a shortcut or folder from within the Shortcuts pane.

To Delete a Shortcut or Folder:

In the Shortcuts pane, right-click the shortcut or folder, click Delete, and then click Yes to confirm that you
want to delete the shortcut or folder.

Using the Catalog Pane

The Catalog pane is one of the most useful panes in Manage mode as it provides so many tools for organizing,
managing, and finding your files. You can drag files into the categories, ratings, keywords, or color labels of the
Catalog pane to assign and quickly organize your files. The Auto Categories section can be used to find files with
specific information such as file size, keywords, or shutter speed. The Saved Searches section allows you to create
and run custom searches. Special items such as the Image Well display all the images on the computer in one
click, or you can click Uncategorized to display only those that are not yet in a category.

To Open the Catalog Pane:

In Manage mode, click Panes | Catalog.

The Catalog pane opens on the left, tabbed with the Folders and Calendar panes.

Easy-Select Bars

Select multiple albums, ratings, keywords, labels, and categories with the Easy-Select bars to display files
matching these selections in the File List pane.

To use the Easy-Select bar:

Select the indicator.. to the left of one or more items in the Catalog pane to display the files in the File List
pane that match the specific set of criteria.

The ACDSee Database

Any organizing you do using categories, ratings, or labels (on the Catalog pane or the Properties pane) is stored in
the ACDSee database. If you choose to, you can then also embed this information in each individual file, making it
easier to relocate and share files, or retrieve the information from the file if you need to.

Changing Views

You can select different views to display your files in the File List pane, including thumbnail previews and file
details. You can also customize the appearance and size of thumbnails, and specify the information displayed in
the Details view.

To Change the File List View:

In Manage mode, in the File List pane, under View, select from the following:

Views
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Thumbs+Details Displays file names and details in a list, and adds a thumbnail preview to the
Filename column.

Filmstrip Displays thumbnail previews of your files in a single row across the bottom of
the File List pane, and displays the currently selected file in an expanded
Preview pane.

Thumbnails Displays thumbnail previews of all image and media files in the File List pane.
You can customize the appearance of thumbnails, and specify what information
to display with them.

Tiles Displays each file in the File List pane on a "tile" that includes a thumbnail
preview and file information. You can resize the tiles using the Zoom slider.

Icons Displays files in a list, represented by large default system icons for each file
type.

List Displays a list of file names and extensions.

Details Displays a list of file names and details about each file, such as size, format,

and creation date. You can customize the appearance of the Details view mode,
as explained below, and specify what information it displays.

Toggle Overlay Mode Controls whether overlay icons are invisible, visible in grayscale, or visible in
color. Use the (]) key to choose.

Highlight Overlay Controls which overlay icon is colored. Use the ([) key to rotate through.

Customizing the Details View

You can set the Details view to automatically resize columns, display or hide grid lines, and select an entire row
when you select a column entry in that row. You can also change the appearance of the Details view, select which
columns to display, and customize the column order.

To Select Columns and Set Column Order:
1. In Manage mode, from the File List drop-down, click View | Choose Details.
2. In the Choose Details dialog box, do one or more of the following:

* Toadd a column, select a folder or detail name in the Available Details pane, and then click Add.
Adding a folder adds all detail names within the folder.

* Toremove a column, select a detail name in the Currently Displayed Details pane, and then click
Remove.

* To move a column to the left in the File List pane, select its name in the Currently Displayed
Details pane and click Move Up.

* To move a column to the right in the File List pane, select its name in the Currently Displayed
Details pane and click Move Down.

3. Click OK.

You can click Reset to display only the default column names in the Currently Displayed Details pane, and
==£_|you can also move a column in the File List pane by dragging its header to a new position. A vertical line
indicates where the column will be inserted.

Filtering Files

You can use the Filter By options to identify the types of files and folders you want to display in the File List pane.

To Filter Files in the File List Pane:
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Do one of the following:
* Click View | Filter By and select a filter option.

* Click the Filter drop-down and select a filter option.

' ) If all your thumbnails seem to disappear, click Filter | All and they reappear.

To Create a Custom Filter:
1. Do one of the following:
* Click View | Filter By | Advanced Filters.
* Click the Filter drop-down and select Advanced Filters.
2. Select Apply filtering criteria.

3. Select or clear one or more of the following options to show or hide that file or folder type in the File List
pane:

* Show image files
+ Show media files
+ Show folders

* Show archive files

* Select Show hidden files and folders to show files and folders that are normally hidden by
your operating system.

* Select Show THM files to show thumbnail files.

4. Click OK.

Grouping Files

If you have to browse a lot of images in the File List you should consider using Group By to organize images into
different groups. You may find it easier to find images when they are organized into groups. For example, if you
use more than one camera, you can quickly organize your images according to the camera you used to capture the
images. Similarly, if you save your images into different file formats you can quickly organize your images
according to their file format.

f Group By only works in the Thumbs, Thumbs + Details, Details, Tiles, and Icons views.

fThe Edited State group is particularly useful for finding images that you have edited.

To Group Files in the File List:
1. Browse to the folder or folders containing your files.
2. Do one of the following:
* Click View | Group By and select a group option.

* Click the Group drop-down and select a group option.

Navigating Through Groups in the File List

To Expand and Collapse Specific Groups:
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Click the Expand or Collapse arrows, on the left side of the group header.

To Expand and Collapse All Groups:
Right-click a group header, and then select either Open All Groups or Close All Groups.

To Display a Preview of the Images in a Closed Group:

Hover your cursor over the group header.

To Scroll Through Multiple Groups:

Click the Next Group and Previous Group buttons at the bottom of the File List scroll bar.
To Display the Table of Contents:
Do one of the following:
* Click View | Group By | Table of Contents.
* Click the Group drop-down list and select Table of Contents.

+* At the bottom of the File List scroll bar, click the Table of Contents button.

To Quickly Jump to a Specific Group:
1. Display the table of contents.
2. Click the group that you want to display.
To Change the Sort Order of the Groups:
Do one of the following:
* Click View | Group By and select either Group Forward or Group Backward.

* Click the Group drop-down and select either Group Forward or Group Backward.

Removing Groups from the File List

To Remove a Group:
Do one of the following:
* Click View | Group By | None.

* Click the Group drop-down list and select None.

Selecting Files in One or More Groups

To Select Files in Groups:
Do one of the following:

* Click the group header to select all of the files in that group.

* Press and hold the CTRL key and click two or more group headers to select all of the files in those groups.

Sorting Files

In Manage mode, you can sort your files according to different file properties to quickly organize your images, find
specific files, and create a range of files with similar attributes for easy selection.

Page 48 of 329



ACDSee Photo Studio Standard 2019

To Sort Items in the File List:
1. Click View | Sort By, and then select a sort option:

* Filename
+ Size (KB)
* Image Type
* Modified Date
* Image Properties
* Caption
* Rating
* Tagged

* More (sort by metadata, EXIF, file properties, image attributes, IPTC information, or multimedia
attributes)

2. Toset the direction of the sort, click View | Sort By, and then select a direction:
* Sort Forward

* Sort Backward

Your sort settings are saved until you change them. For example, if you sort images in the File List pane
=f | according to Rating, the images will remain sorted according to Rating until you change the sort settings.

Sorting Files Using Column Headers

You can quickly sort files in Details view mode using column headings.

To Sort Files Using a Column Header:
1. Click a column header. An arrow appears, indicating the sort direction.

2. Click the column header again to change the sort direction.

Custom Sorting Files

You can use custom sorting to customize the order of files in the File List pane. After custom sorting your files,
ACDSee automatically saves the file order for the selected folder until you change it or delete the custom sort
order.

To Customize the Sorting Order of Your Files:
1. Select one or more files.

2. Drag the selected files to a new location in the File List.

J,-To delete a custom sort order, click View | Sort By, and then select Delete Custom Sort.

Selecting Files

In the File List pane, you can select all of your files and folders at once, select all of the files in the current folder,
select only the image files, or clear your selection entirely.
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You can also set an option to automatically select new files whenever you add them to the File List. Click Tools |
Options | File List to set this option.

To Select Your Files or Folders:
* Click a thumbnail to select the file.
* CTRL + click to select more than one file.

* SHIFT + click to select a number of files in a row.

i ) Click off to the side in the file list pane to clear your selection.

To Select Your Files or Folders Using the Menu:
1. In Manage mode, click Edit.
2. Select one of the following:
+ Select All: Selects all files and subfolders in the current folder.
+ Select All Files: Selects all files in the current folder.
* Select All Images: Selects all image files in the current folder.
* Select Tagged: Selects all tagged image files regardless of their folder.

* Select by Rating: Displays a list of ratings, and selects all files currently assigned to the rating
you select.

* Clear Selection: Clears your selection.

* Invert Selection: Selects all files except for your original selections.

Previewing Images

You can preview image, audio, and video files in the Preview pane. By default, the Preview pane displays a
thumbnail of the currently selected image or media file. You can resize the pane to adjust the thumbnail
dimensions, and reposition the pane anywhere on your screen. You can set the Preview pane to display highlights
of the image's EXIF information for quick reference.

To Open or Close the Preview Pane:

Do one of the following:
* Click Panes | Preview.

* Press CTRL + Shift + P.

To Show or Hide What Displays in the Preview Pane:

You can customize the options displayed in the Preview pane when you have an image displaying. Right-click the
image in the Preview pane, select Image and Information, and then select one of the following:

* Show Image: Displays only a preview of the image.

* Show Information: Displays EXIF information about the image. This is called the Information palette.
The Information Palette

The Information palette provides immediate access to the most useful elements of an image's EXIF information. It
includes:
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* Camera Name and Lens Model
* Dimensions

* File Size

* Exposure Program

*  White Balance

* Metering Mode

* Flash

* RAW (will be blank for files that are not RAW)
+ ISO

+ F-Stop

* Shutter Speed

+ Exposure Compensation

* Focal Length

L

% If you are unsure what a certain symbol means, you can hover your mouse over it for a pop-up
explanation.

To Customize the Preview Info:

You can customize what information displays at the bottom of the Information palette section of the Preview pane.
The date and time that the image was taken is selected by default.

1. Right-click the date and time at the bottom of the Information palette in the Preview pane.
2. Click Choose Preview Info...

3. In the Choose Details dialog box, select the item listed under Currently Displayed Details and press the
Remove button.

4. From the Available Details column, choose an item by checking the checkbox next to it and pressing the
Add button.

5. Click OK.

To Preview Audio or Video Files:
1. Click Tools | Options | Preview.
2. Check the Preview audio and video clips checkbox.

3. Click OK.

The Information palette also displays in View and Edit mode. To turn off the Information palette, deselect
=* | Info Palette under the View menu in Edit mode, or Panes menu in View mode.

Rotating Images

You can rotate images in Manage and View modes using the Rotate icons in the bottom toolbar.

,_/ When you rotate unedited JPEG images, ACDSee performs a lossless rotation.

To Rotate Images:
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1. In Manage mode or View mode, select one or more images.

2. Click the Rotate Left or Rotate Right icon in the bottom toolbar.

Rotate Icons

\:} Rotate Left Rotates the image 90° to the left.

(, Rotate Right Rotates the image 90° to the right.

Comparing Images

You can use the Compare Images feature to compare a group of images. The tool highlights both the similarities
and the differences in the properties, metadata, and pixel intensity levels of images you select. You can save your
preferred images to a new location on your hard drive, or tag images you would like selected in Manage mode, and
then delete, move, rename, or alter the images.

To Compare Images:
1. IntheFile List pane, select the images that you want to compare.
2. Click Tools | Compare Images.... Up to four images display in the Compare Images Viewer.
3. Tochange which image displays in the comparison view, do one or more of the following:

* In the Comparison List, right-click an image and click Send to Active View (indicated by a pale
box).

* In the Comparison List, drag an image to a box in the Compare Images Viewer.
* In the Compare Images Viewer, right-click an image and click Next Image or Previous Image.

* In the Compare Images Viewer, right-click an image and click File | Remove From View or click
the Remove icon in the image toolbar.

4. Totag images, do one of the following:

* In the Comparison List, click the checkbox that is located at the bottom of the image on the right
side.

* In the Compare Images Viewer, right-click an image and click Tag or click the Tag icon in the
image toolbar.

* Click the Tag All button in the bottom left corner to tag all of the images, or click Untag All to
untag all of the images.

5. Torateimages, right-click an image, click Set Rating, and then select an appropriate rating.

6. To categorize images, right-click an image, click Set Categories, and then select an appropriate category
(or create an appropriate category).

7. Click OK, located in the bottom right corner.

Compare Images Toolbar
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G Previous

o Next
E Zoom In

Q Zoom Out
p Zoom menu

1T Pan Lock

g Exposure warning
j—
N—

Properties

Il Histogram

55} Metadata Setup

n One Image

E Two Images
":E Three Images
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Swaps the selected image with the previous image in the Comparison
List.

Swaps the selected image with the next image in the Comparison List.

Increases the magnification of the selected image.

Reduces the magnification of the selected image.

Opens a menu of zoom options. Select from the following options:
* Actual Size: Displays the image at its original size.

* Fit Image: Displays the image at the largest magnification that
fits in the Compare Images Viewer.

* Fit Width: Displays the image to fit between the left and right
sides of the Compare Images Viewer.

* Fit Height: Displays the image to fit between the top and
bottom of the Compare Images Viewer.

+* Zoom Lock: Displays all images at the zoom option of the
current image. If the zoom is adjusted, the new zoom level is
applied to all images that you view.

* Zoom To: Opens a dialog box where you can select a zoom
option.
Locks the panned image area, so that when you zoom and pan an image
to a specific area, the Compare Images Viewer displays the same area
for all images you view.

Indicates pixels that may be over or underexposed.

Displays properties for each image in the Compare Images Viewer.
Click the Metadata Setup button to specify which file properties are
displayed.

The Compare Images tool displays the file properties in a field below
each image. Differences in properties are bolded, while similarities are
displayed in regular font.

Displays a histogram for each image in the Compare Images Viewer.

Opens a dialog box where you can select the metadata to display for
S

each image in the Compare Images Viewer (ensure Properties === g
toggled to on).

Displays one image in the Compare Images Viewer.

Displays two images in the Compare Images Viewer.

Displays three images in the Compare Images Viewer.
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I_[E Four Images Displays four images in the Compare Images Viewer.
Properties Pane If one image is displayed, this button opens the Properties, Histogram,
Magnifying Glass, and Navigator panes.

0 Help Opens the Help file.

Image Toolbars

Each image in the Compare Images tool has a toolbar located below it. You can use this toolbar to adjust each
image individually.

Save Opens a dialog box where you can save the image with a different file
— name and a different file format.
Previous Swaps the displayed image with the previous image in the Comparison
List.
O Next Swaps the displayed image with the next image in the Comparison List.
@ Zoom In Increases the magnification of the image.
;3 Zoom Out Reduces the magnification of the image.
x Delete Deletes the image from your hard drive.
% Remove Removes the image from the Comparison List.
Tag Tags the image so that it will remain selected when you close the
J Compare Images tool.

Gathering Images in the Image Basket

You can use the Image Basket to gather and hold images and media files from different locations or folders. Once
you have placed items in the Image Basket, you can use any of the tools or features in ACDSee to edit, share, or
view those files.

To Use the Image Basket:
1. Toopen the Image Basket, in Manage mode, click Panes | Image Basket.

2. Inthe File List pane, select the files you want to add. Drag the items to the Image Basket, or right-click a
selected item and select Add to Image Basket.

3. Toremove one or more files, right-click the file, and then select Remove from Image Basket.

4. Toremove all files, right-click the Image Basket, and then select Clear Image Basket.

,_/ You can also add images to the Image Basket by dragging them from Windows Explorer.
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Cataloging and Managing Files in ACDSee

In addition to its browsing, viewing, and editing capabilities, ACDSee features integrated management tools you
can use to organize and sort your images and media files. These tools include batch functions (tools that can alter
or adjust multiple files at the same time), category and rating systems, and a powerful database to hold all of your
important image information.

You can use the ACDSee batch functions to convert the file format, rotate, resize, rename, and adjust the time
stamp or the exposure of a single image, a group of images all at once. With the category, color label, and rating
systems, you can create a virtual folder structure, and use it to find related images and media files with a single
click.

ACDSee displays file properties and image information in an easily accessible Properties pane that you can use to
directly add and edit file information, including ACDSee Metadata. You can add an author, description, notes, and
keywords to your files, and adjust the category and rating assignments at the same time.

Organizing with the Catalog Pane

The Catalog pane is one of the most useful panes in ACDSee as it provides many ways to catalog, sort, group,
search for, and manage your files.

Categories

Categories are an easy way to organize your files into context-related sections. When you assign a fileto a
category, you do not move the file from its folder or create an extra copy. Your categories can be simple or complex
and use any names you choose. There are different icons to use for different categories to help you identify them
at a glance. Once your files are in categories, you can search, sort, group, and find them by category.

One way to assign files to a category is to select and drag one or more files from the file list and drop them onto the
category. Any file that is assigned to a category has a blue tab above its thumbnail in the File List. A file can belong
to multiple categories, but it will only have one blue tab. For comprehensive categories management, use the
Organize tab of the Properties pane.

Keywords

Keywording is a highly efficient way to group files in hierarchies that make sense to you and find them quickly in
an expanding tree. The hierarchical tree of keywords you have created in the Organize tab of the Properties pane is
displayed in the Keywords section of the Catalog pane without the need to select an image . Utilize this group to
manage your keywords on the fly by using the context menu (right-click). Keyword quickly by dragging a keyword
onto an image , or by dragging an image onto a keyword.

Ratings

You can assign a numerical rating from 1 to 5 to your images and files. Once you have assigned ratings, you can
search, sort, and catalog your files based on the ratings, or a combination of ratings, categories, auto categories
etc. A file can have only one rating. When a file has a rating, the number appears on top of the thumbnail in the
File List pane.

Color Labels

Color labels can be used in many ways to help you catalog your files. You can use different colors to represent
different stages of your workflow. As you review your photos you can assign them to the color labels and rename
them accordingly.
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Auto Categories

Most digital cameras create and embed information about the file as you take a photo. This information is called
metadata and can include the name and model of the camera, the file size, shutter speed, camera settings used in
the shot and much more. ACDSee uses this information to create auto categories. When you click on an auto
category, ACDSee searches for images containing that metadata. You can select one or more auto categories to
find files, for example, photos of a certain size, taken by a particular camera. You can also add to this data using
the Properties panes.

Saved Searches

If you find yourself creating the same search criteria frequently, you can save the search to use again later. Saved
searches appear at the top of the Search pane but they also appear in the Catalog pane for you to re-run using a
single click on the name or in the white checkbox of the Easy-select bar.
To Create a New Saved Search from the Catalog Pane:
1. In the Saved Searches area of the Catalog pane, click the New saved search icon.
The Search pane opens.

2. Enter your search criteria and then click the Saved searches icon.

The new saved search appears in the Saved Searches on the Catalog pane and in the Saved Searches
drop-down list of the Search pane.

Special Items

You can use Special Items to quickly view all of the images in your database and any uncategorized images. Select
one of the following items:

* Image Well: Displays all images cataloged in the ACDSee database. If you have a substantial image
collection, it may take a few moments to gather all of the information.

+* Embed Pending: Displays all the files with database data that has changed but has not yet been
embedded in the files.

* Uncategorized: Displays any images cataloged in the database that have not been assigned to a
category.

* No Keywords: Displays any images cataloged in the database that have no ACDSee keywords assigned.
* Tagged: Displays all the tagged images on the computer.

You can assign a rating or category to any type of file, but the options in the Special Items area only apply to
images.

The ACDSee Database and Embedded Data

When you assign a file to a rating, or category, this information is stored in the ACDSee database. If you choose to,
you can also embed this information in each individual file, making it easier to relocate and share files, or retrieve
the information from the file if you need to. As the database, information is always associated with a particular file.
If you move or rename files using an application other than ACDSee (like Windows Explorer) the link between the
file and the ACDSee database will be broken. If this happens, and you have embedded the information in each file,
you can rebuild the database and retrieve all the information.

You can also use the Properties pane to add information to the ACDSee database like captions, keywords and much
more. Taking the time to assign categories and add keywords, notes, etc., makes it much easier to find and
organize your files.
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! ACDSee uses XMP to embed ACDSee Metadata into each file. Only some file formats and file extensions
support XMP. These include GIF, JPEG, DNG, PNG, PSD, and TIF. In the case of these file formats, the
ACDSee Metadata is embedded inside the file and so you can rename or move the file outside of ACDSee
and still be able to retrieve the ACDSee Metadata. For formats that currently do not support XMP,
including RAW and ABR, the ACDSee Metadata is written to a sidecar file that is stored in the same folder
as its file. Because a sidecar file is separate from the file itself, you need to rename or move them
together, or you could lose the ACDSee Metadata permanently.

Easy-Select Bars

The Easy-Select bars are the indicators on the left side of the Folders and Catalog panes. You can use the Easy-
Select indicators to select multiple folders or categories, and display their contents in the File List pane. In the
Catalog pane you can also use the Easy-Select indicators to select combinations of categories, ratings, auto
categories, saved searches, and special items. For example, you could display all your photos with a rating of 1
that belonged to the category People.

You can also use the Easy-Select indicators with the Selective Browsing pane (View | Selective Browsing).
When you use the Match Any/All buttons and the Easy-Select indicators together, the Catalog pane becomes a
powerful search tool for finding unique sets of files.

To Use the Easy-Select Bar:

In the Catalog pane, select the indicator to the left of each item with contents you want to display. The indicator
changes orientation to point to the item you have selected.

"o displays a message and shows no thumbnails. The quickest way to return to a folder with files is to click
the back arrow.

’d) If you select a category, rating, or combination that does not have any files that match, the File List
To View Cataloged Files:

Select one or more categories, ratings, auto categories, saved searches, or special items. Files assigned to
those classifications are displayed in the File List pane.

The Contents bar at the top of the File List pane displays whatever categories or items are currently selected.
You can browse through specific categories, ratings, or items within specific folders using the Selective
Browsing pane.

Match All Match Any

There are two Match All/ Match Any drop-down lists on the Catalog pane; one at the top of the pane that affects
categories and one that affects saved searches. You can use the Match All and Any options to affect the display of
thumbnails in the File List in the following way:

* Match All: To beincluded, afile has to belong to all the categories or searches you select. So the file has
to be in both or all of the categories or searches before it will display in the File List. Match All is more
exclusive. You can use it to limit the number of files that display and narrow a search down.

* Match Any: To beincluded, afile can belong to any of the categories or searches you select. So any files
in the selected categories or searches will display in the File List. Match any is more inclusive.

Catalog Icons
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m Category Identifies files that have been assigned to a category.
[4] Ratings 1-5 Identifies file ratings.
+ New Saved search Opens the Search pane so that you can create a new
saved search.
[E] Saved search Displays the Save/Save As menu so you can save a
search.
Easy-Select indicator (selected) Selects the category, rating, auto category, or other item

for display in the File List pane.

Easy-Select indicator (not selected) Does not select the category, rating, auto category, or
other item for display in the File List pane.

Match Any/All Controls which images are displayed in the File List pane.

#H a v

To hide the icons in the Catalog pane, click Tools | Options, and then select Catalog. Deselect the Show
= Icons checkbox in the Options dialog box.

Creating Categories

Create and manage a system of categories for your files in the Organize tab of the Properties pane. You can easily
customize your category system in a way that makes sense to you.

Select the Organize tab in the Properties pane to create, rename, delete, and move your categories. You can also
access the Categories pane by choosing Panes | Categories.

To Create a Category:
1. Do one of the following:
* Right-click a category in the Catalog pane, and then select New Category.
* In Manage mode, click Edit | Set Categories | New Category.
2. Select one of the following:
* Create a new, top-level category
* Create a sub-category within the current selection

3. If you are creating a sub-category, select a top-level (or parent) category from the drop-down list. (If you
right-clicked a category in the Catalog pane, the new sub-category will be added below that category by
default.)

4. Type a name for the new category in the Name field.

5. Click OK.

When you create a new top-level category, you can select an icon to help identify the category. The Icon
=£ | drop-down only appears if the Show Icons checkbox is selected on the Catalog page of the Options
dialog box. In Manage mode, click Tools | Options, and then select Catalog.

Manage Categories

To Manage Your Categories:
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Select a category in the Catalog pane, and do one of the following:
* To move the category, drag it to the new location.
* To edit the category, right-click the selected category and select Edit.

* Todelete the category, right-click the selected category and select Delete.

Create Easy-Access Category Sets

If you have a long list of categories, or would like to break your categories up into different events or areas of
interest, you can use the Edit Category Sets feature.

To Create Easy-Access Category Sets:
1. First create the categories you want in your set.
2. Inthe Properties pane, click the Quick Categories drop-down list and select Manage Quick Categories.

3. Customize the number of rows and columns for your set by selecting values from the Rows and Columns
drop-down menus.

4. Enter your commonly used categories into the entry fields. For sub-categories, use the pipe key. Example:
A|B|C.

5. Click the Save button.
6. Click OK. This category set will be listed in the Quick Category drop-down list.

7. Select one or more files and click a button in the category set. The category will be assigned to the
selected files. The button text color will change to indicate that the category is assigned to currently
selected files, and will display in italics if assigned to only some (but not all) of the currently selected files.

,_/ Make sure the category button name matches the category name in the category tree.

Assigning and Searching Categories and Ratings

You can assign files to a rating, or one or more categories, without moving the file or making an extra copy.

/"  If the Properties pane or Catalog pane is not visible in Manage mode, click Panes | Properties or Panes
h | Catalog.

Quickly Assign Ratings

1. Hover over a thumbnail to display the gray box with diagonal line through it.

2. Click the gray box to make your selection.

Example of Hovering Over a Thumbnail to Select a Rating:

1.
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jThe hover icons display in Thumbnail view only.

“') Use the keyboard shortcut CTRL + 0-5 to quickly rate a file.

The rating number you select can be reflected as a star rating in other applications. Give your favorite
-=*_ | shots a high rating, and your least favorite shots a low rating.

Assign and Search Categories and Ratings in the Catalog Pane

The Catalog pane allows you to both assign categories and ratings as well as search them.

To Assign Files to Categories or Ratings in the Catalog Pane:
1. In Manage mode, do one of the following:
* Drag selected files to a category or rating in the Catalog pane.
* Drag the category or rating from the Catalog pane to selected files.

* Right-click the files, and then click Set Categories and click the category in the fly out, or click
Set Rating and click the rating.
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2. In View mode, do one of the following:

-

-

Click Edit | Set Categories and then click the category to which you want to assign the file.

Right-click the file, click Set Categories, and then click the category to which you want to assign
the file.

Click Edit | Set Rating and then click the rating to which you want to assign the file.

Right-click the file, click Set Rating, and then click the rating to which you want to assign the
file.

On the status bar, click the rating icon, and then click a new rating. This icon only appears once a
rating is set.

3. If you are comparing images and want to categorize them, do one of the following:

-

Right-click one of the files, click Set Categories, and then click the category to which you want
to assign the file.

Right-click one of the files, click Set Rating, and then click the rating to which you want to
assign the file.

"~ % Ratings embedded by ACDSee can be seen in other applications supporting xmp:rating and vice versa. To
J embed metadata into one or more selected files click Tools | Metadata | Embed ACDSee Metadata |

Embed In Selected Files.

Use the Context Menu (Right-Click) in the Category Tree to Do the Following:

* Assign Items

* Remove Items

* Create New Category

* Search

+ Cut
* Copy
* Paste

+* Delete

* Edit Category

To Search a Category or Rating in the Catalog Pane:

Click the Category name or Rating number to display all corresponding files in the File List pane.

Assign Categories and Ratings in the Properties Pane

The Properties pane provides another way to assign categories and ratings.

To Assign Files to Ratings in the Properties Pane:

1. In theFile List pane, select the files you want to assign a rating.

2. Inthe Properties pane, select the Metadata tab.

3. Click the rating you want these files to have from the numbers listed at the top of the Properties pane.

To Assign Files to Categories in the Properties Pane:
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1. In theFile List pane, select the files you want to assign a rating.
2. Inthe Properties pane, select the Organize tab.

3. Click the category you want these files to have from your Categories list.

/ ) Assign files quickly with a category sets button. See Create Easy-Access Category Sets.

Remove Categories or Ratings from Files

You can remove a file from a category or rating without moving or deleting the original file, or affecting any other
files assigned to that classification.

To Remove Categories or Ratings from Files:
1. In theFile List pane, select the files you want to remove.
2. Do one of the following:
* Right-click a selected file, and then click Set Rating | Clear Rating.

* Right-click a selected file, click Set Categories, and then click the name of the category from
which you want to remove the file, or to remove all categories, click Uncategorize All Selected
Items.

* Clear a checkbox for a category or a radio button for a rating in the Catalog pane.

* Right-click a category or rating in the Catalog pane, and then click Remove Items.

Assigning Color Labels

Color labels are useful for naming and quickly identifying your processing plans for your images. Different colors
can be used to represent different stages of your workflow. For example, as you review your photos you can
quickly label files to upload, print, reject, review, or sharpen, or any other term that matches your workflow
needs. Once your files have been labeled, you can click a color label in the Catalog pane to instantly display all of
the files assigned to that label.

You can also use color labels in combination with the Group by, or Filter By features to refine your list. Color labels,
like tagging, categories, and ratings, are a way to set aside, organize, and group your photos without moving them
into different folders.

“ % If the Properties pane or Catalog pane is not visible in Manage mode, click Panes | Properties or Panes
h | Catalog.
I

Create a Color Label Set

Begin by creating a label set so you can quickly select and assign specified labels. Once you have a label set in
place, you can assign your images to the appropriate labels corresponding to your workflow.

To Create a Color Label Set:

1. In the Catalog pane, click the Labels settings button 'ﬁ} and select Edit Label Sets.
2. Enter names for your labels and click the Save icon.

3. Click Save As from the Save Label Set dialog box.
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4. Enter a name for your new label set.

5. Click OK.

Once you have created color label sets, you can access them from the Catalog pane by clicking the Labels settings
button and selecting from the drop-down list. Before assigning a color label, make sure the intended label set is
active. The active label set name is shown in brackets in the label header.

Assign Color Labels

You Can Assign Color Labels to Your Files by Using the Following:

*

*

b

Hover icons in thumbnail view
Catalog pane

Properties pane

Edit menu in Manage and View mode
Context menu

Keyboard shortcuts

ACDSee uses XMP to embed ACDSee Metadata into each file. Only some file formats and file extensions
support XMP. These include GIF, JPEG, DNG, PNG, PSD, and TIF. In the case of these file formats, the
ACDSee Metadata is embedded inside the file and so you can rename or move the file outside of ACDSee
and still be able to retrieve the ACDSee Metadata. For formats that currently do not support XMP,
including RAW and ABR, the ACDSee Metadata is written to a sidecar file that is stored in the same folder
as its file. Because a sidecar file is separate from the file itself, you need to rename or move them
together, or you could lose the ACDSee Metadata permanently.

’} You can also set labels from the status bar in View and Edit mode.

To Assign a Color Label Using the Label Line Hover Icon in Thumbnail View:

1.

2.

[ |

Hover over a thumbnail to display the gray label icon. I!l

Click the gray label icon to make your selection.

Example of Hovering Over a Thumbnail to Click and Select a Color Label:
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J,- Use the overlay icon on one of a number of selected images to assign the label to all.

To Assign a Color Label to a File Using the Catalog Pane:
1. In Manage mode, do one of the following:
* Drag selected files to a color label in the Catalog pane.

* Drag the color label from the Catalog pane to selected files.

To Assign Files to Color Labels in the Properties Pane:
1. Inthe File List pane, select the files you want to assign a color rating.

2. Inthe Properties pane, select the color label from the boxes along the top.

To Assign Color Labels Using the Edit Menu in Manage and View Mode:

* Click Edit | Set Label and then select a color.

To Assign Color Labels with the Context Menu:

* Right-click the file, click Set Label, then select a label name.

To Assign Color Labels Using Keyboard Shortcuts:
+* Keyboard shortcuts are available for the five color labels, plus Alt-0 to clear the label (exactly the same as
ratings, except Alt is used instead of Ctrl)
Alt-1
Alt-2
Alt-3
Alt-4
Alt-5
Alt-0

OO0O00OmO
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Search Images Assigned to a Label

To Search All Images in the Database Assigned to a Label:
* Click the color label in the Catalog pane to display all corresponding files in the File List pane.
* Use the Search box.

* Use Quick Search.

To Search All Images in the File List Assigned to a Label:

Click the Filter drop-down above the File List pane and select a label name. All files assigned to that label in the
current file list will be selected.

To Select All Images in the File List Assigned to a Label:

Use Alt-1 through Alt-5 for the five colors, plus Alt-0 to clear the label, (exactly the same as ratings, except it uses
Alt instead of Ctrl).

Removing Color Labels and Color Label Sets

To Remove a Color Label from a File:
1. IntheFile List pane, select one or more files you want to remove a label from.
2. Do one of the following:
* Right-click a selected file, and then click Set Label | Clear Label.

* In the Properties pane, click the gray unlabeled icon.

To Delete a Label Set:
1. In the Catalog pane, click the Labels settings button and select Edit Label Sets.
2. Select the set you want to delete from the Labels Sets drop-down list.

3. Click the delete button.

Creating Collections

Collections is a powerful grouping and search query tool. You can use the Collections pane to group accumulated
photos based on a common variable, such as the camera used, location, or size. You could also use Collections to
group photos for sorting, processing, sharing, and much more.

Collection

Nl
m Collection Set

Smart
K8 collection
To Create a Collection:

1. In Manage mode, choose Panes | Collection. The Collections pane will appear tabbed in the Folders
pane.

2. In the Collections pane, right-click and select Create Collection... from the context menu.
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3. In the Create Collection dialog box, configure the options as described below.

4. Press the Create button.

Create Collection Dialog Box Options

Name Enter a name for your collection.
Location Inside a Collection Select this checkbox if you would like to place this collection inside
Set of another previously-created collection set, thereby developing a

hierarchy. Select the collection set you would like to add your
image to from the drop-down menu.

Options Include selected Select this checkbox to include any currently selected photos in the
photos collection.
Set as target Select this checkbox to designate this collection as the target
collection collection for images you will add photos to. You will be able to

quickly send images directly to this collection by selecting images
and pressing Ctrl+Alt+C. To customize the keyboard shortcut,
see Customizing Keyboard Shortcuts.

To Add Photos to a Collection:

Do one of the following:

* In the File List pane, select the image(s) before using the Create Collection command described above.
Then enable the Include selected photos checkbox inside the Create Collection dialog box.

* In the File List pane, right-click the image(s) and choose Collections | Add to | [name of the
collection].

* Drag and drop the image(s) from the File List pane to the collection inside the Collections pane.

* Select the image in the File List pane. In the Organize tab of the Properties pane, in the Collections group,
select the checkbox next to the collection.
To Set a Collection as Your Target Collection:

You can set a specific collection as the target collection, allowing you to quickly add images to it using a keyboard

shortcut. A target collection will display a blue circle icon next to it in the Collections pane. . You cannot set a
smart collection as a target.

Do one of the following:

* When creating a collection, enable the Set as target collection checkbox in the Create Collection dialog
box.

* Right-click a collection in the Collections pane and choose Set as Target Collection.

To Add Images to Target Collections:

Select the image and press the Ctrl+Alt+C key.

’) You can customize this keyboard shortcut. See Customizing Keyboard Shortcuts.

To Search for Collections:

You can search for collections, collection sets, and smart collections in the Filter Collections field at the top of the
Collections pane.

* Enter the name, (or portion of the name), of the collection, smart collection, or collection set you are
looking for. If the collection you are searching for is part of a collection set, the search will return the root
collection set if one of the sub-collections contains the text you entered in the Filter Collections field.

To Remove an Image from a Collection:
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1. Select the collection.

2. Right-click the image and choose Collections | Remove from Selected Collection.

J,-This will only remove the image from the collection and will not delete the image.

" You can remove multiple images from a collection at once by selecting them all and then right-clicking
‘iJ and choosing Collections | Remove from Selected Collection.

To Remove an Image from All Collections:

To remove an image from all collections, right-click the image and choose Collections | Remove from all
collections.

J,-This will only remove the image from all collections and will not delete the image.

" You can remove multiple images from all collections at once by selecting them all and then right-clicking
1 and choosing Collections | Remove from all collections.

Collections Sets

You can create a collection set and add other collection folders inside. You can use this method to create a
hierarchy for further organization. You cannot add images to collection sets themselves. You can only add images
to folders (collections) inside of collection sets. Selecting the root of a collection set will display all of the images in
all of the collections inside of the root.

To Create a Collection Set:
1. In the Collections pane, right-click and select Create Collection Set... from the context menu.
2. In the Create Collection Set dialog box, enter a name for your collection set.

3. Select the Inside a Collection Set checkbox if you would like to add your collection set inside of another
collection set. Select the collection set from the drop-down menu.

4. Click Create.

To Add Collections to Collection Sets:

Do one of the following:

* Select the Inside a Collection Set checkbox while creating a collection inside the Create Collection dialog
box. Select the collection set from the drop-down menu.

* 1In the Collections pane, drag and drop the collection from the root level to the collection set.

Smart Collections

Smart collections are collections with queries built into them based on search criteria you specify. These search
queries get saved to the database. When you catalog new images in the future, those that fit the criteria of your
search query will automatically show up in your smart collection. You can also create a search query to locate files
based on the date they were cataloged.

To Create a Smart Collection and Add Search Criteria to Your Query:
1. Inthe Collections pane, right-click and select Create Smart Collection... from the context menu.

2. In the Create Smart Collection dialog box, configure the options as described below.
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3. Press the OK button.

Create Smart Collection Dialog Box Options

Name Enter a name for your smart collection.

P

.‘u) It is recommended that you give your smart collection a name reflective of the
search query assigned to it. This will save you the time of having to open it to find

out what it contains.

Location Inside a Collection Set Select this checkbox if you would like to place
this collection inside of another previously-
created collection set, thereby developing a
hierarchy. Select the collection set you would
like to add your smart collection to from the
drop-down menu.

Match Press the Add button to select search criteria for your query. In the Add Search Criteria
dialog box, choose criteria by clicking the plus + signs to expand the tree and toggling the
checkboxes on and off to select your properties. Press OK. Your chosen criteria will appear
in the Match field box. Refine each item by clicking the underlined variables and selecting
an option from the drop-down, or entering a number into the field.

For example, if you chose Size as your search criteria, click "is" and select "is not", "is less

than", "is less than or equal to", "is greater than", "is greater than or equal to", or "is
between". Then click the "0" and enter the size value.

To Remove Criteria from Your Search Query:

Select the criteria from the Match field and select Remove.

To Edit Your Search Query:
1. Right-click your smart collection in the Collections pane and choose Edit.
2. In the Edit Smart Collection dialog box, add and remove search criteria as described above.

3. Click OK.

Using the Properties Pane

The Properties pane displays all the metadata about your files. It also displays file properties such as file size,
creation date, and read-only or hidden status. You can use the Properties pane to add, change, or delete the
metadata for image and media files.

The Properties pane is open in Manage mode on the right of the File List pane by default. The Properties pane is
available in all modes .

To Open the Properties Pane in Any Mode:

Click Panes | Properties.

h label and field to display the double arrow cursor. Click and drag to adjust width. Double-click to toggle

’d) The Metadata panel offers adjustable width for metadata fields. Simply hover between a corresponding
between the width of the longest label in the group or the longest label in the pane.

Properties Pane Areas

The Properties pane is divided into 3 tabs: Metadata tab, Organize tab, and File tab.
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W Use the overlay icons, which appear as you hover over a thumbnail, to tag, rate and add color labels to
1 your images. Alternatively, you can display these setting in the Properties pane by clicking Tools |
Options | Properties Pane and selecting Show Tagged, Rating, and Color Labels.

Metadata Tab

The Metadata tab displays the rating, category, IPTC, EXIF, and ACDSee Metadata stored with a photo. The ACDSee
Metadata fields are available for you to enter the caption for your photographs as well as date, author, and notes.
The keywords field is display-only and can be entered in the Organize tab. The label field can be entered here or
selected from the Labels section in the Catalog pane. IPTC information is automatically embedded into your image,
while ACDSee Metadata is not embedded in your files, but instead is held in the database. ACDSee Metadata can be

embedded into all your files (or just selected ones) by clicking the Tools | Metadata | Embed ACDSee
Metadata command.

The IPTC data fields provide a standard means for entering and storing information about your photographs such
as description, creator, and copyright information. ACDSee supports fields defined in IPTC Core 1.1.

The EXIF data fields hold information captured by your camera such as shutter speed, camera model, and GPS
information.

Certain EXIF fields are no longer visible by default. The EXIF Artist, Copyright, Image Description, and Date/Time
Original fields are automatically modified when their matching IPTC fields are modified, (see table below). This
change reflects the recommendations of the Metadata Working Group (MWG). If you need to have these fields

visible in the EXIF section you can adjust your settings by clicking Tools | Options | Properties Pane and
clicking the Manage Metadata Views button.

Matching IPTC and EXIF Fields

IPTC EXIF

Description writes to Image Description
Creator writes to Artist

Copyright Notice writes to Copyright

Date Created writes to Date/Time Original

._/" When ACDSee parses metadata from a file, the content of the field is displayed without mapping.

Organize Tab

The Organize tab displays a tree of categories and a tree of keywords. The Category tree context-menu (right-
click) allows you to add and delete categories and sub-categories. You can create category sets to quickly
categorize your files. Right-clicking the Keyword tree also allows the same options. Use the keyword tree to create
a hierarchy to easily organize your files in a way that holds meaning for you.

File Tab

The File tab displays detailed file information and image attributes for a selected file or files. You can set or change

the Read-Only and Hidden properties of a file or folder, and view a summary of any EXIF information contained in a
file.

Embedding ACDSee Metadata into Files

1. If you have metadata in your files and they are copied, moved, or renamed, outside of ACDSee, the link

between the file and the database will be broken, but you can rebuild the database using the embedded
datain the file.
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! ACDSee uses XMP to embed ACDSee Metadata into each file. Only some file formats and file extensions
support XMP. These include GIF, JPEG, DNG, PNG, PSD, and TIF. In the case of these file formats, the
ACDSee Metadata is embedded inside the file and so you can rename or move the file outside of ACDSee
and still be able to retrieve the ACDSee Metadata. For formats that currently do not support XMP,
including RAW and ABR, the ACDSee Metadata is written to a sidecar file that is stored in the same folder
as its file. Because a sidecar file is separate from the file itself, you need to rename or move them
together, or you could lose the ACDSee Metadata permanently.

Browsing and Cataloging with Auto Advance

You can use Auto Advance to quickly move through your images while adding tags, ratings, labels, categories, or
keywords. You can use Auto Advance in Manage and View mode.

To Turn on Auto Advance in Manage Mode:
At the bottom of the File List toolbar, toggle the Auto Advance button or press CTRL+Q.

To Use Auto Advance:

When Auto Advance is enabled, adding (or clearing) a tag, rating, color label, keyword, or category will advance
the selection to the next image in the folder, allowing you to continue adding metadata. This is particularly useful
when paired with keyboard shortcuts, as you can organize entire folders without moving your hands from the
keyboard.

To select which types of applied metadata will trigger Auto Advance, see Setting the Auto Advance Options.

1. Keywords and Categories are disabled by default.

Manage Mode

In Manage mode, using the keys on the numpad, apply the following keyboard shortcuts
to make the most out of Auto Advance:
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! Turn on the Num Pad by pressing the Num Lock key before utilizing any of the following keyboard
shortcuts.

~

Tag

*

Purple Color Label
Blue Color Label
Green Color Label
Yellow Color Label
Red Color Label
Rating of 5

Rating of 4

Rating of 3

Rating of 2

Rating of 1
Remove Rating
Next

+ O R |IN W d U1 OIN O O

Previous

Removes Color Label.

! If the Num Lock key has not been activated, this will act as the Delete
button.

You can also customize keyboard shortcuts.

Keywords and Categories

You can streamline the process of adding keywords and categories to your images by combining customized
keyboard shortcuts and Auto Advance.

Keywords

In the Properties pane, on the Metadata tab, in the IPTC group, you can add keywords to the Keyword field, press
ENTER, and Auto Advance will move to the next image. You can also use the same method in the Keywords field on
the Organize tab of the Properties pane. In both locations, you can add multiple keywords at once, separating them
with commas. You can continue the process for all images without moving your hands from the keyboard.

Categories

In the Properties pane, on the Organize tab, expand the Categories group. Add categories to images by enabling
the checkbox of your desired category. Or do one of the following:

* Right-click the image, and choose Set Categories | [your desired category] from the context menu.
* Choose Edit | Set Categories | [your desired category].

Use any of the these methods and Auto Advance will move to the next image.

To utilize this same type of convenience in all IPTC fields, see To Use Keyboard Shortcuts to Enter Metadata into
the Same Field of Multiple Photos.
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View Mode

To Turn on Auto Advance in View Mode:

In the Bottom toolbar, toggle the Auto Advance button or press CTRL+Q.@

To Use Auto Advance in View Mode:

1. Choose Panes | Properties.

2. Add ratings, color labels, tags, categories, or keywords in the Properties pane and Auto Advance will
advance it to the next image in the Filmstrip, allowing you to continue adding metadata.

In View mode, use the following keyboard shortcuts to navigate your folder:

Home Selects the first image in the folder.
End Selects the last image in the folder.
Page Down Next

Page Up Previous

Using the Map Pane

Use the Map pane to add photo locations from anywhere in the world to your photos. You can then recall and view

that information for reference at any time. Use the map to select groups of files for further workflow steps, and
select photos for display in View mode.

The location of files displayed in the Map pane is based on the latitude and longitude information in the file
properties. If you have a camera with geotagging capabilities, the geographic location is automatically conveyed
visually on the map. You can also add map coordinates to files by dragging them directly onto the map and
pressing the Save All button.

Geotagged images are indicated on the map with pins. You can click a pin on the map to select files within a

geographic location for viewing or processing. If your geotagged image pin is not displayed on the map, try using
the keyboard shortcut F5 to refresh the map.

jThe following file formats can be added to the map: JPG, TIFF, RAW, DNG, and PNG.

h However, if you have a large number of files, you may want to catalog those files first to speed up the

"'J ACDSee automatically adds file information, including geographical tags, to the database as you browse.
loading time for the pins on the map. To catalog your files, click Tools | Database | Catalog Files.

To Open the Map Pane:
In Manage mode, click Panes | Map (CTRL + SHIFT + M).

The Map pane appears above the File List pane in Manage mode by default. You can drag the Map title bar to a
new location and float the pane or dock it in another position like the other movable panes in ACDSee.

’) You can toggle the Map on and off with the keyboard shortcut CTRL+SHIFT+M in Manage mode.
"y

To Add Files to the Map by Dragging:
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1. In Manage mode, drag one or more files onto the map.

2. Click Save All in the top left corner of the map.

1. Ideally images should be geotagged prior to processing. If an image is geotagged after it has been edited
and the Restore to Original command is used, then the geotag will be lost.

To Delete a Pinned Location on the Map:

Right-click the geotagged image thumbnail and select Map | Remove from Map.

To View a Geotagged Image on the Map:
Right-click the geotagged image thumbnail and select Map | View on Map.

To Find a Location:

To find a specific location, enter a place or landmark into the Search for Location field at the top right of the Map
pane.

To Set Default Location, Zoom, and Map Type:

1. Pan to your preferred location on the map, then adjust the zoom-level and select your preferred map type
(Map, Satellite, or Terrain).

2. Click Tools | Map | Set default map location.

# Note: The map reflects the current File list. If the File list has images mapped to a different location from
£ | your default setting, then that location will be displayed.

“"J To pan and zoom the map to a specific location, enter the location into the Map search field and press
h Enter.

Reverse Geocoding:

The Reverse Geocoding command allows you to save location information into certain IPTC fields. These include:
Country, Country Code, State/Province, and Location.

1. In Manage mode, drag one or more files onto the map.

2. Click Save All in the top left corner of the map.

3. Press the Reverse Geocode button to preview the location information.
4

Click Save to save this information into the IPTC fields of the selected images.

» If images with multiple different locations are selected, only one of those locations will be used to do the
=£_ | reverse lookup.

Using the Map Pane to Further Your Workflow
With the images from a particular location all selected, here are a few possible workflow options:

* Enter Edit mode to process this selection together.
* Use the Batch tool to apply the same settings on photos from the same location.
* Click Slideshow to view and present a slideshow of the photos from this location.

* Send photos from this location via email.

/ If a geotagged image does not display, try using the keyboard shortcut F5 to refresh the map.
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Pin Legend
, Indicates geotagged location.

, Indicates more than one geotagged location in this area. (Zoom in to see locations)
Q Indicates selected geotagged location.

, A dot on a pin of any color indicates unsaved image location.

Creating and Assigning Hierarchical Keywords

You can keyword your files in a hierarchy and maintain these groups in the Keyword tree. Select the Organize tab
in the Properties pane to create, rename, delete, and move your keywords.

You can also access the Keywords pane by choosing Panes | Keywords.

Creating Keywords

To Create Keywords:
In the Properties pane, located to the right of the File List pane, do one of the following:
* Right-click Keywords in the Organize tab, and then select New Keyword.

* Type a keyword into the field of the Keyword group and press Enter.

To Keyword Files with Existing Keywords, Do One of the Following:
* Select one or more files, then drag the keyword onto them.
* Select one or more files, then check the box next to the appropriate keyword.
* Select one or more files, then right-click the keyword. Select Assign items.

* Select one or more files, then drag them onto the keyword.

To Establish a Hierarchy, Do One of the Following:

* In the keyword field, type the lesser or more specific keyword, followed by the less than symbol, followed
by the greater or more general keyword.

Example:

Owl < Bird
or
Madrid < Spain < Europe

* Right-click an existing keyword, then select New Keyword. The new keyword will automatically become a
child to the existing keyword.

When assigning multiple keywords to a file, it is important to note that separating keywords with commas
= will not generate a hierarchy.

Page 74 of 329



ACDSee Photo Studio Standard 2019

Managing Keywords

To Manage Your Keywords:

Select a keyword in the Organize tab, and do one of the following:

* Tounassign a keyword from a file, right-click the selected keyword and select Remove Items or uncheck
the box.

* To edit the keyword, right-click the selected keyword and select Edit.

* Todelete the keyword, right-click the selected keyword and select Delete.

+ To edit the keyword tree, click and drag the keyword to other parts of the tree.

*+ Toduplicate a keyword, right-click the selected keyword and select Copy, then Paste where desired.
* To merge duplicate keywords, click and drag one keyword into the other.

+* To create a keyword from an existing category, click and drag the category into the keyword tree.

Creating Quick Keywords

In order to keep your keywords organized and streamline your workflow, you can use quick keywords by creating
a group of related keywords that hold an association for you. This is ideal for keywords you would like to be easily
accessible, rather than buried in the hierarchical tree. You can create multiple groups and choose between them
based on the photos you are viewing at the time. You can also add these keywords to your tree.

Example:

Italy

Florence Venice Lake Como
Rome Milan Verona
Genoa Bologna Naples

To Create Easy-Access Quick Keywords:

1. Inthe Keyword group, on the Organize tab, select Manage Quick Keywords from the drop-down menu.
The Quick Keywords dialog box opens.

2. Customize the number of rows and columns for your set by selecting values from the Rows and Columns
drop-down menus.

3. Enter up to 250 associated or commonly-used keywords into the open fields. To create a hierarchy within
afield, use the pipe key. Example: A|B|C.

4. Click the Save button and choose a name for your set. Click OK.
5. Click OK.

6. Apply keywords from your set by selecting a file and clicking the applicable keyword from the Quick
Keywords Table.

7. Adialog will open asking if you would like to create this keyword. Click Yes. The keyword will be added to
the tree. If you specified a hierarchy in the keyword set, the parent keyword will appear in the tree with
the child under it. The text of the keywords in the table will change color to indicate that the keyword is
assigned to the currently selected files, and will display in italics if assigned to only some (but not all) of
the currently selected files.
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Copying and Moving Files

You can use the Copy To Folder and Move To Folder commands to relocate files and folders on your hard drive, and
specify how to handle overwriting existing files. You can also select from a list of previously accessed folders to
save time looking through your directory structure.

When you use ACDSee to relocate your files, by default any ACDSee Metadata associated with those files is
-=£_ | copied to the new location. However, if you do not want to copy the associated files, clear the Include
related files for non-RAW images checkbox.

! When you do NOT use ACDSee to move or copy your files, you break the link to any database information
you have added to those files. This is because ACDSee cannot track the files. You will lose important
categorizing and other database information. You can fix this by clicking Change Binding and rebinding

the database. If you have embedded the database information in the files themselves, you can also
retrieve this information using Tools | Database | Catalog Files.

! ACDSee uses XMP to embed ACDSee Metadata into each file. Only some file formats and file extensions
support XMP. These include GIF, JPEG, DNG, PNG, PSD, and TIF. In the case of these file formats, the
ACDSee Metadata is embedded inside the file and so you can rename or move the file outside of ACDSee
and still be able to retrieve the ACDSee Metadata. For formats that currently do not support XMP,
including RAW and ABR, the ACDSee Metadata is written to a sidecar file that is stored in the same folder
as its file. Because a sidecar file is separate from the file itself, you need to rename or move them
together, or you could lose the ACDSee Metadata permanently.

To Copy or Move Files:
1. Do one of the following:

* In the File List pane, select one or more files, and then click Edit | Copy To Folder or Move To
Folder.

*  While viewing an image or media file in View mode, click Edit | Copy To Folder or Move To
Folder.

2. Inthe Copy To Folder or Move To Folder dialog box, do one of the following:
* Select the Folders tab, and locate the folder on your hard drive where you want to place the files.
* Select the History tab, and select a folder from the list of recently-accessed folders.
* Select Create Folder and enter the name of a new folder.

3. In the Overwriting duplicate files drop-down list, select one of the following options to specify how
ACDSee should handle overwriting files:

* Ask: Prompts you for confirmation when overwriting a file.

* Rename: Prompts you to rename a file.

* Replace: Overwrites any file with the same file name and extension.

* Skip: Cancels the operation if there is a file with the same file name and extension.

4. Click OK.

Copying Images to the Clipboard

You can copy an image to the Clipboard and then paste it into another application. Using the Copy Image command
transfers only the image data to the Clipboard: no EXIF, IPTC or metadata information is retained.
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To Copy an Image:
1. In Manage mode or View mode, select the image file you want to copy.
2. Click Edit | Copy Image.

3. Paste the image into your other application.

Pasting Files and Folders

You can cut or copy files to the Clipboard, and then paste them into another folder without losing your ACDSee
Metadata.

To Cut and Paste Files:
1. In Manage mode, in the File List or Folders pane, select one or more files or folders.
2. Click Edit | Copy or Cut.
3. In the Folders pane, browse to a new location.
4

Click Edit | Paste to place the files or folders into the new location.

Replacing or Overwriting Files

When copying or moving files from one location to another, a file name collision occurs if a file already exists in the
destination folder with the same file name and extension as a file you are relocating. In ACDSee, you can view both
of the files involved in the Confirm File Replace dialog box. If the files involved are image files, ACDSee displays
thumbnail previews of both files, and provides options to replace the existing file, rename, delete, or skip the file
you are moving, or cancel the operation entirely.

To Use the Confirm File Replace Dialog Box:

1. If you are moving a number of files and want to handle all potential file name collisions in the same
manner, select the Apply to all checkbox.

2. Tohelp determine any differences between the two files, use the toolbar between the two preview fields to
shrink or enlarge the size of the previews.

3. Do one of the following:
* Toreplace the destination file with the source file, click Replace.

* Torename the new file before moving it into the destination folder, type a new name for the file in
the Rename to field, and then click Rename.

* To skip this file, and leave both files intact, click Skip.

* To delete either the destination or source file, click Delete below the file you want to remove from
your hard drive.

* To cancel the operation and not move or copy any more files, click Cancel.

! In the Confirm File Replace dialog box, destination file refers to the file that exists in the target folder,
and source file refers to the file you are moving or copying.

Renaming a File or Folder

You can rename a file or folder on your hard drive in the Folders and File List panes.
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To Rename a File or Folder:
1. In Manage mode, in the File List or Folders pane, select the item you want to rename.
2. Click Edit | Rename.
3. Without removing or changing the file name extension, such as “.jpg”, type a new name for the file.
4.

Press Enter.

._/f You can rename multiple files at the same time using the Batch Rename tool.

Storing Files in Private Folders

Private folders are secure folders where you can store confidential files. When you place files into a private folder,
ACDSee moves them from their current location into the private folder. Private folders are password-protected and
the files in them can only be viewed in ACDSee.

When you add files or folders to a private folder all information related to them is permanently removed from the
database. Restoring files and folders from a private folder does not restore information to the database. The only
way you can preserve database information related to the files or folders is to back up or export the database
before you add them to a private folder.

To Open the Private Folder Pane:

In Manage mode, click Panes | Private Folder.

To Create a Private Folder:
1. Close any open private folders.
2. Right-click the private folder icon in the Private Folder pane and select Create Private Folder.

3. Inthe Enter Password text box, type a password for the private folder. Your password must be less than
40 characters long.

4. In the Re-enter Password text box, type the password again to verify it.
5. Click OK.

A new folder will not display in the Private Folder pane. Private folders are hidden and are only identified by their
password. When you have a private folder open you will see any subfolders that exist within the private folder, but
do not confuse these subfolders with the private folder itself.

To Open a Private Folder:

1. Close any open private folders.

2. Click Panes | Private Folder.

3. Click the Open button in the Private Folder pane header.
4. In the Enter Password text box, type the password of the private folder that you want to open.
5.

Click OK.

The contents of an open private folder remain visible until you close it. Remember to close your private
= | folder if you have to step away from your computer and do not want anyone to see its contents.

To Close a Private Folder:
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Do one of the following:
* Click the Close button in the Private Folder pane header.

* Click File | Exit to exit ACDSee. The private folder is closed automatically.

To Add Files to a Private Folder:
1. Open the private folder to which you want to add files.

2. Click and drag the files onto the private folder icon in the Private Folder pane. A warning message
displays.

3. Click Yes to move the files to the private folder.

! When you add files and folders to a private folder they are removed from their original location in the file
system and added to the password-protected private folder. There is no way to recover files and folders
from a private folder if you have forgotten your password. Ensure that you choose a password that you
will be able to remember.

To Add an Existing Folder and its Contents to a Private Folder:
1. Open the private folder to which you want to add files.
2. Click and drag the folder onto the private folder icon in the Private Folder pane.

3. Click Yes to move the folder and its contents to the private folder.

To Restore Folders and Files from a Private Folder:
1. Open the private folder containing the folders or files that you want to restore.
2. Select the folders or files and click File | Restore from Private Folder.

3. Click the browse button, navigate to the folder where you would like to move the folders or files, and then
click OK.

4. Click OK.

ACDSee moves the folders or files from the private folder to the selected location. These folders and files
are now visible to anyone with access to the computer.

To Delete a Private Folder, or the Folders or Files in the Private Folder:
1. Open the private folder containing the folders or files that you want to delete.
2. Do one of the following:
* To delete the private folder, right-click the private folder icon and select Delete.
* To delete folders or files in a private folder, right-click them and select Delete.
A warning message displays.

3. Click Yes to delete the private folder and all of its contents, or the selected folders or files in the private
folder.

Use caution when deleting folders or files in private folders. If you delete folders or files in private folders

-=*_|they are permanently destroyed. Restore the folders and files if you want to move them from the private
folder to a non-secure location on your computer.
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Tagging Images

It is easy to take hundreds of photos at an important event like a wedding or a marathon. After you have
transferred your photos to your computer, you may want to review them and sort out your favorites. Tagging is a
fast and easy way to identify your best photos or to separate them for editing or review.

The tagging checkbox is at the bottom right corner of the thumbnails. Click the checkbox to tag or un-tag photos .
Photos remain tagged until you clear the checkmark from the checkbox.

You can display all your tagged photos with one click by clicking Tagged under Special items in the Catalog pane.
Tagging, like categories and ratings, is a way to set aside, organize, and group your photos without moving the
files into different folders.

{w Tagging is intended as a temporary means of separating your images. Once tagged, you can move or
‘u) apply categories and ratings to the images, and then clear all of the tags. Categories, ratings, color
labels, and folders are more effective for organizing and grouping your images over a long period of time.

To Tag a Selected Image:

* Use the keyboard shortcut \ backslash key to toggle the tag on.
* Select the checkbox in the bottom right corner of the thumbnail.
* Right-click on one or more thumbnails and select Tag.

* In the Properties pane, select the tag checkbox at the top left corner in the Metadata tab.

To Untag a Selected Image:

* Use the keyboard shortcut \ backslash key to toggle the tag off.

* In the Properties pane, uncheck the tag checkbox at the top left corner in the Metadata tab.

To Untag All Tagged Images:

1. Click Tagged in the Catalog pane to display all tagged files in the File List pane.
2. Usethe keyboard shortcut CTRL + A to select all.

3. Click the backslash key \ to toggle the tag off.

To Display Tagged Images:

In Manage mode, click Panes | Catalog to display the Catalog pane, then click Tagged in the Special Items
section.

Tagged photos from all your folders display in the File List pane.

To Tag an Image in View Mode:
Do one of the following:

+* In View mode, select the checkbox in the bottom right corner of the status bar.

+ In View mode, click Panes | Properties to display the Properties pane, click the Metadata tab, then select
the Tagged checkbox in the top left corner.

To Tag an Image When You Are Comparing Images:
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1. In the Comparison List, select the checkbox in the bottom right corner of the image thumbnails.

2. Click OK. The Compare Images Viewer closes. You will see a checkmark in the checkbox of the images that
you tagged.

Manage Metadata Views and Presets

To Select a Metadata View:
1. Click Panes | Properties to open the Properties pane.
2. Select the Metadata tab of the Properties pane.

3. Click the Metadata View drop-down list in the Metadata tab to select one of the view options: Default
Metadata View (most commonly used fields), All EXIF, All IPTC, ACDSee Metadata, or saved custom views.

To Create a Customized Metadata View:
1. Click the Metadata View drop-down list in the Metadata pane and select Manage Metadata Views.
2. In the Choose Metadata to Display dialog box, select New Metadata View from the drop-down list.

3. Click the plus + signs to expand the tree and toggle the checkboxes on and off to select your preferences.
See Manage Metadata View options below.

4. Click the save button and enter a name for your customized view.

5. Click OK.

=[] ADSes Metadata

Database Date

L[] Kevwards
Manage Metadata Views Options b [P Miotes
=[] EXIF
* When all items in a group are selected, the group checkbox is checked. --|:|Camera Info
* When noitems in a group are selected, the group checkbox is clear. |:| @PsS
. . ) [ ]Image
* When some, but not all items in a group are selected, the group checkbox is --DMisceIIanenus
solid.
=- [ PTC

Toggle the checkboxes on and off to make your selections.

[#-[f] Contact
|§| Cantent
Copyright
|§| Image
|§| Skatus

% You can choose whether or not to display maker notes by selecting or deselecting the Display Maker
‘I;‘) Notes checkbox.

Adding ACDSee Metadata to Multiple Files

We recommend entering and editing metadata prior to processing your images. If you use the Restore to

Original command, the metadata will be lost unless it was entered prior to processing (except in the case of RAW
images).

Page 81 of 329



ACDSee Photo Studio Standard 2019

onu cannot set IPTC and EXIF information for read-only files, such as those on a CD-ROM.
“') If the Properties pane is not already open, select Panes | Properties.
h

To Add Metadata to One or More Files:
1. In Manage mode, select one or more files in the File List pane.
In the Properties pane, select the Metadata tab.

Enter information into the metadata fields.

BN

Click Apply or press Enter to apply your changes.

# When you click Apply or Enter in Manage Mode, the focus is returned to the File List pane allowing you to
-=£__| quickly make another file selection using your keyboard.

% Toinclude numbers in a sequence with your metadata, select the files and enter <#> as the start
b number, in whichever field you want. Ex) Entering <5> will begin the sequence at 5.

Metadata Tab Keyboard Shortcuts

This Shortcut Has This Result
TAB Jumps focus forward from field to field.
SHIFT + TAB Jumps focus backwards from field to field.

Places the cursor in the ACDSee Metadata Keywords field of the Organize tab in the

CTRL + K Properties pane.

ALT + K Places the cursor in the IPTC Keywords field of the Metadata tab in the Properties pane.
ENTER Applies your changes.

ESC Discards your changes.

1. If you click away from the Properties pane, any metadata that you have just entered will be lost. You must
click Apply or press ENTER to apply your changes.

To Use Keyboard Shortcuts to Enter Metadata into the Same Field of Multiple Photos:
1. Selectthe first photoin your list and enter content into a Metadata field.

2. Press the Page Down key to move to the next photo. The cursor remains in the same field of the
Properties pane for each photo, allowing you to quickly enter content for the same field for multiple
photos.

3. Enter contentinto the field and again press Page Down to move to the next photo.

4. Continue Step 3 until complete.

/You do not need to click the Apply button when using this shortcut.

onu can use the Page Up key to move back to the previous photo.
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Removing IPTC Keywords from Auto Categories

You can remove unused IPTC keywords from the ACDSee database. Once removed, the IPTC keywords will no
longer display under Keywords (IPTC) in the Photo Properties' Auto Categories list of the Catalog Pane.

This process also applies for the Supplemental Categories field. This field is only visible if selected from
= | the Choose Metadata to Display dialog box found under Tools | Options | Properties Pane by pressing
the Manage Metadata Views button.

To Remove IPTC Keywords and Supplemental Categories:
1. In Manage mode, select any image which supports IPTC.
2. If the Properties pane is not already displayed, click Panes | Properties.
3. Toensuretheimage is writable, do the following:
* Select the File tab and check to see if there is a checkmark in Read only.

* If thereis a checkmark the image is not writable. Deselect the Read only checkbox to make the
file writable.

4. Inthe IPTC section of the Metadata tab, click the keyword picker button ! beside the Keywords field.
5. In the IPTC Keywords Picker dialog box, click Edit List.

6. Select the keyword you want to remove from the Value list.

") To select more than one keyword, press and hold the CTRL key while selecting the keywords.

7. Click Remove.
8. Click OK.
9. Click OK.

i~ % Only keywords that are not in use can be removed from the list. To find photos associated with a keyword,
‘IJ click the keyword listed under Photo Properties in the Auto Categories list of the Catalog pane.

Changing the Date and Time Properties of Images

You can use the Batch Adjust Time Stamp tool to change the date and time properties of one or more images in
Manage mode or in View mode.

To Change the Date and Time Properties of a File:
1. Do one of the following:
* In Manage mode, select one or more images, and then click Tools | Batch | Adjust Time Stamp.
* In View mode, click Tools | Modify | Adjust Image Time Stamp.

2. On the Date to Change tab, choose from the following:

Date to Change
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EXIF date and EXIF date/time original The original date/time the image was captured.
time EXIF date/time digitized The date/time the image was converted to a digital
image (usually the same as original).
EXIF date/time The date/time the image was lasted edited.

File last-modified The date/time the image or file was lasted edited. For example, image editing or
date and time updates to metadata.

File creation date The original date/time the file was created.
and time

ACDSee Database The date and time held in the ACDSee Database.
date and time

3. On the Advanced Options tab, select the options for the Adjust Image Time Stamp tool described below,
then click Next.

Advanced Options

Accept defaults and Accepts the default settings for the new time stamp options. To start

start conversion changing the date and time of your images, click Adjust Time Stamp.
Automatically close Closes the Adjust Image Time Stamp wizard as soon as the process is
wizard when complete.

finished

Save current Remembers the current settings and applies them the next time you change

settings as defaults time stamps.

4. On the Choose new time stamp page, select one of the following options:

* Use different date and time: Replaces the selected date and time with another time stamp
property from the same file. Select the file property you want to use from the Select date and
time drop-down list.

* Use specific date and time: Changes the selected time stamp in each file to a specific date and
time. Type the new date and time for the time stamp in the Date and Time fields.

* Shift to a new starting date and time: Replaces the earliest time stamp with a date and time
you specify, and shifts all later time stamps ahead accordingly. Specify the time stamp for the
earliest file in the Date and Time fields.

* Shift date and time by a specific number: Shifts all the time stamps either forwards or
backwards by a specific number of hours (to adjust for time zones). Select either Shift forward
or Shift backward, and type a number into the Hours, Minutes, and Seconds spin boxes.

5. Click Adjust Time Stamp to begin adjusting your files.

6. When the wizard is finished, click Done to return to ACDSee.

Backing Up Your Files to Another Computer

The Sync wizard will guide you through the process of creating a synchronized copy of your files to protect you
from local hard drive failure. You can synchronize your local folders with a network drive, remote computer, or
external hard drive. You can name the synchronization, specify the actions you want to take each time you
synchronize your files, schedule the synchronization to run at specific intervals, and edit or remove the
synchronization at a later time.

! The Sync wizard does not backup your database when your files are copied to a new location. To back up
files with database information, use the ACD Database Backup wizard.
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To Create a Synchronization:
1. In Manage mode, click File | Sync | Create Sync.
2. On the Welcome page, click the Next button when you are ready to continue.
3. On the Synchronization Options page, do the following:
* In the Source folder field, specify the folder containing files you would like to copy.

+ In the Backup destination field, specify a folder on a network drive, remote computer, or
external hard drive in which to place the backup files.

* In the Options area, specify how Sync should handle errors and logs.
* In the Confirmations area, specify how Sync should handle file duplication conflicts.
* Click Next when you are ready to continue.
4. On the Synchronization Schedule page, do the following:
* In the Name text box, type a name for your synchronization.

* In the Schedule area, specify whether you would like to run the synchronization immediately, or
schedule the synchronization.

* Click Finish when you are ready to complete the wizard.

! Schedule: An account with no password cannot set up a schedule. You must set a password for your
account for schedules to work. A blank password will not work; you must have a real password with more
than one character.

Updating or Deleting a Synchronization

You can adjust the settings of a synchronization, schedule it to run at regular intervals, or delete the
synchronization from ACDSee.

To Update or Delete a Saved Synchronization:
1. In Manage mode, click File | Sync | Edit Sync.
2. Inthe Saved Synchronizations dialog box, select a synchronization from the list.
3. Do one of the following:

* To schedule the synchronization, click Schedule. Specify how often to run your synchronization,
and then click OK.

* To adjust the settings, click Edit. In the Edit Synchronizations dialog box, update the folder
containing files you would like to copy, and a folder on a network drive, remote computer, or
external hard drive in which to place those files. In the Options area, update how Sync should
handle errors and logs. In the Confirmations area, update how Sync should handle file
duplication conflicts. Click OK when you are finished.

* Torename the synchronization, click Rename. Type a new name for the synchronization and
click OK.

* To delete the synchronization, click Delete.

4. Click Close.

Running a Saved Synchronization

After you create a synchronization, you can run it at any time, even if it is scheduled to run at regular intervals.
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To Run a Saved Synchronization:

In Manage mode, click File | Sync, and then select the name of the synchronization you want to run.

Searching with ACDSee

ACDSee includes a number of ways to search your computer for files and folders. You can use the Search pane to
search by file name, keywords, or image properties. You can create advanced searches to locate files that fall
within a date or rating range and then save and name the search to use later. You can also use the Duplicate
Finder to locate and manage identical files.

For simpler searches, you can use the Quick Search bar to quickly locate files and folders, or search the database
for specific names and keywords. You can also customize the Quick Search bar to only search for specific items or
certain parts of the database.

Also, you can use the Catalog pane to quickly locate and list all images on your hard drive, or to locate any files in a
folder that have not been categorized. If you are working with larger image collections, you can use Selective
Browsing to specify broad or narrow criteria for the images you want to display in the File List pane.

Using the Quick Search Bar

You can use the Quick Search bar in Manage mode to quickly locate files or folders. You can use the Quick Search
options or basic operators to refine or expand your search, and view the results in the File List pane.

The Quick Search feature always searches the following IPTC fields: Title, Headline, Description, Keywords,
Creator, City, Location, State/Province, Country, and Instructions. The Quick Search also searches Color labels and
the ACDSee Metadata fields: Caption, Author, Notes, and Keywords.

When ACDSee searches file names, it only considers the first term in the file name. For example, a file
£ | called Cat_Dog would be found by searching for Cat, but not for Dog. Search terms are not case-
sensitive.

To Run a Quick Search:

Do one of the following:
* In the Quick Search bar, type the term or part of a word for which you want to search.

* Click the drop-down list beside the Quick Search field and select a previously entered search term.

" You can use the keyboard shortcut Ctrl+F to put the focus in the Quick Search bar and immediately
J begin typing.

%
I

Quick Search Operators

You can use the following operators to further refine or expand your searches in the Quick Search bar. Note that a
search term cannot begin with an operator; it must start with a word.
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Operator Result Examples

- Searches for all items containing the first search term, and then Cat -Dog returns all
displays only those items that don't also contain the second search items that contain Cat,
term. except those that also

contain Dog. Be sure to
insert a space before
the minus sign. If you
do not insert a space,
ACDSee will assume you
are searching for a
hyphenated word.

+ Searches for all items containing both the search term before and  Cat+Dog or Cat Dog
after the operator. Those items that only contain one of the terms,  returns items
are excluded. The Quick Search bar treats spaces between words containing both Cat
as + operators. and Dog.

Cat+Dog+-Kittens
returns items that
include both Cat and
Dog, but not those that
include Cat and Dog

and Kittens.
| Searches for all items containing one or the other of the search Cat|Dog includes all
elements. items with either Cat or

Dog in the search.

Cat+Dog]|Kittens
includes items that
contain both Cat and
Dog, and those that
contain Kittens.

Using the Search Pane

You can use the Search pane to search for your files and folders. You can do basic searching by file name or
keyword phrase, and create advanced searches to narrow your results by folders, categories, and image
properties. You can also search for patterns in file names and find duplicate files.

You can also save a search and give it a name. Saved searches are listed on the Search pane and the Catalog pane.
On the Search pane, can select Saved searches from the drop-down list to run again. On the Catalog pane, Saved
Searches are listed below Auto Categories where you can run them again by clicking once on the Saved Search
name.

The Search pane will not return results for folders that are not cataloged in the ACDSee database.
= | Cataloging happens automatically when you browse to a folder. You can also click Tools | Database |
Catalog Files.

To Open the Search Pane:

In Manage mode, click Panes | Search.

Search Pane Areas

The Search pane contains several areas to help you manage your searches. When you create a search, remember
that the search tool will only return files that match all of the criteria that you specify.

Saved Searches
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In the Saved searches area, you can save a complex search to use later, select a search to run again, or delete a
saved search.

Saved searches If you have saved a search, itis listed in this drop-down list for you to select
and run again. When you click Start at the bottom of the pane, the search
results are listed in the File List pane.

Saved searches are also listed on the Catalog pane, from where you can run
them with a single click on the Saved Search name.

Save a search Click the Save icon, and then Save or Save As to save or overwrite a saved
8 search. When the Saved Search dialog opens, type in a name for the search. If
you use a descriptive name, it makes it easier to remember the criteria in your

saved search.

Delete a search Select a search from the drop-down list and then click the Delete icon. Click
- Yes to confirm the deletion, when the prompt opens.

Files and Text

In the Files and Text area, you can identify what you are searching for, and where you want to search for it.
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Search for files or Type a portion of the file or folder name for which you want to search, or select

folders named a previous search term from the drop-down list. You can also use wildcards to
search for file name patterns. To exclude all non-image files, click the right-
arrow button beside the field and select Images only.

With the text Type the text you want to search for within the ACDSee database. This can
include portions of a caption or keyword, or even the name of a folder or
category that might contain the files you want to find. When you search by both
file name and a keyword or phrase, an item is included in the search result only
when it includes both criteria.

To specify what parts of the database you want to search, and indicate how to
treat the text you type in the field, click the arrow next to the field and select any
of the following options:

* Find all words: Only returns files that match all of the words you
enter.

* Find whole words only: Only returns files that contain the entire
word, exactly as you type it.

* Search in Caption: Searches the Caption field of files in the database.

* Search in Keywords: Searches the Keyword field of files in the
database.

* Search in Notes: Searches the Notes field of files in the database.

* Search in Categories: Searches the Category assignments of files in
the database.

+* Search in Folders: Searches in the name of folders in the database.

* Search in Labels: Searches the labeled images by color.

Search in Select one of the following options:

* Entire database: Performs a search on the entire ACDSee database.
Note that any folders on your computer that have not been cataloged are
not included in the search results.

+* Specific folders and categories: Performs the search only within the
categories and folders you specify. Selecting this option opens the
Categories and Folders area, where you can select the location and
categories in which you want to search.

Sync to file list settings Imports the current Manage mode settings, including Selective Browsing
settings, into the Search pane. Note that this may also remove criteria from the
Search pane.

Properties Area

In the Properties area, you can identify file properties that you want to search for, and specify ranges of values to
include or exclude from your search.

To Use the Properties Area:

1. Below the Search file properties field, click Add.
2. In the Add Search Criteria dialog box, select one or more properties on which to base your search.
3. Click OK.
4. 1Inthe Properties area, click the hyperlinks to define conditional statements for each property.
5. Click Start to perform the search.
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Searching with File Name Patterns

You can type a text pattern into the Search pane's Search for files and folders named field to search for file
names. You can search for simple patterns such as portions of file names, or more advanced patterns that include
wildcards.

File Name Pattern Wildcards

Wildcar Result Example

d

? Matches any single character in the file name. ca?.jpg results in cat.jpg, cap.jpg, and
car.jpg, but not cats.jpg

* Matches zero or more characters in the file name. cat* results in cat.jpg, cats.jpg, and
cathy.jpg

[...] Matches any of the enclosed characters. ca[tr] results in cat.jpg or car.jpg, but
not cap.jpg

[L..] Matches any character not enclosed. cat[!0] results in cata.jpg and

catb.jpg, but not cat0.jpg

[...-...] Matches any character in the specified range. cat[a-f0-9] results in cata.jpg,
catb.jpg, catf.jpg and cat0.jpg,
catl.jpg, ..., cat9.jpg

\ Blocks the use of other wildcard characters that are also Because square brackets are wildcards,
characters permitted in a file name, such as square if you wanted to search for a file name
brackets: [ ]. The * and ? characters are not permitted in  that contains a bracket, you must
file names so this function does not work with them. precede the bracket with a backslash:

ACD\[123\] results in ACD[123].gif

._/' Patterns are not case-sensitive. To use multiple patterns, separate the names with spaces or semicolons.

-=*_ | To match a pattern containing a space or semicolon, enclose the pattern in double quotation marks. If you
do not include the * wildcard in your pattern, the pattern is matched as a sub-string. For example, cat
would match cat, cathy and bobcat, and is equivalent to the pattern *cat*.

Using Selective Browsing

You can use selective browsing to browse for files that are located in a specific folder, assigned a specific date,
and/or assigned to a specific Catalog classification. By adjusting the selective browsing criteria, you can quickly
include or exclude files from the File List pane, and view only those files you want to browse.

To get the most out of selective browsing, it is recommended that you catalog and organize your files in the
ACDSee database. The more information you enter for your files, the more helpful you will find the selective
browsing feature.

To Use Selective Browsing:

Open the Selective Browsing panel by clicking View | Selective Browsing. The panel appears on the left side
of the File List pane.

Setting Selective Browsing Criteria

The Selective Browsing panel is divided into three areas: Folders, Catalog, and Calendar, each of which
corresponds to the Manage mode pane of the same name. When the Selective Browsing panel is open, the
Contents bar in the File List pane is replaced by the Selective Browsing bar, which lists all of the current browsing
criteria.
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When you add a folder, date range, or organize method to the Selective Browsing panel, ACDSee excludes any files
that do not match that criteria. You can add or remove criteria to narrow or broaden your results.
To Add Selective Browsing Criteria:

With the Selective Browsing panel open, do any of the following:
* In the Folders pane, select one or more folders.
* In the Catalog pane, select one or more categories, and/or a rating.
* In the Calendar pane, select one or more date ranges.

As each criteria is added to the Selective Browsing panel, ACDSee searches its database for files in that folder, that
match the date range, and are assigned to the classification, and displays them in the File List pane. You can then
select those files and use the ACDSee features to edit, share, move, and view them however you want.

You can also adjust or refine your criteria in the Selective Browsing panel:

* Toremove a selected criteria from the Selective Browsing panel, right-click any of the criteria, and then
select Remove From Scope.

* To exclude all of a certain type of criteria, click the bar above the list, and toggle the option to include that
type in the scope. For example, to exclude the listed folders from the scope, click the Folders bar, and
then click Include Folders in Scope. The folders you selected will still be displayed in the Selective
Browsing panel, but will not factor in the results.

* Toremove all criteria of a certain type, click the bar above the list, and select Clear All.

The default behavior for categories in the Selective Browsing panel is to display files that match any of the
categories listed. You can refine your results by choosing to display only those files that are assigned to all of the
specified categories. To toggle between behaviors, right-click the bar above the categories you selected, and
select Match Any or Match All.

Tips for Selective Browsing

When you add a criteria to the Selective Browsing panel, you are indicating that the files you want to browse must
have that attribute. For example, if you select a folder in the Folders pane, then ACDSee displays only files in that
folder. If you select a rating in the Catalog pane, ACDSee displays only files assigned to that rating.

You can combine criteria to refine your selective browsing even further. For example, if you select a category and a
date range, then ACDSee displays only those files that belong to both the category and date range you selected.
ACDSee does not display items that fall within the date range unless they are also assigned to the correct category,
and does not display files assigned to that category unless they also match the date range.

Hiding the Selective Browsing Panel

You can use the Auto Hide feature to automatically hide the Selective Browsing panel and increase space for the
File List pane. When the panel is set to auto-hide, it rolls away when you click outside it, leaving only an edge
displayed. You can access the panel again by moving the cursor over the edge.

Searching with Auto Categories

Do you have hundreds, possibly thousands, of images? Do you use more than one camera? Do different members
of your family share cameras? Or do you have images on your computer that were captured by friends and family?
If you answered yes to any of these questions you should consider using auto categories to search for images.

You will see auto categories in the Catalog pane, below Labels. Double-click or click the plus sign (+) to expand
auto category groupings. Double-click or click the minus sign (=) to collapse the auto category groupings.
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Some auto category information is added to your images by your camera. For example, cameras will record
information such as the camera make and model, the white balance settings you used, the focal length you used,
and the aperture. You may want to supplement that information with the city, province/state, or country in which
you captured the images, as well as keywords or copyright. You can do this by manually entering information in
the Properties pane.

When you click on an auto category, ACDSee searches for images belonging to that category. For example, imagine
that you use more than one camera. You can expand the Photo Properties and Camera Model groupings, then
select the category representing your camera model. All images captured with that camera model will display.
Similarly, imagine that your brother captures a lot of images and sends them to you. You can expand the Photo
Properties and Photographer groupings, then select your brother's name from the list of photographers. All
images captured by your brother will display.

Below are some tips for searching with auto categories.

Identifying Commonly Used Search Categories

If there are certain auto categories in the Photo Properties grouping that you use frequently, you can save time by
adding them to the Commonly Used grouping. Some Photo Properties groupings are available in the Commonly
Used grouping by default. You can add as many auto categories as you want to the Commonly Used grouping, and
you can easily remove any grouping from the Commonly Used grouping when you no longer need them.

To Add an Auto Category Grouping to the Commonly Used Grouping:
1. Expand the Photo Properties grouping.

2. Right-click the auto categories grouping that you want to add to the Commonly Used grouping, and select
Add to Commonly Used. The grouping is added to the Commonly Used grouping.

It remains visible in the Photo Properties grouping as well.

To Remove an Auto Category Grouping from the Commonly Used Grouping:
1. Expand the Commonly Used grouping.

2. Right-click the auto categories grouping that you want to remove from the Commonly Used grouping, and
select Remove from Commonly Used.

The grouping is removed from the Commonly Used grouping.

Refining Your Auto Categories Search

You can refine your auto categories search by selecting more than one auto category. For example, imagine that
you are learning to combine aperture and shutter speed settings to properly expose images in a variety of lighting
and you want find images taken at specific settings. If you click the Easy-Select indicator beside the f/16 aperture
auto category and the 1/30 s shutter speed auto category, ACDSee will search for images that belong to both of
those auto categories.

When you select more than one auto category you can further control the search by selecting Match All or Match
Any from the Match Any/All drop-down list at the top of the Catalog pane. If you select Match Any, ACDSee will
display any images associated with the selected auto categories. If you select Match All, ACDSee will display only
those images that are associated with all of the selected auto categories.

You can also refine your auto categories search by selecting a category or rating. For example, imagine that you
clicked on the Photographer auto category and found over 1000 images. However, you only want to see the best
images by that photographer. Click the Easy-Select indicator beside 1 in the Ratings area of the Catalog pane.
Only the images by that photographer with a rating of 1 will display.

You can also use the Selective Browsing pane to refine your auto categories search. For example, imagine that you
clicked on the Camera Model auto category and ACDSee displayed over 1000 images. However, you only want to
see the images that you took on a specific date. Display the Selective Browsing pane by clicking View | Selective
Browsing, then select the Calendar pane and select the appropriate date. Only the images taken with that
camera model on that day will be displayed.
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Finding Duplicate Files

You can use the Duplicate Finder plug-in to search for duplicate files on your hard drive. Once you locate any
duplicates, you can rename or delete them to better manage your file collection.

The following steps are a basic overview of how to use the Duplicate Finder. There is also extensive context-
sensitive Help in the plug-in dialog box to provide you with additional information.

/ ) Limit your search by selecting only a portion of the photos or images in a folder.

L

To Find Duplicate Files:
1. In Manage mode, select a folder or images to search for duplicates.
2. Click Tools | Find Duplicates.

3. Inthe Duplicate Finder dialog box, on the Select Search Type page, add any other files and folders you
want to search.

4. Do one of the following:

* Tofind duplicates within the files and folders you added to the list, select Find duplicates
within this list of files.

* To compare files between the list you created and another group of files, select Find duplicates
between these files and another list.

5. Click Next.

6. If you are comparing the files with another list, add the files or folders you want to compare to the second
list, and then click Next.

7. On the Search Parameters page, specify whether you want to find exact duplicates, or just files with the
same name.

8. Select Find images only if you only want to search for image files.
9. Click Next.
10. If noduplicates are found, click OK and refine your search or click Cancel to exit the Duplicate Finder.

11. If duplicates are found, specify from which list you want to delete the duplicates, and then select the
checkbox next to the files you want to delete. You can also right-click a file name to open, rename, or
delete a file.

12. Click Next to review your changes, and then click Finish.

Finding Images Quickly

You can click on the name of a saved search to quickly re-run the search. You can select Special Items in the
Catalog pane to locate all of the images in your database, or list all of the images that you have not yet assigned to a
category.

To Re-Run a Saved Search:
In Manage mode, in the Catalog pane, click the name of a saved search.

The results of the search display in the File List pane.

To Find All of Your Images at Once:
1. In Manage mode, click Panes | Catalog to open the Catalog pane.

2. Inthe Catalog pane, under Special Items, click Image Well.
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To Locate Uncategorized Images:
1. In Manage mode, click Panes | Catalog to open the Catalog pane.

2. In the Catalog pane, under Special Items, click Uncategorized. The Image Well and Uncategorized
features only display images that have been cataloged in the database; they do not search your hard drive
for specific file types.

To Locate Images That Haven't Been Keyworded:
1. In Manage mode, click Panes | Catalog to open the Catalog pane.

2. In the Catalog pane, under Special Items, click No Keywords.

Sharing Files with ACDSee

ACDSee makes it easy to share your images and other files with friends and family. You can email files directly
from ACDSee, upload images to a Web site, create your own Web pages with the HTML Album plug-in, or print a
contact sheet. You can also create slideshows and screensavers that you can give to anyone with a computer—
they do not need ACDSee to view them.

Taking a Screen Capture

You can use the ACDSee Screen Capture utility to create images from different areas of your screen. You can select
what areas to capture, how you want to perform the capture, and where to store the captured image.

To Take a Screen Capture:
1. In Manage mode or View mode, click Tools | Screen Capture...

2. Inthe Source area of the Screen Capture dialog box, identify the part of the screen you want to capture.
See the table below for a description of the Source options.

If you want to include your cursor in the output image, select the Include mouse cursor checkbox.
In the Destination area, identify where you want to place the output image.

In the Initiate capture area, identify how you want to take the screen capture.

a A~ W

Click Start to launch the screen capture tool.
An icon appears in the Taskbar Notification area.

7. Prepare your screen to show the area you want to capture, and then follow the steps that appear in the
bubble above the Screen Capture icon.

8. To exit the Screen Capture utility without taking a screen capture, right-click the Screen Capture icon, and
then select Exit Screen Capture.

Screen Capture Options
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Desktop Current monitor Captures an image of the entire area displayed on the
screen.
Window Entire window Captures an image of the entire active window.
Content only Captures an image of the window contents (does not

include the frame or title bar).
Region Fixed size Captures an image of a fixed area on the screen.

Click the drop-down button and select a dimension
setting or select Custom, and enter the dimension in
pixels.

Selected region Captures a selected area of the screen. Click and drag
your cursor to surround the area you want to capture.

Object Child window Captures an image of sections of the window. For
example, a toolbar or button.

Menu under cursor Captures selected menu commands.

Include mouse cursor Includes the cursor in the screen capture.

Destination options Clipboard Places a copy of the image on the Clipboard. From the
Clipboard you can paste the image in a new location.
File Displays the Save dialog box to save the file; you can
specify location, format, and file name.
Editor Opens the captured image in the default editor.
Initiate Capture Hot key Designates a keystroke combination to trigger the
options screen capture.

To set the Hot Key, press a key or combination of keys
(e.g., CTRL + S) on the keyboard; do not type in the
box.

Timer Takes a screen capture after a designated period.
Choose enough time to set up your desktop or window
for the screen capture. The maximum setting is 60
seconds.

Creating a Desktop Screensaver

You can create a desktop screensaver using your own images. You can set the screensaver options to adjust how
long each image is displayed, set the background color, apply transition effects, and add header or footer text.

To Create a Screensaver:

1. In Manage mode, in the File List pane, select a group of images, and then click Tools | Configure
Screensaver.

2. In the ACDSee Screensaver dialog box, click Add to browse for more images to add to your screensaver, or
select images you do not want to include and click Remove.

3. Click Configure, specify the options as described below, and then click OK.
4. To automatically use the screensaver on your desktop, select the Set as default screensaver checkbox.

5. When you are satisfied with your choices, click OK.

To Activate the Screensaver on Your Computer:

Select the Screen Saver tab in your Windows Display Properties dialog box, and then select ACDSee
Screensaver from the drop-down list.
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ACDSee Screensaver Options

Basic Select transitions

Variations

Effects

Background color

Slide duration (sec)

Advanced General settings
Slide order
Text Display header text

Display footer text
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Displays a list of transitions for you to select and plays
each transition, variation, or effect in the Preview as you
select it.

* Select all: Selects all the transitions and
displays them randomly.

* Clear all: Clears any selected transitions.

These transitions do not work with the 2-up, 4-
-=%_ | up and Collage variations.

Click the drop-down list to select from the following:
* None: Uses no variations

* Pan and Zoom: Zooms in and pans across each
slide during the time it is displayed.

* 2-up: Displays two images at a time.
* 4-up: Displays four images at a time.

* Collage: Displays images as a collage where
images overlap each other.

Click the drop-down list to select from the following:
* None: Uses no effects.
* Black & white: Displays all images in grayscale.
* Sepia: Displays all images in sepia.

* Vivid: Increases the saturation of the images to
make colors brighter.

* Soft: Blurs images slightly for a softening effect.

Specifies the background color. Click the color picker to
select or change the color. Click Other to set a custom
color in the Color dialog box.

Specifies how long you want the screensaver to display
each image.

Select or clear the following options:

* Stretch images to fit screen: Enlarges small
images to fill the entire screen.

* Play embedded audio: Plays any audio clips
embedded in the images.

Select one of the following options to specify the order to
display your images:

* Forward

*  Shuffle

Displays a text caption at the top of each image. Set the
options to specify the text you want to display.

Displays a text caption at the bottom of each image. Set
the options to specify the text you want to display.
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Screensaver Text Options

Alignment Specifies the alignment of the text captions.

Background color Specifies a background color for the caption text.

Text Specifies the text to display as a caption.

Font Opens the Font dialog box where you can select or change the font options for your
text.

Insert Metadata Inserts file-specific information called metadata into the caption.

Tag

Click to open the Choose Properties dialog box and select the metadata you want to
insert.

Viewing and Configuring a Slideshow

You can view a slideshow of images and/or videos from Manage mode or from View mode. You can also configure
your slideshow to start automatically whenever you run it, and set the slideshow options to adjust how long each
image is displayed, set the background color, apply transition effects, and add header or footer text.

To Start a Slideshow in Manage Mode:
1. Do one of the following:
* In the File List pane, select a group of images.
* In the Folders pane, select a folder.
* Usethe Easy-Select bar to select multiple folders that contain images.

2. Click Tools | Slideshow (keyboard shortcut CTRL+ S)

To Start a Slideshow in View Mode:

Click Tools | Slideshow.

To Configure a Slideshow:
1. In Manage mode, do one of the following:
* In the File List pane, select a group of images.

* In the Folders pane, select a folder or use the Easy-Select bar to select multiple folders that
contain images.

2. Click Tools | Configure Slideshow.
3. Inthe Slideshow Properties dialog box, select or change the slideshow options as described below.

4. Tosave your settings as the default slideshow behavior, select the Save current settings as default
checkbox.
5. Click OK.

Slideshow Options
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File Selection Slideshow contents

Always use these contents for
this selection type and start
slideshow automatically

Basic Select transitions

Variations

Effects

Background color

Slide duration (sec)

Advanced General settings
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Specifies which of the following media to include in
the slideshow:

* All media in current folder: Displays all
the files (images or video) in the folder you
have selected.

* All media in current folder and
subfolders: Displays all the files in the
currently selected folder and its subfolders.

+* Selected media: Displays only the files that
you selected before opening the Slideshow
Properties dialog box.

Retains the current Slideshow contents setting and
starts automatically the next time you launch the
slideshow.

Displays a list of transitions for you to select and
plays each transition, variation, or effect in the
Preview as you select it.

+ Select all: Selects all the transitions and
displays them randomly.

* Clear all: Clears any selected transitions.

These transitions do not work with the 2-up,
=£ | 4-up and Collage variations.

Click the drop-down list to select from the following:
* None: Uses no variations.

* Pan and Zoom: Zooms in and pans across
each slide during the time it is displayed.

* 2-up: Displays two images at a time.
* 4-up: Displays four images at a time.

* Collage: Displays images as a collage where
images overlap each other.

Click the drop-down list to select from the following:
* None: Uses no effects.

* Black & White: Displays all images in
grayscale.

+* Sepia: Displays all images in sepia.

* Vivid: Increases the saturation of the images
to make colors brighter.

* Soft: Blurs images slightly for a softening
effect.

Specifies the background color. Click the color picker
to select or change the color. Click Other to set a
custom color in the Color dialog.

Specifies how long you want the slideshow to display
each image.

Select or clear any of the following options:
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* Stretch images to fit screen: Enlarges
small images to fill the entire screen.

* Play embedded audio: Plays any audio clips
embedded in the images.

* Stretch video to fit screen: Enlarges video
files to fill the entire screen.

* Autohide control bar: Hides the slideshow
controls whenever the cursor stops moving
for more than a few seconds.

* Loop: Repeats the slideshow after displaying
the last image.
Slide order Select one of the following options to specify the order
to display your images:
* Forward

* Shuffle

Music directory Displays music from the previously-selected folders,
or you can click Browse to find a new folder.

Text Display header text Displays a text caption at the top of each image. Set
the options to specify the text you want to display.

Display footer text Displays a text caption at the bottom of each image.
Set the options to specify the text you want to display.

Save current settings as default Retains the current settings on all of the tabbed pages
and applies them the next time you view a slideshow.

Slideshow Text Options

Alignment Specifies the alignment of the text captions.

Background color Specifies a background color for the caption text.

Text Specifies the text to display as a caption.

Font Opens the Font dialog box where you can select or change the font options for your
text.

Insert Metadata Tag Inserts file-specific information called metadata into the caption.

Click to open the Choose Properties dialog box and select the metadata you want
toinsert.

Sharing Slideshows and Screensavers

You can view a slideshow of your images from Manage or View mode at anytime by clicking Tools | Slideshow
(keyboard shortcut CTRL+S in Manage mode). With ACDSee, you can also create slideshows and screensavers of
your favorite photos, and send them to friends and family, or display them on your website. You can even save
your slideshow or screensaver project to edit at a later time.

To Create a Slideshow:
1. In Manage mode, click Tools | Create | Slideshow File.

2. On the Welcome page, to create a new slideshow, select the Create a new slideshow radio button. To
specify what type of slideshow you want to create, select one of the following options:
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* Standalone slideshow: Creates a single executable file (.exe) containing all of your images and
everything needed to view them. You can share this type of file with anyone who has a computer,
even if they do not own ACDSee.

* Windows screensaver: Creates a standard Windows screensaver file (.scr) that can be stored
and used on any Windows system.

* Adobe Flash Player® slideshow: Creates a compact Adobe Flash file (.swf) that you can
display on a Web site.

3. To edit an existing slideshow or screensaver project, select the Load an existing slideshow project
radio button, and then click Browse to locate your project (.asw file).

4. Click Next to continue.

5. On the Choose your images page, you can view the images included in your slideshow, in the default order
they will be displayed. Click Add or Remove to change the images, and use the arrow buttons to reorder
them. Click Next when you are ready to continue.

6. On the Set file specific options page, click the underlined words beside each thumbnail to set the
individual options for each image. These include transitions between photos, the duration of the transition
and slide, text captions, and audio files to play when the image is displayed. Note that the options
available depend on your choice of output file format, and not all formats support all options. Click Next
when you are ready to continue.

7. On the Set slideshow options page, set the timing for each slide to automatic or manual, the order to
display slides, and whether or not to hide the controls. You can also add audio files to play in the
background, and adjust the quality, or speed, of the transitions. Click Next when you are ready to
continue.

8. On the following pages, set the options for image size, location of your slideshow file and the project file.

9. Finally, click Next, and wait a few moments while ACDSee generates your slideshow. When complete, you
can launch your slideshow and exit the wizard.

If you assign an audio file to an individual image, as well as to the whole slideshow on the Set slideshow
=£ | options page, then both audio files will play simultaneously when that slide displays.

Creating a Desktop Slideshow

You can use ACDSee Showroom to create a slideshow of your photos and display that slideshow in a small window
on your computer desktop. You can run up to 16 different slideshows on your computer at once.

You can configure the ACDSee Showroom window to always stay on top of other application windows. You can also
configure it to open when you start your computer. You do not have to open ACDSee to use ACDSee Showroom.

To Create a Desktop Slideshow with ACDSee Showroom:
1. In Manage mode, navigate to a folder containing images that you want to add to the desktop slideshow.
2. Do one of the following:
* Click Tools | Create | ACDSee Showroom.
* Click Start | Programs | ACD Systems | ACDSee Showroom.

The slideshow starts immediately and the ACDSee Showroom icon appears in the taskbar.

Using the ACDSee Showroom Slideshow Controls

There are a number of slideshow controls in the ACDSee Showroom window.
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* Click the Back or Forward buttons to display the previous or next photos in the slideshow.

* Click the Pause button to pause the slideshow while a particular photo is displayed.

If you cannot see these slideshow controls in the ACDSee Showroom window, click anywhere in the
=£ | window. The controls disappear while the slideshow is playing so you can fully enjoy your photos.

To Create More Than One ACDSee Showroom:

With ACDSee Showroom open, do one of the following:
* Right-click in the ACDSee Showroom window and select New Showroom.

* Click the ACDSee Showroom icon in the taskbar and select New Showroom.

To Close ACDSee Showroom:

Do one of the following:
* Click Close in the ACDSee Showroom window.

* Click the ACDSee Showroom icon in the taskbar and select Exit ACDSee Showroom.

If you have configured ACDSee Showroom to open when you start your computer, it will automatically
= open the next time you start your computer.

Creating a PDF

You can use ACDSee to combine your images into PDF (portable document format) files. The Create PDF wizard will
guide you through the process of creating one or more PDF files from your images, or adding images to a PDF
slideshow.

To Create a PDF:
1. In Manage mode, in the File List pane, select the images you want to share.
2. Click Tools | Create | PDF.
3. On the Welcome page of the Create PDF wizard, select one of the following options, and then click Next:

* Create a PDF slideshow: Combines all of your images into a single PDF file that you can view as
a slideshow.

+* Create one PDF file containing all images: Combines all of the selected images into a single
PDF file with multiple pages.

* Create one PDF file for each image: Converts each image into a separate PDF file.

4. On the Choose images page, you can change the selected images, and use the arrow buttons to reorder
them. Click Next to continue.

5. Do one of the following:

* If you selected to create a PDF slideshow, set or change the transition options by clicking the
hyperlink next to each image. Click Next to set the order, color, and file name options for your
slideshow. Click Next when you are ready to continue.

* If you selected to create one or more PDF files, specify a file name and location, and then click
Next.

6. Click Finish to close the wizard and return to ACDSee.
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Creating a PowerPoint Presentation

You can create a PowerPoint presentation quickly from inside ACDSee using the Create PPT wizard. The wizard
walks you through the process of creating or editing a presentation using your photos. You can set slide duration,
the location of the file, number of images per slide and whether or not to use a design template as a background.
You can also add captions, a title, or notes to each slide.

fThis feature only works if you have Microsoft PowerPoint® installed on your computer. The feature does
=*_ I not support RAW files, so you will need to convert RAW files to another format.

To Create a PowerPoint Presentation:

1. In Manage mode, in the File List pane, select the images you want to share.

2. Click Tools | Create | PPT.

3. On the Choose images page of the Create PPT wizard, click Add if you want to add more images.
4. Click Next.

5. On the Presentation Options page, do one or all of the following:

* In the Presentation Options area, if this is a new presentation, set the duration that you want
each slide to display.

* If you are editing a presentation, select Existing presentation to activate the Path field, and
browse to your presentation. Select whether you want to Insert slides at the beginning or end of
the presentation.

* Select the Number of images per slide from the drop-down list. (If you select more than one,
the Title and Notes options on the next page do not appear.)

* Select Link to Image file if you want your images to stay linked to ACDSee rather than be
embedded in the presentation.

* Click Use a design template if you want to use a background template and browse to the folder
on your computer to select it. (PowerPoint templates are usually under Microsoft Office |
Templates | Presentation Designs.)

6. Click Next.

7. On the Text Options page, do one or all of the following:

* On the Caption tab, type in a caption and select its background color and alignment. You can also
select a different font, or insert metadata like file name or picture dimensions. Captions appear at
the bottom of the slide.

* On the Title tab, type in a title for the slide and select its background color and alignment. You
can also select a different font, or insert metadata.

* On the Notes tab, type in any notes that you want to appear in the Notes section attached to each
slide. These notes do not appear on the slide itself.

8. Click Create.

The presentation opens in PowerPoint where you can edit it like any other presentation.

Creating an HTML Album

You can use the HTML Album wizard to prepare photo collections for posting on the Internet. The HTML album
includes slideshow controls and a thumbnail display. You can select from a list of gallery style templates and then
customize the gallery by adding your own logo as an image or text to the header or footer. You can also change the
fonts and colors used in the gallery.
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To Create an HTML Album:
1. In Manage mode, in the File List pane, select the images you want to share.
2. Click Tools | Create | HTML Album.

3. On the Style Settings page of the Create HTML Album wizard, select a Gallery Style from the Web page
styles box.

A selections affect the appearance of your HTML album. You can also generate your HTML album from any

i ) After you select a Gallery Style and other settings, you can click Preview Gallery to see how those
I
page in the HTML Album wizard by clicking Generate Album.

4. Click Next.
5. On the Gallery Customization page, do one or all of the following:
* In the Gallery Title text box, type the title that you want to display at the top of the Web page.

* Select Include header to display a header at the top of the Web page, or clear the Include
header checkbox to remove the header.

* Select Include footer to display a footer at the bottom of the Web page, or clear the Include
footer checkbox to remove the footer.

+ If you want to display an image in the header or footer, select Use image and click Browse and
select a company logo, a photo of yourself, or another image to display in the header.

* If you want to display text in the header or footer, select Use information and click Set
Information and add enter the text that you would like to display.

* In the Folder settings section, click Browse and select the folder where you would like to save
the HTML album files.

6. Click Next.
7. On the Thumbnail and Image page, do one or all of the following:

* In the Thumbnail settings section, adjust the appearance and format of the thumbnails in the
album.

* In the Image settings section, adjust the appearance and format of full size images in the
album.

* In the Slideshow duration section, specify how long to display full size images during a
slideshow.

* In the Color and font settings section, click Color and font, adjust the colors and fonts used
in the Web page, and then click OK.

k settings, you can quickly reapply them to a Web page style from the Style Settings page of the Create

/ ) Click Save Settings to save the settings that you select for specific Web page styles. If you save the
I
HTML Album wizard.

8. Click Next to create your HTML album. You may need to wait a few moments while ACDSee generates the
thumbnails and creates the Web page.

9. Click Create Another Album to create another album, or click Finish to exit the wizard and return to
ACDSee.

You will need to use FTP or another method to post the HTML album files to your Web site.
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Creating a Contact Sheet

You can create contact sheets—thumbnail previews of your images arranged on pages — that you can use to
organize and share your images. You can use the Create Contact Sheet utility to save your contact sheets in
multiple image formats, and as HTML image maps. You can save your options as a preset for future use.

The size of the thumbnails depends on how many columns and rows the contact sheet displays, and how much

space is displayed between them.

To Create a Contact Sheet:

1. In Manage mode, in the File List pane, select the images you want to include.

Click Tools | Create | Contact Sheet.

In the Contact sheet format area, set the Contact sheet format options.

If desired, add or change the text on the page.

Click OK.

2
3
4. In the Output Settings area, set the Output Settings options.
5
6

If you do not specify an output file path, the Create Contact Sheet utility places a file named Contact
= | Sheet.<ext> in your default image folder. For multiple-page contact sheets, the utility adds a number to
the file name; for example, Contact Sheet3.bmp.

Contact Sheet Format Options

Thumbnail settings Size

Spacing

Frame options Use thumbnail frame

Margin
Solid color

Tiled image
Thumbnail options Colored drop shadow
Colored edge fade
Colored matte
Beveled edges
Solid color

Page background options

Tiled image
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Specifies the number of columns and rows to create
on each page.

Creates a frame around each thumbnail. Specifies the
amount of space between rows or columns. In the
Horizontal and Vertical spin boxes, type a value to
indicate the amount of space to display.

Creates a frame around each thumbnail.
Specifies the width of the frame.

Specifies the frame's color. Click the color picker to
define a color.

Specifies an image to use as a frame. Click Browse to
locate the image you want to use.

Creates a drop shadow effect around each thumbnail.
Click the color picker to define a color.

Creates a fading frame effect around the image. Click
the color picker to define a color.

Uses a solid color as a background for the page. Click
the color picker to define a color.

Creates a beveled edge effect on each thumbnail. This
effect is not displayed in the Preview window.

Uses a solid color as a background for the page. Click
the color picker to define a color.

Uses a tiled image as the background for the page.
Click Browse to locate the picture you want to use.
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Creating Archives of Your Files

You can use the Archive Creator plug-in to create archives of your images and media files. Archive Creator
supports multiple archive formats, and helps you manage your files using compression, encryption, and password
protection tools.

To Create an Archive:

1.
2.

5.
6.

7.

In Manage mode, in the File List pane, select a folder or group of files.
Click Tools | Create | Archive.

In the Create Archive dialog box, in the Options area, click the Archive Type drop-down list and select the
archive format you want to create.

Some archive formats have additional settings that you can adjust by clicking the Settings button.

Do any of the following:
* Toinclude the contents of any subfolders you selected, select the Include subfolders checkbox.
* Toinclude any hidden files in your archive, select the Include hidden files checkbox.

* Toremove the selected files and folders from your hard drive once they have been added to the
archive, select the Delete files after archiving checkbox.

* To protect the contents of your archive with a password, select the Password Protect Archive
checkbox, and type a password into the field beside it. Note that not all archive types support
passwords, and some formats require them.

Type a path and file name into the Output File field, or click Browse to locate a folder on your hard drive.
Select one of the following:

* Add to existing archive: Adds your files to an existing archive. This option is only available if
the archive specified in the Output File field already exists.

* Overwrite existing archive: Replaces any existing archive with the archive you are creating.
This option is only available if the archive specified in the Output File field already exists.

When you are satisfied with your choices, click Create to begin archiving your files.

Extracting Archived (.zip) Files

You can extract archived (.zip) files very quickly and easily without leaving ACDSee. You can either extract the
files to a folder or simply double-click and view them.

To Extract an Archived File to a Folder:

1.

a A W N

In Manage mode, navigate to the folder containing the archived file, using the Folders pane.

Click the archived file in the File List.

Click Edit | Extract to Folder.

In the Extract to Folder dialog, navigate to, and select the folder where you want to keep the files.
To create a new folder, click Create Folder, type in the name of the folder and then press Enter.

Use the Overwriting duplicate files drop-down list if you want to specify what do so with files in the
folder that have the same name as those you are extracting. You can select any of the following:

* Ask: To be asked what to do about each individual file.

* Rename: Duplicates are given a new name.
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* Replace: Duplicate files are overwritten.
* Skip: No duplicates are extracted.

7. Click OK.

To View Files Inside an Archived File:
1. In Manage mode, navigate to the folder containing the archived file.
2. Double-click the archived file.

Thumbnails of the contents of the archived file open in the File List pane.

Printing Images

With the ACDSee print utility, you can print your images on any size of paper, in any orientation, and at any
resolution your printer can support. You can also use the print utility to create and print contact sheets, complete
with headers, footers, and captions specific to each image.

As you change the options in the Print dialog box, you can view a dynamically updated preview of the image and its
position on the page. You can adjust the output size, print multiple copies of each image, and change the
orientation of the images on each page.

To Print Your Images:
1. Select the image or images you want to print.
2. Do one of the following:
* In Manage mode, click File | Print.

* In View mode, click File | Print All Images. (If you want to print a single image in View mode,
select Print Image.)

3. Under Print layout, do one of the following:
* Select Full page and then choose a print size from the Format list.

* Select Contact sheet and then set the Contact sheet format options to define the appearance
of your contact sheet.

* Select Layout and then choose one of the available layout options.

4. On the Printer Options tab, specify the printer you want to use, the paper size, the orientation, the
number of copies you want, the range of pages that you want to print, and image resolution.

5. On the Page Settings tab, specify the image position on the paper and the margin widths.

6. On the Adjustments tab, specify any adjustments you want to apply.

7. Specify the number of prints of each photo. If you are printing a Full page or a Contact sheet this option
is available on the Page Settings tab. If you are printing a Layout this option is available below the list of
layouts.

8. Add captions, headers, or footers. You can only add captions, headers, or footers if you are printing a Full
page or a Contact sheet.

9. Click Print.

Setting Printer Options

When printing your images with ACDSee, you can specify which printer you want to use, and set the printer
options on the Printer Options tab in the Print dialog box.
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Printer Options

Printer Specifies the printer you want to use. Select a printer from the drop-down list and click the
Properties button to set its options. Refer to the printer manufacturer's Help file or manual for
more information.

Paper size Specifies the size of the paper, e.g. Letter, Legal, A4.
Orientation Specifies Portrait or Landscape page orientation.
Copies Specifies the number of copies you want to print.

Print range Select one of the following options:
* All: Prints all of the pages in the document.

* Pages from: Prints a range of pages. Specify the first and last pages of the range in
the fields.

Resolution Specifies a resolution in pixels-per-inch (PPI) for the image. The higher the value, the more
dots per inch, and the higher the resolution of the printed image. For example, 600 PPI is
360,000 (600 x 600) pixels per square inch.

Filter Specifies the resampling filter to use when printing images. Click the drop-down list and
select one of the following:

* Box: Displays considerable tiling or jaggies when you resize an image.

* Triangle: Produces good results for image reduction and enlargement, but displays
sharp transition lines.

* Bicubic: Produces good results with photo-realistic images and with images that are
irregular or complex. Uses interpolation to minimize the raggedness normally
associated with image expansion.

* Bell: Smoothes the image.
* B-Spline: Produces smooth transitions, but may cause excessive blurring.

* Lanczos: Produces the sharpest images, but may also introduce some ringing
artifacts.

* Mitchell: Produces smooth transitions when enlarging photo-realistic images. This
filter is good compromise between the ringing effect of Lanczos and the blurring effect
of other filters.

Gamma Applies gamma correction to the printed images. Type a number from 0.10 to 3.00 in the
Gamma value field to adjust the gamma of the image. Higher values make the image appear
brighter, while lower values make the image appear darker.

Use EXIF Your camera may capture EXIF information that, when shared with your printer, will optimize
2.2 printing printing results. Select this option if your camera and printer support EXIF 2.2 printing.
when

available

Creating Custom Print Layouts

You can create your own custom print layouts and store them as print options.

To Create a Custom Print Format:
1. In the Print dialog box, select Full page.
2. Inthe Print format area, click Add.

3. Inthe Add Custom Format dialog box, select a measurement unit from the Measurement units drop-
down list.
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4. Enter the dimensions for the new format in the Format width and Format height fields.

5. Click Add.

Setting Image Size and Positioning

You can use the Page Settings tab in the Print dialog box to adjust and control the size of the images you are
printing, and the positioning of images on each page.

Page Settings Options

Page position Specifies where to place the image on each page.

Margins Specifies the size of the margins. Type a value or click the arrows in the Top,
Bottom, Left, and Right spin boxes.

Number of prints Specifies how many copies of each image to print. The print utility adds pages as
required.

Automatically Specifies whether you want the print utility to determine automatically which

rotate picture based orientation to use for each image. If you select the checkbox, the print utility changes

on print format each page's orientation to best suit the image you are printing.

Maintain aspect Specifies whether you want the print utility to maintain the original image's aspect

ratio

ratio. Select one of the following options to indicate how the print utility should handle
the aspect ratio for oversized images:

* Crop image to fit print format: Prints only the part of the image that fits
within the print format.

Shrink image to fit print format: Prints the entire image, reduced to fit
inside the print format.

Setting Print Adjustments

You can use the settings on the Adjustments tab of the Print dialog to compensate for quirks specific to your
printer, such as the way your printer handles exposure.

!

It is recommended that you adjust these settings only after printing initially, when you know what
corrections your printer may require.

Please note that any adjustments made on the Adjustments tab will not be reflected in the Preview
window.

To Apply Adjustments to Images Prior to Printing:

1.
2.

Select the image or images you want to print.
Do one of the following:

* In Manage mode, click File | Print.

* In View mode, click File | Print Image or File | Print All Images.

In the Print dialog, on the Adjustments tab, adjust the Exposure, Contrast, or Sharpness sliders as
desired.

Click Print.
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Adding Text to Pages

You can add headers and footers to pages, and captions beneath your images.

To Add Captions to Your Printed Images:
1. Inthe Print dialog box, click the Caption tab.
Select Use caption text.
Click Font to open the Font dialog box and set the font options.
In the text box, type the text you want the caption to display.
Click Insert Metadata to insert file-specific information into the caption for each image.

In the Text alignment drop-down list, select the caption positioning.

N o b~ W N

To set the maximum number of text lines for each caption to display, select the Number of lines
checkbox, and then specify a number in the field.

To Add Headers and Footers to Your Printed Pages:
1. Do one of the following:
* Click the Header tab and select Use header text.
* Click the Footer tab and select Use footer text.
2. Click Font to open the Font dialog box and set the font options.
3. In the text box, type the text you want the header or footer to display.

4. Toinsert the current page number or the total number of pages into the text, click Insert Page Number,
and then select an option from the menu.

5. Inthe Text alignment drop-down list, select the header or footer positioning.

6. Tosetamaximum number of text lines, select the Number of lines checkbox, and then specify a number
in the field.

Setting Contact Sheet Printing Options

The Contact sheet format area of the print utility contains settings you can adjust to control the appearance,
layout, and size of your thumbnails. If you saved your format options as a preset you can select the preset.

Contact Sheet Format Options
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Thumbnail Size

settings
Spacing

Frame options Use thumbnail frame
Margin
Solid color

Tiled image
Thumbnail options Colored drop shadow
Colored edge fade
Colored matte
Beveled edges
Page background Solid color

options

Tiled image

About Batch Editing

Specifies the number of columns and rows to create on each
page.

Specifies the amount of space between rows or columns. In
the Horizontal and Vertical spin boxes, type a number to
indicate the amount of space to display.

Creates a frame around each thumbnail.
Specifies the width of the frame.

Specifies the frame's color. Click the color picker to define a
color.

Specifies an image to use as a frame. Click Browse to locate
the image you want to use.

Creates a drop shadow effect around each thumbnail. Click
the color picker to define a color.

Creates a fading frame effect around the image. Click the
color picker to define a color.

Creates a matte effect around each thumbnail. Click the color
picker to define a color.

Creates a beveled edge effect on each thumbnail. This effect
is not displayed in the Preview window.

Prints a solid color as a background for the page. Click the
color picker to define a color.

Prints a tiled image as the background for the page. Click
Browse to locate the image you want to use.

In ACDSee you can make one type of edit to many images. For example, if you need to resize multiple images you
can use the Batch Resize tool. Or, if you need to rotate multiple photos by 90 degrees you can use the Batch

Rotate/Flip tool.

You can speed up the batch editing workflow by tagging your files. For example, you can quickly tag the files you

want to change, then click Tagged in the Catalog pane to display all the tagged files in the File List pane. Then you

can select the files and choose a batch tool.

Converting Multiple Images to Another File Format

You can convert multiple images to any supported file format. You can set the options for each format individually,

specify how to handle multiple-page images, and apply the conversion defaults automatically. The Convert File

Format wizard guides you through the process.

To Convert an Image to Another File Format:

1. Do one of the following:

* In Manage mode, select one or more images, and then click Tools | Batch | Convert File

Format.

* In View mode, click Tools | Modify | Convert File Format.

2. On the Select a format page, select a new format for your image or images from the list displayed on the

Format tab.

3. Select the Advanced Options tab to change the settings for this wizard.

4. Click Next to continue.
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On the Set output options page, identify where you want to place the converted images, and specify how
you want the wizard to handle any file name conflicts by selecting one of the following options from the
Overwrite existing files drop-down list:

* Ask: Prompts you when overwriting a file.
* Skip: Cancels the operation if there is a file with the same file name and extension.
* Replace: Overwrites the file without prompting for confirmation.
* Rename: Prompts you to rename the file.
Click Next to continue.

On the Set multiple page options page, you can specify how you want to handle any multiple-page images
you are converting.

If you did not select any multiple-page images to convert, and did not specify a multiple-page image
format as your output file format, you can skip the options on this page.

When you are satisfied with your choices, click Start Convert, and wait a few seconds while the wizard
converts your images.

Rotating or Flipping Multiple Images

You can rotate or flip multiple images at preset angles.

To Rotate or Flip an Image:

1.
2.

5.

In Manage mode, select one or more images, and then click Tools | Batch | Rotate/Flip.

In the Batch Rotate/Flip Images dialog box, select the angle of rotation you want to apply. See below for an
explanation of each angle.

If you select an image with multiple pages and want to apply the selected angle of rotation to all of the
pages, select the Apply to all pages of the current image checkbox.

Do one of the following:

* Click Next Image to move on to the next selected image. The Next Image button is not available
if the Apply to all selected images box is checked.

* If you select multiple images and you want to apply the same angle of rotation to all of them, select
the Apply to all selected images checkbox.

* Click Options to specify how you want to save and store the images.

When you are ready to apply the rotations to your images, click Start Rotate.

Rotate / Flip Angles
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1 Rotates the image counter-clockwise 90 degrees.
€
2 Rotates the image 180 degrees.
P
3 Rotates the image clockwise 90 degrees.
o ¥
4ty Rotates the image according to any EXIF data contained within the image. (Does not affect images

without EXIF information.)

&
= Flips the image along the vertical axis.

& Flips the image along the horizontal axis.

ny,

—

T Flips the image along the vertical axis, and then rotates it counter-clockwise 90 degrees.

Flips the image along the vertical axis, and then rotates it clockwise 90 degrees.

,_/ You can also use the Rotate tool in Edit mode to rotate an image using a custom angle of rotation.

Setting Rotated and Flipped File Options

You can change the settings in the Batch Image Rotate/Flip Options dialog box to control where ACDSee places
modified images, how to handle file duplication conflicts, and specify whether you want to preserve the last-
modified date of the file when you use the Batch Rotate/Flip Images tool.

To Set the Rotate and Flip Options:
1. In Manage mode, select one or more images, and then click Tools | Batch | Rotate/Flip.
2. In the Batch Rotate/Flip Images dialog box, click the Options button.
3. Setthe options as described below.

4. Click OK.

Rotate and Flip Options
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Force lossless JPEG Rotates JPEG images without decompressing and re-compressing the JPEG
operations information. As a result, the image does not lose quality when rotated or flipped.
File options Specifies where to place the new images. Select one of the following options:

* Remove/replace original files: Overwrites the original file with the new
image.

* Rename modified images and place in source folder: Adds identifying
labels to the image names and places them in the same folder as the
originals.

* Place modified images in the following folder: Places the converted
image in a folder that you can specify. Click the Browse button and select a

folder.
Overwrite existing Determines how ACDSee should handle overwriting files. Select one of the following
files options from the drop-down list:

* Ask: Prompts you when overwriting a file.

* Skip: Cancels the operation if there is a file with the same file name and
extension.

* Replace: Overwrites the file.

* Rename: Prompts you to rename the file.

Preserve last- Retains the date and time properties of the file.
modified dates

Remember and apply Automatically applies the same settings the next time you rotate an image.
the last rotation
performed

Auto-close progress Automatically closes the dialog box after all images have been adjusted.

dialog if all
operations succeed

Save current settings Stores the current settings and applies them the next time you use the Rotate/Flip
as default Images wizard.

Resizing Multiple Images

You can resize a group of images by specifying their dimensions in pixels, specifying a percentage of their original
size, or by constraining them to a physical print size.

To Resize a Group of Images:
1. In Manage mode, select one or more images, and then click Tools | Batch | Resize.

2. In the Batch Resize Images dialog box, select one of the following options:
* Percentage of original: Resizes the images to a percentage of their original size.
* Size in pixels: Resizes the images to a specific size in pixels.
* Actual/Print size: Resizes the images to specific printed dimensions.

3. Set the options for your selection as explained in the table below.

4. Click Options to specify how you want to save and store the images.

5. When you are satisfied with your choices, click Start Resize.

fYou can also resize an image, and use alternate resampling filters, in Edit mode.
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Resize Options

Percentage of Percentage Specifies how to resize the images. Enter a percentage less than
original 100 to reduce the images, and greater than 100 to enlarge
them.
Apply to Specifies whether the resize is applied to the height, width, or
both.
Size in pixels Width Specifies the new width for the images in pixels.
Height Specifies the new height for the images in pixels.
Resize Specifies how to scale the images. Select one of the following

Actual /Print
size

Preserve original
aspect ratio

Fit within

Units
Width
Height
Resolution

Preserve original
aspect ratio

Fit within

options:

* Enlarge only: Resizes only those images that are
smaller than the specified height and width.

* Reduce only: Resizes only those images that are larger
than the specified height and width.

* Enlarge or reduce: Resizes all images to the specified
height and width.

Retains the width-to-height ratio of the original images.

Specifies whether the aspect ratio is maintained based on the
specified width. For more information about how the different
combinations affect the images, see Pixel resize options and
resulting action.

Specifies the units of measurement.
Specifies the new width for the images.
Specifies the new height for the images.
Specifies the print resolution for the images.

Retains the width-to-height ratio of the original images.

Specifies whether the aspect ratio is maintained based on the
specified width. For more information about how the different
combinations affect the images, see Pixel resize options and

resulting action.

Adjusting Exposure For Multiple Images

In ACDSee, you can lighten or darken the colors of an image or a group of images with the Batch Adjust Exposure
wizard. You can adjust each image individually and preview the changes before applying, or make adjustments to
an image and automatically apply the same changes to all of the images you selected.

You can also save your settings as a preset for future use.

To Adjust Image Exposure:
1. In Manage mode, select one or more images, and then click Tools | Batch | Adjust Exposure.
2. In the Batch Adjust Exposure dialog box, do one or more of the following:

* To adjust image exposure, contrast, and fill light level, select the Exposure tab and adjust the
options.

* To precisely adjust the contrast and light levels in your images, select the Levels tab and set the
options.
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-

-

To adjust image exposure automatically, select the Auto Levels tab and set the options.

To precisely adjust the RGB color channels in your image, select the Tone Curves tab and set the

options.

3. Do one of the following:

-

Select the Apply settings to all selected images checkbox to apply the current settings to all

of the images you selected.

De-select Apply settings to all selected images and click Next Image to move to the next

image, and then repeat step 2 for each image you want to adjust.

4. Click Options to specify how you want to save and store the images.

5. Click Filter All Images.

J,-You can also adjust your image's exposure and color levels in Edit mode.

Adjusting Batch Exposure Options

You can use the options in the Batch Adjust Exposure dialog to correct the exposure of your images. There are four
tabs in the Exposure section: Exposure, Levels, Auto Levels, and Tone Curves.

To Use the Exposure Options:

In the Batch Adjust Exposure dialog box, use the following options:

Exposure Options

Exposure
Auto

Contrast

Fill Light

Levels Options
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Specifies the amount of light to add to all areas of the image.
Automatically corrects the exposure based upon the brightness of the image.

Specifies the amount of difference between color and brightness in an image. Moving the

slider to the right darkens the shadowed areas in an image, while moving the slider to the
left brightens them.

Specifies the amount of light to add to the darkest areas of the image.
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Channel Specifies the brightness or color channel you want to adjust.
Shadows Specifies the black point of an image.

Move the slider or type a number from 0 to 255 into the spin box to define the blackest
area of an image. As the value increases, the dark colored areas of the image become
darker.

Midtones Specifies the gamma correction in an image.

Move the slider or type a number from 0.00 to 2.00 into the spin box to set the amount of
gamma correction. Higher values make the image appear brighter, while lower values
make the image appear darker.

Highlights Specifies the white point of an image.

Move the slider or type a number from 0 to 255 into the spin box to define the whitest
area of an image. As the value increases, the light colored areas of the image become

lighter.
Clipped % Indicates how much of the image detail is lost due to black point and white point
correction.
Black Point Click the button with the black eyedropper icon to adjust the black point. Select the area
Eyedropper in the Before image that you want to set as the black point for the After image.
Mid Point Click the button with the gray eyedropper icon to adjust the gamma correction value.
Eyedropper Select the area in the Before image that you want to set as the gamma correction value.
White Point Click the button with the white eyedropper icon to adjust the white point. Select the area
Eyedropper in the Before image that you want to set as the white point for the After image.

Auto Levels Options

Strength Adjusts the amount of exposure applied to the image.

Auto Contrast Adjusts color differences, brightness, and image color channels.
and Color

Auto Contrast Adjusts the color differences and brightness only.

Auto Color Balances color within the whole image.

Tone Curves Options

Channel Specifies the color channels to adjust.
Show Histogram Toggles the histogram display.

Histogram Displays a visual representation of the color information levels in the image, based on the
selected channel. Click and drag the line to manipulate the curve.

Renaming Multiple Files

You can use the Batch Rename tool to rename multiple files. You can specify a template with a numerical or
alphabetical sequence, save your template for future use, replace specific characters or phrases, and insert file-
specific information into each new file name.

To Rename a Group of Files:
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1. In Manage mode, select one or more files, and then click Tools | Batch | Rename.
2. In the Batch Rename dialog box, do one or more of the following:
* Select the Template tab to specify the Template options.
* Select the Search and Replace tab to set the Search and Replace options.
* Select the Advanced Options tab to adjust the settings for the Batch Rename tool.
* Review your changes to the file names in the Preview field.

3. Click Start Rename.

fYou cannot rename any file on a read-only file system, such as a CD-ROM.

Batch Rename Options
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Template Select the Use Template to rename files checkbox to create a renaming template. You can
specify a numerical or alphabetical sequence for the new file names, and use the original file
names, new names, or names based on image metadata.

Template Displays the template to use to rename the files.

Type an asterisk (*) to insert the original file name into the template.
Use one or more number signs (#) to insert numeric or alphabetic
characters, depending which options you selected.

Click the arrow on the drop-down list to select a recently-used template.

Clear Templates Clears the recently-used templates from the Templates drop-down list.
Use numbers to Replaces any number signs (#) in the template with sequential numeric
replace #'s characters.

Use letters to Replaces any number signs (#) in the template name with sequential
replace #'s alphabetic characters.

Start at Specifies the first letter or number of the sequence.

Insert Metadata Inserts file-specific information into the file name template.

Position the cursor in the Template field, and then click Insert
Metadata to open the Choose Property dialog box. Select the metadata
you want to insert, and then click OK.

File name case Specifies upper or lower case for file names and file format extensions.

Search and Select the Use Search and Replace to rename files checkbox to replace certain letters or
Replace words in the file names. You can replace spaces with underscores, or change upper case letters
to lower case, and combine your changes with any naming template.

Search for Identifies the characters you want to replace in the file names.
Replace with Identifies the characters to use in place of the original text.
Case sensitive Indicates whether you want to limit the search to the same case you

typed in the Search for field.

Advanced Select any of the Advanced Options to adjust the behavior of the Batch Rename tool.
Options

Automatically Closes the Batch Rename dialog box when the renaming process is
close wizard when complete.

finished

Save current Stores the current settings and loads them the next time you rename
settings as files.

defaults

Warn about Provides a warning if you have changed the file extension as part of the
extension changes template.

Automatically Automatically resolves any naming conflicts by adding an underscore
resolve naming and a sequential number to the end of each file name.

conflicts

About the ACDSee Database

The ACDSee database stores image and media file information automatically when you browse your folders. This
process is called cataloging. The database increases the speed with which you can browse your computer, and
you can use the information stored in the database to sort, organize, search, and filter your images and media
files. You can also backup, restore, and share database information.

You can store cached thumbnail previews, and add or edit the following information for each image or media file on
your computer:
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+ Categories

* Notes

+ Keywords

+ Color Labels
* Authors

* Dates

+ Ratings

+ Captions

You can also choose to exclude folders from the database, and keep the contents of those folders separate from
your other images and media files.

! When you add ACDSee Metadata to a file in ACDSee, the file is linked to the database. If you then copy,
move, or rename your files using programs other than ACDSee, such as Windows Explorer, the link to the
database is broken and this can cause the loss of ACDSee Metadata.

Embedding ACDSee Metadata in Files

If you edit or add ACDSee Metadata to your files, ACDSee automatically adds the new data to its database. If you
have the Display embed ACDSee metadata reminder checkbox selected in the Options dialog box, (click Tools
| Options | Database), next time you close ACDSee, the Embed ACDSee Metadata in Files dialog box opens and
offers to embed the new data into the changed files themselves. Embedding ACDSee Metadata in the files as well,
is a safe way to back up this data and make it easier to retrieve if you should need to.

For example, once you have assigned ACDSee Metadata to a file, the file is linked to the database. If the file is
moved using Windows Explorer, or any application other than ACDSee, the link will be broken. However if you have
embedded this data in the file and the link is broken, you can still retrieve the ACDSee Metadata using the
embedded data in the files.

You can use ACDSee to rename, move, or copy the file—even to another computer—and the embedded ACDSee
Metadata will transfer with the file.

To Embed ACDSee Metadata in a File When You Are Prompted:
1. Do one of the following:
* Toembed data in files that are on a network, select the Include Network Drives checkbox.

* To write the information to a sidecar file if the file format does not support embedding inside the
file, select the Write sidecar files for formats that do not support embedded XMP.

* To accept the current selection in the dialog and have these options happen automatically in
future, select Do not ask me this again.

2. Click Yes to embed the data in the files. A progress bar appears, followed by the Embed Summary Report
dialog that lists the following:

* Items Selected: Indicates the number of files that you selected.

* Items Processed: Indicates the number of files actually that were processed. (If you selected
files that did not need to have date embedded, this number may be different from the Items
Selected.)

* Succeeded: Indicates the number of files that had data embedded.

* Failed: Indicates the number of files that, for a variety of reasons, could not have data
embedded. (To see the Error Log, click View Errors.)
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3. Click Close.

To Embed ACDSee Metadata at Any Time:
You can embed data in files at any time.
Click Tools | Metadata | Embed ACDSee Metadata, and then select one of the following:

* Embed in All Files: Embeds data for all files.

* Embed in Selected Files: Embeds data for any files that you have selected.

! ACDSee uses XMP to embed ACDSee Metadata into each file. Only some file formats and file extensions
support XMP. These include GIF, JPEG, DNG, PNG, PSD, and TIF. In the case of these file formats, the
ACDSee Metadata is embedded inside the file and so you can rename or move the file outside of ACDSee
and still be able to retrieve the ACDSee Metadata. For formats that currently do not support XMP,
including RAW and ABR, the ACDSee Metadata is written to a sidecar file that is stored in the same folder
as its file. Because a sidecar file is separate from the file itself, you need to rename or move them
together, or you could lose the ACDSee Metadata permanently.

The Embed Pending Flag

In Manage mode, in the File List pane, the following overlay icon appears on top of files that have ACDSee Metadata
|

S

stored in the ACDSee database that has not yet been written to the file: "=

Right-click and choose either:

* Embed ACDSee Metadata: Writes the metadata to the file.
* Clear Embed Pending Flag: Clears this overlay icon, but does not write the metadata to the file.

Viewing Files That Have Data to Embed

If you want to see the files that have data that needs to be embedded, there is a quick way to list them using the
Embed Pending option.

To View Files That Have Data to Embed:
In the Catalog pane, under Special Items, click Embed Pending.

All the files that have data to embed are displayed in the File List.

Retrieving ACDSee Metadata That is Embedded in Files
If you simply browse to the folder where the files are located, some of the ACDSee Metadata is retrieved and

written to the database. Categories and keywords, however, are not.

The safest way to retrieve all the ACDSee Metadata, (including categories and keywords), is to click Tools |
Database | Catalog Files. Then the following applies:

* If the files are GIF, JPEG, DNG, PNG, and TIF formats, all the data will be retrieved and written to the
database.

+ If the files still have their sidecar files in the folder, and they still have the same file name, the database
information is retrieved and written to the database.

+ If the files have become separated from their sidecar files or renamed, their ACDSee Metadata cannot be
retrieved and will be lost.
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Excluding Folders From the Database

You can choose to exclude folders from the database, and keep the contents separate from your other images and
media files. By default, the Program Files and Windows folders on your hard drive are automatically excluded from
the database.

To Manage Your Excluded Folders Settings:
1. In Manage mode, click Tools | Database | Excluded Folder Settings.
2. Inthe Excluded Folders dialog box, do one of the following:

* To exclude a folder from the database, click Add. Browse to a folder on your hard drive, and then
click OK.

* Toremove a folder from the excluded folders list, select a folder in the list, and then click
Remove.

* Toreset your excluded folders list to the default settings, click Reset to Defaults.

3. When you are satisfied with your choices, click Close to return to ACDSee.

Cataloging Files in the Database

ACDSee automatically adds file information and thumbnails to the database as you browse. You can use the Catalog
dialog box to add groups of files to the database without having to first browse the folders. This can be particularly
useful when using ACDSee for the first time, and when browsing or managing large collections of images as it
reduces the loading time required for these folders.

The first time you run ACDSee, you are prompted to catalog your files.

To Catalog Your Files:
1. In Manage mode, click Tools | Database | Catalog Files.
2. In the Folders to Catalog section, select the checkbox next to the folders you want to catalog.

If you want to add folders that are not in the list, click Add folder, select the folders you want to include,
and then click OK.

3. In the Options section, select the information to add to the database.
4. Click Start.
A progress bar shows your files as they are cataloged.

5. Click Finish.

Y If you are cataloging a large collection of files, do not disrupt the process, or use other software while it is
running. For large file collections, it is best to run cataloging overnight.

About the ACDSee Indexer

The ACDSee database stores image and media file information automatically when you browse your folders. This
process is called cataloging. The database increases the speed with which you can browse your files in ACDSee,
and you can use the information stored in the database to sort, organize, search, and filter your image and media
files. You can also use the Catalog dialog box to add groups of files to the database without having to first browse
the folders, though, during this time, you will not be able to use ACDSee.

However, the ACDSee Indexer allows the cataloging process to be undertaken when your computer is idle and
ACDSee is not running. This allows you to avoid having to browse all of your folders, or experiencing disruptions to
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your computer's speed and usability, or cutting into the time that you are using ACDSee. If the files are modified in
any of the selected folders, the ACDSee Indexer will automatically catalog them again to keep the ACDSee database
up to date.

You can set which folders you would like to be cataloged and how long you would like your computer to be idle
before the ACDSee Indexer begins to catalog your files. To configure these options, see Setting the ACDSee
Indexer Options.

Creating and Switching Between Multiple Databases

ACDSee allows you to create multiple databases and switch between them at any time, giving you complete
organizational control over your file collections.

When you open ACDSee for the first time, (and up until you create additional databases), you will be using the
original database called Default.dbin. It is located in: C:\Users\<Your Name>\AppData\Local\ACD
Systems\Catalogs\<Version # >. All additional databases that you create will be stored in this same location,
unless you specify otherwise.

h application.

i ) You can configure ACDSee to display the database it is currently running in the title bar of the
I

To Create a New Database:
1. In Manage mode, open File | Database | New...
2. Inthe New Database dialog box, enter a name for your new database.

3. Browse to choose the location where the database will be stored, or leave it set to the existing location to
store the new database with your existing database, Default.dbin.

1. Thedatabase file will be stored with a folder of the same name. The database file and folder must
always share exactly the same name, or ACDSee will not be able to connect to the database.

4. If you would like to have the name of your database displayed in the title bar of the application, select the
Show database filename in title bar checkbox.

5. Click OK.

6. Adialog will appear asking you if you would like to switch to your newly created database. Select Yes or
No. If you select Yes, ACDSee will restart and run with the new database.

To Switch from One Database to Another:

In Manage mode, do one of the following:

Open File | Database | In the Open Database dialog, browse to the database file (*.dbin) you want to use
Open... and click Open.

Open File | Database | Select one of your recently used databases.

Recent.

To Quickly Launch ACDSee in a Specific Database Using Command Line Switch:

1. Create a shortcut to ACDSee. It is recommended that you name this shortcut something that corresponds
to the name of the database you want to open.

2. Inthe shortcut properties, set the target to C:\Program Files\ACD Systems\ACDSee\<Version
#>\ACDSee<Version #>.exe" /db "C:\Users\<Your Name>\AppData\Local\ACD
Systems\Catalogs\<Version #>\<Name of Your Database>.dbin".
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Converting an Older Database

You can use the ACD Database Convert wizard to take database information from previous versions of ACDSee and
add it to your current database. This ensures that any information associated with your files using a previous
version of ACDSee is referenced properly in the current database.

! If you have already added information to your current ACDSee database, it is recommended that you
create a backup of your database before converting an older ACDSee database.

To Convert an Older Database:
1. In Manage mode, click Tools | Database | Convert Database.
2. On the Welcome page, click Next to select your conversion options.

3. On the Database Convert Options page, specify the version of the database files you want to convert, as
well as the folder where the database files are located on your hard drive. Click Next.

4. Toautomatically rebuild image thumbnails, IPTC and EXIF information after the conversion process is
complete, select the Rebuild thumbnails, EXIF and IPTC data for local images checkbox.

5. To automatically update your database after converting, select the Optimize database files after
convert checkbox.

6. Click Next.

7. On the Summary page, review your selections, and then click Next to convert your database.

Importing Database Information

You can use the ACD Database Import wizard to import archived database information, or to import database
information that was sent to you with images from another ACDSee user. After you import the information, ACDSee
associates it with the appropriate images.

! If you have already added information to your current ACDSee database, it is recommended that you
create a backup of your database before converting an older ACDSee database.

To Use the ACD Database Import Wizard:
1. In Manage mode, click Tools | Database | Import, and then select Database.
2. Click Next to start the wizard.
3. On the Import Options page, select the type of exported database information you want to import.

You can import image information from a compressed database version, or information from an XML-
based text file.

4. Click the Browse button to locate the database you want to import, and then click OK.

5. Select the Optimize database files after import checkbox to optimize the database after exiting the
wizard, and then click Next.

6. On the Summary page, review your selections. Click Back to make changes, or click Next to begin
importing the database information.

7. Click Finish to close the ACD Database Import wizard.

1. If you areimporting database information sent to you by another ACDSee user, ensure that the images to
which the information applies are in an identical location and folder structure on your hard drive.
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Importing File Information from Other Sources

You can import file information into your database from other sources, including ACDSee Photo Discs and files
from previous versions of ACDSee.

Importing Photo Discs

Previous versions of ACDSee (versions 4.0 and 5.0) created separate database files with a .ddf file extension for
Photo Discs. You can import the Photo Disc database files into your ACDSee database.

To Import a Photo Disc:
1. In Manage mode, click Tools | Database | Import, and then select Photo Disc.
2. Inthe Open dialog box, locate and select the photo disc file you want to import.

3. Click Open.

To import the information from Photo Discs created with ACDSee 6.0 or later, you must convert and
= | import the entire database.

Importing Albums

In previous versions of ACDSee, you could create albums in an .ais file format that consisted of organized
shortcuts to your images. Now you can use categories to create albums of images that do not require a separate
file extension. You can, however, import your albums from previous versions of ACDSee, and add the information
from the albums to the database. ACDSee creates a new category for each album you import.

To Import Album Information into the Database:
1. In Manage mode, click Tools | Database | Import, and then select Album.
2. Inthe Open dialog box, locate and select the .ais file you want to import.

3. Click Open.

Working with Descript.ion Files

In previous versions of ACDSeg, file descriptions were stored in a separate descript.ion file in each folder that
contained images. ACDSee now stores file descriptions as captions in the database, along with other file
information such as notes and keywords.

You can use the Descript.ion tools to import your old descript.ion files and add the information to the database, or
export your existing file captions to a descript.ion file.

To Import a Descript.ion File:
1. In Manage mode, click Tools | Database | Import, and then select Descript.ion File.
2. Inthe Open dialog box, locate and select the descript.ion file you want to import.

3. Click Open.

To Export Captions to a Descript.ion File:
1. In Manage mode, click Tools | Database | Export, and then select Descript.ion File.

2. Inthe Save As dialog box, type a name for the descript.ion file in the File name field.
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3. Click Save.

Exporting Database Information

You can use the ACD Database Export wizard to save selected database information in a compressed format, and
then store it as a backup, or share it with other ACDSee users. You can also choose to export your category and
keyword definitions to a text file.

Exporting your database information differs from creating a backup in that you can choose to export only the parts
of your database that you want to share or store with specific files, such as those on a CD. Other ACDSee users can
import your information without affecting their existing database.

To create a backup of your entire database, including image or media files, use the ACD Database Backup wizard.

To back up the contents of a local folder to a remote location, such as a network drive, use the ACD Sync wizard.

To Use the ACD Database Export Wizard:

1. If you want to export your database information for a specific group of images or media files, select the
files in the File List pane in Manage mode.

2. Click Tools | Database | Export | Database.
3. Click Next to begin using the wizard.

4. On the Content and Format Options page, specify how you want to export your database information by
selecting one of the following options, and then clicking Next:

* Export entire ACDSee database to a read-only, compressed version: Exports the entire
contents of your ACDSee database to a compressed version that can be shared with other ACDSee
users.

* Export database information for selected items to a read-only, compressed version:
Exports all of your database information for the images selected in the File List pane.

* Export database information to a text file: Exports the selected information to an XML-based
text file. Select the checkboxes next to the information you want to include.

5. On the Location Options page, specify a location for the exported information, and a name for the text file,
if necessary, and then click Next.

6. On the Summary page, review your choices. You can click Back to make changes, or click Next to begin
exporting your database information.

7. Click Finish to close the wizard and return to ACDSee.

Generating File Lists

You can generate a text file that lists all of the files in the folder currently displayed in the File List pane. The text
file places the file name, size, image file format, modified date, image properties, caption, and rating for all of the
files in the folder into a table, and creates a single text file.

To Generate a List of Your Files:

In Manage mode, click Tools | Database | Export, and then select Generate File Listing.

ACDSee automatically generates the file listing and opens it as a text file in your default text editor. You can
then edit or save the text file.
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Backing Up Your Database

You can use the ACDSee Backup wizard to back up all of your database information, which you can then restore in
the case of a system failure or other event. You can also choose to back up your image, media, or archive files
along with the relevant database information.

The ACDSee Backup wizard creates a series of files in a specified location that contain your entire database. The
backup is generated using your folder structure and is unique to your computer. To back up portions of your
database, or to share database information with another ACDSee user, use the ACDSee Database Export wizard.

For some suggestions about managing your database backups, see Database backup tips and strategies.

To Back Up Your Database Information:

1. In Manage mode, click Tools | Database | Back Up Database.

2. On the Welcome page, select whether you would like to create a new backup, or update an existing

backup. Click Next.

If you choose to update an existing backup, please go to step #5.

3. On the New Backup page, select the information you would like to back up. Click Next.

4. On the Backup Location page, click Browse and specify a location for your backup, and type a name for
the backup file. Click Next.

5. On the Backup Summary page, review your settings. If you chose to update an existing backup, click the
Backup to update drop-down list, and then select the existing backup. Click Next.

Backup Information Options

Do not include
thumbnails

Include thumbnails
for offline files

Include thumbnails

Backup files of type

All files of specified
types on your local
hard drives

All files of specified
types on local and
network hard drives

All files of specified
types in a folder

(including subfolders)

Excludes thumbnails from the backup, saving a substantial amount of storage
space on your hard drive.

Includes only thumbnails for files that do not reside on your hard drive, such as
PhotoDiscs.

Includes all thumbnails in the database. This will require more space on your hard
drive to store the backup.

Backs up the specified file types with the database information. Select from the
following file types:

* Image: Includes image files in the backup.
* Media: Includes audio and video files in the backup.

* Archive: Includes archive files in the backup.

Backs up all specified files on your hard drive.

Backs up all specified files on your hard drive and network drives.

Backs up all specified files in a specified folder. Click the Browse button and
select the folder to back up.

Database Backup Tips and Strategies

The ACDSee database stores information about your files, including EXIF information, file name and folder location,
thumbnails, categories, ratings, and any other information you add using the Properties pane. The more
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information you store in the database, and the more time you spend entering that information, the more important
it is to back up your database, and to have a good strategy for managing your backups. Losing hours of work to a
system crash or other uncontrollable event is something that should, and can, be avoided.

Backup Schedule

How often you need to back up depends on how often you add or change information in the database. A good rule
to use would be to back up your data as often as you want to avoid retyping it. You can use the backup reminder
settings on the Database page of the Options dialog box to set a regular reminder for yourself to back up your data
as often as you think appropriate. Business environments and professional users should back up every day.

It is also recommended that you back up your database before performing any major adjustments to it, such as
importing information from another ACDSee user, or converting a database from a previous version of ACDSee.

Backup Location

It's a good idea to consider where you back up your data, as well as how often. If you're backing up to your hard
drive, ACDSee creates a new folder for each day. This helps to avoid overwriting your backup, and gives you
several increments from which you can restore. Also helpful is a monthly backup that is stored in a different
physical location than your computer, such as a network drive.

Backup Size

To keep the size of the backup small, choose to back up database information only, and back up your images
separately, also on a regular basis.

Restoring Database Information From a Backup

You can use the ACD Database Restore wizard to restore previously backed up database information.

To Restore Database Information:
1. In Manage mode, click Tools | Database | Restore Database.
2. On the Welcome page, click Next to select the backup.

3. On the Restore Options page, select the backup and date from which you want to restore, or browse to the
location of your backup and select a .bkup file.

4. Click Next when you are ready to restore your database.

! When restoring a backup from a series of backup files, ACDSee will only restore the information included
in and prior to the selected backup file. Therefore, unless required, it is recommended that you select the
last file in the backup sequence.

Maintaining the Database

It is recommended that you regularly perform database maintenance and optimization to increase hard drive
space, remove redundant or extraneous information, and increase overall ACDSee performance.

You can use the tools in the Database Maintenance dialog box to update folders, or to identify folders whose
thumbnails and database information you would like to delete. The Database Maintenance dialog box displays a list
of the folders on your system, and uses icons to indicate the status of database information within specific folders.

Database Content Icons
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[l_:-,l Folder contains files with cached thumbnails stored in the database.

ml Folder contains files that were changed without a database update. For example, a folder or file was
renamed or moved outside of ACDSee.

To Perform Database Maintenance:
1. In Manage mode, click Tools | Database | Database Maintenance.

2. In the Database Maintenance dialog box, browse for folders marked with the database content icons. If
there are no marked folders, you do not need to perform database maintenance and can exit the Database
Maintenance dialog box.

3. Select a folder and click one of the following buttons to identify the maintenance you want to perform on
that folder:

* Remove Thumbnails: Removes all thumbnail information for the selected folder.
* Remove All DB Info: Deletes all database and thumbnail information for the selected folder.

* Remove Orphan Folders: Deletes any out-of-date or broken references to missing files or
information for the selected folder. It is only possible to check for orphans in folders located on
your computer. This option will not be visible if the folder is located on a network.

* Change Binding: Changes all location references for the selected orphaned folder to another
folder, and retains all database information. The default binding folder is My Pictures.

4. The Database Maintenance tool will delete records, creating unused space in your database. To reclaim
the unused space, click Optimize Database, and follow the instructions in the wizard.

5. Click Close.

Optimizing the Database

You can use the Optimize Database wizard to quickly remove redundant or outdated database records. Optimizing
your database, along with performing regular database maintenance, helps regain hard drive space and improves
the overall performance of ACDSee.

“ " If you are cataloging large numbers of files regularly, it is helpful to optimize weekly, or after an extended
) cataloging session. This is also a good time to backup the database.

I
To Optimize Your Database:

1. In Manage mode, click Tools | Database | Optimize Database.

2. In the Database Optimization wizard, click Next.

3. Select one or both of the following:

* Optimize the database tables and fields: Removes obsolete information from the database,
reduces the space used by database fields, and re-indexes the tables.

* Remove orphans from database: Removes any orphan database entries, caused by files or
folders deleted by other programs.

4. Click Next.

5. When the wizard has finished, click Finish to return to ACDSee.
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Mapping Drives for an Incoming Database

If you are upgrading to ACDSee or are importing or restoring your ACDSee database, the Database Drive Mapping
dialog displays how drive mappings (in the incoming database) will be re-established in the ACDSee database. You
can use this dialog to change how each drive will be mapped in the database.

To Select New Drive Mappings:
1. Inthe Database Drive Mapping dialog, select a drive and do one of the following:
* To create a new drive map, select Create new database entry.
* To map the drive to a local drive, select a drive from the Local Drive drop-down list.

2. Click Done.

Rebuilding Thumbnails and Metadata

Situations can develop in which your images will be out of sync with the thumbnail images displayed in the File List
pane and the embedded metadata. You can use the Rebuild Thumbnails and Metadata tool to immediately
regenerate the thumbnails for selected images and rebuild the metadata.

To Rebuild Thumbnails:
1. In Manage mode, do one of the following:
* Select one or more thumbnails in the File List pane.
* Select a folder in the Folders pane.

2. Click Tools | Metadata | Rebuild Thumbnails and Metadata.

Quarantined Files

If ACDSee has trouble reading a corrupted or incomplete image or media file, or a file causes a plug-in to generate
an error, ACDSee will quarantine that file. You can view a list of quarantined files, and remove a file from the list.

To View Quarantined Files:
1. In Manage mode, click Tools | Database | Quarantine Files.
2. Toremove afile, selectitin the list, and then click Remove.
3. Todisable the Quarantine feature, clear the Enable Quarantine checkbox.
4

Click OK to close the Quarantine Files dialog box and return to ACDSee.

Working with Plug-ins

A plug-in is a software module that adds functionality to a larger program. ACDSee comes standard with many
different plug-ins.

Types of Plug-ins

+* Image Decode: Converts a file from a binary format to the image displayed in ACDSee. Decode plug-ins
allow ACDSee to display images of many different file formats. The files that you can view with ACDSee
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depend on which decoding plug-ins are installed on your computer.

* Image Encode: Converts the image displayed in ACDSee to a binary file format. Encode plug-ins allow
ACDSee to save (or convert) images to many different file formats. The files that you can edit and save
with ACDSee depend on which encoding plug-ins are installed on your computer.

* Archive: Allows ACDSee to display and save archives of many different file formats. The archives that you
can view and create with ACDSee depend on which archive plug-ins are installed on your computer.

* Camera: Allows ACDSee to browse images on your digital camera and transfer them to a folder on your
hard drive.

* Command Extension: Adds functionality to ACDSee. For example, there is a plug-in that you can use to
share your images over the Internet.

* Pane Extension: Adds a pane to ACDSee where you can perform tasks like order prints of your digital
images.

! Wecannot ensure the quality of plug-ins that are not certified by ACD Systems. As with any other piece of
software, you are trusting that the plug-in is free of viruses and that the company that produced the
plug-in is trustworthy.

Managing Plug-ins

The Plug-in Settings dialog box displays a list of all the ACDSee plug-ins installed on your computer. You can also
use the Plug-in Settings dialog box to control which plug-ins ACDSee uses.

To Access the Plug-in Settings Dialog Box:

In Manage mode, click Tools | Plug-in Settings.

Disabling a Plug-in
You can disable a plug-in in the Plug-in Settings dialog box so that ACDSee no longer uses it.

To Disable a plug-in:
1. Inthe Plug-in Settings dialog box, select one of the Plug-in tabs.
2. Clear the checkbox beside the name of the plug-in that you do not want ACDSee to use.

3. Click OK.

Changing the Plug-in Order

Some file formats can be supported by more than one plug-in. However, when this happens, you can control
which plug-in is used to read or write a file format. The order that plug-ins appear in the Plug-in Settings dialog
box is the order that ACDSee uses the plug-ins to read or write a file.

To Change the Plug-in Order:
1. In the Plug-in Settings dialog box, select one of the Plug-in tabs.
2. Select a plug-inin the Plug-ins list.
3. Do one of the following:
* Click the Move up button to move the plug-in higher in the list.

* Click the Move down button to move the plug-in lower in the list.
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4. Click OK.

Viewing Plug-in Properties and Getting Help

You can view and set properties for certain plug-ins.

To View Plug-in Properties:

1. In the Plug-in Settings dialog box, select one of the Plug-in tabs.

2. Select a plug-in in the Plug-ins list.

3. Click the Properties button.

To View a Plug-in's Help File:

1. Inthe Plug-in Settings dialog box, select one of the Plug-in tabs.

2. Select a plug-in in the Plug-ins list.

3. Click the Plug-in Help button.
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Chapter 4: Photos Mode

Using Photos Mode

Photos mode is a quick and convenient way to view your entire image collection by date. Photos mode displays
images that have been cataloged. Images in Photos mode are displayed by the date they were taken, as indicated
in the images' EXIF data. If the EXIF data does not contain a date taken, Photos mode will display the images based
on the modified date.

/ ) You can modify the date taken by using Batch Adjust Time Stamp.

L

Photos mode contains two areas:
Date pane: This pane displays all of your cataloged photo collection by date.

Timeline pane: This pane displays the year and month of your photos and how many photos are in each.

Viewing Images

Images are displayed in Photos mode by date. To toggle viewing them by year, month, or day, do one of the
following:

* Click the Year, Month, or Day buttons at the bottom right of the Date pane.

* Use the forward and back arrows at the top left to move from Year to Month to Day view.
* Choose View | Year/Month/Day.

* Click an image to move from Year to Month to Day view.

* Click on a year/month entry in the Timeline pane to navigate to the images from that time.

To View Only Your Microsoft OneDrive® Photo Collection:

Click the Filter drop-down menu and select OneDrive.

To View All of Your Photo Collection (Including OneDrive):

Click the Filter drop-down menu and select All.

To View Photos from Your Pictures Folder Only:

Click the Filter drop-down menu and select Pictures.

To View Photos from Your Desktop Only:

Click the Filter drop-down menu and select Desktop.

To View Orphaned Files with Your Photo Collection:

Click the Show Orphan Files button at the top of the Date pane. Orphaned files will appear in sepia.

To View a Larger Version of an Image:

Do one of the following:
* Double-click an image to open it in View mode.

* Select an image and press Enter to toggle between View mode and Photos mode.

To Open an Image in Another Mode:
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Do one of the following:
* Right-click the image in Day view and select an option from the context menu.

+* Ctrl + right-click the image in Year or Month view and select an option from the context menu.

To Locate an Image in Windows Explorer®:
+ Right-click the image in Day view and select Show in File Explorer from the context menu.

* Ctrl + right-click the image in Month or Year view and select Show in File Explorer from the context
menu.

Cataloging

Photos mode will only display images that have been cataloged. You can catalog your images by:
* Browsing your folders in Manage mode.

* Using the Catalog button at the top of Photos mode.
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Chapter 5: View Mode

View mode is the main viewing component of the user interface.

In View mode, you can:
* Click+hold+drag to pan around large images.
* Press the keyboard shortcut F to toggle in and out of full screen view.
* Zoom in or out on your images.

* View images in a slideshow.

* Play video and audio files and add audio to your image files.

* Add captions to your images.
* Catalog files by tagging them, adding categories, keywords, and other metadata.

* Automatically advance to the next image in the Filmstrip when you apply metadata.

Previewing Your Images with Auto Lens

You can use Auto Lens View to preview your images with a number of filters without actually applying them to the
file.

To View Your Image with an Auto Lens:

1. Open animage in View mode.

2. On the Toolbar, press the Auto Lens button. @
3. Select a filter to preview your image in.

4. Use the Filmstrip or Previous/Next button to preview more images with your selected filter.

fThe Lens will remain turned on in View mode until you turn it off.

Lomo e - () === None

To Turn Off Your Selected Auto Lens:
1. On the Toolbar, press the Auto Lens button.

2. Select None.
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Light EQ™

You can view your image with an instant exposure adjustment in View mode with Light EQ™. You will need to
select Light EQ™ for each image you view.

To View Your Image with Light EQ™:
1. Open animage in View mode.

2. On the Toolbar, press the Light EQ™ button.

o

Rotating Images

You can rotate images in Manage and View modes using the Rotate icons in the bottom toolbar.

f When you rotate unedited JPEG images, ACDSee performs a lossless rotation.

To Rotate Images:
1. In Manage mode or View mode, select one or more images.

2. Click the Rotate Left or Rotate Right icon in the bottom toolbar.

Rotate Icons

»J) Rotate Left Rotates the image 90° to the left.

({, Rotate Right Rotates the image 90° to the right.

Using the Histogram

The Histogram displays a graphical representation of the distribution of intensity levels of pixels for each color
channel in an image.

To Display and Use the Histogram:
1. In View mode, click Panes | Histogram, or View | Histogram in Edit mode.
2. On the Histogram, select or clear the following checkboxes:
* R: Shows or hides the red color channel.
* @G: Shows or hides the green color channel.
* B: Shows or hides the blue color channel.

* L: Shows or hides the lightness of the image.

Viewing Images with Image Advance

You can use the Image Advance feature to create a quick slideshow preview of a group of images, or all the images
in a folder.

To Start Image Advance:
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1. Open agroup of images in View mode.

Click View | Image Advance | Options.

In the Image Advance dialog box, set the options as described below.
Click Start.

To advance to the next image, press Space.

To return to the previous image, press Backspace.

N o u »~A w N

To stop or restart Image Advance, press Pause.

Image Advance Options

Sequence Determines the order that you want to display your images. Select one of the following
options:

* Forward
* Reverse

* Random

Repeat Automatically restarts the slideshow after the last image has been displayed.

Delay Specifies how long to display each image. Drag the slider or type a value from 0 to
864000000 to set the time (in milliseconds).

Sound Select the Play audio clips checkbox to play any audio embedded in the selected images.

Displaying Text on Images in View Mode

You can use the Header/Footer tool to display text with your images in View mode. The text is displayed while you
are viewing the image, but does not modify the original image. You can also hide the headers and footers without
changing the settings.

To add text directly to your photos and save it as part of the image, see Adding text to an image.

To Edit Image Headers and Footers:
1. In View mode, click View | Edit Header/Footer.
2. Do oneor both of the following:
* Select the Header checkbox to add text at the top of the image.
* Select the Footer checkbox to add text at the bottom of the image.
3. Select or change the text options as described below.

4. Click OK.

Text Options

Alignment Specifies the justification of the captions.

Background Adds a background color to the text. Click Color to specify a color.

Description Displays the text you want to see on your images. Type the text you want to appear,
or click inside the field to set an insertion point for inserting metadata.

Insert Metadata Inserts file-specific information into the text for each image.

Font Sets the font, size, and color of the caption text.

To Insert Metadata in Image Text:
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1. Position the cursor in the Description text box where you want to display the file information and click
Insert Metadata.

2. In the Choose Properties dialog box, select the file information you want to include.
3. Click OK.

The information you added is inserted as a placeholder that will be replaced by the specific text for each
image.

Hiding Image Text

You can hide either the header or footer, or disable both at once without changing or deleting the information in
the header and footer fields.

To Hide the Image Text:
1. In View mode, click View | Edit Header/Footer.
2. Do one or both of the following:
* Clear the Header checkbox to remove text from the top of the image.
* Clear the Footer checkbox to remove text from the bottom of the image.

3. Click OK.

fTo show or hide both headers and footers simultaneously, click View | Show Header/Footer.

Selecting Part of an Image

You can use the Select tool in View mode to select a rectangular area of an image. You can then zoom in on the
selection, copy the selection, save the selection as a new image, print the selection, and use the selection as the
desktop wallpaper.

To Select Part of an Image:
1. Click the Select Tool icon.
Drag the cursor across the image to create a marquee.

Right-click inside the marquee and select one of the options described below.

A wN

To cancel the selection, click an area of the image outside of the marquee.

Selection Options

Zoom To Zooms in on the selected area.

Copy Copies the selected area to the Clipboard.

Save Crop As Saves the selected area as a new image.

Print Prints the selected area.

Wallpaper Creates desktop wallpaper using the selected area and centers it on your desktop,
Centered shrinking it to fit if necessary.

Wallpaper Tiled Creates a tiled desktop wallpaper pattern using the selected area.

Page 137 of 329



ACDSee Photo Studio Standard 2019

Viewing File Properties in View Mode

You can view an image’s properties in View mode and edit the information in the Properties pane.

To View an Image’s Properties:

In View mode, click Panes | Properties.

For more information about the Properties pane, and adding or editing ACDSee Metadata, see Using the
Properties Pane.

Viewing and Using Brush Files

You can view brush files in Manage mode just like fonts or other files. This means that you can assign ratings or
organize them just like any other file in ACDSee. Because many .abr files are actually groups of images in one file,
you need to open them in View mode to see the individual images.

'@ This icon indicates an .abr brush file in ACDSee.

To View Brush Files:

In Manage mode, navigate to the folder containing your brush files.

* To see just the top image in any .abr file, hover over the thumbnail to activate the pop-up, or click it to see
the image in the Preview pane.

* Toview the other images in the .abr file, double-click it to open it in View mode. The file opens in View
mode showing the individual images in a pane on the left-hand side.

* To see the number of images, and select them by number, click the down-arrow at the top of the sidebar,
and then select the number of the image.

* Toscroll through the images, click the right and left arrows at the top of the sidebar, or on each image.

To Use Brush Files in Adobe Photoshop®:

With both Adobe Photoshop® and ACDSee open, drag the file from the File List (in Manage mode) onto the
Photoshop® window.

Even though nothing appears to happen, the brush is loaded into the Photoshop® brush library. To view the new
brushes, open the library and scroll to the bottom of the pane.

"
I

% To make it even easier to use brushes in Photoshop®, you can configure it to be your default editor. Then
) you can use CTRL + ALT + X to open Photoshop® and use the brush right away.

Playing Video and Audio Files

You can play video or audio files in many formats in ACDSee. You can control playback volume, and create an
image from a video frame.

To Play Video or Audio Files:
In Manage mode, in the File List pane, do one of the following:

* Double-click a video or audio file.

* Select one or more files and press Enter.
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* Select one or more files, right-click a selected file, and then select View.

* Use the Media toolbar to adjust the volume, pause, loop, or extract frames from playback.

Automatically Playing Audio and Video Files

You can configure your settings to play audio and video files automatically, as soon as you open them in View
mode, or as you view them in the Preview pane in Manage mode.

To Start Playing Media Files Automatically:
1. In Manage mode or View mode, click Tools | Options | Preview.
2. Select the Autoplay audio or video clips checkbox.

3. Click OK.

The Media Toolbar

You can use the Media toolbar to quickly access common media viewing and editing tools.

Media Toolbar Buttons

Play Plays the media file or selection. Changes into the Pause button when a
media file or selection is playing.

=1 Extract Frames Opens a menu you can use to copy, save, and extract video frames.

._/ Frames are extracted at the resolution you viewed them at, (your
= | screen resolution).

m Loop Continuously plays the media file or selection.

Saving Video Frames as Images

You can extract an individual frame from a video and save it as a still image.

To Extract and Save a Single Video Frame as an Image:
1. Do one of the following:
*  While the video is playing, click the Pause button at the frame you want to save.

* Skip to step 2 as the exact frame you want to extract is playing.

On the Selection and media controls toolbar, click the Extract Frames button.

2.

3. In the Extract Current Frame dialog box, select a folder in which to save your file.

4. Inthe File name field, type a filename.

5. Click the Save as type drop-down list and select a file format. You can click the Options button to select
or change any options associated with the file format.

6. Click Save.
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Adding or Editing Image Audio

ACDSee supports images with embedded audio and images with associated audio files.

Images with embedded audio are TIFF or JPEG images with audio saved inside the image file. You can embed audio
inside an image file by adding audio to the image.

Images with associated audio are image files paired with separate WAV audio files. Image files and their associated
audio files contain the same file name and are located in the same folder. You can associate any WAV file with an
image file by giving them the same name and placing them in the same folder, or by adding audio to the image.

! If you move or rename either an image file or the audio file associated with it, both files must be renamed
and in the same folder or they will no longer be associated. This does not apply to images with embedded
audio.

To Add Audio to an Image:
1. Do one of the following:
* Select an image in Manage mode.
* Open an image in View mode.
Click Tools | Image Audio | Edit.
In the Edit Audio dialog box, click the Browse button.
Select a WAV file and click Save.

g A W N

If you would like to truncate or clip the audio file, select the Use markers checkbox, and drag the Start
marker and End marker sliders. Do one of the following:

* Click the Truncate button to remove the beginning and end of the audio file (the sections outside
of the start and end markers).

* Click the Clip button to remove the section of the audio file inside the start and end markers.
6. To hear a preview of the file, click the Play button.
7. Click OK.

Recording Audio to an Image

You can record your own audio files and add them to your images. When you add audio to a JPEG or TIFF image,
the audio is embedded in the image. With other file formats, the audio file is associated with the image; the audio
file is saved in the same folder and is played when the image is viewed.

To Record and Add an Audio File to an Image:
1. Do one of the following:
* Select an image in Manage mode.
* Open an image in View mode.
2. Click Tools | Image Audio | Edit.
3. Inthe Edit Audio dialog box, select or change the Record sound settings options as described below.
4. Click Record and do one of the following:
* Use a microphone and record a sound.

* Play audio from an audio player on your computer.
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5. Click Record to stop the recording.

6. Click Save As to save the audio file.

7. In the Save Sound File dialog box, type a name in the File name field, and then click Save.
8

Click OK.

Record Sound Settings Options

Capture device Specifies which of your computer's devices you want to record the audio.

Input format Determines which sample rate and audio type are used to record the sound. The
formats displayed depend on the sound card you have installed on your computer.

Overwrite Replaces the recorded audio from the Start marker slider location.

Mix Combines the recording with the existing audio file.

Insert using start Inserts the recording at the start marker location. Drag the Start marker slider to

marker select a position.

Append to sound Adds the recording to the existing audio file.

file

Replace sound file Replaces the entire audio file with the new recording.

Printing Images in View Mode

With the ACDSee print utility, you can print your images on any size of paper, in any orientation, and at any
resolution your printer can support. You can also use the print utility to create and print contact sheets, complete
with headers, footers, and captions specific to each image.

As you change the options in the Print dialog box, you can view a dynamically updated preview of the image and its
position on the page. You can adjust the output size, print multiple copies of each image, and change the
orientation of the images on each page.

To Print a Single Image:
1. In View mode, select the image you want to print.
2. Click File | Print Image.
3. Under Format, choose a print size.
4

On the Printer Options tab, specify the printer you want to use, the paper size, the number of copies you
want, the range of pages that you want to print, and image resolution.

5. On the Page Settings tab, specify the image position on the paper and the margin widths, and specify
the number of prints of each photo.

6. On the Adjustments tab, adjust the settings to compensate for the way your printer handles exposure,
contrast, and sharpness.

7. Add captions, headers, or footers.

8. Click Print.

To Print All Images:
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In View mode, click File | Print All Images.
Under Print layout, do one of the following:
* Select Full page and then choose a print size from the Format list.

* Select Contact sheet and then set the Contact sheet format options to define the appearance
of your contact sheet.

* Select Layout and then choose one of the available layout options.

On the Printer Options tab, specify the printer you want to use, the paper size, the number of copies you
want, the range of pages that you want to print, and image resolution.

On the Page Settings tab, specify the image position on the paper and the margin widths.

On the Adjustments tab, adjust the settings to compensate for the way your printer handles exposure,
contrast, and sharpness.

Specify the number of prints of each photo. If you are printing a Full page or a Contact sheet this option
is available on the Page Settings tab. If you are printing a Layout this option is available below the list of
layouts.

Add captions, headers, or footers. You can only add captions, headers, or footers if you are printing a Full
page or a Contact sheet.

Click Print.

Setting an Image as the Desktop Wallpaper

You can select any image and set it as the Windows desktop wallpaper. You can also automatically stretch a
wallpapered image to fill the screen, or restore your previous wallpaper.

To Set an Image as the Desktop Wallpaper:

1.

2.

Do one of the following:
* In Manage mode, select an image, and then click Tools | Set Wallpaper.
* In View mode, click Tools | Set Wallpaper.

Select one of the following:

* Centered: Places the image in the center of the screen. If the image is larger than the screen, it
is shrunk to fit.

* Tiled: Places the image in a tiled pattern that fills the entire desktop.

* Stretched: Stretches the image to fit the screen.

The selected image is saved as ACD Wallpaper.bmp in the Windows folder. ACDSee automatically changes the
wallpaper settings in the Control Panel Display properties to display the image.

To Automatically Stretch Wallpapered Images to Fit the Screen:

1.

A

Click Tools | Options.
In the Options dialog box, click General.
On the General page, select the Automatically stretch wallpaper to fit screen checkbox.

Click OK.

To Display the Previous Wallpaper:

Click Tools | Set Wallpaper | Restore.
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Synchronizing View Mode to a Folder

You can use the Sync to Folder option to change the images being displayed in View mode.

To Synchronize to a Folder:
1. In View mode, click File | Sync To Folder.
2. Type the path to the folder you want to synchronize, or click the Browse button to locate the folder.
3. Select or change the New Images options as described below.

4. Click OK.

New Images Options

Show new images Displays images as soon as they appear in the folder. If this option is cleared, new
immediately images are added to the end of the slideshow.

Ignore open files Delays adding a new file to the slideshow until the transferring application has finished
moving or downloading the file.

Sort by name Sorts the images displayed in the slideshow by their file name.

To Stop Synchronizing to a Folder:

In View mode, click File | Sync To Folder.

Viewing Offline Images

ACDSee stores thumbnails and database information for images contained on CDs or other removable media as

Photo Discs. You can then browse the thumbnails and view the information for those images even when the disc is
not in your CD-ROM drive.

To Add a Photo Disc:
1. Place a disc containing images into your CD-ROM drive.
2. In Manage mode, click File | New | Photo Disc.
3. In the New Disc dialog box, type a name for your disc in the Title field, and then click OK.

You can then browse the contents of the Photo Disc in the Offline Media section of the Folders pane.

If you add or remove images from a disc that you have already added to ACDSee as a Photo Disc, you can
=f | update the information stored in the database. Insert the disc in your CD-ROM drive, and then right-click
the name of the disc in the Folders pane and select Update Photo Disc.

By default, ACDSee identifies Photo Discs by their serial numbers. This is the most reliable setting to use when

working with Photo Discs, particularly if you are importing or converting Photo Discs from previous versions of
ACDSee.

However, if you are working with, or planning to work with, multi-session discs, the serial number may be
regenerated or changed each time you change the contents of a disc. Therefore, the volume label is the required
method of identification for multi-session Photo Discs.

Rebinding Photo Discs

Depending on the method used to identify Photo Discs, ACDSee may encounter a Photo Disc that it does not
recognize. This is most common when you are using the serial number method to identify Photo Discs and you
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insert a multi-session disc. ACDSee may not recognize the disc, as serial numbers are likely to change when
updating a multi-session disc.

You can use the Rebind option to update the identification information, and associate the correct database
information with your disc.

To Rebind a Photo Disc to its ACDSee Database Information:

1. In the Rebind Photo Disc dialog box, carefully review the Current disc information to be sure that the
correct disc is in the drive.

2. Select the Photo Disc record that you want to rebind to the current disc from the Photo Disc Name list.

3. Click Rebind.

Using ACDSee Quick View

ACDSee Quick View is an image viewer that you can use to quickly view images without opening ACDSee. For
example, imagine that you want to view an image that someone sent to you in an email. If you double-click the
image it will open in Quick View, which is like a pared-down version of View mode in ACDSee.

With Quick View you can quickly scroll through your images, temporarily rotate images, and zoom in and out. If
you are viewing a particularly appealing image in Quick View, you can also set the image as your desktop wallpaper
or print the image.

You can easily switch from Quick View to ACDSee. You also have the option to open an image in Manage, View, or
Edit mode.

If you are accustomed to using keyboard and mouse shortcuts in View mode you can use most of those shortcuts
in Quick View as well.

To Open an Image in Quick View:

1. With ACDSee closed, double-click an image. For example, double-click the image in Windows Explorer or
in an email message.

2. Usethe viewing options described below to view the image.

ACDSee Quick View Viewing Options

Previous View the previous image.
Next View the next image.
Rotate Left Rotate the image to the left.
Rotate Right Rotate the image to the right.
D Zoom In View the image at a higher magnification.
=) Zoom Out View the image at a lower magnification.
Delete Move the image to the computer's Recycle Bin.
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/ ) You can close ACDSee by pressing ESC.

To Open the Image in ACDSee:

Click Manage, View, or Edit mode.

To Set an Image as Your Desktop Wallpaper:

1.

Click Previous or Next until the image that you want to make your desktop wallpaper displays in Quick
View.

Click Tools | Set Wallpaper and select one of the following:
* Centered: Displays the image in the center of the desktop.

* Tiled: Displays the image in one or more tiles until the desktop is covered. If the image is small it
may appear in several tiles on the desktop. If the image is large it may appear in only one or two
tiles.

* Stretched: Stretches the image proportionally to fill as much of the desktop as possible.

To Restore Your System to the Default Desktop Wallpaper:

Click Tools | Set Wallpaper | Restore.

To Print the Image:

1.
2.
3.

Click File | Print.
Under Format, choose a print size.

On the Printer Options tab, specify the printer you want to use, the paper size, the number of copies you
want, the range of pages that you want to print, and image resolution.

On the Page Settings tab, specify the image position on the paper and the margin widths, and specify
the number of prints of each photo.

Add captions, headers, or footers.

Click Print.

Using Windows Touch Gestures™ with Quick View

If you have a Windows Touch Gestures™-enabled device, you can use it with ACDSee Quick View for quick, easy
viewing of photos.

To Use Windows Touch Gestures™ with Quick View:

Open an image in ACDSee Quick View.

-

-

Swipe on the image to scroll through images one at a time.

Hold and swipe slowly in one direction to go through all of the images in the folder.

Hold down on an image, and then let go to achieve the same results as right-clicking with a mouse.
Double-tap the image to launch it in ACDSee.

Move two fingers apart to zoom in, and toward each other to zoom out.

After zooming in, you can pan the image with your finger. To return, choose View | Zoom | Fit Image.
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Viewing Images in Another Application

You can open a file in another program from within ACDSee. For example, you can open documents in the
application used to create them.

To Use the Shell Open and Edit Commands:
1. In Manage mode, click File | Shell.
2. Select one of the following options:
* Open: Opens the file using the application that Windows associates with its file extension.

* Edit: Opens the file using the default system application, or opens a dialog box where you can
select an application.

Showing Originals

When you make changes to your images, the original image is saved so that you can restore the image to its
original settings.

To Show the Original Image:
1. In View mode, select an image that has been edited.
2. Click and hold the Show Original button in the bottom toolbar.

When you release the mouse button, the edited image is displayed.

Committing Changes

When you make changes to your images, the original image is saved so that you can restore the image to its
original settings. If you decide that you want to keep your edited image and save that as your original image, you
can commit the changes to the image. This deletes any sidecar files or originals that have been saved, and
removes the Edited overlay icon that indicates the image has been edited.

To Commit Changes to an Image:
1. In Manage mode or View mode, select an image that has been edited.

2. Click Tools | Commit Changes.

Changing Image Color Depth

You can modify an image's color depth in View mode. Color depth refers to the range of colors an image contains.

To Change the Color Depth of an Image:

In View mode, click Tools | Modify | Change Color Depth, and select one of the options described below.

Color Depth Options
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Black and White Two-color black and white palette

16 Grays 16-color grayscale palette

256 Grays 256-color grayscale palette

16 Colors 16-color palette

256 Colors 256-color palette (GIF format uses 256 colors by default)
Hicolor 32,768-color palette

Truecolor 16,777,216-color palette of all colors visible to humans

You can use ACDSee to convert an image to any of these color depths. However, to use certain image enhancement
tools, filters, blends, and adjustment options, the image must be Hicolor or Truecolor. To edit an image that is not
originally Hicolor or Truecolor, you can convert it, edit the image, and then convert it back to its original color
depth.

Zooming an Image

In View mode you can use the Zoom tools to enlarge or reduce the size of the image you are viewing. When an
image is zoomed to a larger size than the View mode window, you can use the Scroll tool (hand icon) to pan or
scroll the image.

To Zoom an Image In or Out:

* Click once on the image to toggle between your default view and Actual Size view.

* Click Tools | Zoom, and then select one of the Zoom menu options.

Zoom Menu Options

Zoom In Increases the magnification of the image.

Zoom Out Decreases the magnification of the image.

Actual Size Displays the image at its original dimensions (100%).

Fit Image Displays the image at the largest magnification that fits in View mode window.

Fit Width Fits the image within the left and right sides of the View mode window.

Fit Height Fits the image within the top and bottom of the View mode window.

Zoom Lock Displays all images at the zoom option of the current image. If the zoom level is
adjusted, the new zoom level is applied to all images that you view.

Zoom To Opens a dialog box where you can select a zoom level.

Pan Lock Locks the panned area of an image.

If you select Fit Image you can display the previous or next image by pressing the left and right arrow
-=£_ | keys on your keyboard.

To change your default image view, click Tools | Zoom and select Actual Size, Fit Image (standard), Fit
= | Width, or Fit Height.

®,

-/',: You can also quickly access the Zoom Lock on the Toolbar by toggling the Zoom Lock button. =%

Setting the Zoom Level

You can use the Set Zoom Level dialog box to set a specific zoom level in View mode.
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To Set a Specific Zoom Level:
1. Click Tools | Zoom | Zoom To...
2. In the Zoom level area, select one of the following:
* Fit whole image: Zooms the image to fit entirely within the window.
* Fit width: Zooms the image to fit the width of the window.
* Fit height: Zooms the image to fit the height of the window.

* Specify: Specifies a zoom percentage. Type a number in the field or click the drop-down list and
select a zoom level.

3. Touse this setting as the default View mode zoom level, select the Lock at this zoom level checkbox.
View mode displays all images based on the specified zoom level.

4. Click OK.

If you select Fit whole image you can display the previous or next image by pressing the left and right
=£_ | arrow keys on your keyboard.

Automatically Shrinking or Enlarging Images

You can use the settings on the Display page of the Options dialog box to automatically enlarge or shrink images to
fit the size of the ACDSee window. For information about how the combination of the choices affects the display of
images, see the Zoom mode and Resize results table below.

To Automatically Shrink or Enlarge Images:
1. In Manage mode or View mode, click Tools | Options.
2. In the Options dialog box, click View mode | Display.

3. Inthe Zoom options area, select one of the following options from the Default zoom mode drop-down
list:

* Actual Size: Keeps images at their original size.
* Fit Width: Resizes images to fit the width of the View mode window.
* Fit Height: Resizes images to fit the height of the View mode window.
* Fit Image: Resizes images to fit the size of the View mode window.
4. Select one of the following options from the Resize drop-down list:
* Reduce Only: Reduces large images to fit the size of the View mode window.
* Enlarge Only: Enlarges smaller images to fit the size of the View mode window.

* Reduce or Enlarge: Reduces large images, and enlarges smaller images to fit the size of the
View mode window.

5. Click OK.

Zoom Mode and Resize Results
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Fit Image

Reduces large
images to fit the size
of the View mode
window.

Reduce Only

Images that are
smaller than the
View mode window
are displayed at
their original size.

Enlarge Only Enlarges small
images to fit the size

of the Viewer.

Images that are
larger than the View
mode window are
displayed at their
original size.

Reduces large
images and enlarges
small images to fit
the size of the View
mode window.

Reduce and
Enlarge

Fit Width

Reduces large images to fit
between the left and right
sides of the View mode
window.

Images that are smaller
than the View mode
window are displayed at
their original size.

Enlarges small images to
fit between the left and
right sides of the View
mode window.

Images that are larger
than the View mode
window are displayed at
their original size.

Reduces large images and
enlarges small images to
fit between the left and
right sides of the View
mode window.

Fit Height

Reduces large images to
fit between the top and
bottom of the View mode
window.

Images that are smaller
than the View mode
window are displayed at
their original size.

Enlarges small images to
fit between the top and
bottom of the View mode
window.

Images that are larger
than the View mode
window are displayed at
their original size.

Reduces large images and
enlarges small images to
fit between the top and
bottom of the View mode
window.

If you select Fit Image you can display the previous or next image by pressing the left- and right-arrow

= keys on your keyboard.

Using the Navigator to View Select Areas of an Image

Use the Navigator pane to display a thumbnail overview of images that are larger than the View mode display area.
In the Navigator, a marquee indicates the area of the image that is visible.

To Display and Use the Navigator Pane:

1. In View mode, click Panes | Navigator.

2. Drag the slider to increase or decrease the magnification of the image in View mode.

3. Drag the marquee to the area of the image you would like to display in View mode.

To Use the Quick Navigator Pane:

1. In View mode, click and hold the Navigator button in the bottom toolbar.

2. Drag the marquee to the area of the image you would like to display in View mode.

Panning a Magnified Image

In View mode, you can pan large images by moving them vertically, horizontally, and diagonally across the display
area to view specific areas of the image. When an image is larger than the ACDSee window and you use the Scroll
tool, the cursor changes to a hand.

To Pan an Image:
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Do one of the following:
* Drag the image to center the area you want to view.

* Press an arrow key. You can hold the CTRL key to pan quickly, or hold the SHIFT key to pan more slowly.

Using Pan Lock
You can use the Pan Lock setting to automatically center the same area of a series of larger images in View mode.

To Use Pan Lock:
1. In View mode, pan over a large image to a specific area you want to view.

2. Using the Zoom menu, zoom in on the image until you reach the magnification you want to use for all of
your images.

3. Click Tools | Zoom | Zoom Lock to keep the current zoom level.

4. Click Tools | Zoom | Pan Lock.

As you move through your images, each one will be automatically zoomed and panned to the same area.

Magnifying Specific Areas of an Image

You can view specific areas of an image at a higher magnification in the Magnifying Glass pane.

To Use the Magnifying Glass Pane:
1. In View mode, click Panes | Magnifying Glass.
2. Move the cursor over an area of the image to view that area in the Magnifying Glass pane.
3. Change the Magnifying Glass pane settings by doing any of the following:

* Move the slider at the bottom of the Magnifying Glass pane to increase or decrease the
magnification.

* Select the Fixed checkbox to apply the slider setting to the original size of the image. Clear the
Fixed checkbox to apply the slider setting to the magnification of the zoomed image in View
mode.

* Select the Smooth checkbox to apply anti-aliasing to the magnified portion of the image, or clear
the Smooth checkbox to view the individual pixels.
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Chapter 6: Edit Mode

Make your final edits in Edit mode, where you can apply fine-tuned adjustments on the more limited RGB image
data. Use the tools in Edit mode for any touch-ups to specific areas of your images.

In Edit Mode You Can:

+ Use the Selection tools to select and apply edits to a specific part of the image.

* Use the Edit Brush to paint an effect onto specific areas of your image.

+ Remove flaws, or red eye.

+ Add text, watermark, borders, vignettes, a tilt-shift, special effects, and drawing tools.

* Crop, flip, resize, and rotate.

+ Adjust lighting using the Exposure, Levels, Auto Levels, Tone Curves, and Light EQ™ tools.

+* Adjust color using the White Balance, Color Balance, Convert to Black & White, and Color LUTs tool.

+* Add details to your image using Sharpen, Blur, Remove Noise, Add Noise or Clarity tools.

Using Edit Mode

In Edit mode, you can use the editing tools to fine tune your image, remove red eye, and apply special effects.

Editing an Image

To Edit an Image:
1. Select Edit mode.
2. Do any one or more of the following:

* At the top of the panel, use the Selections or Drawing tools.

* In the Repair group, click Red Eye Reduction or Repair Tool.

+* In the Add group, click Text, Watermark, Borders, Vignette, Drawing tools, Tilt-Shift, or click Special
Effect and select an effect.

* In the Geometry group, click Rotate, Flip, Crop, or Resize.

* In the Exposure/Lighting group, click Exposure, Levels, Auto Levels, Tone Curves, or Light EQ™.

* In the Color group, click White Balance, Color Balance, Convert to Black & White, and Color LUTs.

* In the Detail group, click Sharpen, Blur, Clarity, or click Noise to remove or add noise.

3. You have several options in saving your images. See Saving images in Edit for more information.

Reverting to Original Settings

You can discard your Edit settings and revert to the original settings for your image. For steps to revert your
image, see Restoring originals.
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Histogram and Image Viewing Controls

While editing an image, you can adjust the magnification with the zoom controls, located in the bottom right

corner.

Histogram

wll

Undo/Redo

Reset

Fe
L=

Display Full Screen

Actual Size

Navigator Pane

Fit Image

Show Previous

Zoom slider

Zoom drop-down list
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Displays the histogram preview for the current image. The histogram provides a
graphical representation of the intensity level of pixels within each color channel.
Spikes at either end of the graph indicate clipped colors. Keeping the histogram open
is particularly useful when adjusting exposure, as the histogram reflects all
adjustments as you make them.

You can also display the Histogram by selecting View | Histogram.

Undo to discard all changes made on the current tab. Redo to return to the options
that you had selected prior to clicking Undo. In Edit, Undo and Redo buttons display
the changes you can undo or redo.

Click on the Reset button to reset the image to its default settings.

Displays the image on a full screen. Press F to view full screen and to return to Edit
mode.

Returns the current image to its actual size.

Automatic Window: When Automatic Window is enabled, the Navigator pane
appears as soon as you zoom in on a photo. Drag your cursor to the section of the
image you would like to see magnified. Release the cursor to settle on an area of the
image.

'_J Right-click on the Navigator pane to switch from Automatic to Manual.

Manual Window: When Manual Window is enabled, you can view the Navigator

pane by selecting the Navigator icon. & The Navigator icon only appears when the
image is magnified or if the Actual Size icon has been clicked. Click and hold the
Navigator icon to display a small duplicate of your image. Then drag your cursor to
the section of the image you would like to see magnified. Release the cursor to settle
on an area of the image.

-_J Right-click on the Navigator icon to switch from Manual to Automatic.

Reduces the image to fit within the Edit mode area.

Toggles the changes on or off, to compare the current image to the last saved
version.

Increases the size of the image if you drag it to the right, decreases the size if you
drag to the left.

Displays a list of zoom sizes to select.
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Using Presets in Edit

Many ACDSee editing tools and special effects allow you to save your settings as presets. This is convenient when
you frequently use the same settings for a particular tool or effect.

For most tools, ACDSee automatically saves the last option settings you applied to an image when you clicked Apply
or Done. This preset is called Last Used.

]|
~ The Save Preset Ij and Delete x buttons are located at the top of an editing tool's panel.

To Save a Preset:
1. In Edit mode, select a tool and specify its settings.
2. Click the Save Preset button.
3. Inthe New Preset dialog box, enter a name for your preset, and then click OK.
The new preset will appear in the tool's Presets drop-down list.
To Use a Previously Saved Preset:
1. In Edit mode, select the tool for which you created the preset.

2. Click the Presets drop-down list and select the preset you want to apply.

To Delete a Preset:

1. In Edit mode, select the tool for which you created the preset.

2. Click the Presets drop-down list and select the preset you want to delete.
3. Click the Delete button.
4

In the Confirm Delete dialog box, click Yes.

Using the Undo/Redo Button

You can undo and redo your changes when editing an image.

To Undo a Change:

In Edit mode, do one of the following:

* Click the Undo button found at the bottom of the left pane.

* Use the keyboard shortcut CTRL + Z.

To Redo a Change:

In Edit mode, do one of the following:

+* Click the Redo button found at the bottom of the left pane.

+* Use the keyboard shortcut CTRL + Y.

Restoring Originals

¥ If you have committed changes to an image, you cannot restore the original.
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You can discard all your changes and revert to the original image.

To Revert an Image Back to the Original in Edit:

In Edit mode, select File | Restore to Original.

To Revert an Image Back to the Original in Manage or View Mode:
1. Select the image.

2. Select Tools | Restore to Original.

Using the Edit Brush

While the tools in Edit mode allow you to make a variety of global adjustments, sometimes you may only want to
adjust specific areas of your photos. For example, instead of blurring an entire photo, you may want to blur certain
areas, such as the background. To do this, and other local adjustments, you can use the Edit Brush.

The Edit Brush allows you to selectively edit your photo by simply brushing on the effects. The Edit Brush is
essentially creating a mask that is used to determine which pixels will be affected by the current settings of the
chosen operation.

C

The Edit Brush button displays at the center of the top editing panel toolbar for all applicable Edit mode tools.

Edit Brush

To Use the Edit Brush:

1. In Edit mode, select the tool you want to use.

i

2. Click the Edit Brush button to enter Brushing mode and open the Brush controls. Or, toggle
the Brush panel open and closed with the B key.

Specify the brush settings in the panel or on the fly as described in the table below.

3

4., Start painting the effects on your photo.

5. Adjust the sliders to get the effect you want.
6

Press Done to apply your brush strokes.

Edit Brush Controls
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Add brush stroke
Erase brush stroke
Nib Width

Feathering

Pressure

Alternating between
Brush mode and
cursor-applied tools

Clear all brush
strokes

Invert all brush
strokes

Load last applied
brush strokes

Show brush strokes

Brush while holding the left mouse button down.
Brush while holding the right mouse button down.

Adjusts the size of the brush. You can use the mouse wheel to adjust nib width or
adjust the Nib Width slider.

Adjust the slider to control the softness of the transition between the brush strokes
and the image. Use SHIFT + mouse wheel to adjust the amount of feathering or
adjust the Feathering slider.

Adjust the slider to control the strength of the brush.

For filters that involve drawing or clicking on the image, such as Light EQ™ and
White Balance, hold down the ALT key to switch from Brush mode to using the tool.

b 4
Removes all brush strokes from the image.

A’Toggle this option to invert brushed strokes. This makes brushed areas no
longer brushed and untouched areas brushed. This is useful if you want the
majority of the image brushed and a small section untouched. Simply brush only
the small area you don't want affected and invert the brush strokes.

v,
A’Applies effects to the area most recently brushed and applied.

When this option is checked, your brush strokes will be displayed in the color
shown. This is helpful when brushing a complex area with a subtle effect, as it can
be difficult to tell if you have missed a spot. Alternatively, hold down the S key to
see your brush strokes on the image.

When you click the Edit brush and enter Brushing mode, you need to apply brush strokes in order to see
=£_ | any of your adjustments.

7]

e

To exit Brushing mode, toggle the Edit brush button.

The Edit Brush is enabled in many of the editing tools and special effects filters. When it does not make sense to
have this option, it is omitted. The Edit Brush is not available in the following tools: Crop, Resize, Rotate, Flip, Text,
Red Eye Reduction, Repair Tool, and Selections.

Using the Gradient Tool

While the tools in Edit mode allow you to make solid, global adjustments, sometimes you want these effects to
gradually progress over your photo. For example, instead of applying a blur across an entire photo, you may want
a blur that advances across the image, or advances over a section of the image. Use the Gradient tool to gradually
progress an effect across an image.

Gradient Tool

The Gradient tool button displays at the center of the top Editing panel toolbar for all applicable Edit mode tools.

To Use the Gradient Tool:

Page 155 of 329



ACDSee Photo Studio Standard 2019

1. In Edit mode, select the tool you want to use.

2. Click the Gradient tool button m to enter Gradient mode. Or, toggle the Gradient panel open and
closed with the G key.

3. Specify the gradient settings in the panel or on the fly, as described in the table below.

4. Position the guides on your photo. Inside the guide boxes, the gradient is transitioning. On either side of
the boxes, the effect being applied by the Gradient tool is at full strength or not applied at all. To make this
clearer, check the Show gradient mask checkbox. Move the boxes to define where the effect will begin
or end. Hold down the SHIFT key while positioning the effect to lock to the nearest 45° angle, for
straightness.

5. Adjust the sliders to get the effect you want.

6. Press Apply or Done.

Gradient Tool Options

Invert gradient ﬁ’

Toggle this option to invert the gradient. By pressing the Invert button after
applying a gradient beginning at the top of the image, the gradient would now
begin at the bottom, and vice versa.

Show gradient mask

w gradiert m

When this option is checked, your gradient mask will be displayed in the color
shown. Alternatively, hold down the S key to see the mask on the image. Click the
drop-down arrow to select another display color.

Alternating between For filters that involve drawing or clicking on the image, such as Light EQ™ and
the Gradient tool and White Balance, hold down the ALT key to switch from Gradient mode to using the
cursor-applied tools tool.

-/To exit Gradient mode, toggle the Gradient tool button. m

% To maintain your gradient mask while switching to Edit Brush mode, hold down SHIFT and click the Edit
‘iJ Brush button. This allows you to add to the gradient mask or erase parts of it that you don't want.

[ e

The Gradient tool is enabled in many of the editing tools and special effects filters. When it does not make sense to
have this option, it is omitted. The Gradient tool is not available in the following tools: Resize, Crop, Rotate,
Drawing Tools, Vignette, Borders, Text, Repair Tool, Red Eye Reduction, and Selections.

Using the Radial Gradient Tool

While the Edit tools allow you to make a variety of adjustments, sometimes you want these effects to draw attention
to a specific area of your photo. For example, instead of applying sharpening across an entire photo, you may want
to only sharpen the center subject. Use the Radial Gradient tool to apply effects around, or directly to, a center
point.

Radial Gradient Tool
The Radial Gradient tool button displays at the top of the Editing panel toolbar for all applicable Edit mode tools.

To Use the Gradient Tool:
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1. In Edit mode, select the tool you want to use.

2. Click the Radial Gradient tool button _ to enter Radial Gradient mode. Or, toggle the Radial
Gradient panel open and closed with the R key.

3. Specify the Radial Gradient settings in the panel or on the fly, as described in the table below.

4. Position the guides on your photo. Inside the circle, the image is unaltered. At the perimeter of the circle,
the effect being applied by the Radial Gradient is transitioning between not applied at all (inside), and full
strength (outside). To make this clearer, check the Show gradient mask checkbox. Hold down the
SHIFT key while positioning the effect to change the radial gradient to a perfect circle.

5. Adjust the sliders to get the effect you want.

6. Press Done.

Gradient Tool Options

Invert gradient g

Toggle this option to invert the radial gradient. By pressing the Invert button,
the effects will be applied to the center of the image (inside the circular guides),
and outside of the radial gradient will be unaltered.

Show gradient mask

| Show gradient m

When this option is checked, your radial gradient mask will be displayed in the
color shown. Alternatively, hold down the S key to see the mask on the image. Click
the drop-down arrow to select another display color.

Alternating between For filters that involve drawing or clicking on the image, such as Light EQ™ and
the Radial Gradient White Balance, hold down the ALT key to switch from Radial Gradient mode to
Tool and cursor- using the tool.

applied tools

-/To exit Radial Gradient mode, toggle the Gradient tool button. “

% To maintain your radial gradient mask while switching to Edit Brush mode, hold down SHIFT and click
‘iJ the Edit Brush button. This allows you to add to the gradient mask or erase parts of it that you don't want.

[ e

The Radial Gradient tool is enabled in many of the editing tools and special effects filters. When it does not make
sense to have this option, it is omitted. The Radial Gradient tool is not available in the following tools: Resize, Crop,
Rotate, Drawing Tools, Vignette, Borders, Text, Repair Tool, Red Eye Reduction, and Selections.

Using Blend Modes and Opacity

When using a tool in Edit, at the top there are blend mode and opacity tools. These tools give you creative control
and let you combine the two to create a new image. You can apply blend modes and opacity to an entire image or to
a selected part of an image.

Opacity

The Opacity slider changes the opacity of the edited image. It gives you control of how much of the edit should be
visible on the image.
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Blend Modes

The ability to control how the edits and the image merge means that other blend modes besides opacity can be
used to affect the final image.
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Normal

Screen

Multiply

Dodge

Burn

Overlay

Difference

Darken

Lighten

Hard Light

Soft Light

Hue

Saturation

Color

Luminosity

Dissolve

Exclusion

Vivid Light

Pin Light

Linear Light
Hard Mix
Subtract
Divide
Darker Color

Lighter Color

Page 159 of 329

Pixels in the edited image are combined with those in the original. Only opacity affects this
blend.

Combines the edited image color with the inverse of the original photo color, resulting in a
color that is the same or lighter.

Combines the edited image color with the original photo to produce a darker color.
Multiplying any color with black produces black; multiplying any color with white leaves the
color unchanged.

Combines the edited image color with the original pixels in the photo to produce a lighter
color.

Combines the edited image color with the original pixels in the photo to produce a darker
color.

Preserves the shadows and highlights of the lower layers while applying either Multiply or
Screen blend mode based on the original image area's color values.

Subtracts the edited image color from the color of the original photo. Any white in the edited
image produces a true negative of the color in the image, while black produces no effect.

Applies pixels in the edited image that are darker than the original image. Pixels in the edited
image that are lighter than the original image disappear (based on RGB values).

Applies pixels in the edited image that are lighter than the original image. Pixels in the edited
image that are darker than the original image disappear (based on RGB values).

Adds strong highlights or shadows by applying Multiply or Screen based on the original
image area's color values.

Adds soft highlights or shadows by darkening or lightening based on the original image
area's color values.

Applies the hue value of colors in the edited image to the color of the original image areas.

Applies the saturation value of colors in the edited image to the color of the original image
areas.

Applies the hue and saturation of the edited image to the image. This blend does not affect
the luminance of the original image.

Applies the lightness value of colors in the edited image to the color of the original image
areas.

Applies some pixels from the edited image layer onto the original image, resulting in specks
of color. The Opacity slider controls the amount of speckling.

Like Difference, but with less contrast, Exclusion subtracts the blend color from the color of
the underlying photo. Any white in the blend color produces a true negative of the color in
the image, while black produces no effect.

Combines the blend color with the underlying pixels in the photo by increasing or decreasing
contrast to produce a lighter or darker color, as determined by the blend color.

When the light source is lighter than 50% gray, the pixels darker than the light source are
replaced. Pixels lighter than the light source remain the same. When the light source is
darker than 50% gray, the pixels lighter than the light source are replaced. Pixels darker
than the light source remain the same.

Dodges or burns by lightening or darkening the brightness value, depending on the blend
color.

Applies red, green, and blue channel values of the blend color to the RGB values of the
image.

Subtracts the blend color from the image (base) color in each channel.
Divides the blend color from the image (base) color.
From the blend color and the image (base) color, the lower channel values are chosen.

From the blend color and the image (base) color, the higher channel values are chosen.
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il
You can use the Edit Brush to paint an effect onto specific areas of your image, and then
set the blend mode and opacity slider to change the way the effect is applied.

The blend mode and opacity controls apply to many of the editing tools and special effects filters. When it does not
make sense to have these controls, they are omitted. The blend mode and opacity controls are not on the following
tools: Crop, Resize, Rotate, Flip, Text, Red Eye Reduction, Repair Tool, Selections.

Saving Images in Edit Mode

Saving Images

When you have finished editing an image, you can choose from one of the many options for saving your image,
depending on what you want to do next.

To Save the Image and Return to the Mode You Were in Previously:

1. Click Done.
2. Select one of the following:
Save Save your changes.

Save as Save a copy of your edited image with a new name or format.

Depending on your file type, any of the following checkboxes appear in the bottom left corner
of the Save as dialog box:

* Preserve Metadata: Retains metadata with the new image.

* Preserve database information: Maintains your catalog information, such as
ratings.

* Embed Color Profile in Image: Retains color profile selected in Color Management
with your new image.

Discard Discard your changes.
Cancel Remain on the same image, with your changes intact, without saving the image.
AutoSave You can enable AutoSave in order to avoid selecting a saving option each time you finish with

an image. When AutoSave is enabled, pressing Done, or selecting another image from the
Filmstrip will prompt ACDSee to automatically save your changes in Edit mode. You will no
longer see the Save Changes dialog. To disable AutoSave, choose Tools | Options... In the
Options dialog, click Edit Mode. Then clear the AutoSave all changes checkbox.

1. AutoSave is not available for RAW images.

To Save the Image and Continue Processing Other Images:
1. Click Save.
2. Select one of the following:
* Save: Save your changes.

* Save As: Save a version of your edited image with a new name or format and switch to the
updated image.
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* Save a Copy: Save a copy of your edited image with a new name or format, and continue to work
on the original file.

# Save a Copy is useful for making multiple versions of an image while continuing to work from the
=£_|original file instead of a new processed copy. For example, if you take a RAW image and save a copy of it
as a JPG, instead of switching to this lossy JPG image, you remain on the RAW file with the settings still
intact.

._/ Save is not available for RAW file formats because you cannot directly save changes to a RAW file.

To Discard Changes to the Image and Return to the Mode You Were in Previously:

Click Cancel or use the keyboard shortcut ESC.

Using Selections

Use Selections to isolate an area of a photo in order to apply edits or filters to only that area, rather than the whole
photo. There are four different selection tools and each selects an area of a photo in a unique way. The controls
available change depending on which tool you select.

To Use a Selection Tool:

1. In Edit mode, at the top of the panel, select the button for one of the following selection tools: Rectangular
selection tool, Elliptical selection tool, Lasso selection tool, Magic wand selection tool. See below for more
detailed steps for using these tools.

You can use Selections with the following Edit tools:
* Add: Vignette, Special Effects, Tilt-Shift, Drawing tools
* Exposure/Lighting: Exposure, Levels, Auto Levels, Tone Curves, Light EQ™
* Color: White Balance, Color Balance

* Detail: Sharpen, Blur, Noise, Clarity

The Selection Tools

. ; Freehand Lasso: Click the left mouse button and drag the cursor to draw around the area that you
wish to select. As you draw, a line appears showing where you have drawn. When you release the mouse,
the end of the line joins to the start automatically to complete the selection. The whole selection animates
and looks like marching ants.

}/’

W

. * Magic Wand: Click on any area of the image and all the pixels the same color are included in the
selection. You can choose whether to select only the same color pixels that are actually touching the one
you clicked, or all the pixels in the photo that are similar. You can increase the threshold to include more
pixels in the selection. The lower the threshold, the more similar a pixel has to be to the one clicked in
order to be included. The greater the threshold, the more different a pixel can be and still be in the
selection.

9-g

. -0 Rectangularor = Elliptical: Click and drag either a rectangle or an ellipse that begins where
you first click and ends when you release the mouse.
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Using the Selection Tools

To Use the Lasso:
1. Select the Lasso button.
2. On theimage, click and hold down the left mouse button as you draw around the area you want to select.

3. Release the mouse button to complete the selection.

4. Toclear the selection, click anywhere on the image (for the Lasso , Rectangular, or Elliptical selection).

5. Toadd to an existing selection, hold down SHIFT, or press the Add to selection button in the Context
bar, and draw a shape that includes any part of the original selection line. +

When you release the mouse, the original selection expands to include the outer edge of your addition.

6. Toadd multiple areas into your selection, hold down SHIFT, or press the Add to selection button in the

Context bar and draw around any part of the image. *

As long as you do not touch the line of any other selection, you can add several separate areas to a
selection.
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7. Tosubtract from a selection, hold down CTRL, or press the Subtract from selection button in the

P

Context bar, and draw a shape that includes part of the original selection, or encircles it completely. il

8. 1If you wish to apply edits or effects to the outside areas of the image, you need to click Select | Inverse
to reverse the selected area.

Now the selection includes all the outside areas of the image with the central area outside the selection.

:J You can preview the selection mask by holding down the Preview button: @=:

You can select an editing tool or a special effect to apply to the selection.

To Use the Magic Wand:
1. Select the Magic Wand button.
2. Click any color in the image.
3. Do any of the following:

* Slide the Threshold slider to adjust the number of pixels to be included or excluded. The
Threshold slider sets how similar a pixel needs to be to the one you clicked in order to be included
in the selection.

* Click the Connected checkbox if you want to include only pixels that are touching the one you
clicked.

* Hold down SHIFT and click around the selection to include more pixels.

* Hold down CTRL and click around the selection to remove pixels from the selection.
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4. From the Wand type drop-down list, select one of the following:
* Brightness: Selects pixels similar in brightness to the area of the image you clicked.

* Color: Selects pixels similar in hue and brightness to the area of the image you clicked.

fj Color is generally your best option.

* RGB: Selects pixels with red, green, and blue combination similar to the area of the image you
clicked.

#2 You can preview the selection mask by holding down the Preview button: -

You can select an editing tool or a special effect to apply to the selection.

To Use the Rectangular or Elliptical Selection Tool:
1. Select either the Rectangular or Elliptical button.
2. Click and drag to draw the selection on the image.

3. Do any of the following:

+ To add to an existing selection, hold down SHIFT, or use the Add to selection button "-I-:E, and
drag another selection that includes any part of the original selection line. Release the mouse and
the selection now includes the additional area.

* To add multiple areas to your selection, hold down SHIFT and drag as many as you want.

* Tosubtract from an existing selection, hold down CTRL, or use the Subtract from selection

button "-5-53, and drag another selection that intersects with the one you want to reduce. Release
the mouse and any part that was inside the new selection is removed.

#:2 You can preview the selection mask by holding down the Preview button: |
I

You can select an editing tool or a special effect to apply to the selection.

Combining the Tools

You can use the Selection tools separately or in combination. For example, you can use the Magic Wand to select
most of a particular color, then switch to the Freehand Lasso to add to, or subtract from, the selection. Or you
could use the Rectangular selection to select a large general area, then refine it using the Freehand Lasso.

To Combine Selection Tools:
1. Choose a tool and make a selection.

2. Switch to another tool.

3. Press the Add to selection button. ..

4. Make another selection.

Saving Selections as Presets:

You can save your settings as a preset for future use. After you have made a selection, click Select | Save
Selection...

To use a previously saved selection, click Select | Load Selection...

To delete a saved selection, click Select | Manage Selections...

Page 164 of 329



ACDSee Photo Studio Standard 2019

Applying Edits or Effects to Selections

You can use the Selections tools to isolate an area of an image. Once selected, you can apply many of the editing
tools, such as color and exposure, or any of the special effects filters, to the selected area. An active selection in an
image looks like a line of marching ants.

To Apply an Edit or Effect to a Selection:
1. Use the Selections tools to create a selection.
2. Select a tool to use from any of the following groups:
* Exposure/Lighting
* Color
+  Detail
* Add (Special Effects)

1. Ensurethat the Use Selection button is toggled on.

3. Use the tool to edit the image.

Use Any of These Special Selections Options:

Show/Hide Click to show or hide the marching ants around the selection. Hiding the selection line

Selection makes it easier to judge the effect of various effects.

Use Selection Click to use the selection or apply the edit or effect to the whole image. This control
means you can edit just the selection, then deselect Use Selection and apply

E another edit to the whole image without clearing the selection.

Invert Selection Click to invert the selection.

Feathering Drag to increase or decrease the blurring between the edge of the selection and the

edit or effect.

Feathering prevents an unnatural or sharp transition between the selection and the
rest of the image as it blends the edges. This control also makes it unnecessary for
your selection to be perfectly on the edge of the area you want to select.

Reducing Red Eye

You can use the Red Eye Reduction tool in Edit mode to correct red eye in digital photographs.

To Correct Red Eye:
1. In Edit mode, in the Repair group, select Red Eye Reduction.

L

*’) You can also access the Red Eye Reduction tool from the Filter drop-down menu or Filter toolbar.

2. Usethe Zoom tools in the bottom right corner to enlarge and center the eye you want to correct.
3. Click within the red portion of the eye.

4. Inthe Red Eye Reduction group, adjust the sliders as described below.
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Red Eye Reduction Options

Size Drag the slider to the right to increase the size of the area being darkened, or to the left to
decrease.
Darkening Drag the slider to the right to intensify the fill color, or to the left to lighten.

# Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=f__| reset your settings.

’) You can right-click a slider to reset to the default value.
b

“') Scroll with your mouse to adjust the size of the area you would like to darken at anytime.
h

j’_} You can show or hide the outline of the darkened area by toggling the Show Outline checkbox.
"1

L ) Use the Delete key to remove the currently selected red eye adjustment.
"y

Removing Flaws

You can use the Repair Tool to remove flaws, such as:
# Skin blemishes
* Telephone wires and other unwanted objects
* Flash flares from snowflakes or windows
* Lens scratches and water drops

There are two options available for the Repair Tool: the Healing Brush and the Cloning Brush.

When you select the Healing Brush, the Repair Tool copies pixels from one area of a photo to another, but it
analyzes the pixels in the source area before copying them. It also analyzes the pixels in the target area, and then
blends the pixels of both source and target, to match the surrounding area. This ensures that the lighting and
color of the replacement pixels integrate with the surrounding area. The Healing Brush works particularly well
with photos that involve complicated textures like skin or fur.

When you select the Cloning Brush, the Repair Tool copies the exact pixels from one area of a photo to another,
creating an identical image area. The Cloning Brush is more effective for photos that have strong, simple textures
or uniform colors, as it is more difficult to identify the copied pixels in the finished photo.

You can save your settings as a preset for future use.

To Remove Flaws from a Photo:

1. In Edit mode, in the Repair group, select Repair Tool.

"j You can also access the Repair Tool from the Filter drop-down menu or Filter toolbar.
kb

2. Select one of the following:

* Heal: Copies the pixels from the source area to the target area, and blends pixels into the
surrounding image area.

* Clone: Copies the pixels from the source area to the target area.

3. Drag the Nib Width and Feathering sliders as described in the table below.
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4. Right-click the image to set a source location. Pixels will be copied from this location and used in the target
location.

5. Click and drag over the area that you want to cover. If you selected the healing brush, ACDSee analyzes
and replaces the pixels when you release the mouse button.

6. Do one of the following:
* Click Done to apply your changes and close the tool.

* Click Cancel to discard all changes and close the tool.

J,- Click Reset to reset the sliders. If you saved your changes, you cannot reset your settings.

" Scroll with your mouse to adjust the brush size on the fly, or press the SHIFT key while you scroll to
‘iJ adjust feathering.

Repair Tool Options

Nib Width Sets the width of the brush. The maximum brush width is relative to the size of your
image.
Feathering Sets the amount to feather on the edge of the brush to prevent sharp transitions

between the original and healed part of the photo.

Feathering is set as a percentage of the nib width, not as a specific number of pixels.
This means that you do not have to adjust the feathering when you reset the Nib Width,
as it automatically adjusts to a percentage of the new nib width.

Pressure After setting a source point for the Clone tool, adjust the slider to control the strength of
the effect being applied.

Show preview in Enable this checkbox to display a preview of your selected source point in the cursor.

cursor

’) You can right-click a slider to reset to the default value.

Adding Drawings to Your Image

You can use the Drawing Tools in Edit mode to add lines and shapes, such as squares, circles, and arrows to your
image. You can also adjust the width, feathering, and blending of your brush, which is useful for creating subtle
and dramatic drawings.

To Draw on Your Image:
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1. In Edit mode, at the top of the panel, select from the following tools:

“JS ONN O L €&
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Tool
Hand

Rectangle

Ellipse

Line

Arrow

Polygon

Curve

Brush

Fill

Gradient

Instructions

Use the Hand tool to exit out of any other drawing or
selection tool. If you have a scrollable image, the Hand tool
also allows you to pan it.

Drag over the image to create rectangle. Press SHIFT as you
draw to create a square. To fill your shape with color, ensure
that the Fill checkbox is selected.

Drag over the image to create an ellipse. Press SHIFT as you
draw to create a circle. To fill your shape with color, ensure
that the Fill checkbox is selected.

Drag over the image to draw a straight line. Press SHIFT as
you draw to create a vertical or horizontal line.

Drag over the image to create an arrow. Press SHIFT as you
draw to create a vertical or horizontal arrow.

Click to set the corner points of a polygon, then double-click
to connect the start and end points to complete the polygon.
To fill your shape with color, ensure that the Fill checkbox is
selected.

Drag over the image then release. Next, move your mouse to
create the curve and click to set.

Drag over the image to draw a free-flowing line. Left-click
with your mouse to draw with the foreground color, and
right-click to draw with the background color.

b the Nib Width slider at the top of the panel, near

"dj Use the mouse wheel to adjust nib width or use
the Opacity slider.

% Use SHIFT + mouse wheel to adjust the amount
d) of feathering or adjust the Feathering slider at the
top of the panel, near the Opacity slider.

Select the Fill button, and click on a pixel to shade every
pixel of that same color value with your selected color. Your
selected color is defined in the color box, as described

below. Use the Threshold slider to adjust the number of
pixels to be included or excluded. The Threshold slider sets
how similar a pixel needs to be to the one you clicked in order
to beincluded in the selection. Enable the Connected
checkbox in the Context Bar to fill all of the connected pixels
of the same color.

Use the Gradient tool to draw gradients across your image,
or use the radial option to draw a gradient around an area.
Select the Gradient tool, then configure your color, opacity
and blend mode using the Context bar. For a radial gradient,
select the Radial Gradient button in the Context bar. Then
draw your gradient by dragging across the image. To
discard your gradient, press the Discard button in the
Context bar. Rearrange your gradient as desired, then press
the Commit button in the Context bar. You can undo your
commit by pressing Ctrl + Z or selecting Edit | Undo.
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z’ Eye Dropper

Use the Eye Dropper tool to select colors from your images.
Click a color in the image, which will appear in the color
boxes at the top right of the panel. You can then apply this
color using the drawing tools, such as the Brush tool.

You can select the background color (bottom of the color
boxes) by right-clicking on your image.

You can select a color from outside of the application by left-
clicking on your image and dragging your cursor to the color
outside of the application. When you release your mouse
button, the color will be selected and shown in the color
boxes at the top right of the panel.

2. Select from one or more of the following options (Note: options vary depending on the tool selected):

Option

Q Color
-

Nib Width

=51
=

Feathering

Spacing

Fill

Opacity

Blending

3. Drag over the image to draw.

Instructions

Select a color by clicking the color boxes at the top right of the panel
to open the Foreground or Background Color dialog, which displays a
dialog of swatches to choose from. If you are drawing a solid shape,
such as a rectangle, the top (foreground) color box defines the color
for the outline of the shape. The bottom (background) color box
defines the color that fills the center of the shape. If you want your
shape to be a solid color, set both color boxes to match.

"% You can reset to black and white by pressing the reset button

‘if directly next to the color boxes.

Drag the Nib Width slider to set the diameter of the brush measured
in pixels. You can also adjust the nib width with the mouse wheel or
by right-clicking on the image to reveal the Nib Width sliders.

Select the Nib Width button to reveal the Feathering slider. Drag the
Feathering slider to set the blurring radius of the brush. You can
also right-click on the image to reveal the Nib Width and Feathering
slider. Or, you can also hold down SHIFT while using the mouse
wheel to adjust the feather radius, represented by the dotted circle.

Drag the Spacing slider to set how far apart each brush segment will
be. This slider specifies the percentage of the size of the nib width,
which determines how smooth or choppy the strokes will appear.

Use Auto Spacing: Select the Use Auto Spacing checkbox to allow
ACDSee to choose a spacing percentage based on the nib width and
feathering settings, which will create a smooth-looking stroke.

Select the Fill checkbox to fill the shapes you draw with the selected
color.

Drag the Opacity slider to specify the transparency of the brush
strokes.

Select an option from the Blending drop-down menu to affect how
your brush strokes blend with your image as you draw.

) You can right-click a slider to reset to the default value.
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Adding Text to an Image

You can use the Add Text tool in Edit mode to add formatted text to a photo, or add talk and thought bubbles to
create a comic-book effect. You can also adjust the opacity of the text to create a watermark effect, which is useful
for putting copyright information onto your photos.

You can save your settings as a preset for future use.

To Add Text to an Image:

1. In Edit mode, in the Add group, select Text.

( ) You can also access the Text tool from the Filter drop-down menu or Filter toolbar.

2. Type the text you want to add in the Text field.

3. Inthe Font area, specify the font you want to use, the formatting options, such as italics or justification,
and the color of the text. Drag the Size slider to specify a point size, and then drag the Opacity slider to
specify the transparency of the text.

4. Click and drag the text marquee to reposition it anywhere on your image, or drag the marquee's handles to
resize it.

5. Select an option from the Blend Mode drop-down list to specify how you want the text to blend into the
underlying image.

6. Do one of the following:

* Select the Bubble Text checkbox, and set the Bubble Text settings as explained in the table
below. Note that other text effects cannot be applied to bubble text.

* Select one or more of the Effects, Drop Shadow, and Bevel checkboxes to customize your text.
Click the Settings button to adjust the settings for each of these options as explained in the table
below.

7. Do one of the following:

* Click Apply to add the text to your image, and keep the Text tool open so you can add more text.
The Text tool creates a new, empty marquee, and you can return to step 3 in the list above.

* Click Done to add the text to your image, and leave the tool. If you still have an empty marquee
open, it will be discarded.

* Click Cancel to discard your changes and leave the tool.

Add Text Options
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Bubble Text Settings

Effect Settings

Drop Shadow Settings

Bevel Settings

L
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Talk

Thought

Stem Angle

Thickness
Length
Fill

Border

Effect

Distance

Blur

Opacity

Angle

Bevel

Strength

Elevation

Angle

Encloses your text in a comic-book text bubble with a
pointed stem.

Encloses your text in a comic-book text bubble with a
dotted stem.

Specifies the direction of the text bubble stem. Drag
the arrow to adjust the angle.

Specifies the thickness of the text bubble border.
Specifies the length of the text bubble stem.

Specifies the background color of the text bubble.
Click the arrow to select a color.

Specifies the color of the text bubble border. Click the
arrow to select a color.

Specifies the effect you want to apply to your text.
Each effect has different options that control its
appearance. Drag the sliders to adjust the
appearance of the text.

Specifies the distance between the drop shadow and
the text. The higher the value, the farther the shadow
and the higher the text appears.

If a drop shadow is cut off, or has a noticeably sharp
edge, you may need to increase the size of the text
rectangle.

Specifies the amount of blur applied to the drop
shadow. Sharp shadows tend to seem less realistic
than those with a slight blur.

Specifies the darkness of the drop shadow where it
falls on the image.

Specifies the direction of the imaginary light source
that creates the drop shadow. Drag the arrow to
adjust the angle — note that this also adjusts the
shading of the text bevel.

Specifies how much of each letter's edge is bevelled.
Higher values give the text a more rounded, smoother
look.

Specifies the difference between the highest and
lowest points on the text. Higher values heighten the
difference between the flat portions of the text and the
bevelled edges.

Specifies the height of the imaginary light source that
creates the bevel's shadowed effect. Lower values
produce longer shadows on the text, while a higher
value produces a more direct lighting effect and
shorter shadows.

Specifies the direction of the imaginary light source
that creates the bevel effect. Drag the arrow to adjust
the angle — note that this also adjusts the angle of the
drop shadow.

_} You can right-click a slider to reset to the default value.
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Adding a Watermark to an Image

You can use the Watermark tool to add a watermark to a photo. You can move the watermark to any position on the
photo. You can also change the opacity of the watermark and blend the watermark into the image.

You can save your settings as a preset for future use.

You will need to create a watermark image before you can add the watermark to your photos.

To Add a Watermark to an Image:

1.

10.

In Edit mode, in the Add group, select Watermark. A watermark displays in the center of the photo by
default.

4 j You can also access the Watermark tool from the Filter drop-down menu or Filter toolbar.

Click Browse, select your watermark, and then click Open.

Click and drag the watermark to reposition it anywhere on your image, or click Center to quickly position
the watermark image in the center.

Drag the marquee handles to resize the watermark image.

Select Maintain aspect ratio when resizing if you want to resize the watermark image without
distorting it.

Select Apply Alpha Channel to apply the alpha channel if it is present in the watermark.
(Only TIF and ICO watermark files can have an alpha channel.)
Select Apply Transparency to make a color in the watermark transparent.

The default color is white. You can enter the RGB value of the color. If you do not know the RGB value,
move your mouse over the watermark preview thumbnail on the Edit panel, and then click on the color that
you want to make transparent.

Select an option from the Blending Mode drop-down list to specify how you want the watermark to blend
into the underlying image.

Drag the Opacity slider to specify the transparency of the watermark.

Do one of the following:
* Click Apply to add the watermark to your image, and keep the Watermark tool open.
* Click Done to add the watermark to your image, and leave the tool.

* Click Cancel to discard your changes and leave the tool.

/ ) You can right-click a slider to reset to the default value.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot

= reset your settings.

Adding Borders

You can use the Borders tool to add one or more borders and edge effects to your images. You can set the size of
each side of the border, change the color and texture of the border or pick up a color from within the image by
clicking on that color in the image.

There are libraries of edges and textures to get you started, but you can save your own textures or edges to the
ACDSee folder so that they appear in the library for you to use.
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You can also use Edge blur to soften the edges or blend the image into the background texture. You can also add a
third dimension to your images using the Drop Shadow and Raised edge effects.

Using combinations of multiple borders and edge effects can add to the mood and atmosphere of a photo,
emphasize contrast, and enhance color.

You can save your settings as a preset for future use.

To Add a Border to an Image:

1. In Edit mode, in the Add group, select Borders.
"j You can also access the Borders tool from the Filter drop-down menu or Filter toolbar.
1

2. Create the border by selecting its size, color, texture, edge, or edge effects as described in the Borders
options below.

3. Do one of the following:
* Click Done to apply your changes and close the Border tool.
* Click Cancel to discard all changes and close the tool.

4. Toadd another border, restart the border tool and repeat these steps.

# Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=£_ | reset your settings.

Border Options
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Eyedropper Picks up the color beneath the cursor when you click on the

6’ image. The border changes to the clicked color, which also
appears in the Color box on the Borders pane so that you can
adjust it if you open the Color dialog box.

f The eyedropper is not available when you are using a
-=£__| texture.

Border Size Sets the size of all the sides of the border
simultaneously. Drag the slider left and right to
adjust the width of the border. You can also type
in a different number or use the up and down
arrows to change the size of the border.

The text below the Size field shows the final size of
your image with the border added. The final size
changes dynamically as you adjust the size of the

border.
Advanced Opens a fly-out of advanced size controls. Use the
size sliders, up- and down-arrow keys, or typein a
controls number, to set the size of each side of the border

individually. For example, you can set the bottom
border to be larger to include a space for
copyright information. Click on the arrow beside
the Size slider to open the advanced size controls
menu.

Color box Activates when you select the Color radio button.

Do any of the following:

* Click on a color in the image to make the
border that color. The clicked color
appears in the Color box.

* Click on the color in the middle of the Color
box to open the Colors dialog, where you
can adjust the color in multiple ways.

* Click the down-arrow beside the box and
hover over the quick-color box until you
find a color you like. When you click inside
the quick color box, the picked color
appears in the Color box and the border
changes to the selected color.

Texture Activates when you select the Texture radio
box button.

Do any of the following:

* Click the side arrow to open the texture
library and view thumbnails of textures to
select.

#* Click the forward and back arrows to
browse through the textures one at a time,
without opening the library.

Edge Straight Sets the edge of the border to be a straight line.
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Irregular

Edge blur

Edge effects Drop
shadow

Raised

Activates when you select the Irregular radio
button.

Do any of the following:

* Click the side arrow beside the edge box to
open the edge library and view thumbnails
of edges to select.

* Click the forward and back arrows to
browse through the edges one at a time,
without opening the library.

Blurs the edges of the edge of the image into the
border. Drag the slider to the right to increase the
blur, or to the left to decrease the blur.

Adds a drop shadow to the image that appears to
lift it off the page. The drop shadow appears
behind the image, between it and the border. You
can adjust the depth of the blur on the edge of the
shadow, and the transparency of the shadow,
which affects how much of the border shows
through the shadow. You can also change the
direction of the imaginary source of light by
dragging the glow on the Light Source ball.

* Blur: Adjusts the blur on the edge of the
shadow when you drag the slider.

* Opacity: Adjusts the transparency of the
drop shadow when you drag the slider.

Adds a raised edge to the image that appears to
raise it above the border, giving it a 3D look. The
raised effect is applied to the image, between it
and the border. You can change the direction of
the imaginary source of light of the raised edge by
dragging the glow on the Light Source ball. You
can also adjust the size, strength, and color of the
raised edge in the following ways:

* Size: Drag the slider to the right to
increase the size of the raised edge so that
it appears higher. The greater the size the
more rounded the effect.

* Strength: Drag the slider to the right to
increase the 3D effect of the raised edge.

* Colored: Select this option to apply the
border color to the raised edge.

Light Source Activates when you click either the Drop shadow or Raised
checkboxes. Click and drag the glow on the ball to reposition the
imaginary light source for the 3D effect of the Drop shadow or
Raised edge effects.

'_";‘ You can right-click a slider to reset to the default value.
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Adding Your Own Textures or Edges

It is possible to add custom textures and edges to the libraries in the Borders tool. If you make your own edges or
textures, or own a collection from the Internet, you can add them to the texture and edge libraries. You can also
delete existing files from the libraries to make room for others.

The textures or edges have to be in the following file formats with these extensions:
+ BMP
+ EMF
+ GIF
+ JPG
+ GIF
* PNG

+ TIF

Textures

As the textures are tiled, it is important to use an image that can be seamlessly repeated. The files are used at
their full resolution, not scaled up or down. For example, if your texture image is 100 x 100 pixels and you are
creating a bordered image thatis 1000 x 1000 pixels, then your texture file will be tiled 10 times. If you use a
texture file that is 1000 x 1000 pixels, then there would just be the one texture tile for the whole border.

To Add Your Own Textures to the Texture Library:
1. In ACDSee, close the Borders tool if it is open.
2. Copy and paste your texture files into this folder:
C:\Program Files\Common Files\ACD Systems\borders\textures
3. In Manage mode, select the image you want to use and then click Tools | Edit.
4. Inthe Add group, click Borders.

5. Select the Texture radio button and then click the arrow on the right side of the texture box to open the
texture library.

Thumbnails of the textures display for you to select.

Edges

Edge files are grayscale images that are resized to fit the image. The image file shows through any areas in the
edge file that are white, and does not show through any black areas. Pixels that are tones of gray in the edge file
show through with relative opacity depending on how close the pixels are to black or white (in other words, the
darker the gray pixel, the less it shows through).

To Add Your Own Edges to the Edges Library:
1. In ACDSeg, close the Borders tool if it is open.
2. Copy and paste your edge files into this folder:
C:\Program Files\Common Files\ACD Systems\borders\edges
3. In Manage mode, select the image you want to use and then click Tools | Edit.

4. Inthe Add group, click Borders.
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5. Select the Irregular radio button and then click the arrow on the right side of the edge box to open the
edge library.

Thumbnails of the edges display for you to select.

,_/ If you open an image with borders already applied, another border will be applied to the image.

Adding a Vignette

You can use the Vignette effect to add a frame around a subject, such as a person or a bouquet of flowers. You can
change the focal point in the portrait. You can also control the appearance of the border.

You can save your settings as a preset for future use.
To Apply a Vignette Effect:
1. In Edit mode, in the Add group, select Vignette.
F 3

j You can also access the Vignette tool from the Filter drop-down menu or Filter toolbar.
k

2. Setthe options as described below.
3. Do one of the following:
* Click Done to apply your changes and close the tab.

* Click Cancel to discard all changes and close the tab.

# Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=£_ | reset your settings.

Vignette Options
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Horizontal

Vertical

Clear zone

Transition zone

Stretch
Shape

Show outline

Frame

Frame settings
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Specifies the focal point of the portrait on the horizontal axis. A value of 500 places
the center in the middle of the photo.

Specifies the focal point of the portrait on the vertical axis. A value of 500 places the
center in the middle of the photo.

Specifies the size of the clear area around the focal point in the portrait. Drag the
slider to the left to reduce the size of the clear area. Drag the slider to the right to
increase the size of the clear area.

Specifies the width of the transition area between the clear zone and the frame. Drag
the slider to the left to narrow the transition area. Drag the slider to the right to widen
the transition area.

Stretches the vignette horizontally to make the shape elliptical rather than round.

Specifies the shape of the frame:
* Round: Select Round if you want the frame to be round.

* Rectangular: Select Rectangular if you want the frame to be square.

Select Show outline if you want to display an outline that shows the outside edge of
the clear zone and the inside edge of the frame.

Applies the following special effects to the vignette frame area around the focal point:

* Color: Changes the color of the frame area to the color you select in the color
picker.

* Saturation: Removes color from the people or objects in the vignette frame
so they are gray scale.

* Blur: Blurs the vignette frame area.
* Clouds: Applies a Clouds effect to the frame area.

* Edges: Applies an Edges effect by tracing the lines and details of people or
objects with neon colors.

* Radial Waves: Creates the appearance of waves radiating from the focal
point into the frame area.

* Radial Blur: Creates a Radial Blur that rotates and stretches the frame area.
* Zoom Blur: Applies a Zoom Blur to the frame area.

* Crayon Edges: Applies the Crayon Edges effect by tracing the lines and
details around people or objects with crayon.

* Dauber: Creates the impression that the people or objects around the focal
point were painted with a brush.

* Pixelate: Applies a pixel effect to the frame.
* 0ld: Applies an aging effect to the frame to make it look like an old photo.

* Glowing Edges: Applies glowing edges to all the strong lines in the frame
area.

* Ripple: Adds ripples to the frame so that it looks like liquid ripples moving
outwards from the focal area.

The settings that display below the Frame drop-down list change depending on the
frame you select. For example, if you select Color in the Frame drop-down list, a
color picker displays so that you can select the color for the vignette. Similarly, if you
select Blur in the Frame drop-down list, a slider appears that you can use to change
the amount of blur surrounding the photo. For some choices, like Edges, there are no
settings to apply.
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’) You can right-click a slider to reset to the default value.

Adding a Tilt-Shift Effect

You can use the Tilt-Shift effect to create emphasis on specific subjects in your photos, or make your photos look
like miniature landscapes.

To Use the Tilt-Shift Effect:

1. In Edit mode, in the Add group, select Tilt-Shift.

"j You can also access the Tilt-Shift tool from the Filter drop-down menu or Filter toolbar.

2. On the Tilt-Shift panel, set the options as described below.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Tilt-Shift Options

Use the guides on the image to place the effect. The inside boxes represent the points where the focus is
transitioning to blur. Complete blur occurs at the outside boxes. Move the boxes to define where the effect will
begin or end. Hold down the Shift key while positioning the effect to lock to the nearest 45° angle, for
straightness.

Blurring Select the type of blur you want from the Blur drop-down menu.
* Lens Blur
* Gaussian Blur

See Blur Types for more information.

Amount Specifies the amount of blur
applied.
Bokeh Frequency Specifies how often the bokeh
shapes occur.
Bokeh Brightness Specifies how bright the bokeh
shapes appear.
Bokeh Sides Defines the number of sides the
bokeh shape will have.
Saturation Drag the slider to the right to intensify the effect.
-
=
You can use the Edit Brush to paint this effect onto specific areas of your image.

Fa
I) You can use the Gradient tool m to transition this effect across specific areas of your image.

Fan

|£ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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About Special Effect Filters

You can use filters to add unique effects to your images. ACDSee includes more than 40 special effect filters, such
as Crosshatch, Pencil Drawing, and Solarize.

To Access the Special Effects Filters:

In Edit mode, in the Add group, select Special Effect.

L

i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

For more information about each effect, click the Help button to view a Help file page specific to that effect.

Applying a Bathroom Window Effect

The Bathroom Window effect divides your images into bars, transforming them so they resemble the view through
privacy glass often found in bathrooms. You can select or change the Bathroom Window options to apply this
effect to your image.

You can save your settings as a preset for future use.

To Apply a Bathroom Window Effect:

1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Bathroom Window.
3. Drag the Bar width slider to set the thickness of the bars. Thinner bars result in a more distorted image.
4. Inthe Bar direction area, select one of the following to specify the orientation of the bars in your image:
* Vertical
* Horizontal
5. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

i ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Applying a Blinds Effect

Use the Blinds effect to divide your image into bars that look like venetian or vertical window blinds. You can
customize the characteristics of the blinds you would like added to your image.

You can save your settings as a preset for future use.
To Apply a Blinds Effect:

1. In Edit mode, in the Add group, select Special Effect.

i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Blinds.
3. On the Blinds panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Blinds Options

Width Specifies the width of the blinds. Type a number from 1 to 1000 or drag the slider to
adjust the width of each blind. As the value increases, the width of the blind also
increases.

Opacity Specifies the opacity of the blinds. Type a number from 1 to 99 or drag the slider to
adjust the opacity of the blinds. The higher the opacity, the more the image is
obscured.

Angle Specifies the angle of the blinds. Type a number from 1 to 360 or drag the arrow to

adjust the angle.

Blind color Specifies the color of the blinds.

L

/ ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.
“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Blue Steel Effect

You can use the Blue Steel effect to give your images a stylish blue tint.

To Apply the Blue Steel Effect:
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1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Blue Steel.
3. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

") You can right-click a slider to reset to the default value.
? il

You can use the Edit Brush to paint this effect onto specific areas of your image.
P

J You can use the Gradient tool m to transition this effect across specific areas of your image.

P

'j) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Bob Ross Effect
You can use the Bob Ross effect to give your images a painted look.
You can save your settings as a preset for future use.

To Give Your Photos a Bob Ross Effect:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Bob Ross.

3. On the Bob Ross panel, set the options as described in the table below.

4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Bob Ross Options
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Brush size

Coverage

Paint thickness

Colorfulness

Background Image
color

Randomize

Drag the Brush size slider to specify the width of the brush strokes in
the effect. The higher value, the wider the brush stroke.

Drag the Coverage slider to specify the amount or density of paint on
the "canvas" of your photo.

Drag the Paint thickness slider to specify how three dimensional the
paint appears.

Drag the Colorfulness slider to specify the amount of color in your
image.

Enable the Image checkbox to use the color in the image as the
background color behind the brush strokes added to the photo. To use
a different color for the background, disable the Image checkbox and
select a new color from the color drop-down menu.

Indicates the random placement of the paint daubs. When you apply
the Bob Ross effect to an image, ACDSee places the daubs randomly.
This makes the paint daubs different every time you apply the filter. To
generate a new random placement of the paint daubs, click Randomize.

’) You can right-click a slider to reset to the default value.

r

I
You can use the Edit Brush

Pan

i

to paint this effect onto specific areas of your image.

Fa
IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

Applying a Bulge Effect

IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Use the Bulge effect to stretch or shrink areas of your images horizontally and vertically. You can customize the
strength, radius and position of the distortion.

You can save your settings as a preset for future use.

To Apply a Bulge Effect:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Bulge.

3. On the Bulge panel, set the options as described below.

4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Bulge and Shrink Options
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Horizontal position
Vertical position

Radius
Strength

Background color

Bulge direction

"

"
I

"
I

Specifies the center of the distortion along the horizontal axis. A lower value moves
the distortion towards the left side of the image, while a higher value moves it
towards the right side of the image.

Specifies the center of the distortion along the vertical axis. A lower value moves the
distortion towards the bottom of the image, while a higher value moves it towards the
top of the image.

Specifies the radius of the distorted area. A lower value decreases the radius of the
distortion, while a higher value increases the radius of the distortion.

Specifies the strength of the distortion. A negative value shrinks the center of the
distortion, while a higher value bulges the distortion.

Specifies the background color for the filtered image.

Select the Image checkbox to use the original image color, or click the color picker to
select a different color.

Specifies the direction of the distortion. Select one or both of the following options:
* Horizontal: Moves the distortion horizontally.

* Vertical: Moves the distortion vertically.

C

/ ) You can right-click a slider to reset to the default value.
You can use the Edit Brush to paint this effect onto specific areas of your image.

) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Cartoon Effect

You can use the Cartoon Effect to give your images a sketched appearance.

You can save your settings as a preset for future use.

To Apply a Cartoon Effect:

1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Cartoon.

3. On the Cartoon panel, set the options as described below.

4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Cartoon Options
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Shading strength Specifies the strength of the shading in the image. The higher the setting, the
more intense the shading that is applied to the image.

Shading radius Specifies how spread out the shading is.

Shading threshold Specifies how sharp an edge must be in the image before shading is applied. If
you specify a higher value, more edges in the photo will be shaded.

Smoothness Controls how smooth the transitions between similar colors are.

Outline detail Specifies how much the details are outlined in black.

Outline strength Specifies how strong the black outlines are applied.

Artifact Suppression Remove small details Prevents small details from being outlined in

black, allowing the image to appear more
cartoon-like.

' ) You can right-click a slider to reset to the default value.

 § i[>

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Childhood Effect

You can use the Childhood effect to give your images a dreamy, nostalgic look.
To Apply the Childhood Effect:
1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Childhood.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

i ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.
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“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Collage Effect

You can use the Collage effect to creatively break up a photo into a number of photos.
You can save your settings as a preset for future use.

To Use the Collage Effect:

1. In Edit mode, in the Add group, select Special Effect.

i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Collage.
3. Drag the sliders to set the Number and Size of the photos.

4. Select a background color by clicking the drop-down arrow to display gradients of colors, or click the color
box to display a dialog of swatches to choose from.

5. If you would like to reshuffle the photos, click Randomize.
6. Do one of the following:
* Click Done to accept your changes and close the panel.
* Click Cancel to discard your changes and close the panel.

7. Click Exit to leave Special Effects, and return to the Filter menu.

i ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Colored Edges Effect

You can use the Colored Edges effect to trace the lines and details of people or objects in your images.

You can save your settings as a preset for future use.

To Apply a Colored Edges Effect:
1. In Edit mode, in the Add group, select Special Effect.

i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
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2. Click Colored Edges.
3. On the Colored Edges panel, set the options as described below.

4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Colored Edges Options

Intensity Specifies the amount of color added to the edges within the image. The higher the
setting, the thicker the color that is applied to the image.

Edge color Specifies the color of the edges.

Edge detection Specifies the edge detection algorithm. The algorithm controls the formula used to

detect the edges and the direction of the edge indicators.

Blurring Blurs the edges in the image. Select the Use blurring checkbox, and then select a
blur setting to determine how much blur is applied.

’) You can right-click a slider to reset to the default value.

Fa
You can use the Edit Brush to paint this effect onto specific areas of your image.
P

IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

L
IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Contours Effect

You can use the Contours effect to draw contour lines on your image to create a cartoon effect. Select or change
the rounding, line frequency, color and strength setting to apply to your image.

You can save your settings as a preset for future use.

To Apply a Contours Effect:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Contours.
3. On the Contours panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Contours Options
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Rounding Specifies the amount of curve in the contour lines. The higher the value, the rounder
the lines.

Line frequency Specifies the amount of space between the contour lines. The higher the value, the
closer the lines move together.

Strength Specifies the strength of the line. The higher the value, the darker the line.

Line color Specifies the color of the contour lines.

' ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Crayon Drawing Effect

You can use the Crayon Drawing effect to give your photos the appearance of a crayon drawing.
To Use the Crayon Drawing Effect:
1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Crayon Drawing.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Crosshatch Effect

You can use the Crosshatch effect to add crosshatching to an image.

To Use the Crosshatch Effect:
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1. In Edit mode, in the Add group, select Special Effect.

( ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Crosshatch.
3. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

‘iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Dauber Effect

You can use the Dauber effect to make your images look like they were painted with a paint dauber. Select or
change the settings of the effect you want applied to your image, such as intensity, frequency and more.

You can save your settings as a preset for future use.
To Use the Dauber Effect:

1. In Edit mode, in the Add group, select Special Effect.

i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Dauber.

3. On the Dauber panel, set the options as described below.

4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Dauber Options

Intensity Specifies the amount of color applied with each daub.
Frequency Specifies the number of daubs added to the image.
Background color Specifies the background color of the filtered image.

Select the Image checkbox to use the original image colors or click the color picker to
select a different color.

Randomize Indicates the random placement of the paint daubs.

When you apply the Dauber effect to an image, ACDSee places the daubs randomly.
This makes the paint daubs different every time you apply the filter. You can define a
specific random seed to generate identical daubs.

To generate a new random seed, click Randomize.
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/ ) You can right-click a slider to reset to the default value.

“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

‘iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Dramatic Effect

You can use the Dramatic effect to make your images look dramatic and moody by drastically changing the
contrast in specific areas.

You can save your settings as a preset for future use.
To Apply a Dramatic Effect:
1. In Edit mode, in the Add group, select Special Effect.
i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Dramatic.

3. On the Dramatic panel, set the options as described below.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Dramatic Options

Strength Specifies the strength of the contrast being applied.

Spread Specifies how far the effect spreads over the details in the photo.

i ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying an Edge Detect Effect

You can use the Edge Detect effect to create a highlighted outline of your image. After creating a black image, the
effect uses colored lines to outline the detail of an image where significant color differences exist. Greater

Page 190 of 329



ACDSee Photo Studio Standard 2019

differences between colors in the original image produce brighter outline colors. (The Sobel effect is similar to the
Edge Detect effect, but produces sharper and brighter outlines.)

To Use the Edge Detect Effect:
1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Edge Detect.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

9 il e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Fa
I) You can use the Gradient tool m to transition this effect across specific areas of your image.

Fan

' ) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

.
I

Applying an Emboss Effect

You can use the Emboss effect to add a grayscale relief to an image.

You can save your settings as a preset for future use.

To Emboss an Image:

1. In Edit mode, in the Add group, select Special Effect.

*’) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Emboss.
3. Onthe Emboss panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Emboss Options

Elevation Specifies the light source's elevation on the image. Lower values produce more
shadows and a darker image. Higher values produce fewer shadows and a lighter
image.

Weight Specifies the amount of relief added to the image. Higher values increase the relief
depth.

Azimuth Specifies the angle of shadows that extend from the edges of image details. A value of

0 adds shadows to the left side, while a value of 180 adds shadows to the right side.
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’) You can right-click a slider to reset to the default value.

r

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

=
'j You can use the Gradient tool m to transition this effect across specific areas of your image.

P
'jj You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Furry Edges Effect

You can use the Furry Edges effect to add fur and bristles to the lines and details of people or objects in your
image.
You can save your settings as a preset for future use.

To Use the Furry Edges Effect:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Furry Edges.
3. On the Furry Edges panel, set the options as described below.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Furry Edges Options
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Frequency Specifies how much fur is added to the image. The higher the setting, the more
dense the fur that is applied to the image.

Threshold Specifies how sharp an edge must be before fur is applied to it. As the value
decreases, the area of the image that fur is added to increases.

Fur length Specifies the length of each strand of fur. As the value increases, the length of each
fur strand also increases.

Variance Specifies how much of the fur grows in the direction indicated by the Hair direction
setting. The higher the value, the more random the fur direction will be.

Hair direction Specifies the general direction in which fur appears to grow.

Edge detection Specifies the edge detection algorithm. The algorithm controls the formula used to

detect the edges and the direction of the edge indicators.

Background color Specifies the background color of the filtered image. Select the Image checkbox to
use the original image colors, or click the color picker to select a different color.

Fur color Specifies the color of the fur. Select the Image checkbox to use the original image
colors, or click the color picker to select a different color.

Randomize Indicates the random placement of the fur strands.

When you apply the Furry Edges effect to an image, ACDSee places the fur randomly.
This makes the fur strands different every time you apply the filter. You can define a
specific random seed to generate identical fur patterns.

To generate a new random seed, click Randomize.

' ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.
“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Glowing Edges Effect

You can use the Glowing Edges effect to add color to the lines and details of people or objects in your images. The
colored lines and details appear to glow.

You can save your settings as a preset for future use.

To Apply a Glowing Edges Effect:
1. In Edit mode, in the Add group, select Special Effect.

- ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Glowing Edges.

3. On the Glowing Edges panel, set the options as described below.
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4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Glowing Edges Options

Intensity Specifies the amount of color added to the edges within the image. The higher the
setting, the more intense the color that is applied to the image.

Color Specifies the color of the edges.

“') You can right-click a slider to reset to the default value.
b

Fa

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Fai
"hd) You can use the Gradient tool m to transition this effect across specific areas of your image.

Fa

"-'J You can use the Radial Gradient tool _ to apply effects around, or directly to, a center point.

Applying a Granite Effect

You can use the Granite effect to give your images the appearance of being painted on a rock wall.
You can save your settings as a preset for future use.

To Use the Granite Effect:

1. In Edit mode, in the Add group, select Special Effect.

"j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
k

2. Click Granite.
3. On the Granite panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Granite Options

Light Angle Specifies the direction from which an imaginary light source is shining on the image.
Drag the arrow to adjust the angle. Different light angles will change the highlights
and shadows in the peaks and valleys on the rock.

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.
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“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Lomo Effect
Simulate the retro-effects of a lomo camera. Photos taken with a lomo camera are high contrast, with a golden hue
and a noticeable vignette.

You can save your settings as a preset for future use.

To Use the Lomo Effect:

1. In Edit mode, in the Add group, select Special Effect.

_;i You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

Click Lomo.

Drag the Color Distortion slider to the right to increase the color distortion.

Drag the Vignette Strength slider to the right to increase the vignette strength.

aua b W N

Do one of the following:
* Click Done to accept your changes and close the panel.
* Click Cancel to discard your changes and close the panel.

6. Click Exit to leave Special Effects, and return to the Filter menu.

) You can right-click a slider to reset to the default value.

 { e

You can use the Edit Brush to paint this effect onto specific areas of your image.

‘ii You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Mirror Effect

You can use the Mirror effect to reflect an image along the horizontal or vertical axis. Select or change the Mirror
options to apply mirroring to your image, including mirror axis and direction.

You can save your settings as a preset for future use.

To Apply a Mirror Effect:
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In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

Click Mirror.

On the Mirror panel, in the Mirror direction area, select one of the following options to indicate which
direction you want to mirror the image:

* Horizontal
* Vertical

Drag the Mirror axis slider to adjust the position of the mirror. A value of 500 places the mirror in the
center of the image.

Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

i

You can use the Edit Brush to paint this effect onto specific areas of your image.
You can use the Gradient tool m to transition this effect across specific areas of your image.

You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Negative Effect

You can

use the Negative effect to create a negative of your image. You can also apply the Negative filter to a

negative scanned from a roll of film to produce a positive image.

To Create an Image Negative:

1.

2.
3.

In Edit mode, in the Add group, select Special Effect.

"_j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

Click Negative.
Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

i

You can use the Edit Brush to paint this effect onto specific areas of your image.
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“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying an QOil Paint Effect

You can use the Oil Paint effect to give your images a painted appearance.
You can save your settings as a preset for future use.
To Create an Oil Painting from a Photo:

1. In Edit mode, in the Add group, select Special Effect.

) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Oil Paint.

3. On the Qil Paint panel, drag the Brush width slider to specify the width of the brush strokes in the effect.
The higher the value, the wider the brush stroke.

4. Drag the Variance slider to specify the color variance in each brush stroke. Higher values increase the
number of colors used in each stroke.

5. Drag the Vibrance slider to adjust the intensity of the colors in the image.
6. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

|

) You can right-click a slider to reset to the default value.
You can use the Edit Brush to paint this effect onto specific areas of your image.

Y )
“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying the Old Effect

You can use the Old effect to give your images an antique look. (The Old effect is similar to the Sepia effect, but
produces a more realistic appearance of age.)

You can save your settings as a preset for future use.

To Apply the Old Effect:
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1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click old.
3. On the Old panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Old Options

Age Specifies the intensity or degree of the effect. (The numbers do not correspond to
how old the photo should appear.)

’) You can right-click a slider to reset to the default value.

b | i

You can use the Edit Brush to paint this effect onto specific areas of your image.

L
IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

Pan

IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying the Orton Effect

Create beautiful impressionistic images with the Orton effect. The Orton effect mimics a darkroom technique
created by sandwiching two images together, one of which is slightly out of focus, and both of which are slightly
overexposed.

You can save your settings as a preset for future use.

To Use the Orton Effect:

1. In Edit mode, in the Add group, select Special Effect.

"j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Orton.
3. Drag the Blur, Contrast, and Brightness sliders to adjust each effect.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

5. Click Exit to leave Special Effects, and return to the Filter menu.

“') You can right-click a slider to reset to the default value.

L
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You can use the Edit Brush to paint this effect onto specific areas of your image.

Fai
I) You can use the Gradient tool m to transition this effect across specific areas of your image.
P

' ) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

.
I

Applying an Outline Effect

The Outline effect is similar to the Edge Detect effect. You can use the Outline effect to create a highlighted outline
of your image. However, with the Outline effect you can control the thickness of the outline, whether an edge is
outlined or not, and the color that displays behind the outlined image.

You can save your settings as a preset for future use.
To Use the Outline Effect:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Outline.
3. On the Outline panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Outline Options

Line width Specifies the width of the outline in the effect. The higher the value, the wider the
outline.
Threshold Specifies how sharp an edge must be in order to be outlined. If you specify a higher

value, more edges in the photo will be outlined.

Background color Specifies the background color of the filtered image. Click the color picker to select a
different color.

’) You can right-click a slider to reset to the default value.

T

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

P

) You can use the Gradient tool m to transition this effect across specific areas of your image.
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“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Pencil Drawing Effect

You can use the Pencil Drawing effect to create a pencil drawing from your images.

To Create a Pencil Drawing from an Image:

1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Pencil Drawing.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

4 i

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Pixel Explosion Effect

You can use the Pixel Explosion effect to explode pixels from a center point in your images. Select or change the
Pixel Explosion settings, such as intensity and direction, to apply this effect to your image.

You can save your settings as a preset for future use.

To Use the Pixel Explosion Effect:

1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Pixel Explosion.
3. On the Pixel Explosion panel, set the options as described below.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Pixel Explosion Options
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Horizontal center Specifies the center point of the explosion on the horizontal axis. A value of 500
places the explosion at the middle of the image.

Vertical center Specifies the center point of the explosion on the vertical axis. A value of 500 places
the explosion at the middle of the image.

Intensity Specifies the intensity of the explosion. A higher value creates a larger, more brilliant
spread of the pixels in the image.

Explosion direction Specifies the direction of the explosion. Select one or both of the following:

* Explode horizontally: Explodes the pixels towards the right and left sides
of the image.

* Explode vertically: Explodes the pixels towards the top and bottom of the
image.

Randomize Indicates the random placement of the pixels.

When you apply the Pixel Explosion effect to an image, ACDSee places the pixels
randomly. This makes the pixels different every time you apply the filter. You can
define a specific random seed to generate identical pixel patterns.

To generate a new random seed, click Randomize.

i ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

‘iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Pixelate Effect

A pixel is the smallest piece of a digital image, arranged in rows and columns. When you reduce the resolution of
your image, the size of the pixel increases and produces blurring. You can use the Pixelate effect to increase the
size of the pixels in your image.

You can save your settings as a preset for future use.

To Apply a Pixelate Effect:
1. In Edit mode, in the Add group, select Special Effect.

- ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Pixelate.

3. On the Pixelate panel, drag the Width and Height sliders to set the size of the pixels in your image. Select
the Square checkbox to make the width and height equal.
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4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

' ) You can right-click a slider to reset to the default value.

 { e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Posterize Effect

You can use the Posterize effect to reduce the number of brightness levels in your image. Select or change the
Posterize options to apply this effect to your image.

You can save your settings as a preset for future use.

To Apply a Posterize Effect:

1. In Edit mode, in the Add group, select Special Effect.

- ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Posterize.

3. On the Posterize panel, drag the Brightness levels slider to adjust the variance of colors in the image.
The lower the value, the fewer colors used in the image.

4. Do one of the following:

* Click Done to accept your changes and close the panel.

-

Click Cancel to discard your changes and close the panel.

i ) You can right-click a slider to reset to the default value.

 § e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

‘iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Applying a Purple Haze Effect

You can use the Purple Haze effect to give your image a hyper-retro, purple tint.

To Apply the Purple Haze Effect:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Purple Haze.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

L

P

L

C

’) You can right-click a slider to reset to the default value.
) You can use the Edit Brush to paint this effect onto specific areas of your image.

Fa

L

You can use the Gradient tool m to transition this effect across specific areas of your image.

-
I) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Radial Waves Effect

You can use the Radial Waves effect to display waves radiating from a center point in the photo. You can change
the center point in the photo and you can also control the appearance of the waves.

You can save your settings as a preset for future use.
To Apply a Radial Waves Effect:
1. In Edit mode, in the Add group, select Special Effect.
") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Radial Waves.
3. On the Radial waves panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Radial Waves Options
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Horizontal position Specifies the center of the waves on the horizontal axis. A value of 500 places the
waves in the middle of the image.

Vertical position Specifies the center of the waves on the vertical axis. A value of 500 places the waves
in the middle of the image.

Amplitude Specifies the depth and height of each wave.

Wavelength Specifies the amount of space between waves.

Light strength Specifies the amount of light contrast between the top and bottom of each wave.

Background color Specifies the background color of the filtered image. Select the Image checkbox to

use the original image colors, or click the color picker to select a different color.

Wave direction Specifies the direction of the waves. Select one, or both, of the following:

* Wave horizontally: Makes the waves move towards the right and left sides
of the image.

* Wave vertically: Makes the waves move towards the top and bottom of the
image.

|

/ ) You can right-click a slider to reset to the default value.
You can use the Edit Brush to paint this effect onto specific areas of your image.

Y )
“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Rain Effect

You can use the Rain effect to make it look like it was raining when you took a photo. Control the amount, the angle,
strength and other characteristics of the rain.

You can save your settings as a preset for future use.
To Apply Rain to a Photo:

1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Rain.
3. On the Rain panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Rain Options
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Strength Specifies the length of the rain drops. Drag the slider to the right to increase the
length.
Opacity Specifies the opacity of the rain drops. Type a number from 0 to 100 or drag the

slider to adjust the opacity of the rain drops. The higher the opacity, the more the
image is obscured.

Amount Specifies the number of rain drops.

Angle variance Specifies the angle of the rain drops. Type a number from 0 to 50 or drag the arrow
to adjust the angle.

Strength variance Specifies how much variety there should be in the length of the rain drops. Drag the
slider to the left if you want rain drops to have a similar length. Drag the slider to the
right if you want to vary the length of rain drops. If you vary the length of rain drops
they look natural.

Background blur Specifies the amount of blur in the photo. Heavy rain will block your vision. Use this
option to blur the photo so the rain effect looks natural.

Angle Specifies the angle at which the rain drops are falling.

Color Specifies the color of the rain drops.

/ ) You can right-click a slider to reset to the default value.

L

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Ripple Effect

You can use the Ripple effect to divide your images into concentric circles that resembles what you see when you
drop a pebble into water. Select or change the Ripple settings to apply to your image, such as position, strength
and more.

You can save your settings as a preset for future use.
To Apply a Ripple Effect:
1. In Edit mode, in the Add group, select Special Effect.
i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Ripple.
3. On theRipple panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Ripple Options
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Horizontal position
Vertical position

Amplitude
Wavelength
Light strength

Background color

Ripple direction

?

Specifies the center of the ripples on the horizontal axis. A value of 500 places the
ripples in the middle of the image.

Specifies the center of the ripples on the vertical axis. A value of 500 places the
ripples in the middle of the image.

Specifies the depth and height of each ripple.
Specifies the amount of space between ripples.
Specifies the amount of light contrast between the top and bottom of each ripple.

Specifies the background color of the filtered image. Select the Image checkbox to
use the original image colors, or click the color picker to select a different color.

Specifies the direction of the ripples. Select one or both of the following:

* Ripple vertically: Makes the ripples move towards the top and bottom of the
image.

* Ripple horizontally: Makes the ripples move towards the right and left
sides of the image.

"% You can right-click a slider to reset to the default value.

|

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Scattered Tiles Effect

You can use the Scattered Tiles effect to divide your images into rectangular tiles, and scatter and stack the tiles.
Select or change the Scattered Tiles options to apply this effect to your image.

You can save your settings as a preset for future use.

To Apply a Scattered Tiles Effect:

1. In Edit mode, in the Add group, select Special Effect.

“m You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

.

2. Click Scattered Tiles.

3. On the Scattered Tiles panel, set the options as described below.

4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Scattered Tiles Options
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Tile size Specifies the size of the tiles.

Scatter amount Specifies how much the tiles will move from their original positions.

Background color Specifies the color of the background. Click the color picker to select a different color.
Randomize Indicates the random placement of the tiles.

When you apply the Scattered Tiles effect to an image, ACDSee places the tiles
randomly. This makes the effect different every time you apply the filter. You can
define a specific random seed to generate identical tile patterns.

To generate a new random seed, click Randomize.

’) You can right-click a slider to reset to the default value.

L

You can use the Edit Brush to paint this effect onto specific areas of your image.
P

IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

L
IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Sepia Effect

You can use the Sepia effect to give your images an antique look. (The Old effect is similar to the Sepia effect, but
produces a more realistic appearance of age.)

You can save your settings as a preset for future use.
To Add a Sepia Tone to an Image:
1. In Edit mode, in the Add group, select Special Effect.

L

*’) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Sepia.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

“') You can right-click a slider to reset to the default value.

Fan

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

-
I) You can use the Gradient tool m to transition this effect across specific areas of your image.
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Fan

' ) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

.
I

Applying a Seventies Effect

You can use the Seventies effect to give your images a retro look.

To Apply the Seventies Effect:

1. In Edit mode, in the Add group, select Special Effect.

"j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Seventies.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

’) You can right-click a slider to reset to the default value.

L
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You can use the Edit Brush to paint this effect onto specific areas of your image.

Pan

IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

P
IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Sheet Metal Effect

You can use the Sheet Metal effect to turn your images into sheet metal impressions.
You can save your settings as a preset for future use.
To Apply a Sheet Metal Effect:
1. In Edit mode, in the Add group, select Special Effect.
"j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Sheet Metal.
3. On the Sheet Metal panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Sheet Metal Options
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Rounding Specifies the amount of curve in the edges of the impressions.

Detail Specifies the amount of detail in the impression.

Angle Specifies the angle of the grain in the sheet metal.

Metal color Specifies the color of the sheet metal.

Direction Specifies the direction in which the sheet metal was manipulated. Select one of the
following:

* Indented: Stamps the metal from the top side of the image.

* Pushed out: Stamps the metal from underneath the image.

/ ) You can right-click a slider to reset to the default value.

 { e

You can use the Edit Brush to paint this effect onto specific areas of your image.
‘iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Shift Effect

You can use the Shift effect to divide your images into bars and shift them in random directions.

You can save your settings as a preset for future use.
To Apply a Shift Effect:
1. In Edit mode, in the Add group, select Special Effect.

- ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Shift.

3. On the Shift panel, set the options as described below.

4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Shift Options

Strength Specifies the amount of shift between the bars.

Width Specifies the width of each bar.

Angle Specifies the angle of the bars.

Background color Specifies the background color of the filtered image. Select the Image checkbox to

use the original image colors, or click the color picker to select a different color.

/ ) You can right-click a slider to reset to the default value.

L
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“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Slant Effect

You can use the Slant effect to make a photo appear slanted. For example, you could use the Slant effect to distort
a photo by pushing the top of the photo to the left and the bottom of the photo to the right. Similarly, you could use
the slant effect to push the left side of the photo upwards and the right side of the photo downwards.

You can save your settings as a preset for future use.
To Apply a Slant Effect:

1. In Edit mode, in the Add group, select Special Effect.

i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Slant.
3. On the Slant panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Slant Options

Amount Specifies the degree of the slant.

Fulcrum Specifies the center of the slant. Drag the slider to the left to place the center of the
slant near the bottom of the photo. Drag the slider to the right to place the center of
the slant near the top of the photo.

Background color Specifies the background color of the filtered image. Click the color picker to select a
different color.

Slant Direction Specifies the angle of the slant:

* Horizontal: Select Horizontal to push the top or bottom of the photo to the
left or right.

* Vertical: Select Vertical to push the left or right side of the photo up or down.

/ ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

‘iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

Page 210 of 329



ACDSee Photo Studio Standard 2019

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Sobel Effect

You can use the Sobel effect to create a highlighted outline of your image. After creating a black image, the effect
uses colored lines to outline the detail of an image where significant color differences exist. Greater differences

between colors in the original image produce brighter outline colors. (The Sobel effect is similar to the Edge Detect
effect, but produces sharper and brighter outlines.)

To Use the Sobel Effect:

1. In Edit mode, in the Add group, select Special Effect.

( ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Sobel.
3. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

‘iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Solarize Effect

You can use the Solarize effect to simulate the effect of overexposing an image, as though the film was exposed to
light before developing. Select or change the Solarize options to apply this effect to your image.

You can save your settings as a preset for future use.
To Apply a Solarize Effect:

1. In Edit mode, in the Add group, select Special Effect.

i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Solarize.
3. On the Solarize panel, drag the Threshold slider to specify the brightness threshold of the image.
4. In the Effect area, specify which pixels you want to adjust by selecting one of the following options:

* Solarize: adjusts pixels located above the specified threshold option. The effect takes any pixels
above the threshold and replaces them with their negative value. When you solarize an image, a
higher threshold value sets a brighter threshold, and colors need to be brighter to be
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overexposed.

* Lunarize: adjusts pixels located below the specified threshold option. The effect takes any pixels
below the threshold and replaces them with their negative value. When you lunarize an image, a
higher threshold value sets a darker threshold, and colors do not have to be as bright to be
overexposed.

5. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

' ) You can right-click a slider to reset to the default value.

 § i[>

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Somber Effect

You can use the Somber effect to give your images an austere or sleek look.
To Apply the Somber Effect:
1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Somber.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

i ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

‘iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Applying a Stained Glass Effect

You can use the Stained Glass effect to divide your image into fragments of a random size and shape, to give the
photo the appearance of a stained glass window. Control the size and position of the fragments using the effect
settings.

You can save your settings as a preset for future use.

To Apply a Stained Glass Effect:
1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Stained Glass.
3. On the Stained Glass panel, set the options as described below.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Stained Glass Options
Fragment size Specifies the size of the fragments.
Randomize Indicates the random placement of the fragments.

When you apply the Stained Glass effect to an image, ACDSee places the fragments
randomly. This makes the effect different every time you apply the filter. You can
define a specific random seed to generate identical fragment patterns.

To generate a new random seed, click Randomize.

’) You can right-click a slider to reset to the default value.

P

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Pan

IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

Fa
IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Sunspot Effect

You can use the Sunspot effect to add a bright spot in your images.

You can save your settings as a preset for future use.

To Apply a Sunspot Effect:
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1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Sunspot.

3. On the Sunspot panel, drag the Horizontal Position and Vertical Position sliders or click the image to
set the location of the sunspot.

4. Drag the Brightness slider to set the intensity of the sunspot.
5. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

’) You can right-click a slider to reset to the default value.

L

Applying a Swirl Effect

You can use the Swirl effect to rotate and stretch people and objects in your image.

You can save your settings as a preset for future use.
To Apply a Swirl Effect:
1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Swirl.
3. On the Swirl panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Swirl Options
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Horizontal position Specifies the center of the swirl on the horizontal axis. A value of 500 places the swirl
in the middle of the image.

Vertical position Specifies the center of the swirl on the vertical axis. A value of 500 places the swirl in
the middle of the image.

Radius Specifies the size of the swirl effect.

Strength Specifies the strength and direction of the swirl. Higher values create a clockwise

swirl, while negative values create a counter-clockwise swirl.

Focus Specifies the concentration of the swirl. Higher values concentrate the effect on the
center of the swirl, while lower values spread the swirl across the image.

Background color Specifies the background color of the filtered image. Select the Image checkbox to
use the original image colors, or click the color picker to select a different color.

Swirl direction Specifies the direction of the swirl. Select one or both of the following:

* Swirl horizontally: Moves the swirl towards the top and bottom of the
image.

* Swirl vertically: Moves the swirl towards the right and left sides of the
image.

' ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying the Threshold Effect

You can use the Threshold effect to create a black and white image.

You can save your settings as a preset for future use.

To Apply the Threshold Effect:

1. In Edit mode, in the Add group, select Special Effect.
i ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Threshold.
3. On the Threshold panel, set the options as described below.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Threshold Options
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Threshold This slider determines which pixels become black and which ones become white in
the black and white image. Any pixels that are brighter than the selected threshold
will become white and any pixels that are darker than the threshold will become
black.

i ) You can right-click a slider to reset to the default value.

i

You can use the Edit Brush to paint this effect onto specific areas of your image.
“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

‘iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Topography Effect

You can use the Topography effect to change the details of your images into contour lines.
You can save your settings as a preset for future use.
To Apply a Topography Effect:

1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Topography.

3. On the Topographic Map panel, drag the Rounding slider to adjust the amount of curve in the contour
lines.

4. Drag the Number of lines slider to specify how many contour lines you want to add.
5. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

i

You can use the Edit Brush to paint this effect onto specific areas of your image.

/ ) You can right-click a slider to reset to the default value.
You can use the Gradient tool m to transition this effect across specific areas of your image.

?
:
.

You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Applying a Water Effect

You can use the Water effect to insert an expanse of water below the subject of a photo and to display a reflection
of the subject in the water. You can control the position of the water below the subject. For example, you can
position the water below a person's chin, or below their waist. You can also control the appearance of ripples in
the water and how dark or light the water appears.

You can save your settings as a preset for future use.

To Apply a Water Effect:

1. In Edit mode, in the Add group, select Special Effect.

4 j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Water.
3. On the Water panel, set the options as described below.
4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Water Options

Position Specifies the position of the water below the subject of the photo.

Amplitude Specifies the height of the ripples in the water. Drag the slider to the left to reduce
the height of the ripples and the distortion caused by the ripples. Drag the slider to
the right to increase the height of the ripples and the distortion caused by the
ripples.

Wavelength Specifies the distance between ripples. Drag the slider to the left to reduce the
distance between ripples and increase the distortion caused by the ripples. Drag the
slider to the right to increase the distance between ripples and reduce the distortion
caused by theripples.

Perspective Changes the size of the waves as they get farther from the subject. Drag the slider to
the left to increase the size of the waves farthest from the subject and to increase the
illusion of distance.

Lighting Specifies the amount of light in the water.

/ ) You can right-click a slider to reset to the default value.

i~

You can use the Edit Brush to paint this effect onto specific areas of your image.

‘iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Applying a Water Drops Effect

You can use the Water Drops effect to display water drops on the surface of the photo. You can control the number
and size of water drops, and their position on the photo.

You can save your settings as a preset for future use.

To Apply Water Drops to a Photo:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Water Drops.
3. On the Water Drops panel, set the options as described below.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Water Drops Options
Density Specifies the number of water drops on the photo. Drag the slider to the left to
remove water drops. Drag the slider to the right to add water drops.

Radius Specifies the size of the water drops. Drag the slider to the left to make the water
drops smaller. Drag the slider to the right to make the water drops larger.

Height Specifies the height of the water drops above the photo surface. Drag the slider to the
left to reduce the height of the water drops and the distortion caused by the water
drops. Drag the slider to the right to increase the height of the water drops and the
distortion caused by the water drops.

Randomize Indicates the random placement of the water drops.

When you apply the Water Drops effect to an image, ACDSee places the water drops
randomly. This makes the effect different every time you apply the filter. You can
define a specific random seed to generate identical water drop patterns.

To generate a new random seed, click Randomize.

’) You can right-click a slider to reset to the default value.

P
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You can use the Edit Brush to paint this effect onto specific areas of your image.

Pan

IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

L
IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Applying a Waves Effect

You can use the Waves effect to display waves across the photo. You can change the distance between waves.
This distance is called wavelength. You can also change the height of the waves, and the angle at which the waves
cross the photo.

You can save your settings as a preset for future use.

To Apply a Waves Effect:
1. In Edit mode, in the Add group, select Special Effect.

( ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click Waves.
3. On the Waves panel, select or change the options as described below.
4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Waves Options

Wavelength Specifies the distance between waves. Drag the slider to the left to reduce the
distance between waves and increase the distortion caused by the waves. Drag the
slider to the right to increase the distance between waves and reduce the distortion
caused by the waves.

Amplitude Specifies the height of the waves. Drag the slider to the left to reduce the height of
the waves and the distortion caused by the waves. Drag the slider to the right to
increase the height of the waves and the distortion caused by the waves.

Angle Specifies the angle of the waves. Type a number from 1 to 360 or drag the arrow to
adjust the angle.

Background color Specifies the background color. Select the Image checkbox to use the original image
colors, or click the color picker to select a different color.

/ ) You can right-click a slider to reset to the default value.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

‘iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Applying a Weave Effect

You can use the Weave effect to give a photo the appearance of being woven into a tapestry or basket. You can
control the width of the vertical and horizontal strips, the width of the gap between the strips, and the background
color that displays through the gap.
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You can save your settings as a preset for future use.

To Apply a Weave Effect:

1. In Edit mode, in the Add group, select Special Effect.

") You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.
2. Click Weave.

3. On the Weave panel, set the options as described below.

4. Do one of the following:

* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Weave Options

Strip width Specifies the width of the vertical and horizontal strips.
Gap width Specifies the width of the gap between the strips.
Background color Specifies the color of the background. Click the color picker to select a different color.

") You can right-click a slider to reset to the default value.

L

P
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You can use the Edit Brush to paint this effect onto specific areas of your image.

Fan

|£ You can use the Gradient tool m to transition this effect across specific areas of your image.

Fa
I) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Applying a Wind Effect

You can use the Wind effect to add wind lines that make stationary objects in your image look like they are moving.
Select or change the settings to control the effect of the wind added to your image.

You can save your settings as a preset for future use.
To Apply a Wind Effect:
1. In Edit mode, in the Add group, select Special Effect.
F 3

j You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

L

2. Click Wind.

3. On the Wind panel, select or change the options as described below.
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4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Wind Options

Strength Determines how strong the wind lines are in the image. The higher the value, the
stronger the wind lines.

Threshold Determines how sharp an edge must be before the filter will apply wind. The higher
the value, the sharper the edge needs to be.

Chance of wind Determines the amount of wind lines to place in the image.

Edge detection Specifies the edge detection algorithm. The algorithm controls the formula used to
detect the edges and the direction of the edge indicators.

Background color Specifies the background color. Select the Image checkbox to use the original image
colors, or click the color picker to select a different color.

Wind color Specifies the color of the wind lines. Select the Image checkbox to use the original
image colors, or click the color picker to select a different color.

Wind angle Specifies the angle of the wind lines.

Randomize Indicates the random placement of the wind lines.

When you apply the Wind effect to an image, ACDSee places the wind lines randomly.
This makes the wind lines different every time you apply the filter. You can define a
specific random seed to generate identical wind lines.

To generate a new random seed, click Randomize.

/ ) You can right-click a slider to reset to the default value.
You can use the Edit Brush to paint this effect onto specific areas of your image.
' J

You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Creating a Custom Special Effect Filter (Convolution Effect)

You can use the Convolution filter to create your own special effects and apply them to your image.

You can save your settings as a preset for future use.

To Create a Custom Effect Filter:

1. In Edit mode, in the Add group, select Special Effect.

( ) You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

2. Click User Defined Convolution.

3. On the User Defined Convolution panel, set the options as described below.
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4. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

User Defined Convolution Options

Convolution Matrix Specifies the formula to use when altering the image.

Type numbers in the matrix fields to change the pixels in the image. Using a
mathematical formula, the color value of each pixel in an image is multiplied by the
numbers in the matrix to produce an effect.

Division Specifies the fractional coefficient of the matrix.

Type a number into the Division field to use fractional coefficients in the matrix. The
product of the convolution matrix is divided by the division factor before being
applied to a pixel.

Bias Specifies the brightness of the image.

Type a number into the Bias field to change the brightness of the image. The bias
number is added to the RGB values of each pixel. A positive number brightens the
image, while a negative number darkens the image.

Clear Matrix Resets the matrix.

Sample Filters Loads a sample effect to use as a starting point for creating your own effect.
Drop-Down Menu

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Rotating an Image

You can rotate an image at preset or custom angles in Edit mode.
You can save your settings as a preset for future use.

To Rotate an Image at a Custom Angle:

1. In Edit mode, in the Geometry group, select Rotate.

i ) You can also access the Rotate tool from the Filter drop-down menu or Filter toolbar.

2. Select one or more of the following:
* Select one of the default orientation options.
* Drag the Straightening slider to the left or right until the image appears straightened.
* Click the Horizontal or Vertical button, and use the tools as described below.

* Select Crop straightened image if you want to crop the image after it is straightened.
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* Select Preserve straightened image if you do not want to crop the straightened image. Select
the color that you would like to display behind the straightened image from the Fill color drop-
down.

+ Select Show grid overlay to display a grid over the image. You may find that the grid helps you
straighten the image and understand how the image will be cropped.

3. Do one of the following:
* Click Done to apply your changes and close the tool.

* Click Cancel to discard all changes and close the tool.

# Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=f_ | reset your settings.

Rotate Icons

Horizontal Click on the horizontal icon, and then use the cursor to draw a line on the image that you
want to set as the horizontal line.

Vertical Click on the vertical icon, and then use the cursor to draw a line on the image that you want
to set as the vertical line.

’) You can right-click a slider to reset to the default value.
b

Flipping an Image

You can flip an image both vertically and horizontally in Edit mode.

You can save your settings as a preset for future use.

To Flip an Image:

1. In Edit mode, in the Geometry group, select Flip.

") You can also access the Flip tool from the Filter drop-down menu or Filter toolbar.
kb

2. Do one or both of the following:
* Select the Horizontal Flip checkbox.
* Select the Vertical Flip checkbox.

3. Do one of the following:
* Click Done to apply your changes and close the tool.

* Click Cancel to discard all changes and close the tool.

# Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=£_| reset your settings.

4 al [

You can use the Edit Brush to paint this effect onto specific areas of your image.
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“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

Cropping an Image

You can use the Crop tool to remove unwanted parts of your images, or to reduce the image canvas to a particular
size.

You can also save your settings as a preset for future use.

/ ) When zooming in, hold down the Spacebar to pan the image.

L

To Crop an Image:

1. In Edit mode, in the Geometry group, select Crop.

i ) You can also access the Crop tool from the Filter drop-down menu or Filter toolbar.

2. Resize the crop window, and position it over the area of the image you want to keep.

3. Todarken the parts of the image outside the crop window, drag the Darken outside crop area slider to
the left. Drag the slider to the right to lighten the area outside the crop window.

4. Click Estimate new file size to view how big your image file is after cropping.
5. Do one of the following:
* Click Done to crop the image and close the tool.

* Click Cancel to exit the tool without cropping the image.

i ) You can right-click a slider to reset to the default value.

Resizing the Crop Window

You can resize the crop window in three ways:
* Drag the edges of the crop window to the desired size.
* Specify an exact size for the crop window in pixels, inches, centimeters, or millimeters.

* Apply a ratio to constrain the crop window proportions.

To Resize the Crop Window by Dragging:

1. Position your cursor over the edge or corner of the crop window until it changes into a double-pointed
arrow.

2. Drag the crop window's border to the desired size.

To Specify an Exact Size for the Crop Window:
1. Typethe desired crop window proportions into the Width and Height spin boxes.
2. Inthe Units drop-down list, select a unit of measurement.

3. Usethe Dots per inch spin box to specify a resolution.

To Constrain the Crop Window to a Ratio:
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1. Select the Constrain cropping proportion checkbox.

2. Selecta
window

ratio from the drop-down list and select or clear the Landscape checkbox to toggle the crop
between landscape and portrait orientation.

3. Do one of the following:

-

Position your cursor over the edge of the crop window until it changes into a double-pointed
arrow, and then drag the edge of the crop window to the desired size.

Use the Width or Height spin box to specify a dimension for one side of the crop window.
ACDSee automatically resizes the other dimension based on the ratio you selected.

Resizing an Image

You can resize an image by adjusting its dimensions in pixels, percentage, or actual/print size. While resizing,
you can also choose an aspect ratio and a resampling filter to adjust the resized image's appearance.

You can save your settings as a preset for future use.

To Resize an Image:

1. In Edit mode, in the Geometry group, select Resize.

“m You can also access the Resize tool from the Filter drop-down menu or Filter toolbar.

.

2. Select one of the following resize options:

-

Pixels: resizes the image to specific dimensions in pixels.
Percent: Resizes the image to a percentage of the original.

Actual /Print size in: Resizes the image to match a specific output size. Click the drop-down list
to specify a unit of measurement.

3. If you want to maintain a specific width to height ratio, select the Preserve aspect ratio checkbox, and
then select one of the following options from the drop-down list:

-

4. Selecta

Original: Maintains the original image's width to height ratio.
1 x 1: Forces the width and height to be equal.

2 x 3: Forces a width to height ratio of 2:3.

3 x 2: Forces a width to height ratio of 3:2.

3 x 5: Forces a width to height ratio of 3:5.

5 x 3: Forces a width to height ratio of 5:3.

Custom: Applies a custom ratio. Enter a width to height ratio in the Custom Aspect Ratio dialog
box.

resizing filter from the Resizing Filter drop-down list.

5. Under the resize option you selected in step #3, type the image's new dimensions into the Width and
Height spin boxes. If you selected Actual/Print size in, click the Resolution drop-down list, and then
select a resolution (in dots per inch) for your output image.

6. To estimate the size of the output image, click Estimate new file size.

7. Do one of the following:

-

-
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’) Resizing Tips:

* Maintain image quality by reducing images only by 33%, 50%, or 66%. Other percentages
can distort the aspect ratio.

* Avoid resizing an image repeatedly. Each resizing places image pixels using a slightly
different orientation. As a result, multiple resizes can change the overall color and
appearance of the image. If your first resize attempt does not produce the desired result,
click the Undo button.

* Avoid increasing the size of an image. Increasing image size makes the image's pixels more
apparent, causing a grainy effect.

Pixel Resize Options and Resulting Action

You can reduce and enlarge the size of one or more images from Manage mode by entering a new dimension in
pixels. For more information on how to resize an image using pixel dimensions, please see Resizing an image or
Resizing multiple images.

’) Enlarging an image tends to pixelate the image, reducing image quality. It is best to avoid enlarging
b images.
I
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Resize Options

Enlarge only

Reduce only

Enlarge or reduce
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Fit within Options
Width only

Height only

Width and height

Width or height (largest

image)

Width only

Height only

Width and height

Width or height (largest
image)

Width only

Height only

Width and height

Width or height (largest
image)

Action

Resizes the image if the specified dimensions
are larger than the image's original dimensions.
The width is increased to the specified value and
the height is increased to maintain the aspect
ratio.

Resizes the image if the specified dimensions
are larger than the image's original dimensions.
The heightis increased to the specified value
and the width is increased to maintain the
aspect ratio.

Resizes the image if the specified dimensions
are larger than the image's original dimensions.
The width and height are increased as close to
the specified value as possible, while
maintaining the aspect ratio.

Resizes the image if the specified dimensions
are larger than the image's original dimensions.
The width or height is increased as close to the
specified value as possible to maximize the size
of the image, while maintaining the aspect ratio.

Resizes the image if the specified dimensions
are smaller than the image's original
dimensions. The width is decreased to the
specified value and the height is decreased to
maintain the aspect ratio.

Resizes the image if the specified dimensions
are smaller than the image's original
dimensions. The height is decreased to the
specified value and the width is decreased to
maintain the aspect ratio.

Resizes the image if the specified dimensions
are smaller than the image's original
dimensions. The width and height are decreased
as close to the specified value as possible, while
maintaining the aspect ratio.

Resizes the image if the specified dimensions
are smaller than the image's original
dimensions. The width or height is decreased as
close to the specified value as possible to
minimize the size of the image, while
maintaining the aspect ratio.

Resizes the width to the specified value and
resizes the height to whatever value is
necessary to maintain the aspect ratio.

Resizes the height to the specified value and
resizes the width to whatever value is necessary
to maintain the aspect ratio.

Resizes the image within the specified width and
height. The width and height are resized as
close to the specified value as possible while
maintaining the aspect ratio.

Resizes the image within the specified width and
height. The width or height is resized as close to
the specified value as possible to maximize (or
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Resize Options Fit within Options Action

minimize) the size of the image, while
maintaining the aspect ratio.

Adjusting Image Exposure

You can use the Exposure tool to adjust an image's exposure, contrast, and fill light.
You can save your settings as a preset for future use.
To Adjust the Image Exposure:

1. In Edit mode, in the Exposure/Lighting group, select Exposure.

") You can also access the Exposure tool from the Filter drop-down menu or Filter toolbar.

2. Setthe options as described below.

3. Do one of the following:
* Click Apply to apply your changes and set options on another tab.
* Click Done to apply your changes and close the tool.

* Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=f_ | reset your settings.

Image Exposure Options

Exposure Drag the slider to the right to increase the exposure, or drag to the left to decrease
exposure.

Auto Click the Auto button to automatically adjust the exposure level.

Contrast Drag the slider to the right to increase contrast, or drag to the left to decrease
contrast.

Fill Light Drag slider to the right to increase the amount of light in the darkest areas of the
image, or drag to the left to decrease fill light. Fill light brightens dark areas of the
image.

Exposure warning Highlights overexposed and underexposed areas of the image. Overexposed pixels

“ turn red, underexposed pixels turn green. The icon is gray when disabled, and

turns yellow if enabled.

’) You can right-click a slider to reset to the default value.

e

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Fai
I) You can use the Gradient tool m to transition this effect across specific areas of your image.
P

' ) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

.
I
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Adjusting Image Levels

You can use the Levels tool to precisely adjust the contrast and light levels in your images.
You can save your settings as a preset for future use.
To Adjust Image levels:

1. In Edit mode, in the Exposure/Lighting group, select Levels.

"j You can also access the Levels tool from the Filter drop-down menu or Filter toolbar.
b

2. Do one of the following:
* Set the options as described below to adjust the contrast and light levels manually.
* Click Auto and select a menu option to automatically adjust image properties.
3. Do one of the following:
* Click Apply to apply your changes.
* Click Done to apply your changes and close the Levels tool.

* Click Cancel to discard all changes and close the tool.

# Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=f_ | reset your settings.

Levels Options
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Channel Specifies the brightness or color channel you want to adjust.

Shadows Specifies the black point of an image.

Move the slider or type a number from 0 to 255 into the spin box to define the
blackest area of an image. As the value increases, the dark colored areas of the image
become darker. You can also click on the arrow to automatically set it to where the
black point start in the image.

Midtones Specifies the midtones in an image.

Move the slider or type a number into the spin box to set the midtone. Higher values
make the image appear brighter, while lower values make the image appear darker.
You can also click on the arrow to automatically set it to the midtone of the image.

Highlights Specifies the white point of an image.

Move the slider or type a number from 0 to 255 into the spin box to define the whitest
area of an image. As the value increases, the light colored areas of the image become
lighter. You can also click on the arrow to automatically set it to where the highlights
startin the image.

Auto Select one of the following options:
* Adjust Contrast: Automatically analyzes and adjusts image contrast.

* Adjust Color and Contrast: Automatically analyzes and adjusts each color
channel independently, and then adjusts the contrast.

* Adjust Color and Brightness: Automatically analyzes and adjusts image
color and brightness.

* Tolerance: Opens the Tolerance settings dialog box. Specify the maximum

clipping percentage for black and white levels, and click OK. ACDSee adjusts
the image levels automatically.

Black Point picker Click the Black Point picker, and then click the image area you want to set as the

black point.

Mid Point picker Click the Mid Point picker, and then click the image area you want to set as the mid

point.

White Point picker Click the White Point picker, and then click the image area you want to set as the
white point.

When you click around the image with a selected eye dropper you will see the RGB numbers changing to
= | reflect the RGB values of the pixel under the eye dropper. The RGB values represent the source pixel
(unprocessed) and the current pixel as it appears on the screen.

e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.
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“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Adjusting Levels Automatically

You can use the Auto Levels tool to automatically correct the exposure levels of your images. Auto Levels makes the
darkest image pixels darker, and the brightest pixels brighter.

You can save your settings as a preset for future use.

To Automatically Correct an Image's Levels:

1. In Edit mode, in the Exposure/Lighting group, select Auto Levels.

- ) You can also access the Auto Levels tool from the Filter drop-down menu or Filter toolbar.

2. Select one of the following options:
* Auto Contrast and Color: Adjusts color differences, brightness, and balances RGB channels.
* Auto Contrast: Adjusts the color differences and brightness only.

* Auto Color: Balances the RGB channels in the image, without changing the brightness or
contrast.

3. Usethe Strength slider to fine tune the amount of exposure you want to apply.

4. Click Exposure Warning to make overexposed and underexposed pixels visible. Overexposed pixels turn
red, underexposed pixels turn green.

5. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=~ reset your settings.

/ ) You can right-click a slider to reset to the default value.

L

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.
*iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Adjusting Tone Curves

In Edit, you can use the Curves tool to change the tonal range of an image. Select the RGB color channel to adjust
the entire range of the image, or select a specific color.

You can save your settings as a preset for future use.
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To Adjust the Brightness Curves in an Image:

1. In Edit mode, in the Exposure/Lighting group, select Tone Curves.

i ) You can also access the Tone Curves tool from the Filter drop-down menu or Filter toolbar.

2. Setthe options as described below.
3. Do one of the following:
* Click Apply to apply your changes.
* Click Done to apply your changes and close the Curves tool.

* Click Cancel to discard all changes and close the tool.

f Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=f_ | reset your settings.

Curves Options

Channel Specifies the color channels to adjust.
Show Histogram Toggles the histogram display on and off.
Histogram Displays a graphic of the color information levels in the image, based on the selected

channel. Click and drag the line to manipulate the curve. Each time you click the
curve, a new point is added. You can drag the points up and down the curve. To
remove a point, right-click it and choose Delete point. You can also delete a point by
dragging it off of the top or the bottom of the graph.

Exposure warning Highlights overexposed and underexposed areas of the image. Overexposed pixels
turn red, underexposed pixels turn green.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Adjusting Lighting

You can use the Light EQ™ tool to adjust areas in an image that are too dark or too light, without affecting other
areas of the photo. You can also simultaneously lighten dark areas that are too dark, and darken areas that are too
bright. Examples would be a photo of a person silhouetted against a bright background like the sea, or a window.
In fact, most photos taken on a dull day, or with a flash, can be improved in various ways with fine adjustments.

You can save your settings as a preset for future use.

The Light EQ™ tool lets you make quick and easy adjustments. ACDSee analyzes the photo and varies the
adjustment throughout the image automatically. For example, darker images are brightened more. By opening the
Light EQ™ tool, 1-Step applies an automatic exposure adjustment. For a more hands-on approach, the Basic tab
allows you to click the Auto button and have ACDSee fully analyze the photo and set the slider positions

automatically. You can also click directly on an area of the image to generate automatic settings optimal for that
area, (usually the subject of the photo).
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+* 1-Step tab: For an instant, effortless exposure adjustment.

+* Basictab: Is for very quick and easy adjustments using three sliders. ACDSee analyzes the photo and
varies the adjustment throughout the image automatically. For example, darker images are brightened
more. By clicking the Auto button, you can have ACDSee fully analyze the photo and set the slider
positions automatically. You can also click directly on an area of the image to generate automatic settings
optimal for that area, (usually the subject of the photo).

To Open the Light EQ™ Tool:
In Edit mode, in the Exposure/Lighting group, select Light EQ™.

’) You can also access the Light EQ tool from the Filter drop-down menu or Filter toolbar.

Using the 1-Step Tab

When you open an image in the Light EQ™ tool, 1-Step automatically adjusts your image's exposure. You can
further adjust it using the Amount slider. To return to the 1-Step automatic adjustment, press the Reset button.

Using the Basic Tab

To Add Light to Dark Areas:
1. Drag the Highlights slider to the right to add light to the dark parts of the photo.

2. Adjust the settings using any of the controls in the table below.

To Darken Areas That Are Too Bright:
1. Drag the Shadows slider to the right to lighten and return detail to areas that are too dark.

2. Adjust the settings using any of the controls in the table below.

To Adjust Midtones That Are Too Light or Dark:
1. Drag the Midtones slider to the right to lighten and return detail to areas that are too dark.

2. Adjust the settings using any of the controls in the table below.

Light EQ™ Controls

Right-click on a Right-click on a slider to reset it.

slider

Exposure Warning Click the Exposure Warning to make any overexposed or underexposed areas visible.
‘ Overexposed pixels turn red, underexposed pixels turn green. You can also toggle

Exposure Warning on and off momentarily by holding down the E key.

Auto Click to allow the software to analyze the photo and apply optimal settings based on the
amount of light and dark pixels in the photo. Darker photos are brightened more than
photos that are already bright.

Done Click to apply your changes and close the tool.

Cancel Click to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=£_ | reset your settings.

’) You can right-click a slider to reset to the default value.
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| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Fai
I) You can use the Gradient tool m to transition this effect across specific areas of your image.
P

' ) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

.
I

Adjusting White Balance

You can use the White Balance tool to remove unwanted hue from an image. For example, if you take a photo at
sunset and the resulting image has a reddish hue, you can use the White Balance tool to remove it.

You can save your settings as a preset for future use.

To Remove a Color Cast from an Image:

1. In Edit mode, in the Color group, select White Balance.

") You can also access the White Balance tool from the Filter drop-down menu or Filter toolbar.

2. Click an image area that should be white or gray. The color square shows the color of the original pixel on
the left, and the modified pixel on the right.

3. Drag the Temperature slider to the left (more blue) or right (more yellow) to select a specific color
temperature.

4. Drag the Tint slider to the left (more magenta) or right (more green) to match the white balance settings
that you selected when you took the photo.

5. To specify the strength of the white balance adjustment, move the Strength slider. Higher settings
remove more of the unwanted color.

6. Click Done to save your changes, or click Cancel to discard your changes and leave the tool.

’) You can right-click a slider to reset to the default value.

L

P

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

% If you are having difficulties achieving the desired effect, try clicking an image area that is a different
‘iJ shade of white or gray.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=f_ | reset your settings.

P
IJ You can use the Gradient tool m to transition this effect across specific areas of your image.

Far

IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Adjusting Color Balance

You can adjust an image's color values using the Color Balance tool.

You can save your settings as a preset for future use.

To Adjust an Image's Color:

1. In Edit mode, in the Color group, select Color Balance.

") You can also access the Color Balance tool from the Filter drop-down menu or Filter toolbar.

2. Adjustthe sliders as described in the table below.
3. Do one of the following:
* Click Apply to apply your changes.
* Click Done to apply your changes and close the tool.

* Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=f_ | reset your settings.

Color Balance Options

Saturation Adjusts the saturation of the image. Drag the slider to the right to increase or drag to the
left to decrease saturation.

Hue Adjusts the hue of the image. Drag the slider to the right to increase or drag to the left to
decrease hue.

Lightness Adjusts the image brightness. Drag the slider to the right to increase or drag to the left
to decrease the image's brightness.

Red Adjusts the red channel in the image. Drag the slider to the right to increase or drag to
the left to decrease the red tone in your image.

Green Adjusts the green channel in the image. Drag the slider to the right to increase or drag to
the left to decrease the green tone in your image.

Blue Adjusts the blue channel in the image. Drag the slider to the right to increase or drag to
the left to decrease the blue tone in your image.

% You can right-click a slider to reset to the default value.

|

You can use the Edit Brush to paint this effect onto specific areas of your image.

L
P
L

P

L

You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

i)
“i) You can use the Gradient tool to transition this effect across specific areas of your image.
i)
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Creating a Grayscale Image

You can create rich grayscale images when you can control the brightness of the red, green, and blue channels,
as well as the overall brightness. Use the Convert to Black and White tool to emphasize different areas or aspects
of a photo, as well as alter its mood and tone.

If you hover your mouse over each slider and watch the effect on the small preview, it shows you which parts of
the image will be affected by each channel. This helps to gauge the effect of each slider on the image.

You can save your settings as a preset for future use.

To Create a Grayscale Image:

1. In Edit mode, in the Color group, select Convert to Black & White.

’d) You can also access the Convert to Black & White tool from the Filter drop-down menu or Filter
"y toolbar.

2. Adjust the settings as described in the table below.

3. Click Done to save your changes, or click Cancel to discard your changes and return to the Filter menu.

Grayscale Options
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Brightness Tab
On the Brightness tab, do any of the following:

* Drag individual color sliders, or left-click on the image (where a color previously occurred) and drag up or
down to alter the brightness of specific tones. For instance, drag your cursor on sky areas to alter the
brightness of the blue.

* Drag the Percent Red slider to the left or right.

The more red there is in a pixel, the more effect the red slider has on that pixel. The area of red in the
picture is brightened or darkened more than other areas.

* Drag the Percent Green slider the left or right.

The more green there is in a pixel, the more effect the green slider has on that pixel. The area of green in
the picture is brightened or darkened more than other areas.

* Drag the Percent Blue slider to the left or right.

The more blue there is in a pixel, the more effect the blue slider has on that pixel. The area of blue in the
picture is brightened or darkened more than other areas.

* Drag the Percent Brightness slider to the right or left to brighten or darken the whole image.
i ) You can right-click the slider to reset the value to zero.

Contrast Tab

You can increase or decrease the contrast of each individual color. In addition, you can specify the brightness
range that the contrast adjustment will target for each color.

On the Contrast tab, do the following:

Strength: To adjust the contrast in specific color tones, drag individual color sliders, or left-click on the image
(where a color previously occurred) and drag up or down.

Balance: To set the targeted brightness range for the contrast adjustment, adjust the slider to bring details out
of highlights or shadows. To bring details out of the midtones, leave the Balance sliders set to 0.

k slider.

i ) Hold down SHIFT while clicking and dragging on the image to target the color's corresponding Balance
I

/ j You can right-click the slider to reset the value to zero.

At the bottom of the Convert to Black & White panel, you can use the Amount and Hue sliders to add color back
into the image. Choose the color using the Hue slider. The saturation of the color added back to any given pixel is
scaled based on both the amount of color/saturation that existed in the original image and the Amount slider.

. e

You can use the Edit Brush to paint this effect onto specific areas of your image.

“i) You can use the Gradient tool m to transition this effect across specific areas of your image.

“i) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.
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Adjusting Color with LUTs

"Color LUT" stands for Color Lookup Table. Color LUTs are lists that instruct ACDSee or related programs to map
specific RGB values to other specific color values. You can import LUTs and use them as filters in ACDSee. You can
apply a color LUT in the same way you would use any other Edit mode filter. Color LUT supported file types are .3dl
and .cube.

To Apply a Color LUT to Your Image:
1. In Edit mode, in the Color group, select Color LUTSs.
2. On the Color LUTs panel, do one of the following:
* Select a LUT from the list. The LUT is immediately applied.

* Press the Import LUTs button. In the Open dialog, browse to the location of your LUT files, and
press Open. The LUT is immediately applied.

3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

Y If an imported LUT file's location has changed, you will have to re-import it on the Color LUTs panel.

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Fan

' ) You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

.
I

Fai
I) You can use the Gradient tool m to transition this effect across specific areas of your image.
To Remove All Color LUTs:

You can clear your list of all Color LUTs.

On the Color LUTs panel, press the Remove LUTs drop-down menu button and select Remove All LUTs.x

" You can also delete individual LUTs by right-clicking them in the list and choosing Delete LUT from the
‘iJ context menu.

To Remove Unavailable Color LUTs:

You can clear your list of Color LUTs that have been moved or deleted.

On the Color LUTs panel, press the Remove LUTs drop-down menu button and select Remove Unavailable

LUTs. x

To Refresh Your List of Color LUTs:

You can refresh your list of available LUTs to reveal moved or deleted files. Unavailable LUTs will be indicated in a
darker font color.

A
On the Color LUTs panel, press the Refresh List button. e
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Using the Histogram

The Histogram displays a graphical representation of the distribution of intensity levels of pixels for each color
channel in an image.

To Display and Use the Histogram:
1. In View mode, click Panes | Histogram, or View | Histogram in Edit mode.
2. On the Histogram, select or clear the following checkboxes:
R: Shows or hides the red color channel.
G: Shows or hides the green color channel.
B: Shows or hides the blue color channel.

L: Shows or hides the lightness of the image.

Using the Color Dialog Box

The Colors dialog box appears in several places in Edit mode when you select or apply a color. You can use the
Color dialog box to select a color in multiple ways and to adjust a color using several different tools.

Standard

Curmrent
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The Standard Tab

On the first tab, there is a fixed honeycomb of Basic colors to choose from, including gray, black, and white at the
bottom. Below it is a grid of Custom or Favorite colors that you can fill in by selecting a color and then right-
clicking a box in the grid. To create a custom color, click the Custom tab.

The Custom Tab

On the second tab, there is a color palette. On the far right is a color slider, which you can use to navigate to a
color group and gain access to any or all colors of the spectrum. Add colors to your Custom colors by selecting the
color in the palette and then right-clicking a box in the grid.

Selecting and Adjusting Colors

To select a color, click on a square in the grid of custom colors, or on the color palette. You can also drag over the
color palette. When you click a color, that color appears in the New box and all of its numerical values, (Hue,
Saturation, Luminosity, as well as Red, Green, and Blue), appear in the fields on the Custom tab.

You can also adjust a color by changing the Hue, Saturation, and Luminosity values. To select a precise color, type
in the values for that color. You can do the same using the Red, Green, and Blue values.

Sharpening an Image

You can use the Sharpen tool to sharpen an image by enhancing medium and high contrast edges.

You can save your settings as a preset for future use.
To Sharpen an Image Using Sharpen Tool:
1. In Edit mode, in the Detail group, select Sharpen.

") You can also access the Sharpen tool from the Filter drop-down menu or Filter toolbar.

2. Drag the sliders to enhance or fix your image as described below.
3. Do one of the following:
* Click Done to apply your changes and close the tool.

* Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
== reset your settings.

Sharpen Options
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Amount Specifies the amount of sharpening applied by increasing contrast around the edges.

Radius Controls the number of pixels to adjust around each edge. Higher values increase the
number of sharpened pixels and tend to bring out coarser detail, while lower values
reduce the number of sharpened pixels and tend to bring out finer detail.

Detail Suppresses the halo, (the light border that forms around edges with extreme
sharpening), by reducing its intensity. The higher the value, the stronger the
reduction.

Threshold Specifies how different the pixel lightness values within an edge must be before the

pixels within the edge are sharpened. Higher values sharpen only stronger edges but
minimize the appearance of noise. Lower values sharpen both strong and weaker
edges, but can increase the appearance of noise. We recommend you set the
threshold to enhance edges while keeping background noise to a minimum.

") You can right-click a slider to reset to the default value.
Fai
il [

You can use the Edit Brush to paint this effect onto specific areas of your image.
P
' )

You can use the Gradient tool m to transition this effect across specific areas of your image.

-
I) You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

Blurring an Image

You can use the Blur tool to apply different kinds of blur to an image.

You can save your settings as a preset for future use.
To Blur an Image:
1. In Edit mode, in the Detail group, select Blur.

") You can also access the Blur tool from the Filter drop-down menu or Filter toolbar.

2. Inthe Blur type section, select the type of blur to apply.
3. Setthe options as described below.
4. Do one of the following:
* Click Done to apply your changes and close the Blur tool.

* Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=*__| reset your settings.

Blur Types
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Gaussian

&

Linear
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Smart Blur "*
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Lens \r

L
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Produces an even, smooth blur.

Amount Specifies the amount of blur. Move the slider
to the right to intensify the effect.

Produces a blurring effect that gives the illusion of movement.

Amount Specifies the amount of blur. Move the slider
to the right to intensify the effect.
Angle Specifies the direction of the blur effect.
Produces blur around a center point. Click the image to set the center point.
Amount Specifies the amount of blur. Move the slider
to the right to intensify the effect.
Clockwise Specifies clockwise blur.
Counter-clockwise Specifies counter-clockwise blur.
Horizontal position Specifies the blur's center point on the

horizontal axis.

Vertical position Specifies the blur's center point on the
vertical axis.

Produces a smeared or frosted blur.

Amount Specifies the amount of blur. Move the slider
to the right to intensify the effect.

Produces inward or outward blur to or from a center point.

Amount Specifies the amount of blur. Move the slider
to the right to intensify the effect.

Zoom in Creates a blur that zooms in to the image's
center.

Zoom out Creates a blur that zooms out from the

image's center.

Horizontal position Specifies the blur's center point on the
horizontal axis.

Vertical position Specifies the blur's center point on the
vertical axis.

Produces blur by detecting and avoiding edges, and preserves detail based on the
threshold setting. This effect is usually used to smooth out skin.

Amount Specifies the amount of blur. Move the slider
to the right to intensify the effect.

Threshold Specifies how little detail an area must have
before the blur will apply to it.

Produces a blur that mimics the blurring effect of a camera aperture.

Select a bokeh shape from the options on the Blur panel. These shapes concentrate
in highlights.

Amount Specifies the strength of the blur. Move the
slider to the right to intensify the effect.

Bokeh Frequency Specifies how often the bokeh shapes show
up.

Bokeh Brightness Specifies how much the bokeh shapes stand
out.

.’) You can right-click a slider to reset to the default value.
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You can use the Edit Brush to paint this effect onto specific areas of your image.
“iJ You can use the Gradient tool m to transition this effect across specific areas of your image.

“iJ You can use the Radial Gradient tool n to apply effects around, or directly to, a center point.

About Noise and Noise Reduction

Image noise looks like random black, white, or colored pixels in an area of a photo where there should be solid
color, such as a dark night sky. In digital photography, noise is typically more visible in the dark areas of a photo.

There are many causes of image noise. You will increase image noise if you use a high ISO setting (such as ISO
800) to capture a photo, or if you extend the exposure time. (You would typically use a high ISO setting and extend
exposure time to take a photo in low light.) However, image noise can be caused by dead or stuck pixels in a digital
camera's image sensor. Similarly, dust on a camera lens or scanner bed can cause noise by blocking or reflecting
light.

Images generally have two types of noise: luminance and color. Luminance noise is random variations of
brightness, and particularly in gray areas, may appear spotted when there should be a solid color in the area of
the image.

Color noise is random variations of color in the image.

Noise is visually distracting, so in most cases you will want to reduce noise in your photos. However, if you reduce
noise too much you may unintentionally reduce image sharpness.You can use the Noise Removal tool to remove
both luminance and color noise in your images.

Removing Noise

You can use the Remove Noise tool to remove noise from your images while preserving details that you want to
retain.

% You can use the Remove Noise tool to remove hot image pixels caused by digital cameras with
‘IJ malfunctioning CCD array sensors, or the extra pixels caused by a dusty scanner or camera lens.
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You can save your settings as a preset for future use.
To Remove Noise from an Image:
1. In Edit mode, in the Detail group, select Noise.

;":} You can also access the Noise tool from the Filter drop-down menu or Filter toolbar.
b

2. Select the Remove Noise tab.
3. Select an option from the Noise Type section.

4. Setthe options as described below.

;":} Hold down the ALT key while adjusting a slider to view a preview of its effect on the image.
b

5. Do one of the following:
* Click Done to apply your changes and close the Remove Noise tool.

* Click Cancel to discard all changes and close the tool.

# Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
= reset your settings.

Noise Removal Options
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Noise Type Camera Noise Removes digital camera noise. Adjust the following sliders
P e ® to further remove noise:
Removal
Luminance Reduces the random variations of

brightness in the noise.

Strength Controls the strength of the
Luminance slider.

Color Reduces the random variations of
color in the noise.

Preserve Detail Restores details lost due to strong
noise removal. Set the slider to
adjust how much detail is

restored.
Preserve Detail Determines the level of detail
Threshold necessary to be included in the
Preserve Detail slider's
adjustments.
Median Noise Square Removes noise using a 3 x 3 pixel
'E'-:‘“ square.
Removal .
X Removes noise using a 3 x 3 pixel

X shape. Use this option when
you want to preserve an image's
thin and diagonal lines.

Plus Removes noise using a 3 x 3 pixel
plus (+) shape. Use this option
when you want to preserve an
image's thin, vertical, and
horizontal lines.

‘fh Removes noise.
-
Despeckle 1=

’) You can right-click a slider to reset to the default value.
P

You can use the Edit Brush to paint this effect onto specific areas of your image.
i
' J

You can use the Gradient tool m to transition this effect across specific areas of your image.

Far

IJ You can use the Radial Gradient tool “ to apply effects around, or directly to, a center point.

Adding Noise

You can use the Add Noise tool to add a grainy texture to an image. Adding small amounts of noise can reduce the
appearance of minor imperfections in the original image.

You can save your settings as a preset for future use.
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To Add Noise to an Image:

1. In Edit mode, in the Detail group, select Noise.

") You can also access the Noise tool from the Filter drop-down menu or Filter toolbar.

2. Select the Add Noise tab.
3. Setthe options as described below.
4. Do one of the following:
* Click Done to apply your changes and close the Add Noise tool.

* Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you cannot
=*__| reset your settings.

Add Noise Options

Intensity Specifies the amount of noise to add to the image. A higher intensity increases the
chance that a noise pixel will replace a pixel in the original image.

Color proximity Specifies the color of noise pixels to add to the image. A lower value gives each noise
pixel a color similar to the pixel it replaces. Higher values result in a random selection
of the noise pixel color.

Noise color Select one of the following options to specify noise pixel color:
* Random: Randomly selects the color.
* Monochrome: Produces black and white noise pixels.

* Adjustable: Randomly selects the color of each noise pixel, but more pixels
match a defined color. To define a color, click the color picker and select a
color.

Noise placement Adds noise to image areas that closely match a defined color. Select the Set color
checkbox to enable noise placement, and click the color picker to specify a color.

Randomize Indicates the random placement of noise in an image.

When you use Add Noise tool, ACDSee places the noise pixels based on a random
seed. This makes the image noise different each time you use the Add Noise tool. You
can define a specific random seed to generate identical image noise.

To generate a new random seed, click Randomize.

“') You can right-click a slider to reset to the default value.

Fa

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Fai
'j) You can use the Gradient tool m to transition this effect across specific areas of your image.
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Adjusting Clarity

The Clarity tool adds subtle definition to the details in your image. Use the Clarity tool to enhance the contrast of
midtones in your images, without overpowering the shadows and highlights.

You can save your settings as a preset for future use.

To Adjust the Clarity of Your Image:
1. In Edit mode, in the Detail group, select Clarity.

"j You can also access the Clarity tool from the Filter drop-down menu or Filter toolbar.
k

2. Drag the Strength slider to the right for greater clarity, or to the left for reverse clarity.
3. Do one of the following:
* Click Done to accept your changes and close the panel.

* Click Cancel to discard your changes and close the panel.

’) You can also type a number into the number box and incrementally make precise adjustments.
h

“') You can right-click a slider to reset to the default value.
b

Fa

| e

You can use the Edit Brush to paint this effect onto specific areas of your image.

Fai
"hd) You can use the Gradient tool m to transition this effect across specific areas of your image.

Fa

"-'J You can use the Radial Gradient tool _ to apply effects around, or directly to, a center point.
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Chapter 7: Dashboard Mode

Using Dashboard Mode

Dashboard mode is a quick and convenient way to browse your file, camera, and database statistics. Camera
statistics are read from your images' metadata, and file information is analyzed from your ACDSee database.
Therefore, it is important to catalog to get the most out of Dashboard mode.

Cataloging Files

To catalog, do one of the following:
* Goto Tools | Database | Catalog.

* Browse your folders in Manage mode.

Dashboard Mode

Dashboard mode contains the following tabs:

* Overview tab: The Overview tab summarizes the information found on the other tabs. It also displays a
graph detailing your monthly or yearly photo counts. You can use the drop-down menu at the top of the
tab to switch between viewing a range of months or a range of years. You can use the Prev and Next
buttons to navigate backward or forward in time.

* Database tab:The Database tab displays data pertaining to your database, such as its location, size,
backup information, a breakdown of your assets, and more.

+* Cameras tab: The Cameras tab displays data pertaining to your camera usage, such as which cameras
you use the most, your favorite ISO setting, and more.

+* Files tab: The Files tab displays data pertaining to your image and video files, such as your most used bit
depths, image resolutions, and more.
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Chapter 8: PicaView

About ACDSee PicaView

ACDSee PicaView is a quick and easy file viewer "add-on" for Windows/File Explorer™ that saves you time by
letting you preview files without having to open them in an application. You can view your image files in various
sizes — including RAW files — or its EXIF information, or both, by right-clicking. You can also view a preview of

any other image file format supported by ACDSee. You can access the ACDSee PicaView preview by right-clicking a
file in Windows/File Explorer™.

You can configure a variety of ACDSee PicaView's settings, including the size of the preview, what information
displays, and more. Access these settings by clicking ACDSee PicaView | Options..., or through ACDSee, by
going to Tools | Options... and navigating to ACDSee PicaView in the Options dialog's menu.

To Adjust the ACDSee PicaView Options:
1. Right-click a file in Windows/File Explorer™ to access the ACDSee PicaView preview.
At the top of the preview, click ACDSee PicaView | Options...

On the ACDSee PicaView Options dialog, set or change the options as described below.

B woN

Click OK to apply your changes.

ACDSee PicaView Options

Display Image Select the Display Image checkbox to display a preview of the right-clicked file
on the context menu.

Location * Add image to main menu: When you right-click,
displays preview in the main menu.
* Add image to sub-menu: When you right-click,
displays preview in a sub-menu, available by clicking
the arrow next to ACDSee PicaView.

Size Select the size of the preview that displays when you
right-click.
Show Original Select Show Original to display the pre-edited version of

the image when you right-click.

Show EXIF Information Toggle the Show EXIF Information checkbox to display the right-clicked
photo's EXIF information.
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Chapter 9: Options and Configuration

Setting the General Options

You can adjust settings in the Options dialog box to display helpful tips, set the format for date displays, set
automatic rotate options, and control the display of certain image types.

To Access the General Options:

1. In any mode, click Tools | Options.

2. In the Options dialog box, click General.

3. On the General page, set or change any of the options described below.

4. Click OK to apply your changes and return to ACDSee.

General Options

Enable gamma
correction

Automatically stretch
wallpaper to fit
screen

Disable image
animation

Automatically rotate
JPEG and TIFF
images based on EXIF
orientation

Status bar date

Date/Time output
format

Show icon in Taskbar
Notification area

Show the Mode
Switching icons

Applies the specified amount of gamma correction when viewing or previewing
images.

Stretches small images to fit the entire desktop when you set them as your
wallpaper.

Displays only the first frame of an animated image in Manage mode's Preview pane
and in View mode.

Automatically corrects the orientation of TIFF and JPEG images (based on their EXIF
data) when displayed in ACDSee.

Specifies the date to display in the status bar for a selected file.
Select one of the following:

* Default system format: Uses the default system format when displaying
the date and time in information overlays.

* Custom format: Uses the specified format to display the date and time in
all information overlays. Select a format for both Date and Time from the
drop-down lists.

Displays the ACDSee icon in the Taskbar Notification area.

Displays the icons next to the names of each mode.

Setting the Auto Advance Options

You can control which applied metadata will trigger Auto Advance.

To Adjust the Auto Advance Options:

1. In any mode, click Tools | Options.

2. In the Options dialog box, click General | Auto Advance.
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3.
4.

On the Auto Advance page, set or change the options as described below.

Click OK to apply your changes and return to ACDSee.

Auto Advance Options

Enable Auto Advance in * Manage Mode Deselect to turn off Auto Advance in either
+ View Mode Manage or View mode.
Auto Advance when * Tags Specifies which applied or removed
applying/clearing + Ratings metadata will trigger Auto Advance.
* Labels

! Keywords and Categories are
* Categories disabled by default.

+* Keywords

Setting the Mode Configuration Options

You can control the appearance of the mode buttons to maximize viewing space.

To Set the Mode Button Options:

1.
2.
3.

In any mode, click Tools | Options.
In the Options dialog box, click Mode Configuration.
On the Mode Configuration page, hide modes by deselecting their corresponding checkboxes.
! You cannot hide Manage mode.
Use the modes' corresponding drop-down menus to set them to display icons and labels, labels only, or
icons only.

Click Condense the appearance of the mode buttons to conserve space with smaller mode buttons.

Click OK.

Setting the Manage Mode Options

You can use the Options dialog box to set various options for Manage mode, including the default start folder.

To Set Manage Mode Options:

1.

A

In any mode, click Tools | Options.
In the Options dialog box, click Manage Mode.
On the Manage mode page, set or change the options as described below.

Click OK to apply your changes and return to ACDSee.

Manage Mode Options
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Default start folder

Display theme

Clear path history on
exit

Show full path in title
bar

Show database
filename in title bar

Folder Tree

Error Reporting

Scanning Destination

Remember from Opens Manage mode in the same folder that was open the
previous session last time you used ACDSee, and automatically applies any
browsing criteria you were using.

Home folder Always opens Manage mode to the specified Home folder.
Click the Browse button to locate a starting folder on your
hard drive.

Show warning if If you have enabled Remember from previous session,

start folder does and that folder, or your Home folder, no longer exist, you

not exist will receive a warning.

Specifies the color scheme to use in ACDSee.

Clears the list of recently-accessed folders whenever you exit ACDSee.

Displays the full path of an image in the ACDSee title bar.

Displays the name of the database that ACDSee is currently running in the title bar.

Display Density Sets how condensed the Folder tree appears.

Use plus signs to Displays plus signs next to items on the Folder tree that can
expand folder tree be expanded.

Select this option if you do not want to see a system error report if there is an error
in ACDSee.

Click the Browse For Folder button to specify the destination for your scanned
images.

Setting the Quick Search Options

You can use the Quick Search options to refine your search.

To Set Quick Search Options:

1. In Manage mode, click Tools | Options.

A wN

Quick Search Options

Include file names

Include categories

Include contents of
folders

In the Options dialog box, click Manage Mode | Quick Search.
On the Quick Search page, set or change any of the Quick Search options described below.

Click OK to apply your changes and return to ACDSee.

Searches for file and folder names that begin with the search term.

Searches for categories that match the search term, and returns any files assigned
to those categories. Subcategories are not included.

Searches for folder names that begin with the search term and returns the contents
of those folders. Subfolders are not included.

Setting the File List Pane Options

You can use the Options dialog box to set options for the File List pane to suit your preferences, such as grouping
archive files with subfolders, or highlighting image types with different background colors. You can also
customize your thumbnails, the file types ACDSee displays, and adjust how ACDSee handles files and thumbnails

in the File List pane.
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To Adjust the File List Pane Options:
1. In any mode, click Tools | Options.
2. In the Options dialog box, click File List.
3. On the File List page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

File List Options
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File List

Configure Filters

Highlight image files

Pop-ups
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Automatically select
new files

Group archives with
folders

Use embedded
thumbnails

Generate high quality
thumbnails

Show thumbnails on
folders

Remember each
folder's sort settings

<CTRL> key activates
hot-tracking

Use animations

Show all files

Apply filtering
criteria

Show hidden files
and folders

Show THM files
Show XMP files

Don't highlight image
files

Use a single color to
highlight image files
Use multiple colors to
highlight image files

Mouse cursor hover
activates pop-ups

<SHIFT> key
activates pop-ups

Automatically selects new files when they are added to
the folder displayed in the File List pane.

Treats archive files as folders when sorting items in the
File List pane.

Displays the RAW files embedded thumbnail if the RAW
file has them.

Creates a high-quality thumbnail of the RAW file in the
background while the embedded thumbnail is
displayed, then replaces the poorer quality thumbnail
once itis ready.

Displays thumbnails of a folder's contents on the folder
icon in the File List pane.

Select this option if you want ACDSee to remember the
sort settings that you used in specific folders.

Activates hot-tracking when holding the CTRL key.
When selected, you can hot-track (update the contents
of the Preview and Properties panes without changing
your file selection) by holding the CTRL key and moving
your cursor over the File List pane.

Activates or deactivates animation for some features as
they close or open. For example, group headers.

Shows image files, folders, media files and archive files
in the File List.

Shows any of the following that you select, and hides
any that are not selected.

* Show image files
* Show folders
* Show media files

* Show archive files

Shows system and other files and that are normally
hidden for safety.

Shows Canon THM files in the File Fist.
Shows XMP sidecar files in the File List.

Does not highlight image files in Details and
Thumbs+Details views.

Uses a single color to highlight all image file types in
Details and Thumbs+Details views.

Uses a different color to highlight each image type in
Details and Thumbs+Details views.

Activates or deactivates the animated pop-up preview
that displays when you hover over thumbnails in the File
List.

Settings below allow you to include text and/or an image
in the pop-up, or if you turn this option off, to activate
the pop-up only when you hold down the SHIFT key.

Activates the pop-up only if you hold down the SHIFT
key while hovering over a thumbnail in the File List. You
can turn this option off if it interferes with SHIFT
selection.
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Auto hide pop-ups Hides pop-ups after 5 seconds, even if you are still
hovering over the image.

Show thumbnail in Shows a pop-up preview of images in the File List when

pop-ups you hover over them with a mouse.

Show information in Includes text file information in the mouse-over pop-up.

pop-ups You can select the information to display by clicking the
Configure file information...button and selecting
your desired pop-up information.

Configure file Opens the Choose Pop-up Information dialog where you can select what information

information to display in the pop-up when you hover over a thumbnail in the File List. The
default is file name, location, size, modified date, and image dimension, but you can
select other ACDSee Metadata, EXIF, file, image, IPTC, or multimedia attributes.

Show the Windows Displays the default Windows Explorer context menu instead of the ACDSee context
Explorer shell context menu.

menu as the default

right-click menu

Setting the Thumbnail Info Options

You can use the Options dialog box to change what information to display with thumbnails of images in the File List
pane. These options are set under File List | Thumbnail Info.

To Adjust the Thumbnail Info Options:
1. In Manage mode, click Tools | Options.
2. In the Options dialog box, click File List | Thumbnail Info.
3. On the Thumbnail Info page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Thumbnail Info Options
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Information

Overlay icons

% Toview the
'y overlayicons, go

to Browsing Files

in the File List
Pane.

File name
Choose Thumbnail
Info

Choose Tiles Info

Show unrated,
untagged, and
unlabeled overlay
icons on hover
Rating

Embed Pending

Icon

Category

Collection

Shortcut

Offline

Excluded items

Tagged items

Auto-rotate

Edited

Geotagged

Label

Displays the name of each file on the thumbnail in the
File List pane.

Opens a dialog box where you can select the information
to display on each thumbnail in the File List pane.

Opens a dialog box where you can select the information
to display on each tile in Tiles view mode.

Shows unrated, untagged, and unlabeled overlay icons
on hover.

Displays a rating overlay icon on thumbnails if the file
has been rated in the ACDSee database.

Displays a database overlay icon on the thumbnails of
files that have had metadata information added and
stored in the ACDSee database, but have not yet been
written to the files. This icon indicates that a file and the
database are out of sync.

Displays a file format overlay icon on thumbnails in the
File List pane.

Displays a category overlay icon on thumbnails if the file
has been categorized.

Displays a collection overlay icon on thumbnails if the
file has been added to a collection.

Displays a shortcut overlay icon on thumbnails if the
item is a shortcut to another file.

Displays an offline overlay icon on thumbnails if the file
is stored on an offline device.

Displays an excluded file icon on thumbnails if the file is
excluded from the ACDSee database.

Displays a tagging overlay icon on thumbnails. If the file
is tagged, a checkmark displays in the icon.

Displays an auto-rotate overlay icon on thumbnails if the
file was automatically rotated.

Displays an Edit overlay icon on thumbnails if the file
has been edited.

Displays a marker overlay icon on thumbnails if the file
has been pinned on the map.

Displays a color label overlay icon on thumbnails if the
file has been labeled.

Setting the Thumbnail Style Options

You can use the Options dialog box to change how the thumbnails of images display in the File List pane. These

options are set under File List | Thumbnail Style.

To Adjust the Thumbnail Style Options:

1. In Manage mode, click Tools | Options.

2. In the Options dialog box, click File List | Thumbnail Style.
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3. On the Thumbnail Style page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Thumbnail Style Options

Thumbnail frame Show drop shadow Shows thumbnails with a 3D drop shadow.
Show slide Displays a shaded background behind the thumbnail
background and its information.
Folder style XP style folder Displays folders as an XP-style image.
3D style folder Displays folders as a 3D folder with transparency.
Thumbnail ratio Custom Specifies a custom height-to-width ratio for the shape

of the thumbnails in the File List pane. Drag the slider
under the preview to set the ratio. The preview shows
you the shape as you move the slider.

Portrait Specifies a standard 3:4 portrait ratio for the shape of
the thumbnails in the File List pane.
Landscape Specifies a standard 4:3 landscape ratio for the shape
of the thumbnails in the File List pane.
Thumbnail spacing Slider Increases or decreases the space between each
thumbnail.

High-quality scaling Uses high-quality thumbnail scaling in the File List pane.

Setting the Details View Options

You can use the Options dialog box to change how thumbnails display in the File List pane.

To Adjust the Details View Options:
1. In any mode, click Tools | Options.
2. Inthe Options dialog box, click File List | Details View.
3. On the Details View page, set or change the options as described below.
4

Click OK to apply your changes and return to ACDSee.

Details View Options

Show grid lines Separates each row and column in Details view mode with a grid line.
Full row select Selects the entire row when you click a column entry in that row.
Column auto-width Automatically resizes each column to fit its contents.

Highlight sort column Highlights the column used to sort files when you click on the column's title.

Choose Details Specifies the columns you want to use to sort files in Details view mode.

Setting the Preview Pane Options

You can specify how ACDSee displays previews of your images, and configure settings to play audio and video files
automatically, as soon as you view them in the Preview pane.

To Set the Preview Options:
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1. Do one of the following:

* In Manage mode, click Tools | Options | Preview.

* In Manage mode, right-click in the Preview pane and select Preview Options.

2. On the Preview options page, set or change the options as described below.

3. Click OK to apply your changes and return to ACDSee.

Preview Options

Delay

Size

Preview audio and
video clips

Autoplay audio and
video clips

Instant image
preview

Image and
Information

Choose Preview Info

Specifies how quickly the Preview pane displays an image after you select it in the
File List pane.

Specifies the size of the previewed image in relation to the selected image.

Previews media files as you select them in the File List pane.

Automatically starts playing audio and video files in the Preview pane.

Displays an instant preview that improves in quality as the image is decoded.

Select one of the following:

* Show image: Displays a preview of the selected image in the Preview
pane.

* Show information: Displays information about the selected image in the
Preview pane.

Specifies the type of information you want to display in the Preview pane. For more
information, see Previewing Images.

Setting the Folders Pane Options

You can customize the Folders pane by showing or hiding the Easy-Select bar, displaying archives, and identifying

excluded folders.

To Customize the Folders Pane:

1. In any mode, click Tools | Options.

2. In the Options dialog box, click Folders.

3. On the Folders page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Folders Pane Options
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Easy-Select Show Easy-Select

Enable Easy-Select
tooltip

Show archives in
Folder Pane

Folder display

Confirm drag & drop
move within folder
views

Show overlay for
excluded folders

Setting the Catalog Pane Options

Displays the Easy-Select bar in the Folders pane, which
you can use to select multiple folders.

Displays a tool-tip when you place your cursor over the
Easy-Select bar.

Lists archive files in the Folders pane.

Prompts you for confirmation of folder movements
within the Folders pane.

Displays an overlay icon on folders that are excluded
from the ACDSee database.

You can customize the Catalog pane to specify which confirmations you want to be prompted for while working
with categories, and choose whether to show the Easy-Select bar.

To Set the Catalog Pane Options:
1. In any mode, click Tools | Options

2. In the Options dialog box, click Catalog.

3. On the Catalog page, set or change the options as described below.

4. Click OK.

Catalog Options

Category deletion Confirm if category

has assigned files

Confirm if category
has sub-categories

Confirm file removal
from category

File removal

Easy select Show Easy-Select

Enable Easy-Select
tooltip

Show icons for
categories, ratings,
color labels, and
special items

Icons

Enable setting
categories, keywords,
ratings, and color
labels

Setting the Calendar Pane Options

You can customize the ACDSee Calendar to start each week on a specific day, to use a 12- or 24-hour clock format,

and to use one of four date types when sorting files.
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Prompts you for confirmation when deleting a category
with assigned files.

Prompts you for confirmation when deleting a category
containing sub-categories.

Prompts you for confirmation when un-assigning files
from a category.

Displays an Easy-Select bar in the Catalog pane, which
you can use to select multiple categories, special items,
and ratings.

Displays a tool-tip when you place your cursor over the
Easy-Select bar.

Displays icons so you can easily identify categories,
ratings, color labels, and special items.

Allows you to set categories, ratings, and color labels in
the Catalog pane.
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To Set the Calendar Pane Options:
1. In any mode, click Tools | Options.
2. In the Options dialog box, click Calendar.
3. On the Calendar page, set or change any of the options described below.

4. Click OK to accept your changes and return to ACDSee.

Calendar Pane Options

Date types Database date Sorts files in the Calendar pane based on
the date stored in the ACDSee database.

Date taken Sorts files in the Calendar pane based on
the EXIF date of each item.

File modified date Sorts files in the Calendar pane based on
the last-modified date of each item.

File created date Sorts files in the Calendar pane based on
the date each file was created on your
computer.

Filters Apply Advanced File List Filters Filters the items displayed in the Calendar

(excluding folders) pane based on the current File List pane
filter settings.

Show image and media files Displays only image, audio, and video files

only in the Calendar pane.

Start of week Specifies the first day of each week in the Calendar pane.
Clock formats 12 hour Uses a 12-hour clock in the Calendar pane.

24 hour Uses a 24-hour clock in the Calendar pane.

Setting the CD/DVD Management Options

You can use the Options dialog box to set the preferred method for identifying Photo Discs.

To Change the Photo Disc Identification Options:
1. In any mode, click Tools | Options.
2. In the Options dialog box, click CD/DVD Management.
3. On the CD/DVD Management page, set or change any of the options described below.

4. Click OK to apply your changes and return to ACDSee.

CD/DVD Management Options

Photo Disc Use disc Attempts to identify a Photo Disc by its volume label. This setting
Identification volume label is recommended if you are working with multi-session Photo
Discs.
Use disc Attempts to identify a Photo Disc by its serial number. This
serial setting is preferred when working with single-session Photo
number Discs, or importing or converting Photo Discs from a previous

version of ACDSee.
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Setting the Properties Pane Options

You can use the Options dialog box to customize the information available on the Metadata tab in the Properties
pane.

To Customize the Metadata Tab in the Properties Pane:
1. In Manage mode, click Tools | Options.

2. In the Options dialog box, click Properties Pane.

w

On the Properties Pane page, hide the Tagged, Rating, and Color Labels, by deselecting the corresponding
checkbox.

Hide the Categories by deselecting the checkbox.
Click Manage Metadata Views to open the Choose Metadata to Display dialog box.
Click the plus signs to expand the tree and select your preferences.

Click OK.

® N o u b

Click OK to apply your changes and return to ACDSee.

% You can also click the Metadata View drop-down list in the Properties pane Metadata tab and select
) Manage Metadata Views.

"
I

Setting the File Management Options

You can specify how ACDSee handles renaming and deleting files and folders, and whether ACDSee sends deleted
files to the desktop Recycle Bin by default.

To Set the File Management Options:
1. In any mode, click Tools | Options.
In the Options dialog box, click File Management.

On the File Management page, set or change any of the options as described below.

BN

Click OK to accept your changes and return to ACDSee.

File Management Options
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Overwriting duplicate Ask Prompts you for confirmation when overwriting
files duplicate files.
Rename Automatically resolves any naming conflicts when

moving or copying files by renaming the source files.

In the Separator character field, type a character to
use to separate file names in the automatic renaming

system.

Replace Automatically overwrites files in the target folder
without prompting for confirmation.

Skip Does not move, copy, or overwrite any files that result
in naming conflicts.

Save Originals Saves a copy of the original file when it is edited using one of the batch editing
tools. This makes it possible to restore the original file later. Turning this option off
means that originals are not saved during batch editing, and so cannot be restored.

In Edit mode, a copy of the original file is always saved, whether or not this option is

selected.

Other Click to edit file Specifies that file names can be edited by clicking the
name file name in the File List pane.

Use Recycle Bin Sends files to the Desktop Recycle Bin. If not selected,
deleted files are permanently removed from your hard
drive.

Preserve database Copies database information with files when you copy

information when them to another location.

files are copied

Control confirmations for folder delete, file delete, and read-only rename and delete actions in your
-=*__| operating system settings.

Setting the Database Options

You can adjust settings in the Options dialog box to display reminders, control database information, and specify a
location on your hard drive where you want to store your database files and cached thumbnails.

To Set the Database Options:
1. In any mode, click Tools | Options.
2. In the Options dialog, click Database.
3. On the Database page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Database Options
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Database file

Display backup
reminder

Manage excluded
folders

Display embed
ACDSee Metadata
reminder

Set database date to
EXIF date

Import EXIF and
IPTC metadata from
cataloged files

Set "Embed Pending"
when tagging files

Show separator
conflict dialog for
IPTC keywords

Show separator
conflict dialog for
IPTC supplemental
categories

Displays the location on your hard drive where the ACDSee database is stored.

Automatically reminds you to back up your ACDSee database. Click the Every drop-
down list and select how often you would like to be reminded.

Opens the Excluded Folders List dialog box, where you can specify which folders
you want to exclude from the ACDSee database.

Displays a reminder to embed ACDSee Metadata.

Automatically adds the EXIF date to the ACDSee database when you catalog the
contents of a folder.

Note: If the database date is changed, the Embed Pending flag does not
== show up.

Automatically imports EXIF and IPTC information into the ACDSee database
whenever you catalog the contents of a folder.

If this option is not selected, ACDSee does not import the EXIF and IPTC
information, but does set aside space within the database records. To remove the
empty records, be sure to optimize your database frequently.

Displays a database overlay icon on thumbnails if the file has been tagged, but this
metadata has not yet been written to the file. This icon indicates that the file and
the database are out of sync. When this option is disabled, tagged images will not
show up under Embed Pending in the Special Items section of the Catalog pane.

Displays the IPTC Keywords dialog box when a separator conflict occurs. You can
specify a method of handling conflicts within the dialog and select not to display it
again. Select this option to change or adjust those settings the next time a
separator conflict occurs.

Displays the IPTC Supplemental Categories dialog box when a separator conflict
occurs. You can specify a method of handling conflicts within the dialog and elect
not to display it again. Select this option to change or adjust those settings the
next time a separator conflict occurs.

Setting the Photos Mode Options

You can adjust settings in the Options dialog box to determine which files will display in Photos Mode and how.

To Set the Photos Mode Options:

1. In any mode, click Tools | Options.

2. In the Options dialog, click Photos Mode.

3. On the Photos Mode page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Photos Mode Options
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Photos Show database Select Show database orphan files to display missing files
orphan files flagged as orphans. Orphans will be displayed in sepia.
Show Activates or deactivates the animated pop-up navigation
navigation thumbnail, which displays the date on the thumbnail during
thumbnail scrolling. This option is to assist with orientation for users

while scrolling scrolling through large photo collections.

This option only works when using the scroll bar and
=£ | pausing in the desired photo area/date range.

Sort thumbnail dates Select whether your thumbnails will display from oldest to newest or newest to

oldest.

Pop-ups Mouse cursor Activates or deactivates the animated pop-up preview that
hover displays when you hover over thumbnails.
activates pop-
ups
<Shift> key Activates the pop-up only if you hold down the SHIFT key while
activates pop- hovering over a thumbnail.
ups
Auto hide pop- Hides pop-ups after 5 seconds, even if you are still hovering over
ups the image.
Show Shows a pop-up preview of images when you hover over them
thumbnail in with a mouse.
pop-ups
Show Includes file information in the mouse-over pop-up. You can
information in  select the information to display by clicking the Configure file
pop-ups information... button and selecting your desired pop-up

information.

Setting the View Mode Options

You can use the Options dialog box to adjust the behavior of View mode to suit your preferences, and increase the
speed with which images are displayed.

To Set the View Mode Options:
1. In any mode, click Tools | Options.
2. Inthe Options dialog box, click View Mode.
3. On the View mode options page, set or change any of the View mode options described below.

4. Click OK to accept your changes and return to ACDSee.

View Mode Options
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Decoding and caching

Startup files

Dropped files

Always on top
Full-screen

Hide mouse cursor in
full-screen

Instant image preview

Use ACDSee Quick
View

Show pixels when
zoomed past 100%

Always open in
selected Auto Lens

Exit after delete/move

View all images in
folder

Show full image file
path

Sharpen subsampled
images

Decode next image in
advance

Keep previous image
in memory

Replace images in list
Images in hew

window

Replace images in list

Add images to list

Automatically decodes the next image in sequence in
View mode, resulting in shorter load times.

Keeps the previously decoded image in memory for
quick display in View mode.

Does not open a new View mode window if an image is
opened from another application.

Opens a new View mode window to display images
opened from another application.

Replaces the list of images open in View mode with
images dropped into View mode from another
application.

Adds any images dropped into View mode by another
application to the list of images already open.

Keeps the ACDSee window as the top window in a stack of windows.

Opens images in View mode in full-screen mode. (Press F to exit full-screen mode.)

Hides the cursor in full-screen mode.

Displays an instant preview in View mode that improves in quality as the image is

decoded.

If selected, ACDSee Quick View is set as the default viewer for images when ACDSee

is closed.

Resampling is not applied to images zoomed past 100%. When the box is
unchecked, images zoomed past 100% are resampled to produce smooth
transitions, but this may result in excessive blurring.

On startup, opens images in the Auto Lens last selected prior to closing ACDSee.

Automatically returns to Manage mode after moving or deleting an image in View

mode.

Adds all images in a folder to the current image list when viewing any file from that

folder.

Displays the image's full file path in View mode title and status bars.

Automatically sharpens the view for images zoomed in at less than 100%.

Setting the Display Options

You can use the Options dialog box to change the window background and specify how images are zoomed.

To Set the Display Options:

1. In any mode, click Tools | Options.

BN
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Zoom options Default zoom mode

Reset zoom mode to
default on every
image change

Resize
Pan tool Enable click-zooming
Pan speed Slow - Fast
Background Default color

Custom color

Tiled image

Specifies the default zoom level for images in View
mode.

Resets the zoom mode to the selected default when the
displayed image changes.

Resizes the image based on the selected option. For
more information about how these choices affect the
Viewer, see Automatically shrinking or enlarging

images.

Deselect to turn off the one click image toggle between
Default view and Actual Size view.

Specifies the speed when panning an image.

Uses the default ACDSee color for the background in
View and Edit mode.

Specifies a color to use as the background in View and
Edit mode.

Uses a tiled image as the background for View and Edit
mode. Click Browse to locate an image on your hard
drive.

fThe background color and tiled image options do not affect full screen mode.

To change the background color in ACDSee Quick View, open an image in Quick View, and then click

= | Tools | Options.

Setting the Edit Mode Options

You can use the Options dialog box to show icons in Edit mode.

To Show Icons in the Edit Pane:
1. In any mode, click Tools | Options.
In the Options dialog box, click Edit Mode.

Set the options as described below.

BN
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Edit Show icons on filter
menu pane

AutoSave all changes

GPU selection

Displays icons next to the tools in Edit.

Toggles AutoSave on and off. AutoSave saves your changes in Edit
mode automatically, without prompting the Save Changes dialog.

In order to ensure optimum performance, parts of Edit mode run
off of your GPU. ACDSee automatically chooses the best GPU in
your system. This option —Let ACDSee decide — is enabled by
default. When Let ACDSee decide is enabled, GPU model text
displays next to the option, specifying whether Edit mode is
running off of your primary GPU or another, more superior GPU
that ACDSee has detected. In most cases, the GPU detected and
identified as the best by ACDSee will be one and the same: your
primary GPU.

+ Use primary: You can enable this option if you prefer to use
your primary GPU over the GPU ACDSee has chosen.

* Let ACDSee decide: Select this option to enable using the
superior GPU found by ACDSee.

Setting the ACDSee Showroom Options

You can customize the ACDSee Showroom desktop slideshow in a number of ways, including changing the slide
duration, order, and transition or changing the frame opacity, size, and frame style.

To Customize the ACDSee Showroom Desktop Slideshow:

1. Start ACDSee Showroom by doing one of the following:

* In any mode, click Tools | Create | ACDSee Showroom.

* C(Click Start | Programs | ACD Systems | ACDSee Showroom.

Right-click anywhere in the ACDSee Showroom window and select Options.

Set or change the options as described below.

2
3
4. Click Set As Default to use the currently selected options as the default for new Showroom windows.
5

Click OK to apply your changes.

ACDSee Showroom Options
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Picture Folder Include subfolders Select this option if you want to include photos from
subfolders in the slideshow.

Skip hidden folders Select this option to skip hidden folders such as the
[Originals] folders that are created when you process
images.

Slide Duration Drag the slider to the left to decrease the display time
for each photo and to the right to increase the display
time for each photo.

Order From the Order drop-down list select Sequential to
display photos in order or Random to display photos
randomly.

Transition From the Transition drop-down list select None if you

do not want any special transition effects, Slide if you
want photos to enter the window from the right and exit
to the left, and Fade if you want to reduce photo opacity
during the transition from one photo to another.

Apply to all Select Apply to all if you want to apply these changes
to all slideshows.

Showroom Window Opacity Drag the Opacity slider to the left to reduce the opacity
of the Showroom window and to the right to increase
opacity.

Size From the Size drop-down list select either a Small,
Medium, or Large Showroom window frame.

Frame From the Frame drop-down list select a frame style.

Always on top Select Always on top if you want the Showroom
window to display on top of all other application
windows.

Apply to all Select Apply to all if you want to apply these changes

to all Showroom windows.

Run at startup Select Run at startup if you want to start ACDSee Showroom automatically when
you start your computer.

Setting the ACDSee Quick View Options

You can customize ACDSee Quick View in a number of ways, including displaying Quick View on top of any open
windows, displaying Quick view at full screen, or even changing the background color in the Quick View window.

To Customize ACDSee Quick View:

1. Double-click on an image. For example, double-click on the image in Windows Explorer or in an email
message.

2. Click Tools | Options.
3. Setor change the options as described below.

4. Click OK to apply your changes.

ACDSee Quick View Options
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Use ACDSee Quick If selected, ACDSee Quick View is set as the default viewer for images when ACDSee
View is closed.

Enable gamma Applies the specified amount of gamma correction when viewing images.
correction

Disable animation Displays only the first frame of an animated image.

Always on top Keeps the Quick View window as the top window in a stack of windows.

Full screen Opens images in the Quick View window in full screen mode.

Hide mouse cursor in Hides the cursor in full screen mode.
full screen

Default zoom mode Fit image: Displays the image at the largest magnification that fits in the Quick
View window. Images that are smaller than the Quick View window display at their
original size.

Actual size: Displays the image at its actual size in the Quick View window.
Background Default color: Uses the ACDSee background color in Quick View.

Custom color: Specifies a color to use as the background in the Quick View
window. Click the color swatch to select a different color.

Setting the Media Options

You can change what application handles your audio and video files when launched from ACDSee.

To Customize the Default Media Player for Files Launched from ACDSee:
1. In any mode, click Tools | Options.
2. In the Options dialog box, click Media.

3. Tolaunch audio and video files in your system's default media player, check the Use default media
player to open audio and video files checkbox.

4. Click OK to apply your changes.

Setting the ACDSee Indexer Options

You can use the Options dialog to customize the functionality of the ACDSee Indexer.

To Customize the ACDSee Indexer:
1. In any mode, click Tools | Options.
2. In the Options dialog box, click ACDSee Indexer.
3. On the Folders page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

ACDSee Indexer Options
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Auto index folders or Enables the indexing of folders or images while the computer is idle. Set the
images when computer is slider toindicate how long your computer should be idle before indexing begins.
idle for

Index image files only Deselect to index all file types supported by ACDSee.

Current database Displays which database will be indexed.

Folders to monitor Displays which folders will be indexed.

Add Folder... Click the Add Folder... button to add additional folders to be indexed.

Remove Folder Select a folder from the list and click the Remove Folder button to remove it
from the folders to be indexed.

Include Microsoft Enables the indexing of your OneDrive folder.

OneDrive

Setting the ACDSee PicaView Options

You can use the Options dialog box to change your ACDSee PicaView settings, as well as toggling it on and off.

To Adjust the ACDSee PicaView Options:
1. In Manage mode, click Tools | Options.
In the Options dialog box, click ACDSee PicaView.

On the ACDSee PicaView page, set or change the options as described below.

AW N

Click OK to apply your changes and return to ACDSee.

ACDSee Picaview Options

Enable ACDSee This checkbox enables or disables ACDSee PicaView. When enabled, ACDSee PicaView

Picaview appears when an ACDSee-supported file is right-clicked anywhere on your hard drive.
You have the option of displaying a preview of the file or image, and its EXIF information,
or one or the other.

Display Image Select the Display Image checkbox to display a preview of the
right-clicked file.

Location: * Add image to main menu:
When you right-click, displays
image in the main menu.

* Add image to sub-menu:
When you right-click, displays
image in a sub-menu, available
by clicking the arrow next to
ACDSee PicaView.

Size: Select the size of the preview that
displays when you right-click.

Show Original Select Show Original to display the
pre-edited version of the image when
you right-click.

Show EXIF Toggle the Show EXIF Information checkbox to display the
Information right-clicked photo's EXIF information.

Setting the ACDSee Mobile Sync Options

You can use the Options dialog box to change your ACDSee Mobile Sync settings.
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To Set the ACDSee Mobile Sync Options:
1. In any mode, click Tools | Options.
2. In the Options dialog, click ACDSee Mobile Sync.
3. On the ACDSee Mobile Sync page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

ACDSee Mobile Sync Options

Root Folder Click the Browse For Folder button to specify the destination for your sent
images and videos.

Server Name To customize the name of the target server (ACDSee on your PC), enter text in the
field. This name will appear in your list of targets in the ACDSee Mobile Sync app.

Show ACDSee Mobile Displays the ACDSee Mobile Sync folder in the Folders pane.

Sync Root Folder on
Folder Tree

Auto-hiding Panes and Panels

You can use the Auto Hide button to automatically hide some panes and panels in ACDSee. When a pane is set to
auto-hide, it rolls away when you click outside of it, leaving a tab displayed. You can access the pane by moving
the cursor over the tab. When a pane or panel is floating, the auto-hide feature is not available. You cannot move
the pane to a new location if it is set to auto-hide.

The Auto Hide button's appearance on the pane’s title bar reflects its current setting:

A horizontal pushpin indicates that the pane is set to automatically hide when you click outside of
it.

A vertical pushpin indicates that the pane is fixed and will remain visible even if you click outside
of it.

To Set or Remove Auto-Hide:

Click the Auto Hide button on the title bar so that it displays a slanted or horizontal pushpin.

Using the Task Pane

The Task Pane displays groups of often-used tasks from the menus and toolbars based on your current location
and selections in ACDSee. By default, the Task Pane opens on the right side of the Manage mode window.
To Open or Close the Task Pane:

In Manage mode, click Panes | Task Pane.

The menus in the Task Pane change depending on what area of the Manage mode window you are working in

and what items you select. For example, if you select more than a folder in the File List pane, the Task Pane
displays different menus than it does if you select a photo or media file.

The options on the Task Pane menus also change dynamically. For example, if you select multiple images in the

File List, the options in the Fix and Enhance Photos menu change to list options that you can use with multiple
images.
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Customizing Toolbars

You can customize the appearance and organization of toolbars in Manage mode and View mode by selecting
which toolbars to display, and specifying each toolbar’s buttons or commands. You can also discard your changes
and reset the toolbars to their default layout at any time.

Displaying and Hiding Toolbars
You can choose to display or hide the specific toolbars in Manage mode and View mode.

To Display or Hide a Toolbar:

+ In Manage or View mode, click View | Toolbars, and then select the toolbar you want to display or hide.

Customizing Toolbar Contents

You can customize the following toolbars:
* In Manage mode: The Main toolbar and the File List toolbar.
* In View mode: The Bottom toolbar.

You can add, remove, and rearrange buttons on these toolbars. You can also display or hide text labels and tool
tips for the buttons on these toolbars. All toolbar customization options are in the Customize dialog box.

To Display the Customize Dialog Box:

Do one of the following:
* In Manage mode, click View | Toolbars and then select Customize.

* In Manage mode, click the drop-down arrow, located to the right of the Main toolbar or File List toolbar,
select Add or Remove Buttons, and then select Customize.

* 1In View mode, click the drop-down arrow, located to the right of the Bottom toolbar, select Add or
Remove Buttons, and then select Customize.

To Add or Remove Toolbar Buttons:

In Manage Mode:

Main toolbar:
1. Click the drop-down arrow located on the right side of the Main toolbar.

2. Select Add or Remove Buttons | Main Toolbar, then select the name of the button you want to add or
remove.

File List toolbar:

* With the Customize dialog box open, on the Commands tab, drag items from the Commands field to the
toolbar to add buttons.

* Toremove buttons, drag them from the toolbar to the Customize dialog box.

In View Mode:

Bottom toolbar:
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1. Click the drop-down arrow, located to the right of the Bottom toolbar.

2. Select Add or Remove Buttons | Bottom Toolbar, then select the name of the button you want to add
or remove.

To Rearrange Toolbar Buttons:

With the Customize dialog box open, drag buttons to your desired toolbar location.

To Display or Hide Text Labels Below Toolbar Buttons:
1. Display the Customize dialog box.
2. Click the Toolbars tab.
3. In Manage mode: Select File List Toolbar or Main Toolbar.
In View mode: Select Bottom Toolbar.

4. Select the Show text labels checkbox to display text labels, or clear the Show text labels checkbox to
hide text labels.

5. Click Close.

To Display or Hide Tool Tips for Toolbar Buttons:
1. Display the Customize dialog box.
2. Click the Options tab.

3. Select Show ScreenTips on toolbars to display tool-tips, or clear Show ScreenTips on toolbars to
hide tool-tips. If you select this option, you can also select Show shortcut keys in ScreenTips to show
keyboard shortcuts in the tool-tips.

4. Click Close.

Resetting Toolbars

You can discard all of your changes, and return the toolbars and buttons to their default states.

To Reset the Toolbars:
1. Display the Customize dialog box.
2. Click the Toolbars tab, and then click Reset All.
3. Click Yes to reset the toolbars.
4. Click Close.

Customizing Toolbar and Pane Locations

You can hide, resize, float, move, and dock most toolbars and panes to suit your preferences. To learn about all the
ways you can customize your experience in Manage mode, see Using Manage Mode.

Hiding Panes

At the top right corner of Manage, View, and Edit mode, you can use the Hide/Unhide buttons to hide and reveal
panes on the left, right, or bottom of the screen.
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Hide/Unhide Left Panels ]
Hide/Unhide Bottom Panels |;|
Hide/Unhide Right Panels (1

Moving Panes and Toolbars in View and Edit Mode

You can move a pane or toolbar from a docked or floating position to a new location.

! Some toolbars do not activate the Docking Compass.

To Move a Pane or Toolbar:
1. Drag the pane or toolbar's title bar and hold your cursor over any of the arrows of the Docking Compass.

2. When the shaded marquee displays the position of the pane or toolbar you want, release the mouse
button.

3. Toreturn a pane toits previous location, double-click its title bar.

To Move a Docked or Floating Pane or Toolbar:
Do one of the following:
* Drag the pane or toolbar's tab to a new location.
* Drag the pane or toolbar's title bar to a new location.

* If you use dual monitors, you can move the panes and toolbars to your second monitor to free up space on
your main monitor.

Docking Panes and Toolbars in View and Edit Mode

When you select a pane or toolbar, the Docking Compass activates to help you place the pane precisely. The
Docking Compass consists of an outer and inner ring of arrows. When you hold your cursor over any of the
arrows, a shaded marquee displays the potential position of the pane.

! Some toolbars do not activate the Docking Compass.

To Dock a Pane or Toolbar:

Drag the pane or toolbar's title bar or tab to activate the Docking Compass. To dock a pane around the outer edge
of the window, hold your cursor over any of the outer arrows of the Docking Compass, and then release the mouse
button.

Resizing Panes

You can resize all the panes and toolbars, whether they are docked or floating.

To Resize a Docked Pane:
1. Hold your cursor over the edge of the pane or toolbar until the cursor changes to arrows and lines.

2. Drag the edge of the pane or toolbar to the size you want.

To Resize a Floating Pane:

Hold your cursor over the edge or corner of the pane or toolbar and then drag the pane to the size you want.
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" You can enlarge the Filmstrip in View and Edit mode to expedite browsing your folder. To resize the
) Filmstrip, drag one of its edges.

.
I

’) You can tear off and move the Drawing and Selections Toolbar, as well as the ACDSee Actions bar.

Creating a Custom Menu

You can create a new menu in Manage mode with custom commands for easy access. You can also customize the
name and location of your new menu.

To Create a New Menu:
1. Do one of the following:
* In Manage mode, click View | Toolbars and then select Customize.

* In Manage mode, click the drop-down arrow located to the right of the Main toolbar or File List toolbar,
select Add or Remove Buttons, and then select Customize.

2. In the Customize dialog, on the Commands tab, select New Menu from the Categories field.

3. In the Commands field, select New Menu and drag it to your desired toolbar location.

To Add Commands to a New Menu:
1. Inthe Customize dialog, on the Commands tab, select any option from the Categories field.

2. In the Commands field, select your command and drag it over to your new menu on the toolbar. The new
menu will expand down. Drop the command on the menu.

To Delete a New Menu or Command:

! The Customize dialog must be open to delete a new menu or command.

Right-click the new menu or command and choose Delete from the context menu.

To Name a New Menu:

! The Customize dialog must be open to name a new menu.

1. Right-click the new menu and choose Button Appearance... from the context menu.
2. In the Button Appearance dialog, with Text only selected, enter a name in the Button text field.

3. Press OK.

Configuring External Editors

You can configure ACDSee to work with a variety of image editors, such as Canvas, and specify which image editor
ACDSee uses by default. You can then open images in any of your external editing applications from within
ACDSee.
! You must configure an external editor before you can assign a shortcut key to it or place it as a button on
the toolbar.

To Configure an External Editor in ACDSee:
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1. In Manage mode, click Tools | External Editors | Configure Editors.
In the Configure Photo Editors dialog box, click Add.
Browse to the folder on your hard drive that contains an image editing application.

2
3
4. Select the executable file of the editing application. For example, Canvas16.exe.
5. Click Open.

6

In the Name field, type a name for the editor, and then click OK.

To Create a Shortcut to an External Editor:
1. Choose Tools | Customize Shortcuts...
2. In the Customize Shortcuts dialog box, choose Tools from the Category drop-down menu.
3. From the Commands menu, select Default External Editor.
4. Enter a shortcut key into the Enter new shortcut key field.
5. Click Assign and close the dialog box.

Your new keyboard shortcut has been set.

To Add an External Editor to the FileList Toolbar in Manage Mode:

1. Click the Toolbar drop-down arrow (to the right of the Editors and Actions menu options) and select Add
or Remove Buttons | Customize.

2. In the Customize dialog box, on the Commands tab, select External Editors from the Category list.
3. Click and drag an External Editor from the list onto the FileList toolbar.
4. Close the dialog box.

The External Editor is added to the FileList toolbar.

To Add an External Editor Button to the Toolbar in View Mode:
1. Click the Toolbar drop-down arrow next to the tools and select Add or Remove Buttons | Customize.
2. In the Customize dialog box, on the Commands tab, select Tools from the Category list.
3. Inthe Commands list, select Default External Editor, and click and drag it onto the toolbar.
4. Close the dialog box.

The External Editor is added to the toolbar.

To Manage Your Image Editors:
1. In the Configure Photo Editors dialog box, in the Editors list, select the application you want to change.
2. Do any of the following:

* To change the location of the executable file or the name of the application displayed in the Editors
list, click Edit. Set the location and name of the application, and then click OK.

* To set the application as the default external editor for ACDSee, click Set As Default.

* To specify whether the application can handle multiple images at the same time, select or clear
the checkbox in the Supports Multiple Images column.

* Toremove the application from the list, click Remove.

3. Click OK to accept your changes and return to ACDSee.

To Open an Image in an External Image Editor:
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1. In Manage or View mode, select the image you want to open in the external editor.
2. Do one of the following:
* Click Tools | External Editors | Default External Editor or the name of an editor.

* Press CTRL + ALT + X to open the image in the default external editor.

Customizing Keyboard Shortcuts

There are pre-defined keyboard shortcuts for commands that you use frequently. You can change pre-defined
shortcuts, or create keyboard shortcuts for commands that do not currently have shortcuts. The options available
in the Customize Shortcut dialog will be mode-specific, depending on which mode you opened the dialog from.

! Keyboard shortcuts customized in one mode will not take effect in the other modes, even if the defined
command name is the same.

v If ashortcutis already assigned to a command, then assigning it to another command will unassign it
from the original command.

To Customize Keyboard Shortcuts:
In Manage, View, and Edit mode:
1. Click Tools | Customize Shortcuts... or press CTRL + SHIFT + ALT + S.

2. From the Category drop-down menu, select a category, such as File, Edit, or View. The commands
available from that menu display in the Commands list box.

3. Select a command in the Commands list box.
+* If a keyboard shortcut has been defined for that command, it displays in the Current Keys box.
+* If a keyboard shortcut has not been defined for that command, the Current Keys box will be empty.

To remove an existing keyboard shortcut, select the keyboard shortcut in the Current Keys box, and then click
Remove.

To Define a New Keyboard Shortcut:
1. Clickin the Enter a new shortcut key text box.
2. Press the keys on your keyboard that you want to use for the keyboard shortcut.

The keys display in the Enter a new shortcut key text box. The Currently assigned to field will display the
function your entered shortcut is assigned to, if applicable.

3. Click Assign.
The new keyboard shortcut displays in the Current keys box.
4. Click Close.

To remove all custom keyboard shortcuts and restore the default keyboard shortcuts, click Reset All.

Changing the Display Theme

In ACDSee you can change the display theme to change the background color of the panes and toolbars.

To Change the Display Theme:
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1. In Manage mode, click Tools | Options.
In the Options dialog box, click Manage Mode.

In the Display theme drop-down list, select a theme.

B woN

Click OK to apply your changes and return to ACDSee.

Setting JPEG Options

You can change the settings in the Options dialog box to control the quality of the JPEG image, encoding method,
color subsampling method, and whether to update or create embedded thumbnails in the JPEG image.

JPEG Options

Image quality Drag the slider to determine the quality of the JPEG image.
Encoding * Progressive: Select to enable progressive encoding.

+* Optimize Huffman codes: Select to optimize Huffman codes to increase
compression.
Color component + 2:1 Horizontal: Select to subsample color channels on the horizontal axis
sampling by a factor of 2:1.

+* 2:1 Vertical: Select to subsample color channels on the vertical axis by a
factor of 2:1.
Embedded thumbnails * Only update existing thumbnails: Select to update any existing
embedded thumbnails.

* Always add/update thumbnails: Select to update any existing
embedded thumbnails, or create embedded thumbnails.

* Never add/update thumbnails: Select if you do not want to update any
existing embedded thumbnails, or if you do not want to create embedded
thumbnails.

* Generate DCF compatible thumbnails: Select to generate thumbnails
that meet the Digital Camera Format (DCF) specification and are compatible
with the thumbnail view on the LCD of a digital camera. This option forces a
fixed resolution of 160 x 120 and pads any extra space with black.

Save these settings Select this option to use these JPEG settings by default for all JPEGs.
as the defaults
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Chapter 10: Shortcuts

Manage Mode Keyboard Shortcuts

You can use the following keyboard shortcuts while working in Manage mode. There are also shortcuts that can be
used specifically in the Calendar pane.

) To print this page for easy reference, right-click and select Print...
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Using Manage Mode
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This Shortcut
ALT + F4
CTRL + W

CTRL + SHIFT + ALT + S

ALT + O
F1
ENTER
DELETE

\ (backslash)

* (grave accent)
ALT +0to5
ALT + C

ALT + COMMA

ALT + PERIOD
ALT + ENTER
ALT + G

ALT + I

ALT + K

ALT + M

ALT + SHIFT + F
F2

ALT + W

ALT + X
BACKSPACE

CTRL +0to5

CTRL + \ (backslash)
CTRL + A

CTRL + B
CTRL + E

Has This Result
Closes ACDSee.

Opens the Customize Shortcuts dialog box,
in which you can customize keyboard
shortcuts.

Opens the Options dialog box.
Opens the Help file.
Opens the selected item in View mode.

Deletes the selected items.

Tags or untags the image.
Toggles image audio on or off.

Assigns a color label to the currently
selected item. Press ALT + O to remove a
color label.

Copies one or more selected files to a folder
you specify.

Opens the previous tab in the Properties
pane.

Opens the next tab in the Properties pane.
Opens or closes the Properties pane.
Opens the Import dialog box.

Opens the Filters dialog box where you can
specify the types of files displayed in the File
List pane.

Places the cursor in the Keyword section of
the IPTC group in the Metadata tab of the
Properties pane.

Moves one or more selected files to a folder
you specify.

Maximizes the File List pane.
Renames one or more selected files.

Restores your desktop wallpaper to the
settings you were using before you applied
an ACDSee wallpaper.

Removes currently displayed item from the
Image Basket.

Moves up one level in the current drive's
folder structure.

Assigns a rating to the currently selected
item. Press CTRL + 0 to remove a rating.

Selects the tagged images.

Selects the entire contents of the current
folder.

Adds the selected items to the Image Basket.

Opens the currently selected image in Edit
mode.



ACDSee Photo Studio Standard 2019

CTRL + G Generates a file listing as a text document.
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CTRL + I Selects all images in the current folder.
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CTRL + ALT + D Opens the Edit Caption dialog box.
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CTRL + K

CTRL + N
CTRL + O

CTRL + P

CTRL + TAB

CTRL + X

CTRL + C

CTRL + INSERT
CTRL + V

SHIFT + INSERT
CTRL + F

F5
F3
CTRL + ALT + E
Fa4
F6

F7

F8

F9

F10

F11

F12

SHIFT + DELETE

SHIFT + F5
SHIFT + TAB

TAB

CTRL + ALT + R

CTRL + ALT+ W

CTRL + ALT + X

CTRL + RIGHT CLICK
CTRL + SHIFT + 1
CTRL + SHIFT + 2

Places the cursor in the Keywords field of the
Organize tab in the Properties pane.

Creates a new folder in the File List pane.

Opens the Open Files dialog box, in which
you can select one or more images to open in
View mode.

Opens the currently selected image or
images in the ACDSee Print utility.

Moves the focus of the Manage mode window
between the currently displayed panes.

Cuts the currently selected items to the
Clipboard.

Copies the selected items to the Clipboard.

Pastes the contents of the Clipboard.

Puts the focus in the Quick Search bar so
that you can begin typing your search query.

Refreshes Manage mode.

Opens the Search pane.

Opens the Export dialog box.

Displays the Contents bar drop-down list.

Changes the File List to Thumbs+ Details
view,

Changes the File List to Filmstrip view.
Changes the File List to Thumbnails view.
Changes the File List to Tiles view.
Changes the File List to Icons view.
Changes the File List to List view.
Changes the File List to Details view.

Removes the selected item from your hard
drive.

Refreshes the File List pane.

Moves the focus of the Manage mode window
to the previous pane or tool in sequence.

Moves the focus of the Manage mode window
to the next pane or tool in sequence.

Opens the selected images in the Compare
Images viewer.

Sets the selected image as a stretched
desktop wallpaper.

Opens the current image in the default
external editor.

Opens Windows Explorer context menu.
Opens or closes the Folders pane.

Opens or closes the Catalog pane.
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Viewing

Batch Editing

Mode Switching
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CTRL + SHIFT + 3
CTRL + SHIFT + 4
CTRL + SHIFT + 5
CTRL + SHIFT + A
CTRL + SHIFT + B
CTRL + SHIFT + C

CTRL + SHIFT + D

CTRL + SHIFT + E

CTRL + SHIFT + F

CTRL + SHIFT + I
CTRL + SHIFT + L

CTRL + SHIFT + M
CTRL + SHIFT + N

CTRL + SHIFT + O

CTRL + SHIFT + T

CTRL + SHIFT + TAB

CTRL + SHIFT + W

CTRL + SHIFT + ALT + W

ALT + LEFT ARROW

ALT + RIGHT ARROW

CTRL + S

CTRL + SHIFT + P

CTRL + R
CTRL + T

CTRL + ALT + F

CTRL +J

CTRL + L

CTRL + F2

Opens or closes the Search pane.
Opens or closes the Calendar pane.
Opens or closes the Image Basket.
Selects all files in the current folder.
Shows or hides the status bar.

Copies the currently selected image to the
Clipboard.

Clears your current selection.

Opens the current file in the default system
application or opens a dialog box where you
can select an application.

Toggles the full-screen view for the File List
pane.

Inverts your current selection.

Opens or closes the Selective Browsing
panel.

Opens or closes the Map pane.

Opens a second instance of the ACDSee
program.

Opens the file using the system application
associated with its file extension.

Displays or hides the Manage mode Main
toolbar.

Moves the focus of the Manage mode window
between the currently displayed panes.

Sets the selected image as a tiled desktop
wallpaper.

Sets the selected image as a centered
desktop wallpaper.

Returns to the previous folder you browsed
in the File List pane.

Returns to the folder you last moved back
from in the File List pane.

Creates a slideshow from the currently
selected images.

Opens or closes the Preview pane.

Opens the Batch Resize Images dialog box.

Opens the Batch Adjust Time Stamp dialog
box.

Opens the Batch Convert File Format dialog
box.

Opens the Batch Rotate/Flip Images dialog
box.

Opens the Batch Adjust Exposure dialog box.

Switches to Photos mode.
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CTRL + F3 Opens the image in View mode.
CTRL + F5 Opens the image in Edit mode.
CTRL + F7 Switches to Dashboard mode.

Manage Mode Mouse Shortcuts

You can use the following mouse shortcuts in Manage mode.

' ) To print this page for easy reference, right-click and select Print...

Shortcut Resulting Action

Double-click Opens the selected image in View mode.

Right-click Opens the Manage mode context menu.

SHIFT + click Selects a group of images.

Click + drag Selects a group of images. Be sure to click on a blank area of the screen, not

on an image or folder, before you drag, so you can draw a selection box
around the group of images.

CTRL + click Selects images you click on.

CTRL + right click Opens the Windows Explorer context menu.

CTRL + Wheel up Increases the magnification of the thumbnail (zooms in).
CTRL + Wheel down Decreases the magnification of the thumbnail (zooms out).

View Mode Keyboard Shortcuts

You can use the following keyboard shortcuts while working in View mode.

i ) To print this page for easy reference, right-click and select Print...

/ If you would like to define your own keyboard shortcuts, see Customizing Keyboard Shortcuts.
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File Menu

Shortcut

ALT + F4

CTRL + W

* (grave accent)
ENTER

ESC

SHIFT + ESC

CTRL + SHIFT +
ALT + S

ALT + O
F1

CTRL + O
INSERT
SHIFT + F4

CTRL + SHIFT + F4

CTRL + S

SHIFT + L

SHIFT + E

CTRL + P

CTRL + SHIFT + P

ALT + L
ALT + U
ALT + Z

Customizing the Interface
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Resulting Action
Closes ACDSee.

Toggles the display of the full file path in the Status bar.
Switches to the previous mode.

Minimizes ACDSee in View and Edit mode.

Opens the Customize Shortcuts dialog box, in which you can
customize keyboard shortcuts.

Opens the Options dialog box.
Opens the Help file.

Opens the Open files dialog box.

Closes the current item.
Closes all images.

Opens the Save Image As dialog box, in which you can save your
image with a different name or file format.

Opens the file using the system application associated with its file
extension.

Opens the current file in the default system application or opens a
dialog box where you can select an application.

Opens the current image in the ACDSee Print utility.

Prints all currently selected images, or all images in the current
folder.

Opens the Flickr Uploader dialog box.
Opens the SmugMug Uploader dialog box.
Opens the Zenfolio Uploader dialog box.
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Managing
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CTRL + SHIFT + H
CTRL + SHIFT + M
CTRL + + (plus)
CTRL + - (minus)
CTRL + SHIFT + S
ALT + ENTER

ALT +,

ALT + .

CTRL + SHIFT + F
CTRL + SHIFT + I
T

CTRL + SHIFT + T
B

CTRL + SHIFT + B
CTRL + SHIFT + V

Toggles the Histogram open and closed.

Toggles the Magnifying Glass pane open and closed.
Zooms in on the Magnifying Glass pane.

Zooms out on the Magnifying Glass pane.

Toggles the Navigator open and closed.

Toggles the Properties pane open and closed.
Switches to the tab to the left on the Properties pane.
Switches to the tab to the right on the Properties pane.
Toggles the Filmstrip open and closed.

Toggles the Info palette open and closed.

Toggles the Toolbar open and closed.

Toggles the Status bar open and closed.

Toggles the Page View panel open and closed for multi-page images.
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CTRL + X Cuts the current item to the Clipboard.

CTRL + C Copies the currently displayed file to the Clipboard.
CTRL + V Pastes the contents of the Clipboard.

ALT + C Opens the Copy To Folder dialog box.

ALT + M Opens the Move To Folder dialog box.

DELETE Deletes the selected image.

F2 Opens the Rename File dialog box.

ALT + R

CTRL + B Adds the selected image to the Image Basket.

ALT + X Removes the selected image from the Image Basket.
ALT + A Opens the Add Shortcut dialog box.

CTRL + ALT + D
\ (back slash)

Opens the Edit Caption dialog box.
Tags or untags the image.

CTRL + M Opens the Manage Metadata Presets dialog box.
CTRL + O Clears the rating.

CTRL + 1 Assigns a rating of 1.

CTRL + 2 Assigns a rating of 2.

CTRL + 3 Assigns a rating of 3.

CTRL + 4 Assigns a rating of 4.

CTRL + 5 Assigns a rating of 5.

ALT + 0 Clears the color label.

ALT + 1 Assigns a red color label.

ALT + 2 Assigns a yellow color label.

ALT + 3 Assigns a green color label.

ALT + 4 Assigns a blue color label.

ALT + 5 Assigns a purple color label.

CTRL + K Opens the Keywords section of the Properties pane.
ALT + K Opens the Metadata tab of the Properties pane.
CTRL + SHIFT + Sets the selected image as the desktop wallpaper, centered.
ALT + W

CTRL + SHIFT + W
CTRL + ALT + W

Sets the selected image as the desktop wallpaper, tiled.

Sets the selected image as the desktop wallpaper, stretched.

ALT + W Restores your desktop wallpaper to the settings you were using
before you applied an ACDSee wallpaper.
Viewing
PAGE ARROW Displays the next image.
RIGHT
PAGE DOWN

3 (numeric keypad)
SPACEBAR

PAGE ARROW LEFT
PAGE UP

Displays the previous image.

9 (numeric keypad)
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BACKSPACE
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END Switches to the last image in the Filmstrip.

Page 291 of 329



ACDSee Photo Studio Standard 2019

HOME Switches to the first image in the Filmstrip.

Page 292 of 329



ACDSee Photo Studio Standard 2019

CTRL + Right-click Opens the Windows Explorer context menu.
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+ (plus)

- (minus)

SHIFT + 2

/ (forward slash)

* (numeric keypad
asterisk)

SHIFT + 8

ALT + PAGE ARROW

RIGHT

ALT + PAGE DOWN
ALT + \

L

z

PAGE ARROW
RIGHT

PAGE ARROW LEFT
PAGE DOWN

PAGE UP

F

CTRL + PAGE
ARROW RIGHT

CTRL + PAGE
ARROW DOWN

o

E

R

SHIFT + F1
SHIFT + F2
CTRL + Q
SHIFT + F3

F5

CTRL + 6

ALT + S

CTRL + ALT + S
CTRL + A

CTRL + SHIFT + Q

ALT + CTRL + S

SHIFT + PAGE
ARROW DOWN

SHIFT + PAGE
ARROW UP

SHIFT + HOME
SHIFT + END

Zooms in.

Zooms out.

Zooms in to the area you select.
Zooms the image to its actual size.

Fits the image to the viewing area.

Fits image width to the display area.

Fits image height to the display area.
Toggles the zoom lock on and off.
Toggles the pan lock.

Opens the Set Zoom Level dialog box.

Pans right when zoomed into the image.

Pans left when zoomed into the image.
Pans down when zoomed into the image.
Pans up when zoomed into the image.
Toggles full screen mode.

Toggles the right pane open and closed.

Toggles the bottom pane open and closed.

Displays saved version of the image.

Toggles the exposure warning on and off.

Toggles the RAW decode/embedded preview on and off.
Activates the Hand tool after zooming in with the Zoom tool.
Activates the Select tool.

Clears the current selection.

Activates the Zoom tool.

Refreshes the View mode window and reloads the current image.
Toggles the Light EQ button on and off.

Automatically advances to the next image every 1 to 2 seconds.
Launches the slideshow.

Displays or hides headers and footers.

Opens the View Header/Footer dialog box, in which you can specify
the text to display on your images in View mode.

Starts or stops the slideshow.

Advances to the next page of a multi-page image.

Switches to the previous page of a multi-page image.

Switches to the first page of a multi-page image.

Switches to the last page of a multi-page image.
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Editing

Mode Switching

View Mode Mouse Shortcuts

CTRL + SHIFT +
PAGE ARROW LEFT

CTRL + SHIFT +
PAGE ARROW
RIGHT

ALT + E

SHIFT + O

SHIFT + S

CTRL + ALT + F
CTRL +J

CTRL + R

CTRL + L

CTRL + T

CTRL + ALT + R
CTRL + SHIFT + 1
CTRL + SHIFT + 2
CTRL + SHIFT + 3
CTRL + SHIFT + 4
CTRL + SHIFT + 5
CTRL + SHIFT + 6
CTRL + SHIFT + 7
CTRL + SHIFT + 8
CTRL + SHIFT + 9

CTRL + F5
CTRL + F1
CTRL + F2
CTRL + F7

Rotates the current image 90° counterclockwise.

Rotates the current image 90° clockwise.

Opens the image in the default editor.

Restores an edited image to the original version.
Commits the changes.

Opens the Batch Convert File Format dialog box.
Opens the Batch Rotate/Flip Images dialog box.
Opens the Batch Resize Images dialog box.
Opens the Batch Adjust Exposure dialog box.
Opens the Batch Adjust Time Stamp dialog box.
Opens the Batch Rename dialog box.

Changes the image color depth to Black and White.
Changes the image color depth to 16 grays.
Changes the image color depth to 256 grays.
Changes the image color depth to 16 colors.
Changes the image color depth to 256 colors.
Changes the image color depth to Hicolor.
Changes the image color depth to Truecolor.
Converts the image to a 16-bit grayscale palette.

Converts the image to a 48-bit color palette.

Opens the currently selected image in Edit mode.
Switches to Manage mode.
Switches to Photos mode.

Switches to Dashboard mode.

You can use the following mouse shortcuts while working in View mode.

L
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Shortcut
Double-click
Right-click

Middle click

Wheel click

Wheel up

Wheel down

CTRL + Right-click
CTRL + Wheel up
CTRL + Wheel down
SHIFT + Wheel up
SHIFT + Wheel down

Resulting Action

Closes View mode and returns to the previous mode.
Opens the View mode context menu.

Toggles full screen mode (on 3-button mouse).
Toggles full screen mode.

Displays the previous item.

Displays the next item.

Opens the Windows Explorer context menu.
Increases the magnification of the image (zooms in).
Decreases the magnification of the image (zooms out).
Displays the previous page of a multiple-page image.

Displays the next page of a multiple-page image.

Calendar Pane Shortcuts

Once you are familiar with the basic calendar pane options, consider using the following shortcuts:

* Click the title bar on a year, month, or day table to display all available images for that year, month, or day.

* Right-click the title bar on a year, month, or day table to scroll through and select from adjacent years,

months, or days.

* In Year view double-click any month to switch to Month view. Or, in Month view, double-click any date to

switch to Day view.

+ In Month view click the letter indicating a day of the week to display all available images for that day of the
week. For example, click F to select all Fridays in that month.

* In Day view click AM or PM to select the first or second half of a day.

* 1In Event view press and hold the CTRL key and click any month or day to display all available images for

those months or days.

* Click on the title of any month calendar, to select all the photos in that month.

* Click the name of the week, to select all the photos in those weeks of the month.

* Drag and select any days in the calendar to select all the photos in those days.

Edit Mode Keyboard Shortcuts

Use the following keyboard shortcuts in Edit mode.

' ) To print this page for easy reference, right-click and select Print...

f If you would like to define your own keyboard shortcuts, see Customizing Keyboard Shortcuts.

Edit Mode Keyboard Shortcuts
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Shortcut Resulting Action
ALT + F4 Closes ACDSee in all modes.
SHIFT + ESC Minimizes ACDSee in View and Edit mode.
CTRL + SHIFT + Opens the Customize Shortcuts dialog box, in which you can
ALT + S customize keyboard shortcuts.
ALT + O Opens the Options dialog box.
F1 Opens the Help file.
* (grave accent) Toggles the display of the full file path in the Status bar.
File Menu
PAGE ARROW Opens the next image.
RIGHT
PAGE DOWN
3 (numeric keypad)
PAGE ARROW LEFT Opens the previous image.
PAGE UP
9 (numeric keypad)
CTRL + S Saves the image.
CTRL + ALT + S Saves a copy.
CTRL + ALT + E Opens the Export dialog.
END Switches to the last image in the Filmstrip.
HOME Switches to the first image in the Filmstrip.
ESC Switches to the previous mode.
ENTER
Edit Menu
CTRL +Y Redo.
CTRL + Z Undo.
CTRL + SHIFT + 2 Undo all.
CTRL + C Copy.
CTRL + V Paste.
DELETE Delete.
Managing

Page 297 of 329



ACDSee Photo Studio Standard 2019

ALT + 0

ALT + 1

ALT + 2

ALT + 3

ALT + 4

ALT + 5

CTRL + O

CTRL + 1

CTRL + 2

CTRL + 3

CTRL + 4

CTRL + 5

CTRL + K

ALT + K

\ (back slash)

CTRL + M

CTRL + ALT + D
Viewing

CTRL + PAGE
ARROW RIGHT

CTRL + PAGE
ARROW LEFT

CTRL + PAGE
ARROW DOWN

/ (forward slash)
SHIFT + 8

* (numeric keypad
asterisk)

+ (plus)
- (minus)
F

z

PAGE ARROW
RIGHT

PAGE ARROW LEFT
PAGE DOWN
PAGE UP

Customizing the Interface
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Clears the color label.
Assigns a red color label.
Assigns a yellow color label.
Assigns a green color label.
Assigns a blue color label.
Assigns a purple color label.
Clears the rating.

Assigns arating of 1.
Assigns a rating of 2.
Assigns a rating of 3.
Assigns a rating of 4.

Assigns a rating of 5.

Opens the Keywords section of the Properties pane.

Opens the Metadata tab of the Properties pane.

Tags the photo.

Opens the Manage Metadata Presets dialog box.

Opens the Edit Caption dialog box.

Toggles the right pane open and closed.

Toggles the left pane open and closed.

Toggles the bottom pane open and closed.

Zooms the image to its actual size.

Fits the image to the viewing area.

Zooms in.
Zoomed out.

Displays the image full screen.

Toggles Navigator open and closed when zoomed into the image.

Displays saved version of the image.

Pans right when zoomed into the image.

Pans left when zoomed into the image.
Pans down when zoomed into the image.

Pans up when zoomed into the image.
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Selecting

Filters
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F2
Fa4
ALT + ENTER
F5
F6
F7

CTRL + SHIFT + H

F10
ALT + F1
ALT + F2

ALT + A
ALT + D
ALT +1I
ALT + SHIFT + S
ALT + SHIFT + L
ALT + SHIFT + M

Toggles the Filter Menu open and closed.

Toggles the Properties pane open and closed.

Toggles the Filmstrip open and closed.
Toggles the Info palette open and closed.

Toggles the Histogram open and closed.

Toggles the Colors pane open and closed.
Toggles the Toolbar open and closed.

Toggles the Filters toolbar open and closed.

Selects all.

Deselects.

Inverts selection.

Saves the selection.

Opens the Load Selection dialog box.

Opens the Manage Selections dialog box
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Y Opens the Red Eye Reduction tool.
ALT + P Opens the Repair tool.
X Opens the Text tool.
ALT + W Opens the Watermark tool.
ALT + B Opens the Border tool.
\"/ Opens the Vignette tool.
ALT + S Opens the Special Effects panel.
T Opens the Tilt-Shift tool.
ALT + R Opens the Rotate tool.
ALT + F Opens the Flip tool.
C Opens the Crop tool.
J Opens the Resize tool.
ALT + X Opens the Exposure tool.
L Opens the Levels tool.
ALT + L Opens the Auto Levels tool.
V) Opens the Tones Curves tool.
Q Opens the Light EQ tool.
A Opens the White Balance tool.
ALT + H Opens the Color Balance tool.
w Opens the Convert to Black & White tool.
ALT + M Opens the Color LUTs tool.
ALT + N Opens the Sharpen tool.
ALT + U Opens the Blur tool.
N Opens the Noise Reduction tool.
ALT + C Opens the Clarity tool.
Working Inside Filters
B Toggles Brush controls open and closed.
S Toggles the brush stroke display when working inside a filter.
G Toggles Gradient controls open and closed.
R Toggles Radial Gradient controls open and closed.
SPACEBAR Switches to the Hand tool when working with the Brush or Gradients

inside a filter.
E Toggles the exposure warning on and off in the Exposure tool.

Tools
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CTRL + Q

CTRL + SHIFT + R

CTRL + SHIFT + E

CTRL + SHIFT + L

CTRL + A

CTRL + SHIFT + P

CTRL + SHIFT + B

B

CTRL + F

CTRL + G

CTRL + SHIFT + I
Color Tools

CTRL + [

CTRL + ]

CTRL + X
Selection Tools

CTRL + R

CTRL + I

CTRL + L

CTRL + W
Mode Switching

CTRL + F1

CTRL + F2

CTRL + F3

CTRL + F7

Edit Mode Mouse Shortcuts

Activates the Hand tool.
Activates the Rectangle tool.
Activates the Elliptical tool.
Activates the Line tool.
Activates the Arrow tool.
Activates the Polygon tool.
Activates the Curve tool.
Activates the Brush tool.
Activates the Fill tool.
Activates the Gradient tool.

Activates the Eyedropper tool.

Opens the Foreground Color dialog box.
Opens the Background Color dialog box.

Switches the foreground and background color.

Activates the Rectangle Selection tool.
Activates the Ellipse Selection tool.
Activates the Lasso Selection tool.

Activates the Magic Wand Selection tool.

Switches to Manage mode.
Switches to Photos mode.
Opens the image in View mode.

Switches to Dashboard mode.

Use the following mouse shortcuts in Edit mode to make quick image adjustments.

L

'_J To print this page for easy reference, right-click and select Print...

Shortcut Resulting Action

SHIFT + click Turns off the auto-collapse feature in the pane as you open groups.

SHIFT + mouse wheel Makes large adjustments to the sliders.

Right-click Resets any slider to its default value.

Mouse wheel over slider Makes fine adjustments to a slider. Place your cursor over the slider and scroll
up or down.

Mouse wheel over image Adjusts brush size. Place your cursor over the image and scroll up or down to

adjust nib width.

SHIFT + mouse wheel Adjusts feathering. Place your cursor over the image and scroll up or down to

adjust feathering.
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ACDSee PicaView Keyboard Shortcuts

You can use the following shortcut with ACDSee PicaView.

This Shortcut Has This Result
SHIFT + right-click an * If you have Display Image enabled: The image will not display in the
image main context menu.

* If you have Display Image disabled: The image will display in the main
context menu.
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Chapter 11: File Formats

About RAW Files

A RAW file is like a negative. RAW files contain all of the data that was collected by your digital camera's sensor
when you took a photo. If you tried to view a RAW file without processing, it would appear almost completely black.
It is therefore necessary to process your RAW files to produce a photo.

In ACDSee, you can view RAW files using the embedded thumbnail image created by your camera. If you want to
process RAW images, you must use a photo editing program such as ACDSee, which includes tools for developing
RAW images.

ACDSee will automatically apply geometry corrections to DNG files that include geometric distortion
==£ | correction tags. DNG files created from the Adobe DNG Converter© will often generate geometric
distortion tags for micro 4/3rds cameras.

Associating Files

ACDSee can work with a large number of file formats. ACDSee can be set as the default application for opening
certain file types. This process is called associating files. When you associate file types, you set ACDSee as the
default program to open these kinds of files when you double-click them.

To Set File Association Options in ACDSee:
1. Click Tools | File Association Settings.

2. In the four format sections, select the checkboxes of the file formats you would like to associate with
ACDSee for image formats, RAW formats, media formats, and archive formats.

3. Click Save.

To Disassociate a File Type with ACDSee:
1. Click Tools | File Association Settings.

2. In the four format sections, deselect the checkboxes of the file formats you would like to disassociate with
ACDSee for image formats, RAW formats, media formats, and archive formats.

3. Click Save.
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A

Absolute Colorimetric

Rendering intent, generally used for proofing. Based on a device-independent color space, reproducing colors within the available
gamut perfectly, and reducing colors outside of the gamut to the nearest reproducible hue (at the expense of saturation).

Actions, ACDSee Actions

ACDSee Actions record Edit mode adjustments. You can then apply them to other images by "playing" them back. This is an efficient
method to batch editing.

Acquire

Often used term to describe the process of locating images on peripheral devices (such as scanners and digital cameras) and adding the
images to your hard drive. Can also refer to taking screen captures. See import.

Album

Collection of images, often organized by theme or event. In ACDSee, albums contain shortcuts to where the images are stored on your
hard drive.

Aliasing
Jagged edges caused by pixels. Occurs most often in low resolution images or images that have been enlarged. See jaggies.

Anchor

Method of fixing an object such as a selection to a screen, page, or image location.

Antialiasing, Anti-Aliasing

Software technique for reducing jagged lines, or ‘jaggies’. Uses shades of gray and color to smooth out the contrast between adjacent
pixels.

Aspect Ratio
An image’s width-to-height ratio. For example, an image with an aspect ratio of 3:1 has a width 3 times larger than its height.
Azimuth
Angle of shadows that extend from the edges of image details. In ACDSee you can control azimuth when applying the Emboss effect to an

image.

B
Background Processing

Tasks or programs that function without user interaction.

Bandwidth

Amount of data that can be sent through a network connection in a fixed amount of time. Bandwidth is measured in kilobits per second
(Kbps).

Barrel Distortion

In barrel distortion the photo appears to bulge outwards from the center.
Batch Editing

Any operation or tool, such as resizing, converting, or renaming, that can be used to adjust multiple images or files simultaneously.
Bit

Bits are small units of computer memory. The color depth of your image is constrained by the number of bits available to store color

information. For example, it is possible to store 256 different color values per color channel in 8-bit RGB images. Similarly, it is possible
to store 65,536 different color values per color channel in 18-bit images.



Blackpoint

An image’s darkest area. You can control the intensity of the black in an image by adjusting its blackpoint.

Blend Modes

Filters that change the effect of a tool or the appearance of a selected object.

Brightness

Light intensity of an image. You can make an image appear brighter or darker by adjusting its brightness.

Brush

A tool that you can use in Edit mode to isolate or indicate pixels you want to apply effects or adjustments to. The Brush in Drawing Tools
can be used to draw in color on your image.

C
Cache

High-speed storage mechanism. The ACDSee Database is a cache.

Caption

Text associated with a file, or a comment or description added to a printed image.

Cataloging
Adding file information to the ACDSee database.

Category

Assign categories to photos to help sort and manage them more easily.

Chromatic Aberration

A lens artifact that can result in fringes in high contrast areas of some photos.

CMYK

Color model that uses cyan, magenta, yellow, and black (key) as its primary colors.

Color Cast

Changes the hue of an image while keeping the saturation and brightness intact. For example, many digital cameras produce pictures
with a slightly blue color cast. ACDSee includes a tool that removes an unwanted color cast.

Color Channel Value

Contains all pixel information for a single color. A grayscale image has one channel, while an RGB image has three channels. You can
adjust RGB values when editing a color.

Color Gamut

Range of colors that a device such as a printer or monitor can produce or display.

Color Management

Process of adjusting your computer settings so that the color output from your printer matches the colors you see on your monitor.

Color Space

There are two types of color spaces: device-independent or device-dependent. A device-independent color space, such as RGB,
describes all possible colors. A device-dependent color space describes the subset of colors (from the device-independent color space)
that a particular device can reproduce. Device-dependent color spaces are used to map colors between devices (for example, from a
monitor to a printer) to ensure that colors are reproduced accurately.

Compression



Process that converts data to a storage format requiring less space than the original data.

Contact Sheet

Physical or digital page that contains a series of small images, usually in a grid format.

Contrast

Measure of an image’s color and brightness differences.

Convert

Change a file from one format to another. For example, you might convert a file from a bitmap (.bmp) to a JPEG (.jpg) to reduce the file
size.

Cropping

Removing unwanted image areas.

D

Database

Electronic filing system that provides fast access to stored data. The ACDSee Database contains two parts: a cached thumbnail file and
an information file. The cached thumbnail file contains small copies (thumbnails) of the images on your system. The information file
contains details about the files on your system, such as descriptions, dates, authors, notes, keywords, and categories.

Database Date

Date that you apply to the properties of a file and save in the ACDSee Database.

Descriptions

ACDSee stores descriptions in a hidden file named descript.ion. Descriptions such as file name and captions for an image will be
included in the descript.ion files.

Dock

Attaching a toolbar, window, or pane to different screen areas.

DPI (dots per inch)

Measurement of an image’s resolution. For example, 92 DPI means 92 dots horizontally and 92 dots vertically, which equals 8,464 dots
per square inch. More dots per inch result in higher resolution and image quality.

Dynamic Range

The dynamic range of an image is directly related to the dynamic range of your digital camera's sensor. If your digital camera's sensor
has a large dynamic range it can capture the darkest shadows and brightest highlights at the same time, without clipping the shadows
or highlights. (RAW images preserve the dynamic range of your digital camera's sensor.) Adjusting the tonal range of the image
changes how the dynamic range of the image is represented on a monitor or in a photo.

E
Elevation

Height of an imaginary light source over an image. The elevation of the light source works in conjunction with azimuth to generate a
three-dimensional emboss effect.

Encode

Writing (or saving) a file format.

Encryption

Method of converting data into a secure format. You need a digital password or key to read an encrypted file.

EXIF (Exchangeable Image File)



Standard for storing information, primarily with images that use JPEG compression. Most digital cameras create EXIF information and
embed it in the image file. For example, EXIF information can include details about shutter speed and whether a flash was used.

Export

Moving data from one application to another. The exporting application places the data in a format that the other application
understands.

Exposure

Exposure is the amount of time that your digital camera's sensor is exposed to light.

F
Feather

Softening image edges to blend them into the background.
File Listing

In ACDSee, a report of the files currently displayed in Manage mode.
File Format

Medium for encoding information in a file. Each type of file has a different file format that specifies how it organizes the information it
contains.

Filter

Program that can apply an effect to an image, such as an embossed appearance or a sepia tone.

Fisheye Distortion

In fisheye distortion, the photo appears to bulge outwards from the center, as if the photo were wrapped around a sphere.

G
Gamma

Range of color values a monitor, scanner, or printer can display. Adjusting this value increases or decreases the intensity of the light
spectrum.

Grayscale Image

Image composed of different shades of gray.

H
Highlights
Highlights are the brightest or whitest parts of an image.
Histogram
A histogram is a graph that displays the dynamic range of shadows and highlights in an image.
HSL
An acronym for hue, saturation, and lightness.

Hue

Predominant color in an image.

|
Image Editor

Program that you can use to create and edit images. ACDSee is an image editor.



Image Resolution

Quality of image details and colors. Also used to describe the quality of monitors and printer output.

Image Viewer

Program that displays images. ACDSee is an image viewer.

Import

Bringing data into an application from another using a format that the receiving application understands.

Interpolation

Process that uses nearby pixels to estimate the color of new pixels added to the larger image. For example, interpolation might be used
when enlarging a digital image.

IPTC

Standard method of encoding information within image files so that items such as descriptive comments and copyright information can
be transmitted with the image.

J-K
Jaggies

Individual pixels displayed in an image with low resolution. The appearance of pixels in an image causes lines and curves to appear
jagged.

L
Lens Vignetting

Unusual darkness in the corners of images as a result of an inability of the lens to distribute light into the corners of the image.

Lossless Compression

Form of compression that retains all image data and quality.

Lossless Rotation and Flipping

Rotation of a JPEG image without loss of image quality. This works best on images with dimensions that are a multiple of 8 or 16.

Lossy Compression

Form of compression that attempts to remove unnecessary data. This data loss can affect image quality.

M
Marquee

Dashed-line frame that identifies a selected portion of an image. Depending on the tool, you can resize or move a marquee with or
without changing the underlying image.

Metadata

Information about an image and how it was taken. For example, the metadata of digital camera images can contain the date and time the
picture was taken, the shutter speed, the exposure settings of the camera, and whether a flash was used.

Monochrome Image

Image containing a single color.

Noise



Effect produced when a variety of pixel colors are used in the same color region. Noise often occurs in images with high ISO setting or
slow shutter speed.

o)
Opacity

Determines how visible an effect is when applied to an image or a selection. High opacity produces a more solid effect, while low opacity
results in a nearly invisible effect.

Overexposed

Images that are overexposed have too many highlights, and tend to look faded. You typically overexpose images by exposing your digital
camera's sensor to light for too long.

P-Q
Panning

Moving zoomed images vertically, horizontally, and diagonally across the display area to view specific areas of the image.

Perceptual

Rendering intent that scales all of the colors within one gamut to fit within another gamut. Best used for photographic images, as it
maintains the relationship between the colors more accurately than the colors themselves.

Photo Album

See album.
Photo Editor

See image editor.
Pincushion Distortion

In pincushion distortion the photo appears to shrink inwards toward the center.
Pixel (PICture ELement)

Smallest visible portion of a digital image, arranged in rows and columns.
Plug-in

Software module that adds functionality to a larger program.
PPI (pixels per inch)

Measurement of how an image is displayed. More pixels per inch result in higher image quality.

Presets

A preset contains image correction settings. You can create and use presets to ensure that settings you apply are the same and
consistent across all images.

Primary Colors

Colors that can produce other colors when blended. For example, in the RGB color model, red, green, and blue are primary colors.

R
Raster Image

Image composed of a rectangular grid of pixels. Each pixel contains a defined value about its color, size, and location in the image. As a
result, resizing the image can affect its quality.

Rating

Assign ratings (1, 2, 3, 4, 5) to photos to help sort and manage them more easily.



RAW

An image file format. RAW files contain all of the image data that was captured by your digital camera's sensor. RAW files are not
processed by your camera; instead, you must process RAW images using a photo editing program such as ACDSee .

Recursive

Program or task that can repeat itself indefinitely, such as a slideshow.

Red Eye

Red eye occurs when the light from your digital camera's flash reflects off the retinas in the subject's eyes. The subject's eyes look red
instead of their normal color.

Relative Colorimetric

Rendering intent that maps the colors that fall exactly within the color gamuts of both the input and output devices. Best used for single-
or limited-color images as colors outside of both gamuts may be mapped to a single color.

Render

Drawing images to your screen.

Rendering Intent

Approach used to map colors from one color gamut to another. There are four rendering intents available: Perceptual, Relative
Colorimetric, Saturation, and Absolute Colorimetric.

Resolution

Quality and clarity of an image, measured in pixels, dots per inch, or pixels per inch.

RGB

Color model that uses red, green, and blue as its primary colors.

Ringing Artifacts

Distortion around the edges of image subjects, caused by compressing or resizing an image.

S
Saturation

Purity of a color. Higher color saturation results in more gray.

Saturation (rendering intent)

Rendering intent that maintains color saturation from one gamut to another. Best suited for images in which the actual color represented
is less important than the color’s vividness.

Selection
Portion of an image that you define with a selection tool. A marquee surrounds a selection. ACDSee and ACD Photo Editor include
selection tools.

Sepia

Sepia-toned images are composed of shades of brown. Many old photographs have a sepia tone.

Sharpen
The sharpen tool is for sharpening images. The original image is blurred slightly. This blurred version of the image is subtracted from
the original image, revealing the edges in the original image. These edges can then be sharpened by increasing contrast.

Sharpness

The sharpness in an image is determined, primarily, by your digital camera's lens and sensor. You can also create the illusion of
sharpness by increasing the contrast between edges within an image.



Shortcut Menu

Menu that appears when you right-click within a program. Sometimes referred to as a context menu.

Slideshow

Automated sequential display of images. You can use slideshow software such as ACDSee to display slideshows of your images.

Soft Proofing

Using your computer's monitor as a proofing device. The monitor displays a simulation of how colors will appear when rendered by the
printer.

T
Tagging

Tagging, like categories and ratings, is a great way to organize and group your photos without moving the files into different folders.
You can tag a photo with one click. Similarly, you can display all tagged photos with one click.

Thumbnails

Small preview of a full-sized image.

Timestamp

Date and time associated with a file.

Transitions

Special effects used between images or video segments in slideshows, screensavers, and videos.

U
Underexposed

Images that are underexposed have too many shadows. Images typically become underexposed if you don't expose your digital camera's
sensor to light long enough.

\'}
Vector Image

Image consisting of individual objects rather than pixels. Mathematical equations define the objects. You can adjust the size of a vector
image and the image will retain its clarity and quality.

W
Watermark

Background text or graphics added to an image, usually to provide copyright protection.
White Balance

Removes color cast to create a photo that is correctly lit. You can use your camera settings to apply the correct white balance before
taking an image, or correct the white balance in ACDSee.

Whitepoint

Lightest image area. You can control the intensity of the white in an image by adjusting its whitepoint.

X-Z
XML (Extensible Markup Language)

Standard language for Web documents.

Zoom



In ACDSee, zoom refers to the process of increasing or decreasing the display scale for an image. Increase the display scale to view a
portion of an image or a specific image detail. Decrease the display scale to view more or all of the image.
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cataloging files
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CD
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DVD
setting CD/DVD management options
E
E icon
Edge Detect effect
Edit
Add Noise
Auto Levels
Blur
Border
Clarity
Color Balance
Convert to Black & White
Crop
Flip
presets
Red Eye Reduction
Remove Noise
Repair tool
Resize
Rotate
Selections
Sharpen
Text
Tone Curve
Vignette
Watermark
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Edit mode
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editing
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cropping 224

exposure 231
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Oil Paint 197
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Pencil Drawing 200
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Pixelate

Posterize

Radial Waves

Rain

Ripple

Scattered Tiles

Sepia

Sheet Metal

Shift

Slant
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Solarize

Stained Glass

Sunspot

Swirl

Threshold

Topography
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Vignette
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Water Drops
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Weave

Wind
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EXIF
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F
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setting File List options 252

setting thumbnail display options 255
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views 45
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cataloging 55
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details 45
finding duplicates 93
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management options 261
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properties 68
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in Edit 223
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options 258
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printing on pages
fullscreen mode
Furry Edges effect
G
getting photos
renaming templates
Glowing Edges effect
Gradient
Granite effect
grayscale
Group by
Edited State
H
header
in View mode
printing on pages
Heal tool
hicolor
highlights
histogram
home folder
HTML album
I
image advance
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Image Well
images
adding audio
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copying

downloading
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import
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images
importing database information
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from a digital camera
from a disk
IPTC
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viewing
J
JPEG options
K
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customizing
Manage mode
View mode
L
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listing files
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Image Basket
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options
Properties pane
Quick Search bar
Search pane

Selective Browsing pane

27
123

33
28
33

81
83
69

278

277
279
286

62
232
229
125
232

150

272
44
38
41
54

279
72

251
68
86
87
90



using
views
Map pane
using
Mirror effect
mobile sync
modes
switching
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files
Manage mode panes
multiple images
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resizing
N
navigator
Negative effect
noise
about

adding to an image
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Oilpaint effect
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optimizing the database

options
ACDSee Quick View
Calendar pane
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database
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Preview pane
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organizing
assigning categories
assigning color labels
finding images quickly
managing categories

originals
showing

Orton effect

Outline effect

overwriting files

P
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auto-hiding
moving

resetting to default layout
PDF
Pencil Drawing effect
photo discs
Photo Repair tool
photos
PicaView
Pixel Explosion effect
pixel resize options
Pixelate effect
plug-ins

about
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viewing properties
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Preview pane

customizing

using
printing

contact sheet options

custom print formats
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text on pages
Properties pane
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using
Q
quarantining files
R
Radial Waves effect
Rain effect
ratings

assigning
recording image audio
red eye reduction
removeable devices
renaming

file or folder

multiple files

while getting photos

replacing files
resizing
multiple images

one image

restoring database information

restoring originals
retro effect
RGB
Ripple effect
rotating

in Edit

in Manage and View mode

multiple photos
S
Scattered Tiles effect
screen capture
screensavers
creating
sharing
Search pane
searching
file name patterns
for duplicate files
Image Well
Quick Search bar
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setting Quick Search options
wildcards
with ACDSee
with the Search pane
second monitor
moving the panes
selecting
files
part of an image
Selections tool
Selective Browsing
Sepia effect
sharing
archives
contact sheets
HTML albums
PDFs
screensavers
slideshows
with ACDSee
sharpen
Sheet Metal effect
Shift effect
shortcuts
Manage mode
mouse
View mode
Slant effect
slideshows
configuring
image advance
sharing
Sobel effect
Solarize effect
sorting files
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adding to images
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start folder

default
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files between folders

View mode to a folder
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adding to an image
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displaying on images in View mode

lists of files

theme
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Threshold effect

thumbnails

rebuilding
setting display options
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views

timestamp

timestamps

toolbars

Topography effect

truecolor
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undo/redo

USB mass storage device

about

user interface
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video files

extracting frames

View mode

automatic zooming

customizing
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displaying text
fullscreen mode
histogram
image advance
keyboard shortcuts
magnifying glass
mouse shortcuts
navigator
panning
setting display options
setting zoom level
synchronizing to a folder
using
zooming an image

viewing
file properties
file types in the File List
fullscreen
images
images in another application
text on images in View mode

Vignette effect

W

wallpaper

Water Drops effect

Water effect
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Waves effect

Weave effect

White Balance

wildcards
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